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Thank you for purchasing the MV1000/MVV2000 (hereafter referred to as the MV).
This manual explains how to use the MV1000/MV2000 (except for communication
features). Please read this manual thoroughly so that you can use the MV properly.
The following MV1000/MV2000 manuals are available.

Paper Manuals

Manual Title Manual No. Description
MV1000 IM MV1000-02E  Explains how to set up the MV1000 for making
First Step Guide measurements using the quick settings function.

Connection diagrams are also provided to help
you with the setup.

MV2000 IM MV2000-02E  Explains how to set up the MV2000 for making

First Step Guide measurements using the quick settings function.
Connection diagrams are also provided to help
you with the setup.

Control of Pollution IM MV1000-91C  Provides information about pollution control.
Caused by the Product

Electronic Manuals Provided on the Accompanying CD-ROM

Manual Title Manual No. Description

MV1000 IM MV1000-02E  Same content as the paper manual.

First Step Guide

MV2000 IM MV2000-02E  Same content as the paper manual.

First Step Guide

MV1000/MV2000 IM MV1000-01E  Explains how to use all the MV1000 and

User’s Manual MV2000 features (except for communication
and network features).

MV1000/MV2000 IM MV1000-17E  Explains how to use the Ethernet and serial

Communication Interface interface communication features.

User’s Manual

DAQSTANDARD Manuals
All manuals other than IM 04L41B01-66EN are contained in the DAQSTANDARD CD.

Manual Title Manual No.

DAQSTANDARD Data Viewer User’s Manual IM 04L41B01-63EN
DAQSTANDARD Hardware Configurator User’s Manual IM 04L41B01-64EN
DAQSTANDARD DX100P/DX200P Configurator User's Manual  IM 04L41B01-65EN
Installing DAQSTANDARD IM 04L41B01-66EN

The contents of this manual are subject to change without prior notice as a result of
continuing improvements to the instrument’s performance and functions.

Every effort has been made in the preparation of this manual to ensure the accuracy
of its contents. However, should you have any questions or find any errors, please
contact your nearest YOKOGAWA dealer.

Copying or reproducing all or any part of the contents of this manual without
YOKOGAWA's permission is strictly prohibited.

The TCP/IP software of this product and the document concerning the TCP/IP
software have been developed/created by YOKOGAWA based on the BSD Networking
Software, Release 1 that has been licensed from the Regents of the University of
California.

All Rights Reserved, Copyright © 2007, Yokogawa Electric Corporation
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MV'’s Version and Functions Described in This Manual

MV’s Version and Functions
For the procedure to check the version, see section 9.3.

Edition

Mv

Addition and change to functions

Refer to

1

2

Style number 1
Version number 1

New

Compatible with the
DAQSTANDARD R8.21.

page i and First Step Guide.

Acquire the contents of the Notice
of Alterations (rechargable battery
model, etc).

Section 2.4 and First Step
Guide.
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How to Use This Manual

Content Summary

This user’s manual consists of the chapters listed below. For information about the
communication features and the accompanying software DAQSTANDARD, read the
respective manual.

Chapter

Title and Contents

1

Feature Overview
The MV features.

Installation and Wiring
How to install the MV, how to wire input terminals, and how to connect the power
cable.

Measurement Channels and Alarms
How to set measurement conditions and how to set alarms.

Measurement and Recording

How to record and store measured values and other values. This chapter also
explains how to load measured data or setup data from a CF card or USB flash
memory.

Screen Operations
How to use the operation screen.

Display Configuration
How to change the displayed information on the operation screen and how to write
a message.

Event Action
How to make the MV perform a specific action in response to an event, a remote
control signal input, or a pressing of the USER key.

Security Features

How to use the key lock feature and the feature that allows only registered users to
operate the MV.

Environment Settings
How to configure the time settings and how to operate the MV by using a keyboard.

10

Computation and Report Functions (/M1 and /PM1 options)

How to use computation channels and how to create various reports, such as
hourly, daily, weekly, and monthly reports.

1"

External Input Channels (/MC1 option)
How to use external input channels.

12

Troubleshooting and Maintenance
Explains error messages and troubleshooting measures.

13

Specifications
Lists the MV specifications.

Appendix Describes measured data file sizes, text file formats, etc.

Index

Notfte

« This user’s manual covers information about MVs that have a suffix code for language “-2”
(English).
« For language configuration instructions, see section 9.4, “Changing the Language.”
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How to Use This Manual

The following symbols are used in this manual.

Unit
K
k

Markings

>

CAUTION

Note

>

Subheadings
Bold characters

[Ala]#[1]

Explanation

Display

Procedural Explanations
This manual mainly describes the MV1000 procedures. Where procedures differ between

the MV2000 and MV1000, the MV2000 procedures (menu operations) are also provided.
High-Speed and Medium-Speed Input Model Groupings

This manual uses high-speed input model and medium-speed input model to distinguish
between MV models as follows:

Denotes 1024. Example: 768 KB (file size)
Denotes 1000.

Improper handling or use can lead to injury to the user or damage
to the instrument. This symbol appears on the instrument to
indicate that the user must refer to the user's manual for special
instructions. The same symbol appears in the corresponding
place in the user's manual to identify those instructions. In the
manual, the symbol is used in conjunction with the word
“WARNING” or “CAUTION.”

Calls attention to actions or conditions that could cause serious
or fatal injury to the user, and precautions that can be taken to
prevent such occurrences.

Calls attention to actions or conditions that could cause light
injury to the user or damage to the instrument or user’s data, and
precautions that can be taken to prevent such occurrences.

Calls attention to information that is important for proper
operation of the instrument.

This mark is used to indicate a reference to a related procedure or
explanation.

Denotes key or character strings that appear on the screen.
Example: Volt

Indicates character types that can be used.
A Uppercase alphabet, [allowercase alphabet, [#] symbols,
[1] numbers.

Carry out the procedure according to the step numbers.

All procedures are written with inexperienced users in mind;
depending on the operation, not all steps need to be taken.
Explanation gives information such as limitations related the
procedure.

Indicates the display and explains the settings. A detailed
description of the function is not provided in this section.
For details on the function, see chapter 1.

Model type Model

High-speed input model MV1004, MV1008, MV2008

Medium-speed input model MV1006, MV1012, MV1024, MV2010, MV2020, MV2030,
MV2040, MVV2048
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Chapter 1 Feature Overview

1.1 System Overview

System Configuration
The MV can be used to construct a system like the one shown below. The MV can
make voltage and temperature measurements by itself. It can also transfer data to other
devices via Ethernet or a serial interface, and it can acquire data from multiple channels
using the Modbus protocol.

- PC
"o
Ethernet °
(Communication Interface User’s Manual) I
Temperature Recorder PC
regulator
B
7/ Serial communication* AV4
N (Communication Interface || =)
- Measurement User’s Manual) g
T_ input o
> Section 3.3 E?%@
Pulse input* » mv « @ CF card
P> Section 3.10 D> First Step Guide
(e
—
Transmitter power supply*® ~~% USB flash memory
P Section 2.3 « USB port 2 P Section 4.10
Qo
Sodod & o
<— Keys Keyboard
Alarm output* « P Section 9.7
P> Sections 3.5 to 3.8
FAIL/status output « « Remote input*
P Section 9.6 P> Section 7.4
* Options
Terminology

* Memory sampling
Recording measured data.
* Memory start
A command to start memory sampling.
* Memory stop
A command to stop memory sampling.
* Display data
The waveform data displayed on the MV screen. It is essentially measured data that is
recorded at the display data sampling rate.
* Event data
Measured data that is recorded at a set sampling rate that differs from that of the
display data.

IM MV1000-01E 11
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1.1 System Overview

Modes

The MV has an Operation Mode, a Setting Mode, and a Basic Setting Mode.

Mode Transition Diagram Power ON

Operation Mode

Ininfdiv

12:32

i 2
H 1.242\/2
o

MENU or
ESC MENU

- ‘ )
Setting Mode P ——— DISP/ENTER © EH Leseon:

Heas channel »
Hath channel »

Data save
Display
Group o
Hessage

Tiner, Event sction »

Henu custonize

Date/Tine »

Basic setting mode

Range Span_L  Span_ll
oy [-2.6000 [ 2 0008

Configuration
screen

 ——
——
MENU or ESC

Select Basic setting mode from the menu,
or hold down FUNC for three seconds.

Frhernet

Basi¢ Setting Mode Link

DISP/ENTER | %z "ine!
R

Scan interval
A/D in

A A Basic Setting Mode
Basic Setting Mode Ervironent. | ISV nitiolize |

Alarn >
/D, Hemary

Burnout, B
teslocl”  Basic settings
Legin menu

Report

Tine settings
Gomnunication {Ethernet) b
Comnunication (Serial}  »

~ Status relay

Henary

Data k

—
~—

ESC

J
Select End, or press ESC then DISP/ENTER.

Mode Description
Operation Mode For performing measurements.
Setting Mode For configuring settings, such as the input range and the

measurement method. You can change most of the settings in this
mode while the MV is engaged in memory sampling.

Basic Setting Mode For configuring fundamental settings, such as the scan interval and
the measured data save method. You cannot switch to this mode
while the MV is engaged in memory sampling.

*For a list of the contents of Setting Mode and Basic Setting Mode, see the First Step Guide.
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1.2 Input

Measurement Channels

* Number of Channels vs. Scan Interval
The MV acquires data by sampling measurement channel input signals at the set scan
interval. The following is a list of the scan intervals available with different numbers of

channels.

Number of Scan Interval

Model Measurement Normal Mode Fast Sampling Mode
Channels

MV1004 4

MV1008 8 125 ms, 250 ms 25 ms

MV1006 6

MV1012 12 1s,2s,5s 2s,5s 125 ms

MV1024 24

MV2008 8 125 ms, 250 ms 25 ms

MV2010 10

MV2020 20

MV2030 30 1s,2s,5s 2s,5s 125 ms

MV2040 40

MV2048 48

A/D converter integration time 60 Hz/50 Hz 100 ms 600 Hz (fixed)

P For configuration instructions, see section 3.1.

* A/D Converter Integration Time
The MV uses an A/D converter to convert sampled analog signals to digital signals.
You can effectively eliminate the influence of power supply noise by setting the A/D
converter’s integration time to the same length as or to an integral multiple of the
power source period.

» Because 100 ms is an integral multiple of both 16.7 ms and 20 ms, you can effectively
eliminate the influence of power supply noise from both 50- and 60-Hz frequencies by
setting the integration time to 100 ms.

« Power supply noise elimination is less effective in fast sampling mode than it is in normal
mode. When measuring in an environment susceptible to power supply noise, we
recommend that you measure in normal mode.

P For configuration instructions, see section 3.1.

Input Types and Computation Functions

You can measure the following types of input.
Input Type Description
DC voltage You can measure DC voltages in the range of £20 mV to +50 V.
DC current You can measure a DC current signal by converting it to a voltage signal using a shunt
resistor attached to the input terminal.’
The converted signal can be measured within the DC voltage range (see above).
Thermocouple |You can measure temperatures using these thermocouple types: R, S, B, K, E, J, T, N,
W, L, U, and WRe3-25. It is also possible to measure using other thermocouples, such as
PR40-20 and PLATINEL.?
RTD You can measure temperatures using RTD types Pt100 and JPt100. It is also possible to
measure using other RTD types such as Cu10 and Cu25,® and Pt50 and Ni100.2
ON/OFF input |You can display contact input or voltage input signals correlated to 0% or 100% of the
display range.
Contact input: A closed contact is ON (1). An open contact is OFF (0).
Voltage input: Less than 2.4 V is OFF (0). 2.4 VV or more is ON (1).
Pulse input* You can count pulses.

1 Shunt resistor sold separately. For example, you can use a 250-Q shunt resistor to convert a 4- to 20-mA
signal to a 1- to 5-V signal.

2 /N3 option

3 /N1 option

4 /PM1 option

IM MV1000-01E 1-3
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1.2 Input

The following input processing and math operations are available.

Moving average

Linear Calibration Low cut Difference Measured

scaling correction computation  value
(/CC1 option)
DC voltage | Fa 27N POy N
T P ) P
Shunt resistor b N Lo
DC current 1 i ! A~ b AN
it — O 0
! E Square root computation ! i .
1-5V \ = O o .
Burnout detection ) b P i
RIC_ | ! .
Thermocouple —T — o ;o
Burnout detection . - -4 | ! | M b
b N [
RTD Lo D -
| a o
o/ [
! . -
ON/OFF input \?Jr- Do .
| M Lo
/ S
Convert to number of pulses per second
Pul Y
ulse -/

(/PM1 option)

Dotted lines indicate that the function can be selected.

Reference Junction Compensation

Burnout Detection

Performs reference junction compensation on
a thermocouple. MV

Thermocouple 4
P ) Internal
L] reference
Thermocouple junction

External reference junction
For configuration instructions, see section 3.2.

Detects and indicates a sensor burnout.

Burnout
1-5V
C ® Indicated as
Detected on the Burnout.
1-5 V value.

Thermoelectromotive

Burnout foree
Indicated as

C Burnout.

For configuration instructions, see section 3.2.

Moving Average

Eliminates noise.
Operation example when the number

New sampled

New sampled

of moving average data points is 3 data ‘ data '
1| 10.0 mv 15.0 mV 10.0 mV Number of moving
_SatmhpILn%fdata 2| 50mv s 10.0 mv s: 15.0 mvV average data points: 2 to 400
in the burter 3 oomv 50mv_ [ 10.0 mv
) Clear Clear
(Moving average) [ 50mv | [[10.0mv | [117mv ]
Sampling nth time n + 1th time n + 2th time

For configuration instructions, see section 3.4.
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1.2 Input

Square Root Computation

Linear Scaling

Takes the square root of the input value and converts
the unit to obtain the measured value.

b B
— — oX Measured
value X value
a /\

A B

L1

X—a [
X=(B-A)/ —— +A /
b-a A

For configuration instructions, see section 3.3.

a b

Converts the unit to obtain the measured value.

nNV——— 300 °c

Measured
value

ov —

-100 °c

For configuration instructions, see section 3.3.

Calibration Correction (/CC1 Option)

Low-cut

Corrects the input value with the characteristics
specified by segments to obtain the measured value.

Number of break
points: Up to 16

Output
value
()
value

Input
value

For configuration instructions, see section 3.9.

For square root computation, measured values below
the specified value are cut.
For 1-5 V input, values below 0 % are cut.

Measured
value
Low-cut value |+

/! value

For configuration instructions, see section 3.3.

Result of square root
computation

Difference Computation

Pulse Input (/PM1 Option)

The measured value of the channel is set to the
difference with respect to the measured value of the
reference channel.

Input Measured
value value

Measured value on the reference channel

For configuration instructions, see section 3.3.

Counts pulses.
Pulses of 100 Hz or less
can be counted

Input to the MV

Contact }_
' |
J | or
T o Ko
5 ms or more collector

Count on the MV
|The contact changes from open to closed.|

—> MV

The signal level at the input terminal changes from high
to low.

For configuration instructions, see section 3.10.

Note

You can use difference computation even if the reference channel and difference computation

channel’s input types and ranges are different. Difference computation takes place using the

difference computation channel’s decimal place and unit.

Example 1: If the input value of the difference computation channel is 10.00 and the measured
value of the reference channel is 100.0, the result is 10.00—-100.0=-90.00.

Example 2: If the input value of the difference computation channel is 10.00 V and the
measured value of the reference channel is 5.00 mV, the computed result is 10.00
V -5.00mV=5.00V.

IM MV1000-01E
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1.3

Alarms

This function generates an alarm when the measured data meets a set condition. You
can set a maximum of four different alarms on each channel.

Alarm Types

You can use the types of alarms listed below. The letters contained in parentheses are
used as abbreviations for the alarms.
P For alarm configuration instructions, see section 3.7.

High Limit Alarm (H) Low Limit Alarm (L)
Measured value Hysteresis Measured value Hysteresis
Alarm value |>
/ /i
‘\ Alarm value [> ‘
Alarm output ON E—————"—+ Alarm output ON -
Delay High Limit Alarm (T) Delay Low Limit Alarm (t)
‘ Measured value \ Measured value /

Alarm value [>

Alarm value |>
/

Delay time ——<

Alarm output ON ——

‘ Delay time —r——< !

Alarm output ON ——

High Limit on Rate-of-Change Alarm (R)

Low Limit on Rate-of-Change Alarm (r)

Measured value
A

Change in the Measured value
_-~  measured value 3

T2 - T2 Amount of change in
- Amount of change in < the setting
T P the setting T \,\ |T2-T1|
IT2-71| > ~. > Change in the measured value
t1 t2 > i t1 2| > > Ti
7> lime ime
Interval (t2-t1) Interval (t2-t1)
Difference High Limit Alarm (h) Difference Low Limit Alarm (I)
Difference in the measured values of two channels Difference in the measured values of two channels
Hysteresis Hysteresis
Alarm value \ /
I> /. N Alarm value |> \_//
I I I I

Alarm output ON ————7

Alarm output ON ——————

Hysteresis
You can set a difference between the value that activates an alarm and the value that

deactivates it.
P For configuration instructions, see section 3.5.

Delay High Limit Alarm and Delay Low Limit Alarm
If the measured value remains above or below the set alarm value for the set period of
time (the delay time), an alarm is activated.

High Limit on Rate-of-Change Alarm and Low Limit on Rate-of-Change
Alarm

The MV checks the rate-of-change of the measured values over a set period of time (the
interval) and activates an alarm if the rate-of-change in the rising or falling direction is
greater than or equal to the set value.

The alarm value of the rate-of-change alarm is set using an absolute value. The
interval is derived from the sampling count using the following equation:

Interval = scan interval x sampling count

P For instructions on how to set the interval, see section 3.5.

Difference High Limit Alarm and Difference Low Limit Alarm

The MV activates an alarm when the difference between the values of two channels
goes above or below the set value. You can use this alarm on measurement channels
set to difference computation.

1-6
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1.3 Alarms

Alarm display
Alarm conditions are indicated in operation windows (trend, digital, bar graph, overview,
etc.) and by icons in the status display section. The alarm summary displays detailed
alarm information.
* Hold/Nonhold of Indication
When alarm conditions cease, their indicators can be set to either:
« Stop as soon as the alarm condition ceases (Nonhold).
« Continue until the execution of an alarm output release (AlarmACK) operation (Hold).
The default setting is Nonhold.
» For configuration instructions, see Section 3.5.

¢ Alarm Hide Function
If this function is enabled, the MV will not display alarm condition information or record
it in the alarm summary. However, the MV will output alarm information to a relay (/A
options) or internal switch. You can set this function for each channel and alarm.
» For configuration instructions, see Section 3.6.

Alarm Output Relay Operation
The MV can generate a contact signal from an alarm output relay (/A options) when an
alarm occurs. The alarm output relay operation can be changed.
P For configuration instructions, see Section 3.5.

Reflash AND/OR

r Channel 1 —I‘ Channel 1—,—|—

| |
Alarm I Alarm | ‘

Channel 2 | | Channel 2—1—,_31—
L Channel 3 _ ‘

|
|
| | |
oo | Alarm output relay

| i
I I
el
AND ; :
| |

r or
Alarm output relay I U L Int | switch I e B
(reflash ON) | e e nternal swite

7 éggrno]’é é‘ggrr%’é (You can set the alarm output relay and internal
Alarm output relay I E— switch. For details on the internal switch, see the

(reflash OFF) | (when a relay is set to “OR” logic) | Next page.)
Energize or De-energize

When power is shut down  Normal operation When alarm is occurring

. NO: Normally Opened
Energize J /l l /1 l\ l C: Common

NOC NC NOC NC NOC NC NC: Normally Closed
De-energize l /l 1\> l l A
NOC NC NOC NC NOC NC
Non-Hold Hold
Alarm occurrence AIarmACK AlarmACK
Alarm release I L _,_I_LE_
Alarm _!_.I_ . or ! T E
Alarm iActivated Activated Activated | Normall€
output Relay is activated >
relay Deactivated Deactivated Deactivated at the next scan =
interval g
o
Alarm occurrence AlarmACK AlarmACK AIarImACK ;
! —
Alarm ! ,l Alarm release_| ' E ] —,_LE— _,_E_L - %
Alarm Activated or Activated Activated or Activated ese! g
output I L —| —_ _| L _| L |Relayis activated b3
relay Deactivated Deactivated Deactivated Deactivated giéhé;‘rgﬁétealarm
u
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1.3 Alarms

Internal Switch

¢ Reflash
This function enables a single alarm output relay with multiple alarms assigned to it to
indicate all alarm occurrences. After the first alarm, subsequent alarms are indicated
by the brief release (approximately 500 ms) of the output relay.
The reflash function affects the first three output relays.*
*101 to 103 or 111 to 113. With the /A1 option, 101 and 102.

Note

When reflash is enabled, the first three output relays are used exclusively as reflash relays.
The first three output relays are set to OR logic and to the Nonhold operation regardless of the
AND/OR or Nonhold/Hold settings explained below.

¢ AND/OR
When multiple alarms are assigned to one output relay, you can choose to activate the
alarm in one of the following ways (you can also use AND/OR with internal switches):
» AND: Activate the relay when all of the alarms assigned to it occur simultaneously.
* OR: Activate the relay when any of the alarms assigned to it occur.

¢ Energize or De-energize Operation
You can choose whether to energize or de-energize alarm output relays when an
alarm occurs. If you select de-energize, the alarm output relays will be in the same
state when the power is shut off as they are when an alarm occurs. This setting
applies to all alarm output relays.

* Nonhold/Hold
When an alarm condition is no longer met, alarm relays can be set to:
» Turn OFF immediately (Nonhold).
* Remain ON until the execution of an alarm output release (AlarmACK) operation (Hold).
This setting applies to all alarm output relays.

¢ Alarm Output Release Operation
The alarm output release operation (AlarmACK) stops the display and the relay output
of all alarms. For information about how alarm display and output relay operations
respond to an AlarmACK operation, see the previous page.

Nofte

When you enter Basic Setting Mode, the alarm output relay remains at its current active/
released state. In Basic Setting Mode, alarms are not detected and the AlarmACK operation is
invalid.

The MV can transmit the alarm status to software switches (30 internal switches).
Internal switch values are shown below. As with AlarmACK, you can apply an AND or OR
operation (see the previous page).

Alarm occurrence

Alarm _l |_

Alarm release

1
Internal switch F,_L

Internal switches can be used as events with the event action function (for details, see
section 1.7). Internal switches can also be written into computation channel (/M1 and
/PM1 options) expressions.

1-8
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1.4

Display

Common Display functions

LCD Display and Its Layout

The MV1000 has a 5.5-inch (240 x 320 dot resolution) TFT color LCD. The MV2000
has a 10.4-inch (480 x 640 dot resolution) TFT color LCD. The display consists of a
status display section and a data display section.

The MV1000 Display

o23 1.34:5 e I (O

()] =— Status display section

0.5014| 1.6631
o U U — Data displ i
5 1 play section
-0.4410 +Over
m O v v |

¢ Status Display Section
The status display section indicates the display name, date/time, batch name

(when using the batch function), user name (when using the login function), internal
memory and CF card usage, alarm occurrence, computation status (/M1 or /PM1
option), key lock status, and e-mail transmission.

e Data Display Section
The data display section shows measured data using numbers, waveforms, and
bar graphs. It displays a configuration screen when you are configuring a function.

Group Display

On the trend, digital, and bar graph displays, channel data is displayed in preset
groups. With the MV1000, you can register up to 10 groups, each with up to 6
channels. With the MVV2000, you can register up to 36 groups, each with up to 10
channels. The same groups are used for the trend, digital, and bar graph displays.
Displayed groups can be switched automatically at specified intervals (5 s to 1 min).
P For configuration instructions, see section 6.1.

Channel Number Display and Tag Name Display

You can choose to label displayed channels according to their tag names or according
to their channel numbers. This setting applies to all channels.

P For configuration instructions, see section 6.2.

Update Interval of Measured Values

Measured values are updated every second. However, if the scan interval is longer
than 1 s, measured values are updated at the scan interval.

P For configuration instructions, see section 6.3.

Alarm Indication
The MV regularly checks for the alarms set to each channel and indicates alarms with
the following symbols:

Alarm Type Symbol Alarm Type Symbol
High limit alarm H High limit on rate-of-change alarm R
Low limit alarm L Low limit on rate-of-change alarm r
Difference high limit alarm h Delay high limit alarm T
Difference low limit alarm | Delay low limit alarm t

IM MV1000-01E
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1.4 Display

Status Display Section
The status display section contains the following information when the MV is in Operation
or Setting Mode.

Memory Sampling Status

Data type
DISP: Display data
EVENT: Event data

— The green bar indicates the memory sampling progress.
The frame represents either the length of one file save interval (with display
data) or the length of one data segment (with event data).

Internal memory error. Contact your nearest YOKOGAWA dealer for

Memory sampling icon m
No memory sampling %
Fils Sémin
Memory sampling [ =] [ ==
in progress ﬁ M Wait it
W=it i
Display paused bk ol
(memory sampling 11
continues)

repairs.

The remaining memory sampling time.

Indicates that the MV is waiting for an event data trigger.

When an event data pre-trigger is set, the part of the bar that
represents the length of the pre-trigger section will be displayed
in orange.

Display or group name
If all channels are being displayed with trend display,
the group name display shows “ALL”.

Date and time
If the function that gradually adjusts the time is enabled,
the time is displayed in yellow.

When using the batch function

d-AAESL 1 Batch name (displayed

a alternately with the display
name)
Date/time*

If the batch and lot numbers exceed 20 characters,
the date/time area will also be used to display the

When using the login function

1l

Current user name

Date/time*
(displayed alternately with the
display name)

Current user name

I
Alarm Icons
At least one alarm condition has been met.
“}} This icon blinks when an alarm condition is
(Red) met and AlarmACK has not been executed.

—

After an alarm condition has been met, all
alarms have been released, but there is still
at least one alarm for which an AlarmACK
operation has not been performed.

— Status Icon
(Displayed alternately on models with the /M1
or /PM1 option)

m Key lock is on.

E E-mail notification has been activated.

(Green)

M The condition set to the status output
A relay (/F1 option) has been met.

~ Math icon (/M1 and /PM1 options)
+=| White icon: Math in progress
-
+=
-

Yellow icon: Math data dropout

Batch name (displayed
alternately with the display
name and date/time*)

* With the MV2000, the date/time and batch name are displayed
on different lines.

batch and lot. 1

L— CF Card Icons

E] Accessing the CF card.
O

Waiting.

Light blue icon: There is a CF card in the slot,

The green bar indicates the amount of used CF card
memory. If Media FIFO is switched off, the bar

color will change to red when the amount of available
CF card memory falls below 10%.

but it is not connected properly.

Remove the CF card, and then reinsert it. There
is a CF card error. To return the CF card icon to
normal, perform the following:

Remove the CF card, and then reinsert it.
Exchange it with a functional CF card.

Use the MV to format the CF card

(the CF card data will be deleted).

.
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1.4 Display

Trend Display (T-Y)
Displays measured data using waveforms. (For operating instructions, see section 5.2.)
Waveform (displayed with the set channel color)

» To change channel colors, see section 6.5
» To change waveform line width, see section 6.10

Trend interval' ——e:n
P Sections 5.2
and 6.3

Trip line —*

(up to four lines) —

» To display every channel's w

aveform, see section 5.2

Grid
» Section 6.10
You can display a fine grid.

Fine grid
» Section 5.2

Current value mark

» Section 6.1

--Maximum value
- Minimum value

1 dot

Displays the maximum and
minimum values sampled
in the time corresponding
to one dot.

Trend space function
Inserts a division-wide
space here.

}

The tag name or channel number,
measured value, unit, and the set
alarm

]

L —1.8473

W m@—— Alarm mark
Alarm type

— Time at the grid location
Either displays the time, or
the date and time.

» Sections 6.3 and 9.1

Display layout®» Section 6.10

Vertical display

2.8 -1.8 ve.a
NI T N SRR SRR . .
=z =

16z 18

P Section 5.2
, é.‘t

Alarm value mark
» Section 6.8

Color scale band
» Section 6.8

Numeric display
section
» Section 5.2

Measured
value scale
p» Section 6.7

Current value
» Section 6.7

The waveforms

their groups.

Horizontal split display
(displays two groups)

are displayed. The numeric display sections
show the data for the first four channels in

of two consecutive groups

ol))

*1 When the trend interval is changed, only the time axis display changes. The sampling
interval when recording display data (section 1.5) is specified by the Trend/Storage interval
(section 4.1).
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1.4 Display

¢ Waveform Updating

Every 30 dots makes up one division (also referred to as DIV) on the time axis.

The waveform update interval is the time corresponding to one dot. The time

corresponding to one dot depends on the time set to one division (the trend interval).
The relationship between the trend interval and the speed of waveform movement in

the display is as follows:

Trend interval (per DIV) 5s' 10s' [15s2 |[30s 1 min
Time corresponding to one dot (in seconds) 0.125 0.25 |0.5 1 2
Speed of waveform movement (approximation in mm/h) [10000 5000 |2500 1250 625
Trend interval (per DIV) 2 min 5min |10 min {15 min |20 min
Time corresponding to one dot (in seconds) 4 10 20 30 40
Speed of waveform movement (approximation in mm/h) |312 156 78 42 31
Trend interval (per DIV) 30min |1h 2h 4h 10 h
Time corresponding to one dot (in seconds) 60 120 240 480 1200
Speed of waveform movement (approximation in mm/h) |21 10 5.2 2.6 1.0

1 40 dots per division. Available on high-speed input models of the MV.
2 Available on medium-speed input models of the MV when in fast sampling mode .

Switching Trend Intervals (For instructions on how to set the second interval, see

section 6.3.)

You can press T/DIV to change the trend interval. You can also switch from the
ordinary trend interval to the secondary trend interval, and vice versa, while the MV is

collecting data.

* Writing Messages

Preset messages

Start
Material 1

-

\awls

Free messages
You can enter non-preset messages.

o
7

1614 HATERTAL_TY
ARTA
i 1513

Preset Messages (For configuration and operating instructions, see section 6.4.)
You can choose preset messages to be written on the waveform.

Max. number of messages: 100 (Messages 1 through 10 are free messages.)

Free Messages (For configuration and operating instructions, see section 6.4.)

You can enter non-preset messages.
Max. number of free messages: 10

Automatically written messages(For configuration instructions, see

sections 6.3 and 6.17.)

* The MV will automatically write a message to indicate when the trend update rate has

been switched during memory sampling.

» The MV will automatically write a message to indicate when power has been
restored after a power failure that occurs during memory sampling.

Message Display Options

*  When using horizontal or horizontal split display, messages can be displayed either

vertically or horizontally. (For configuration instructions, see section 6.10.)

» Messages can be displayed as a group in the upper left corner of the screen (list

, oo e (56

display). (For operating instructions, see section 5.2.)

>y 18:55 Press

{156 HOLD

T Tene

i

dua) p5:aT
e SR X

List display

Vertical display
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1.4 Display

e Zone Display
You can display channels in specified zones. This allows you to separate waveforms
so that they don’t overlap.
In the following example, channel 1 is set to 0-30%, channel 2 is set to 30-60%, and
channel 3 is set to 60-100%.

Without zone display With zone display
100% = 100%
/ \ Zone 3

NI ] o YRR

I W] =2 — 7 NN Zone 2
// / \\\\// \NA/ 30%
CH1 & /_ \ Zone 1
L 0% — — 0%

Time axis Time axis

P For configuration instructions, see section 6.6.

Auto Zone (For operating instructions, see section 5.2)
You can divide the trend display area evenly between each channel in a group.

e Partial Expansion
This function enables you to compress part of the display and expand the rest of it.
In the following example, the display below 0 V (the boundary value) is shifted to the
bottom 30% of the screen. The bottom 30% of the screen displays -6 V to 0 V, while
the top 70% displays 0 V to 6 V.

Without partial expansion With partial expansion
Percentage of Percentage of
Measured value display span % Measured value display span %
6V 100 6V 100 ——
Boundary| Expanded
Boundal
value \ry VAR JAA value area
0 50 / \ / \ Shlfte_d
location
\/ \ |/ /
0 30 ——
AN // ANI V4 Compressed
area
-6V 0 -6V 0 —t
Time axis Time axis

P For configuration instructions, see section 6.9.

e Alarm Display
The alarm mark, alarm type, and measured values are displayed in the following
ways, depending on the alarm condition.
Indication not held Indication held
AlaimACK AlaamACK

o Oo0mos )| [ i

Release

Blinking |Blinking

Alarm mark Green| Red | Green | Green green

Green Green Ei?king Red |Green

Alarm type None| Red | None | None | Red None :None None| Red : Red|None

Measured
value

Blue| Red | Blue | Blue | Red Blue :Blue Blue| Red : Red| Blue
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1.4 Display

Digital Display

Displays measured data using large numeric symbols.

» Forop

erating instructions, see section 5.2.

5 IZ:-IEF' _m@ o0}
0 N 5014.— Measured value

v Y&— Unit
III. Alarm mark

Nofte

Tag name or channel number

ie
-0.4410
H B U

* Measurement Channel Numeric Value Display
When the MV detects a range-out (see below), the display is either “+Over” or “-Over.”
When the MV detects a burnout on a channel that has been set to be checked for burnouts,
the display is “Burnout”. All other values are displayed numerically.

Ra

e Co

nge-outs are detected on measurement channels in the following circumstances.

If the DC voltage input value goes above the measurable range + 5%, a range-out is
detected. For example, when the measurement range is 2 V, the measurable range is
—2.000 to 2.000 V. If the voltage exceeds 2.200 V, a positive range-out is detected. If it
goes below —2.200 V, a negative range-out is detected.

If the input type is thermocouple or RTD, a range-out is detected when the temperature
goes 10°C above or below the measurable range. For example, when the measurement
range is set to R, the measurable range is 0.0 to 1760.0°C. If the temperature exceeds
1770.0°C, “+Over” will be displayed. If the temperature goes below -10.0°C, “-Over” will
be displayed.

On channels that use linear scaling, the range-out values, ignoring the decimal point,
are above 30000 and below —30000. However, you can also set the range-out values to
105% or greater, and —5% or less of the scale width, as long as those values fall within
+30000.

P> For configuration instructions, see section 3.11.

mputation Channel Numeric Value Display

P> See section 1.9.

¢ External Input Channel Numeric Value Display (/MC1 option)
The range of displayable values, ignoring the decimal point, is —30000 to 30000. The
decimal place is determined by the location of the decimal point on the external input
channel’s minimum span value. Regardless of maximum and minimum span value settings,
all values within the range of —30000 to 30000 will be displayed. If the value exceeds 30000,
“+Over” will be displayed. If the value goes below —30000, “-Over” will be displayed.

e Alarm

Display

The alarm mark and measured values are displayed in the following ways depending
on the alarm condition.

Indication not held Indication held
AlaimACK AlamACK
mam e L T L T Lo
Release —
Blinking |Blinking Blinking
Alarm mark Green| Red | Green | Green —~ green Green Green = Red |Green
y;zzured Blue| Red | Blue | Blue | Red | Blue :Blue Blue| Red :Red| Blue
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.4 Display

Bar Graph Display

Displays measured data using bar graphs.

P For operating instructions, see section 5.2.

Horizontal
5E
-2, 6a88 2. Baea (1
PS H 1 _17R%
-2.5088 2. 508 |2 1 179
|
| L @ ]
[ |
-3. 608 3. B@E (3
B L7
W
-4, BE6 4. mee ¢
]| L7

Vertical > Sect

ion 6.10
q —

IZ:-IEF' _m@

The bar graph base position is set to Normal,
Lower, or Upper.
» Section 6.11

The bar graph base position is set to Center.
» Section 6.11

1 3 4 @—— Tag name or channel number
2 aEaa 2.588 3. 808 <. Bl Alarm mark
- - - %% ___ Maximum value
— Scale
» Section 6.7
® Alarm value mark
— Bar
(displayed with the set channel color)
-2, BEoE -2, 508 -3, @ —4.888..[ P Section 6.11
C ["h} C "} C "} C '3}
B.3699 B.378 B.378 B. 371® L— Unit of measurement and minimum value
— L— Measured value

The bar graph base position is set to Center.

P Section 6.11

The bar graph base position is set to Normal, Lower, or Upper.

P Section 6.11

¢ Bar Graph Display Updating
The bar graph display is updated at the same rate as numeric values.

e Alarm Display

The alarm mark, alarm value mark, and measured values are displayed in the
following ways, depending on the alarm condition.

Indication not held Indication held
AlarACK AlarmACK
Alarm Occurrence |_| I_l |_ |
Release —
Blinking |Blinking Blinking
Alarm mark Green| Red |Green | Green = green Green Green —~ Red |Green
Value mark Green| Red | Green|Green| Red |Green :Green Green| Red :Red |Green
\l\llla:elzzured Blue| Red | Blue | Blue | Red | Blue iBlue Blue| Red :Red | Blue
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1.4 Display

Historical Trend
The MV can display the waveforms of past measured data (display or event data) stored

in internal or external memory. This function is called historical trend.
* Historical Trend Display Options
There are five ways that you can display measured data stored in internal memory:
* From the alarm summary display. P See section 5.7.
« From the message summary display. P> See section 5.8.
« From the memory summary display. P> See section 5.9.
» From the display selection menu. P See section 5.3.
* By pressing HISTORY.
You can also display measured data stored to external memory. p» See section 4.8.

* Display Contents

Background Waveform (channel display color)
color (Changeable)

Location of the most recent data
Trip line

Tag name or channel number
(channel display color)

5,551 B.2519 . .
—.z=se— Measured values (maximum and minimum
I values for the entire display*)
Unit
Measured values (maximum and minimum

values at the cursor position*)
*You can also just display the digital values at the cursor position.

Cursor

Message

Date and time at the right end of the time axis** or the

time at the cursor position
(The time at the cursor position is surrounded by a yellow square.)

Date and time at the left end of the time axis**
** You can also set this area to display the time relative to the start of recording.

Half screen dis
I

play

Present trend
Historical trend

Item Description

Alarm summary Displays a summary of the displayed data’s alarms.

Message summary Displays a summary of the displayed data’s messages.
Memory summary Displays the properties (file name, sample start time, end time,

etc.) of the displayed data.

* Add Message
You can enter added messages.
P For operating instructions, see section 6.4.
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1.4 Display

¢ Auto Span

The MV can automatically adjust the display span of the selected channel.” It sets
the span based on the maximum and minimum displayed historical data values. Auto
span is deactivated when you switch to another group.

* Auto span affects channels that are in the same scale position as the selected channel.
When the maximum or minimum values are outside of the set display span

Measured value Measured value
\
/ \ L
\
\ N / \
0 \ I N—
\[/ \ N
\/ Auto span NN s

\[ /

\/

Time axis Time axis

When the maximum or minimum values are within the set display span

Measured value Measured value
N
\
e / \
0 0
N, » -
~ Auto span \ I
\[/
Vi
Time axis Time axis

If the maximum or minimum data value falls outside the maximum selectable display
span, the MV adjusts the display span to the maximum or minimum possible value.
The MV responds in the same way when it encounters overflow data.

Top Channel
Displays the selected channel’s historical trend waveform in front of all of the others.

This setting is deactivated when you switch to another group.

IM MV1000-01E
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1.4 Display

Overview

Displays a list that shows the conditions of all channels.
You can select a channel to access the trend, digital, or bar graph display of its group.
P> For operating instructions, see section 5.4.

e Alarm Indication
The channel display area, channel number, tag name, alarm type, and measured
value all change in appearance based on alarm conditions in the following ways.

When indication is
set to non-hold

am Occurercs [
Release

Tag/Channel Black

Channel
area

Green

Alarm type None

Measured Black
value

White

Red

Black

Green

None

Black

Black

Green

None

Black

I

Blinking
white

Red

@®—— Measured value and unit

@ Tag name or channel number

When indication is

setto hold

Alaimm ACK

Blinking
black
Green

None

Black

Black Black

Green Green

None None

Black Black

Alarmm ACK

—

Blinking

white

Red

White

White

White

Red

White

.

Black

Green

None

Black
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1.4 Display

Alarm Summary

You can list up-to-date alarm information.

* The data of up to 1000 alarms can be displayed.

* You can select alarm information to access the historical trend of the display data or
event data that contains the alarm.

P For operating instructions, see section 5.7.
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—9a812/8311)  Channel Tope wilarm Time

= v OFF 1 H 2898/81/23 18:87:51
AN 1 H 2898/@1/23 18:87:44
OFF 2 1L zeess81/23 18:85:38 T > To the historical trend display
PN L 2898/@1/23 18:83:45
By 2083/91/23 18:@1:38
0N H 2898/@1/23 89:49:02
OFF IL 2898/@1/23 B9:46:57
0N L 2898/@1/23 A9:45:05
OFF IH 2898/@1/23 89:42:59
0N IH 2898/@1/23 89:4@:23
OFF IL 2898/@1/23 @9:38:19
A?N f 1# 2088/91/23_B9:36:26

R o DRI

| Dlate/time of alarm occurrence/release
Alarm number (1, 2, 3, 4) and type (H,L, h, , R, r, T, t)
Channel
4 0N : Alarm occurrence

( ~ blinks until the AlarmACK operation is carried out if Indicator
is set to Hold.)

oFf : Alarm release
O Atk : Alarm output release (when blinking is cleared through the
AlarmACK operation)

Cursor (selects an alarm)

The alarm information number of the alarm on the screen’s bottom
line and the number of alarm entries in internal memory.
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1.4 Display

Message Summary
You can display a list of messages and when they were written.
» Up to 450 messages can be displayed.
» Up to 50 added messages can be displayed.
* You can select message information to access the historical trend of the display data
or event data that contains the message.
P For operating instructions, see section 5.8.

1o [l EETE(O)E )

—®(Aa7/887)  Hessage *Time Grp
= POYER OFF 83/81/23 18:@9 1
P stor 83/81/23 18:88 A
DANGER #8/81/23 18:06 A —> To the historical trend display
BATTERY 83/81/23 18:03 2
POWER ON 83/81/23 18:82 A
HIGH WOLTAGE 08/01/23 18301

|
The groups on which the message was written

Message Displays a group number, or A for all groups
Added message (blue)

Date and time when the message was written

Cursor (used to select a message)

The message number displayed on the screen’s bottom
line and the number of message entries in internal memory.

¢ Switching Displayed Items
You can switch between two sets of displayed items.
* Message, date and time, and group
* Message and the name of the user who wrote the message
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1.4 Display

Memory Summary

You can display a list of the display and event data that is stored in internal memory.

* You can select a display data or event data entry to access its historical trend display.

» The MV displays the number of manually sampled data and report data (/M1 and
/PM1 options) samples.

P For operating instructions, see section 5.9.

—— Date and time of the most recently
L recorded data

Start Time End Tine Data Fator Internal memory data files/
SoLE it ol lmonds w2 Evial maximum number of recordable files

8127 1Eze2m 8123 16 5 Stor
O i B ke 12 e > istori ;

H H H ¥ oF
Qe Ameen 12 e > To the historical trend display
a1-z2 1918362 1693 3264 s Auto Save
a1-z2 1518368 16-89 1985 s Auto Save
0E Lhe e e = Btg =

H H H H oF —
Blz 16:01i0 1869 1666 ot Sroe Data type

FOzids 1859 §143:52 [

* Display data
* Event data

ﬁ
I

Status

B1-22 EorER: 2432
L ] |

Sampling count

Memory stop date and time

Memory start date and time
Cursor (selects a file)

¢ Switching Displayed Items
You can switch between two lists of information.
» Start and stop times
* File names

¢ Data Storage
You can save the data in the internal memory to a CF card or to USB flash memory.

IM MV1000-01E
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1.4 Display

Report Data (/M1 and /PM1 options)
You can display report data stored in the internal memory.
P For operating instructions, see section 5.5.

—r@lndex : 18/18 Kind : Hourlw

Start : 2988/81/23 10:48:35 — Report type
art | H H -
Timeup: 2808/81/23 11:03:05 ]—— S.tart. Start date and time
th Unit Sts e M Hin Sum Timeout: Report date and time
BBU i iea ‘has somewws | Report data status
S‘E’.‘é v b Gem im 22 | Indicates whether any of the following
1 T ' I occurred during the report interval.
E: Error data
O: Overflow data
P: Power failure
C: Time adjustment
| B: Burnout
Unit Average, maximum, minimum, sum, or instantaneous value
Channel number

Displayed report data number/number of report data entries in internal memory

Stacked Bar Graph (/M1 and /PM1 options)
You can display the report data of each report group in a stacked bar graph.
P For operating instructions, see section 5.6.
P For information on report groups, see section 10.5.
* Displayed Data Type
The type of data that is displayed is determined by the report type (Report kind), which
is set using the report function.

Report kind Displayed Data
Hourly, or hourly + daily ~ Sums for each hour and sums for the day
Daily + weekly Sums for each day and sums for the week

Daily, or daily + monthly ~ Sums for each day and sums for the month
Example: Hourly + daily display

ﬁ Emin :;
2. 672ASTE+AS| 8, FEIAASE+AS| 8. FESS2AE+AS e Daily sum of all channels and the daily
5. BE2A03E+5| B.650B3AEE5| . 656R15Ep5| O 19BE4OEHAE ‘ sums of all report groups
ey (E42) ety (E43)

If you select a bar graph, the sum of the hour
selected with the cursor will be displayed.

Daily sums (bar graph)

a3
20858122

Hourly transition of report group sums (bar graph).

e Display Modes
You can switch the bar graph between single graph and dual graph display.
Single graph display Dual graph display

3 enin | B8]+ 5

8, 672857E+A5| 8, BESERSEHAS| 5, BEEE2EE-+HAS e

5.F620¢3E+A5] 5, E5O03RERS| 8. 656015E+p5| O+ 195648E0E
Wdaw (E+02) Wdaw (E+03)

B 3 B a3
20858122 20858122
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1.4 Display

Status Display

Log Display

These are the available status displays.
P For operating instructions, see section 5.5.

* Relay Status Display
Displays the status of the alarm output relay and the internal switch.

¢ Modbus Client Status Display and Modbus Master Status Display
Display the command status.

Displays all logs (operation histories).
P For operating instructions, see section 5.10.

Log Type Description

Login Login and logout history, time setting history, power failure history
Error Error message history

Communication Communication command history

FTP FTP transfer history

WEB Web operation history

E-mail E-mail transfer history

SNTP SNTP server access history

DHCP DHCP server access history

MODBUS Modbus master and client transfer history

IM MV1000-01E
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1.4 Display

4-Panel Display (only with the MV2000)
You can view four different displays on one screen. The displays are all 1/4 of their
ordinary size, so they have content, format, and command limitations.
P For operating instructions, see section 5.11.

GROUP 1 GROUP 1
23 4586 7T 8 918 “

il

= =)
.2
Em

2

fa

Displayable Screens Limitations

Trend No automatic group switching. Cannot display all channels.
No message display. Number of displayable scales is six or
less.

Digital No automatic group switching.

Bar graph display No automatic group switching. No numeric value display.
Displays one representative alarm letter.

Overview No operations. No numeric display for more than 260
channels.

Alarm summary Cannot use the cursor.

Message summary

Memory summary

Modbus client status display

Modbus master status display

Relay status display -

Report display Cannot use the cursor.

Stacked bar graph display Sums of each channel (numeric value display), report group
sums (numeric value display)

* Registering Display Configurations
You can name and register up to four 4-panel display configurations. You can access
the registered configurations by their names.
The default configurations are as follows:
Configuration Displays

Name

MIX Trend (group 1), digital (group 1), bar graph (group 1), overview
ALL TREND All trend displays (groups 1 through 4)

ALL DIGITAL All digital displays (groups 1 through 4)

ALL BAR All bar graph displays (groups 1 through 4)
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1.4 Display

Other Useful Functions

¢ Automatic Return to a Specified Display

If there is no user activity within a set time period, the MV will automatically switch
back to a specified display.
P For configuration instructions, see section 6.14.

Favorite Display Key

You can access often-used displays easily by registering them to the HISTORY key.
This function is available if you set the HISTORY key operation to Favorite.

P For configuration instructions, see section 6.15.

Menu Customization
You can change the contents of the function menu, which is displayed when you press

the FUNC key, and the display selection menu, which is displayed when you press the
DISP/ENTER key.
P For configuration instructions, see section 6.17.

Display Pause
You can pause the display at any time. Sampling continues while the display is
paused.

LCD Display Condition Settings

You can set the LCD Display conditions.

Display Attribute Settings
Operation screen You can set the screen’s background color to either black or white.
background color The default value is white.

P> For configuration instructions, see section 6.13.
Historical trend screen  You can select white, cream, black, or light gray as the background
background color color.

The default value is black.

P> For configuration instructions, see section 6.13.

LCD brightness You can set the LCD brightness.

MV1000: Eight levels
MV2000: Six levels
The default brightness level is 2.
P> For configuration instructions, see section 9.8.

Backlight saver If there is no user activity within a set time period, you can tell the
MV to automatically turn OFF or dim the LCD backlight. This helps
to extend the backlight’s life. The occurrence of an alarm or the
pressing of a key will return the screen to its ordinary brightness.
You can also activate the backlight saver using the FUNC key. The
backlight saver is disabled by default.

» For configuration instructions, see section 9.8.

IM MV1000-01E
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1.5 Data Storage Functions

This section explains the types of data that the MV can record and how to store them.

Data Types
The MV can record the following types of data.

Data Type Description

Display data » This is the waveform data that appears on the trend display. Measured data
is recorded at the set sampling intervals. Sampling intervals are determined
by the Trend/Storage interval.

*  The maximum and minimum values measured within each sampling interval
are stored.

* You can write a header character string into the file (shared with other files).

» Contains alarm and message information.

» Data formats: Text and binary (undisclosed).

Event data » Measured data acquired at each set sampling interval. There are two
modes: one in which recording starts when a trigger event occurs, and
another in which recording takes place continuously.

* You can write a header character string into the file (shared with other files).
» Contains alarm and message information.
» Data formats: Text and binary (undisclosed).

Manually sampled data
» The instantaneous measured data values when a manual sample operation

is performed.

» You can write a header character string into the file (shared with other files).
» Data format: Text

Report Data (/M1 and /PM1 options)

» This is hourly, daily, weekly, and monthly data. Report data is recorded at
specific intervals (once a day, once a week, and so on).

* You can write a header character string into the file (shared with other files).

» Data format: Text

Snapshot data (screen image data)

» The image data from the MV display screen when a snapshot operation is
performed.
» Can be saved to a CF card.
» Data format: PNG (Portable Network Graphics)
Setup data * The MV setup data.
» Data format: Binary (undisclosed)
* Display Data and Event Data

Display data is similar to the conventional chart-sheet recording of the past and

is useful for long-term recording. Event data is useful for when you want to record

measured data in detail.

:-------.-----.----I Displaydata
Y 9 o , Trend interval
; 1
Manmum value for each sam : . : :  Trend/Storage interval
pling interval —> ® : E 1
P 1

1
| Measured data acquired
| at the set scan interval.

...q_:___

—I—l—l—l—l—l—l—l—l—l—l—» Time

1< Scan Interval
<t Event data sampling interval

<

< Display data sampling interval

For the trend interval, only change the time axis display in the trend display.
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1.5 Data

Storage Functions

Data Recording and Storage Flowchart

Measured data is recorded to internal memory and then saved to external memory.

Measurement = Computation External input
channel channel channel (MV2000 only)

(via communication)

l l -<—  Data of another device
AN
Vo

Displa:
Sampling y

Internal memory

‘ |

|

Setup data

FTP server on
the network

1
Screen image
Save data
-

Display/Event
data

[ Load |

<> I

CF card USB flash memory

Internal Memory

External storage medium

Display data and event data are saved as files in internal memory. They are also saved

as files to an external storage medium.

Internal memory

Manual
Display data and event data

sampled data

Report data

FTP server on <—¢

the network

Directory on an external storage

medium

IM MV1000-01E
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1.5 Data Storage Functions

Display and Event Data Recording Methods
P For configuration instructions, see section 4.1. For operating instructions, see section
4.4,
* Types of Recorded Data

You can choose to record display data only, event and display data, or event data

only.

Choosing What Type of Data to Record

Record the type of data that meets your needs. Use the following examples for

reference.

Example 1 To record continuous waveform data only, just like conventional chart
recorders:
Record display data.

Example 2 To record waveform data continuously and record more detailed data
before and after an alarm event:
Record display data continuously and use an alarm to trigger the
recording of event data.

Example 3 To continuously record data that is as detailed as possible:
Set the sampling interval and record event data.

Example 4 If there is no need to record data continuously but you want to record
data when an alarm occurs:
Use an alarm to trigger the recording of event data.

* Internal Memory
Measured data is partitioned and saved to files at set intervals. If the internal memory
is full or if the number of display data files and event data files exceeds 400, files are
overwritten from the oldest file.

» Display Data Recording Conditions

Item Description

Channel type You can set the channel type to measurement, computation, or
(only with the MVV2000) external input.

Sampling interval Determined by setting the Trend/Storage interval. Choices are

available in the range of 5 s to 10 h. You cannot choose an
interval that is faster than the scan interval.
File generation Files are generated at the set file save interval.

/— /W/\V Jime

I I I 4

File File File Adding data
Files are also generated in these cases:
*  When you generate a file manually.
* When there is a memory stop.
»  When afile is generated using the event action function.
» After recovering from a power failure.

Memory start/stop Pressing START/STOP starts recording (memory start). Pressing
START/STOP again stops recording (memory stop).
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1.5 Data Storage Functions

¢ Event Data Recording Conditions

Item Description

Channel type Same as with display data.

Sampling interval Choices are available in the range of 25 ms to 600 s. However, you
cannot choose an interval that is faster than the scan interval.

File generation Afile is generated when the set data length is reached.
Files are also generated in these cases:
*  When you generate a file manually.
*  When there is a memory stop.
»  When a file is generated using the event action function.
» After recovering from a power failure.

Modes Recording varies depending on the mode. The following modes are
available:
Free
Pressing START/STOP starts recording. Pressing START/STOP again
stops recording.

—t/— /W/—\V Jime

I I I i

File File File Adding data
Single
Pressing START/STOP puts the MV into a trigger-wait state. After a
trigger event occurs, the MV will record data for the set time (Data
length). The MV will not record again even if a trigger occurs afterwards.
Trigger condition met

Time
T T >
I
File

Repeat

Pressing START/STOP puts the MV into a trigger-wait state. After a
trigger event occurs, the MV will record data for the set time (Data
length). After that, the MV will return to a trigger-wait state and will
record data for the set time (Data length) whenever a trigger event
occurs. To stop the recording of event data, press START/STOP again.
Trigger condi:ion met Trigg;ar condition met

_/Y’_/‘\/‘/\‘—’ Time

Event Data Pre-trigger
The event data pre-trigger can be configured for use with triggers.

It is a function that records the data before a trigger event as event data. It is useful for
when you want to record the data before the occurrence of an alarm or other event.
The pre-trigger is set as a percentage of the event data recording time (data length).
You can setitto 0, 5, 25, 50, 75, 95, or 100%. If you set the pre-trigger to 0%, the MV
will only record the data after the trigger event.

Trigger co?dition met

Time

I »

T

Pre-trigger data ——| |<— Post-trigger data—»l

Event Data Recording Start Triggers
You can configure a variety of conditions as triggers for starting event data recording.
Example: Key operations, alarm occurrence, time, remote control

IM MV1000-01E
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1.5 Data Storage Functions

¢ Key Initiated File Generation

You can use key operations to tell the MV to generate a file.

Key operation

—/\/—\_,
/ Time

File File File
Previous files [ Current file ]

Manually Sampled Data

Report Data

/_/‘/\H/\’b’ Jime

i i ii i Manually sampled data

Report data is stored to internal memory. When the number of report data files
exceeds 100, the oldest data files are overwritten.

/ A(/\T“ Jime

i = i i Report data

Manually sampled data is stored to internal memory. When the number of manually
sampled data files exceeds 400, the oldest data files are overwritten.

IM MV1000-01E
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1.5 Data Storage Functions

Saving to External Storage Media
P For configuration instructions, see section 4.2. For operating instructions, see section

4.4.

Types of external storage media
CF card (32 MB or more)

USB flash memory

Auto Save

The data in the internal memory is automatically saved to a CF card as long as the
card is left in the drive.

Auto Save Timing

Data Type Description
Display data Files are saved as soon as they are generated.
)r/—/\‘/\’—i Time
| | | >
File | File |  File |
[Saved to an external storage medium ]
Event data Same as display data.
Manually A manually sampled data file is generated on the CF card when manual

sampled data

sampling first occurs. Data is added to that file whenever manual sampling
occurs. Afile is created every 100 data values. > For operating instructions,
see section 4.4.

Report data Report data is stored in a report data file that is generated on the CF card
when report data is first produced. Report data is added to this file at the
report filing time.

Report File Division
At the set time, the MV stops recording to the current file and begins
recording to a new file. Files can be divided in the following ways.
Report Report File
Type Single File File for Each Type
Hourly [JOne day'’s hourly report data
Daily [JOne month’s daily report data
Hourly and  |[~_JOne day’s hourly and daily [_Afile for each daily report
daily report data [JOne day’s hourly report data
Daily and [JOne week’s daily and weekly |C~_JA file for each weekly report
weekly report data [ JOne week’s daily report data
Daily and [ JOne month’s daily and LA file for each monthly report
monthly monthly report data [__JOne month’s daily report data

Save Destination

CF card

Directory That Data is Saved To
You can specify the name of the directory that data will be saved to (the default

directory is “DATAQ”). The MV will create the directory on the CF card and save data

toit.

Save Operation (when not using media FIFO)

If there is not enough free space on the CF card, internal memory data cannot be
saved. Before the internal memory data is overwritten, change CF cards and save the

data.

Save Operation (always retain most recent data file/media FIFO)
When the MV saves data files automatically, it can save files so that the newest data

files are always retained. With this method, the MV can be used continuously, and the
CF card does not need to be changed.

IM MV1000-01E
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1.5 Data Storage Functions

¢ Operation
'Y

- Il
<eEted File 1 File 2 File 3 <Saved File 4
- e

old Date Last Updated New AN
< >

\_ Medium )

AN N

When saving data to the CF card, if there is not enough space to save a new file,
the oldest files are deleted and then a new file is saved. This operation is referred
to as FIFO (First In First Out).

FIFO is only used when the following files are saved automatically. When files
are saved using other methods, FIFO is not used.

Display data files, event data files, report data files, manually sampled data files,
and screen snapshot data files.

Files subject to deletion

All files in the destination directory, except for the ones listed below, are subject
to deletion.

Files not subject to deletion: Hidden files, read-only files, and files contained
within subdirectories in the destination directory.

The most recent 1000 files are retained. If there are more than 1000 files in the
destination directory, even if there is enough free memory, older files will be
deleted so that the file number remains at or below 1000.

When there are already more than 1000 files in the destination directory, one or
more files are deleted before the new file is saved. In this case, the number of
files is not kept at or below 1000.

¢ Manual Save (collectively storing unsaved data)
Unsaved data in the internal memory is saved to an external storage medium

connected to the MV when a certain operation is carried out.

Save operation

/ W Jime

Previously saved

I I I I 4

File File
N

File

Vo
[ Saved this time ]

When using manual save, it is important that you save the data in the internal memory
to the external storage medium before the data is overwritten. Be aware of the
condition of the internal memory, and save data to the external storage medium at the
appropriate times.

Save Destination
You can select a CF card or USB flash memory.

Directory That Data Is Saved To
You can specify the name of the directory that data will be saved to (the default

directory is “DATAQ”).
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1.5 Data Storage Functions

* File Names
The MV can name measured data files automatically saved to the CF card in one of

the following three ways.

Type Description
Date Display data
Event data 7-digit |BN Specifiedsting WM  Date |.[Extension]
Manual sampled data | Ex: 000123 AAAAAAAAAAA050928 174633.DAD
Snapshot data
Report data 7-digit | _Specified string 1 Date [ETypeE . [Extension
Ex.: 000123_AAAAAAAAAAA050928_174633HD.DAR
Sequence Display data
Event data [ 7-digit W Specified string I . [Extension |
Manual sampled data | gy : 000123_AAAAAAAAAAA DAD
Snapshot data -
Report data 7-digit I Specified string [METyped .
Ex.: 000123_AAAAAAAAAAAAHD.DAR
Batchname  |Display data :
Event data Ex.: 000123_BBBBBBBBBBBBBBBBBBBBB.DAD
Report data [ 7-digit ]| Date [ETypes . [ Extension
Ex.: 000123_050928_174633HD.DAR
Manual sampled data | [ 7.qigit | Date | . [Extension
Snapshot data Ex.: 000123_050928 174633.DAM
Item Description
7-digit Consists of a 6-digit number and 1-character delimiter.
6-digit A sequence number in the order of occurrence. The number ranges from
number 000001 to 999999. If the number reaches 999999, it returns to 000000.
1-character | Starts with ‘_’ and takes on the following values: A to Z and 0 to 9.
delimiter | If a file with the same name exists in the specified directory, the file is
saved by changing the delimiter to prevent overwriting.
Example:If a file named “000123_AAAAAAAAAAA.DAD” already exists,
the file is saved to the name “000123AAAAAAAAAAAA.DAD.”
Date YYMMDD_hhmmss |YY: Year (lower two digits), MM: Month, DD: Day

hh: Hour, mm: Minute, ss: Second

Specified string |AAAAAAAAA--A Up to 16 alphanumeric characters can be used
Batch name BBBBBBBBBBB-++*B |Up to 40 alphanumeric characters can be used
Type H_,D_,W_M, Report data type
HD, DW, DM H_: Hourly, D_: Daily, W_: Weekly, M_: Monthly,
HD: Hourly and daily, DW: Daily and weekly,
DM: Daily and monthly
Extension Display data: DAD, TDD Report data: DAR
Event data: DAE, TDE Snapshot data: PNG
Manual sampled data: DAM Setup data: PDL

IM MV1000-01E
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1.5 Data Storage Functions

Saving Data with Key Operations (DATA SAVE MODE)

The following data save operations can be performed whether in auto save or manual
save mode.

P For operating instructions, see section 5.9.

Data Save Type Description

SELECT SAVE Saves the selected display data or event data file.

ALL SAVE Saves all data in the internal memory.

M.SAMPLE SAVE Saves all manually sampled data in the internal memory.
REPORT SAVE Saves all report data in the internal memory.

You can switch to DATA SAVE MODE immediately after connecting USB flash
memory.
P For operating instructions, see section 4.10.

Save Destination
You can select a CF card or USB flash memory.

Directory That Data Is Saved To

A directory is made with the same name as the destination directory plus the date and
time added on at the end. Then, data is saved to that directory.

Directory name: [Specified directory name]_YYMMDD_HHMMSS

Example: If a file is saved on January 30, 2008 at 17:06:42, the file will be saved to a
directory with the name DATAO_080130_170642. (If DATAO is the ordinary destination
directory name).

Nofte

The number of directories that can be created on an external storage medium depends on the

length of the directory names. When the specified directory name is five characters long, about
170 directories can be created. When it is 20 characters long, about 120 directories can be
created. An error will occur if the limit is exceeded.

Other Types of Saveable Data

Setup Data
You can save the MV setup data to a CF card or to USB flash memory. The setup data
is saved to the root directory.

Setup data file name [ Specified |. PDL
Example: ABCD10005.PDL
P For operating instructions, see section 4.9.

Snapshotdata
The MV display is saved to the CF card as a PNG file. It is saved in the same directory
as display and event data. For information about file naming, see the previous page.

C]/—M
| Time

[=] =] =] =] Snapshot
CF card Data file

P> For operating instructions, see section 4.6.

Saving Data via an Ethernet Network

Using the FTP client function, display data, event data, report data (/M1 or /PM1 option),
and screen image data (snapshot data) can be automatically transferred and saved to an
FTP server via an Ethernet network. Display data and event data are sent as files in the
same format (binary or text, see section 4.2 for the setting) as the "File format." The MV
can also function as an FTP server. You can access the MV from a personal computer
and retrieve and store data files from both internal and external memory.

P See the Communication Interface User’s Manual IM MV1000-17E.
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1.6 Batch Function

You can add the batch information listed below to display data and event data files. You
can use batch information to manage display and event data files.
P For configuration and operation instructions, see section 4.3.

MBIAIDAQ diNjedq

Batch Information

e Batch Number and Lot Number
Display data and event data files can be recognized by their batch and lot numbers

(hereinafter referred to as batch name). The lot number does not have to be specified.
» Batch number (up to 32 characters)
» Lot number (up to eight digits)

¢ Automatic Lot Number Incrementation
The lot number can be automatically incremented when memory sampling is stopped.

* Text Field
You can enter eight text fields into a file. Each text field consists of the following:

+ Field title (up to 20 characters)
» Field string (up to 30 characters)

Text fields can be shown on the MV screen with key operations.

e Batch Comment
You can enter three comments into a file. Each comment can be entered once while

memory sampling is in progress.
+ Comment 1, Comment 2, and Comment 3 (up to 50 characters each)

Using the Batch Function

See the figure below. You could enter the operator and administrator in the text field.

Memo Memo
start v Comment stop i
Batch number + lot number
Text field => /‘/_//\/N Time
Comment I I g
AN J
Vo

Data file
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1.7 Event Action Function

The event action function performs a specified action when a specified event occurs. The
remote control function (/R1 option) is configured using the event action function.
P For configuration instructions, see section 7.1.

Event

e List of Events
You can choose from the following events:

Event Level/edge* Description

Remote Level/edge Remote control input ON or OFF.

Relay Level/edge Alarm output relay activation or deactivation.
Switch Level/edge The internal switch value (0 or 1).

Timer Edge Timer timeout

MatchTimeTimer Edge When a specified time is reached.

Alarm Level/edge An alarm is occurring/no alarms are occurring
UserKey Edge When the USER key is pressed.

* For a description of level and edge, see “Miscellaneous” in this section.

e Timers
There are four kinds of timers. They are also used with the TLOG computation

function (/M1 and /PM1 options).
Types of Timers

Absolute timer Relative timer
Timer set
[ Timer set | (Ref. time) Timer reset
Ly v { - Time i y  Time
| A | A | A A | - B | B | -
+ Timeout A: Interval B: Interval

¢ Absolute Time Mode
The timer expires at the times determined by the reference time and the interval.

The reference time can be set to the hour (00 to 23).
Example: Reference time: 00:00
Interval: 10 min
The timer expires at 00:00, 00:10, 00:20, ... 23:40, and 23:50. For
example, if the timer is set at 09:36, the timer expires at 09:40, 09:50,
10:00, and so on.
* Relative Time Mode
Timing begins when the timer is set, and the timer expires and then begins timing
again at each interval. With this mode, the timer will stop when there is a power
failure and will not resume afterwards.
Example: Interval: 00:15
The timer expires every 15 minutes.
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1.7 Event Action Function

Actions

Match Time Timer

You can set four match time timers. Specify the date/time using the method described
below. For each timer, you can select whether to use the timer once or continuously.
The timers are also used with the TLOG computation function (/M1 and /PM1 options).

Specified Date/Time Description

Month, day, hour

Occurs once a year.

Day and hour

Occurs once a month.

Day of the week and hour

Occurs once a week.

Hour Occurs once a day.

List of Actions
You can choose from the following actions.

Action Level/Edge* Description

MemoryStart/Stop Level Starts or stop memory sampling.

MemoryStart Edge Starts memory sampling.

MemoryStop Edge Stops memory sampling.

Trigger Edge Triggers the recording of event data. Valid
when recording event data in a triggered
mode. See the next page for more details.

AlarmACK Edge Stops alarm output.

Valid when the MV is configured to use the
alarm output release (AlarmACK) operation.

MathStart/Stop** Level Starts or stops computation.

MathStart** Edge Starts computation.

MathStop** Edge Stops computation.

MathReset* Edge Resets the values on all computation
channels.

SaveDisplay Edge Saves the display data currently being
recorded to internal memory. This is the
same as saving data by pressing FUNC.

SaveEvent Edge Saves the event data currently being
recorded to internal memory. This is the
same as saving data by pressing FUNC.

Message Edge Writes a message.

Can be executed during memory sampling.

Snapshot Edge Saves an image of the screen.

DisplayRate1/2 Level Switches between the first and second trend
intervals.

Valid when the MV is set to be able to switch
between trend intervals.

ManualSample Edge Executes manual sampling.

TimerReset Edge Resets the relative timer. Timing begins
again from the point where the timer is reset.
See the next page for more details.

DisplayGroupChange Edge Changes the display group in the trend,
digital, or bar graph display.

Flag** Level When the event is a level operation, the flag
is zero for normal conditions and 1 when an
event occurs. When the event is an edge
operation, the value alternates between 0
and 1 whenever an event occurs.

The flag can be written in a calculation
expression of a computation channel.

PanelLoad Edge Reads the setup data file in the root directory
of the CF card and uses it to configure the
MV. See the next page for more details.

TimeAdjust Edge Sets the time to the closest hour. See the

next page for more details.

* For a description of level and edge, see “Miscellaneous” in this section.

**This is an option.
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1.7 Event Action Function

About TimerReset

If Event is set to Relay, Switch, MatchTimeTimer, or Alarm, TimerReset will not result
in a timeout (an action will not be executed even if the timer is used as an event).

If Event is set to Remote or UserKey, a timeout will occur (if the timer is used as an
event, an action will be executed).

About PanelLoad

PanelLoad can only be specified as an action when Event is set to Remote.
PanelLoad loads a setup data file, LOAD1.PDL, LOAD2.PDL, or LOAD3.PDL, in
the root directory of the CF card onto the MV, and uses it to configure the MV. Only
settings that pertain to Setting Mode are updated.

You must create a setup file and save it to the CF card in advance.

Event Trigger Operation

When Event is set to Relay, Switch, or Alarm:

The Trigger action will always occur when an output relay is activated, when an
internal switch is set to 1, or when an alarm occurs. However, the number of times the
trigger is activated depends on the event data mode (Single or Repeat).

About TimeAdjust
TimeAdjust can only be specified as an action when Event is set to Remote.

TimeAdjust sets the MV internal clock to the closest hour.
¢ Operation When the MV is Not Memory Sampling

Difference from the Nearest Hour Operation

Osto1min59s Truncates the minutes and seconds.
Example: 10 hours 01 min 50 s becomes 10 hours 00
min 00 s.

2 min to 57 min 59 s The time is not changed.

58 min to 59 min 59 s Rounds up the minutes and seconds.
Example: 10 hours 59 min 50 s becomes 11 hours 00
min 00 s.

¢ Operation When the MV is Memory Sampling (See section 1.11 for
details.)
If the time difference between the time when the remote control signal is applied
and the nearest hour is within the preset time, the time is gradually corrected.
Otherwise, the time is corrected immediately.

1-38

IM MV1000-01E



1.7 Event Action Function

Miscellaneous
¢ Limitations on Event and Action Combinations
The checked combinations are valid.
Event |Remote | Relay Switch Timer MatchTime Alarm UserKey

Action Timer

AlarmACK v v v v
TimerReset v v v v v v
PanelLoad v

TimeAdjust v

Other actions v v v v v v v

* Level and Edge
The levels and edges of events affect the levels and edges of actions as shown below.

Type Operation
Event
Edge Edge
Level —]
Action Status 1
Level _| Edge
Status 2 Operation  Operation
executed executed

Level and Edge of the Remote Control Input Signal

Level Edge
ON l
OFF
—>H<—250 ms or more

For contact inputs, the remote signal rises when the contact switches from open to
closed and falls when the contact switches from closed to open. For open collector
signals, the remote signal rises when the collector signal (voltage level of the remote
terminal) goes from high to low and falls when the collector signal goes from low to
high.
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1.8 Security Functions

Key Lock
The Keylock function prohibits key operations. You must enter a password to release the
key lock.
P For configuration instructions, see section 8.1.
Key Lock Item Description
Keys The following keys can be locked independently.
START/STOP, MENU, USER, DISP/ENTER (prohibits switching
operation screens), HISTORY, and T/DIV.
Access to memory devices  Prohibits all operations listed below.
* The manual saving of data
» The loading of display and event data files
* The loading of setup data files
» The listing of files stored to memory
* The deletion of files stored to memory
» The formatting of memory devices

PanellLoad Only prohibits the loading of a setup file from a media device.
Action of Function The following FUNC key operations can be locked
independently.
* AlarmACK

* Message, Free message, Batch, Add message, Add free
message, and Text field

* Math start, Math stop, Math reset, and Math ACK

» Save display, Save event, Manual sample, Trigger, Snap
shot, Timer reset, and Save stop

* E-Mail start, E-Mail stop, E-mail test, FTP test, and
operations to request or release network information

*  SNTP and Time settings (Setting Mode operations)

» Favorite regist, 4Panel, Standard display, Second speed,
Normal speed, Pause Display, LCD Saver
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1.8 Security Functions

Login Function
With the login function, only registered users can operate the MV. Access from
communication functions can also be limited to users registered here.
P For configuration instructions, see section 8.2. For operating instructions, see section
8.3.
* Login and Logout
You enter your user name and password to log into the MV in the following cases.

MV Access Method When the Method is Required

Keys *  When the power is turned ON
*  When logging in after exiting Basic Setting Mode
» When logging in after logging out

When accessing the setting/measurement server, FTP server,
maintenance/test server, or Web server.

Communication

Auto Logout (when logged in using keys)

After logging in by using keys, you are automatically logged out when there is no key
operation for a specified time. If you are automatically logged out from Setting Mode,
the setting changes are cancelled. Automatic logout does not occur while in Basic
Setting Mode.

Operations Available while Logged Out
When logged out, you can switch operation screens by using DISP/ENTER, and
HISTORY.

e User Levels
There are two user levels: “Admin,” and “User.”
Administrator
Administrators can perform all operations on the MV. At least one administrator must
be registered to use the login function.

Item Description
Number of users that 5

can be registered

Limitations No limitations.

Login method
ID information

Select key operation, via communication, or Web server login.
User name and password

User
Item Item
Number of users that 30
can be registered
Limitations Key operations
Operation Limitations
Basic Setting Mode Not allowed
Setting Mode Menu customize Not allowed
Other operations Specified with user
privileges
Operation mode  |Key operation Specified with user
privileges

e User privileges
You can set operation privileges for each user. The available
settings are the same as those available for the key lock function.
Operations via communication
See the Communications Interface User’s Manual.

Login method

Select key operation, via communication, or Web server login.

ID information

User name and password
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1.9

Computation Functions
Expressions can be defined in special computation channels by using measured data or
computed data as variables. The computation channel data can be displayed or saved.
P For configuration instructions, see section 10.1.

Computation and Report Functions (/M1 and
/PM1 options)

¢ Dedicated Computation Channels

Model Number of Channel
Channels Numbers
MV1004, MV1008, MV2008 12 101 to 112
MV1006, MV1012, MV1024 24 101 to 124
MV2010, MV2020, MV2030, MV2040, MV2048 60 101 to 160

¢ Operations

In the table below, [001] represents the measured value of channel 001.

Type Example Description of the Example
Basic 001+002 Determines the sum of [001] and [002].
arithmetic 001-002 Determines the difference between [001] and [002].
001*002 Determines the product of [001] and [002].
001/002 Divides [001] by [002].
Power 001**002 Determines [001] to the power of [002]. y=X"
Square root SQR(001) Determines the square root of [001].
Absolute ABS(001) Determines the absolute value of [001].
value
Common LOG(001) Determines the common logarithm of [001]. y=log1ox
logarithm
Natural LN(001) Determines the natural logarithm of [001]. y=Inx
logarithm
Exponent EXP(001) Determines e to the power of [001]. y=e*
Relational 001.LT.002 The result is 1 when [001] is less than [002] and O
computation otherwise.
001.LE.002 The result is 1 when [001] is less than or equal to [002]
and 0 otherwise.
001.GT.002 The result is 1 when [001] is greater than [002] and O
otherwise.
001.GE.002 The result is 1 when [001] is greater than or equal to [002]
and 0 otherwise.
001.EQ.002 The result is 1 when [001] is equal to [002] and O
otherwise.
001.NE.002 The result is 1 when [001] is not equal to [002] and O
otherwise.
Logical 001ANDO002 The result is 1 when [001] and [002] are nonzero and 0
computation otherwise.
0010R002 The result is 1 when [001] or [002] is nonzero and 0 when
neither of them are.
001XOR002 The result is 0 when [001] and [002] are both zero or both
nonzero, and 1 otherwise.
NOTO001 The result is 1 when [001] is zero and 0 otherwise.
TLOG TLOG.SUM(001) Determines the sum of [001].
computation®  TLOG.MAX(001) Determines the maximum value of [001].

TLOG.MIN(001)

Determines the minimum value of [001].

TLOG.AVE(001)

Determines the average value of [001].

TLOG.P-P(001)

Determines the difference between the maximum value
and minimum value of [001].

* See page 1-43 for information on how to use this function.
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1.9 Computation and Report Functions (/M1 and /PM1 options)

Type Example Description of the Example
CLOG CLOG.SUM(001.002.003)
computation Determines the sum of [001], [002], and [003].
CLOG.MAX(001.002.003)
Determines the maximum value among [001], [002], and [003].
CLOG.MIN(001.002.003)
Determines the minimum value among [001], [002], and [003].
CLOG.AVE(001.002.003)
Determines the average value of [001], [002], and [003].
CLOG.P-P(001.002.003)
Determines the difference between the maximum value and
the minimum values among [001], [002], and [003].
Special PRE(001) Determines the previous value of [001].
computation:  101=HOLD(001.GT.K01):TLOG.SUM(001)
Under normal conditions, TLOG.SUM(001) is carried out to
derive the computed value. When [001] exceeds K01, the
previous computed value is held.
K01 i
p B :f
Explanation
HOLD(a):b When a is zero, b is carried out to derive the computed value.
Otherwise, the previous computed value is held.
RESET(101.GT.K01):TLOG.SUM(001)
Under normal conditions, TLOG.SUM(001) is carried out to
derive the computed value. When [101] exceeds K01, the
previous computed value is reset, and TLOG.SUM(001) is
carried out.
K01 'sset
I H N
Explanation
RESET(a):b When a is zero, b is carried out to derive the computed value.
Otherwise, the previous computed value is reset, and b is
carried out to derive the computed value.
CARRY(K01):TLOG.SUM(001)
Under normal conditions, TLOG.SUM(001) is carried out
to derive the computed value. When the computed value is
greater than or equal to K01, the computed result is the excess
(computed value — KO1).
K01
o 0
Explanation
CARRY(a):b Only TLOG.SUM can be specified for b. If the computed value
X of b is less than a, the computed result is X. If X is greater
than or equal to a, the computed result is the excess (X — a).
Conditional [001.GT.K01?001:001+002]
equation When [001] is greater than KO1, the computed value is set to

Explanation
[a?b:c]

the value of [001].[001]Otherwise, the computed value is set
the value of [001] + [002].

If the computed result of a is nonzero, b is carried out.
Otherwise, c is carried out.

to
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1.9 Computation and Report Functions (/M1 and /PM1 options)

¢ Data That Can Be Used in Equations

The data listed below can be used in equations.

Data Notation Description

Measurement channel data 001, etc. Specify by channel number.

Computation channel data* 101, etc. Specify by channel number.

External input channel data* 201, etc. Specify by channel number.

Constants K01 to K60 Set to numeric values.

Communication input data C01 to C60 Data set through communications.

Status of remote control* D01 to D08**  The value is 1 when remote control input is

input ON and 0 when it is OFF.

Pulse input® P01 to P08 Counts the number of pulses per scan interval.

Q01 to Q08**  Counts the number of pulses per second.

Internal switch status S01 to S30 1or0.

Alarm output relay* status 101 to 136 The value is 1 when activated and 0 when
deactivated.

Flag FO1 to FO8 1 or 0. Set the flag using the event action
function (for details, see section 1.7).

* This is an option. ** Values such as 01 are terminal numbers.

The table below shows the data that can be used with TLOG, CLOG, and PRE.
Checked data is usable.

Data |Meas. |Comp. |Ext. Constant [Comm. |Remote | Pulse |Internal |Relay| Flag
Math Func. CH CH input CH Input Switch
TLOG v v v v v v v
CLOG v v v
PRE v v v v v v v
Other Functions | v v v v v v v v v v

For example, TLOG.SUM(S01), CLOG.AVE(001.002.K01), and PRE(S01) are not allowed.

Order of Operation

Computation functions are performed every scan interval, starting with the smallest
channel number.

Example: If you specify 102 = 101 + 103, the value of the previous scan interval is
used for the 103 value.

How Computation Functions Handle Units

In computations, measured values are handled as values without units. For example,
if the measured data from channel 001 is 20 mV and the measured data from channel
002 is 20 V, the computed result of 001 + 002 is 40.

How Computed Data Is Displayed

You can set a span for the computed data displayed on each computation
channel. Computation channels can be displayed on all operation screens, just like
measurement channels.

P For configuration instructions, see section 10.3.

Alarms

You can set a maximum of four different alarms on each computation channel. The
alarm types are high limit alarm (H), low limit alarm (L), delay high limit alarm (T), and
delay low limit alarm (t).

How Computed Data Is Saved
Just as with measured data, computation channel computed data can be saved as
display data, event data, manually sampled data, and report data.

Computation Data Dropout

A computation data dropout occurs if a mathematical operation is not completed within
the scan interval.

The computation icon in the status display section turns yellow.

When a computation data dropout occurs, the computed data of the scan interval in
which the dropout occurred is set to the same value as the data immediately before
the dropout.

If computation data dropout occurs frequently, reduce the load on the CPU by
reducing the number of computation channels or by setting a longer scan interval.

P For operating instructions, see section 10.4.
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1.9 Computation and Report Functions (/M1 and /PM1 options)

How Numeric Values Are Displayed and Recorded

The range of displayable values for computed data, ignoring the decimal point, is —
9999999 to 99999999. The decimal place is determined by the location of the decimal
point on the computation channel’s minimum span value. Regardless of maximum and
minimum span value settings, all computed values within the aforementioned range
of displayable values will be displayed. Non-numeric values are displayed in these
circumstances.

Display/Recorded Value Computed Data Status

+Over » +Display range-out: When the computed result exceeds 99999999
» +Computation range-out: When the value exceeds approximately 3.4
x10°%8 in the middle of computation.
» When a computation error* occurs (You can select +Over or —Over.)
-Over » —Display range-out: When the computed result is less than -9999999

» —Computation range-out: When the value goes below approximately
—3.4x10% in the middle of computation.
» When a computation error* occurs (You can select +Over or —Over.)

* Computation errors occur when the following computations are carried out.
* X/0, SQR(—X), or LOG(—X)
* When a channel number set to Skip or Off is used in an expression

Rolling Average

The computation channel’'s computed value is the rolling average of the computed
result of the expression specified for the channel. The number of samples and the
sampling interval can be specified for each computation channel. The rolling average
is applied over the time corresponding to: the number of data samples x the sampling
interval. The maximum sampling interval is 1 hour, and the maximum number of
samples is 1500.

Starting Computation Operations
You can configure the MV to start computation operations when you press START/

STOP.

TLOG Computation
TLOG computation determines the sum, maximum value, minimum value, average,

or the difference between the maximum and minimum values of a specific channel for
each interval determined by a timer.

Timer Assignment
Timers are assigned separately to each channel.

Units in Sum Operations

When using the sum operation (TLOG.SUM), set the unit (referred to as sum scale) of
the values to be summed.

You can select from Off, /s, /min, and /h. For details, see the next page.

Resetting the TLOG Computed Value
You can select whether or not to reset the TLOG computed value at every interval.

The figure below illustrates the reset operation for sum computation (TLOG.SUM).
Example: Result of the TLOG.SUM computation

Timer timeout 1 2 3
Reset Reset Reset

Reset: On

Reset: Off

When reset is On, the sum is calculated over each interval. When reset is Off, the sum
of all values since the beginning of computation is calculated.

Power Failure Operation, Handling of Abnormal Data, and Handling of

Overflow Data
P See “Special Data Handling Cases and Exceptions” in this section.
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1.9 Computation and Report Functions (/M1 and /PM1 options)

Report Function

This function is used to create hourly, daily, weekly, and monthly reports.
P For configuration instructions, see section 10.5.

* Report Data Types

You can select four of the following types of report data: maximum value, minimum
value, average value, sum value, and instantaneous value.

Report Types

Type Description

Hourly report ~ Produces report data for the previous one hour every hour on the hour.
Daily Produces report data for the previous day every day at a specified time.

Weekly report  Produces report data for the previous week every week at a specified time on
a specified day of the week.
Monthly report Produces report data for the previous month at a specified day and time.

Combinations of Reports That Can Be Produced
The MV can produce hourly reports, daily reports, hourly and daily reports, daily and
weekly reports, and daily and monthly reports.

Source Channels

You can select the source channels from measurement channels, computation
channels, and external input channels. Report data is not produced for channels that
are set to Skip or Off.

Model Number of Report Channels
MV1004, MV1008, MV2008 12
MV1006, MV1012, MV1024 24
MV2010, MV2020, MV2030, MV2040, MV2048 60

Units in Sum Operations

With sum operations, data is summed over the scan interval. However, for flow rate
values and other values whose units are time based (/s, /min, /h, or /day), a simple
summation results in the actual value not matching the computed result, because
the scan interval and the time unit of the input value are different. In such cases, set
the sum unit, (the Sum scale parameter in the MV interface), to match the unit of the
input value so that a sum with the same unit as the input value is calculated.

For example, if the scan interval is 2 s, and the input value is 100 m®min, a simple
summation would add 100 every 2 s resulting in 3000 after one minute. However, if
the sum unit is set to /min, then 2 s/60 s is multiplied every scan interval before the
value is added giving a result that has the right time based (m%/min) unit.

The following conversion equations are used to compute the sum. The scan interval
unit is seconds.

Off:  Z(the measured data at every scan interval)

/s:  Z(the measured data at every scan interval) x the scan interval

/min: Z(the measured data at every scan interval) x the scan interval/60

/h:  Z(the measured data at every scan interval) x the scan interval/3600

/day: Z(the measured data at every scan interval) x the scan interval/86400

Displaying Report Data
You can display report data by using key operations.
P For configuration instructions, see sections 5.5 and 5.6.

Saving Report Data
P See section 1.5.

Report Data Values

The range of displayable values for report data, ignoring the decimal point, is —
9999999 to 99999999 (except —3.4x10°® to 3.4x10% for sum values).

P For special cases and exceptions, see “Special Data Handling Cases and
Exceptions” in this section.

P For details on the report file format, see appendix 3.
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1.9 Computation and Report Functions (/M1 and /PM1 options)

Special Data Handling Cases and Exceptions

This section explains special data handling cases and exceptions for TLOG computation,
CLOG computation, and reports.
* Power Failure Data Handling (for TLOG and reports)

If a power failure occurs when the report function is enabled or in the middle of a
TLOG operation, the report and TLOG operations resume when the MV recovers from
the power failure. The operation executed after recovery varies depending on whether
the MV recovers from the power failure before or after the report or TLOG data
production time.

Time of Recovery Operation
After the data The report or TLOG data is produced immediately after the MV
production time recovers. The measured data up to the time of the power failure

is used. When the next report or TLOG is produced, the data after
recovery from the power failure is used.
Before the data After the MV recovers, the report or TLOG is produced at the data
production time production time. The measured data is used with the data for the
power failure period left out.

Handling of Abnormal Data (TLOG, CLOG, and reports)

If an error occurs in channel or other data, the abnormal data is discarded, and the

computation continues. If all of the data is abnormal, an error message is produced.

The following result in abnormal data:

*  When channels are set to Skip or Off.

* When an error value is returned as a measured result on a measurement channel
(A/D converter failure, etc.).

* When a measurement channel is in a burnout condition

* When an error value is returned as the computed result on a computation channel.

*  When an external input channel is Off or when data is not being received from it (in

cases such as when communication is prohibited).

How Overflow Data Is Handled

* Overflow data refers to range-out values on measurement, computation, and external input
channels.

For TLOG, CLOG, and reports
Channel overflow data is handled in the following ways:

Operation Description
Average, Sum You can choose from three methods of handling the data: ERROR,
SKIP, and LIMIT.
ERROR: Treats the data as a computation error.
SKIP: Discards the overflow data and continues the computation.
LIMIT: Replaces the data with the limit value and continues the
computation.

The limit value is the span upper or lower limit, or the scale
upper or lower limit of the channel.

Maximum, minimum, You can choose one of two methods of handling the data: OVER, or
maximum-minimum  SKIP.

OVER:  Performs the computation using the overflow data.

SKIP: Discards the overflow data and continues the computation.

For Multiplication, and Relational Computations EQ and NE

Operation Type Calculated Values Computed Result

Multiplication 0*(+Over)

0*(-Over)

(+Over)*0

(-Over)*0

EQ. (+Over).EQ.(+QOver)

(-Over).EQ.(-Over)

.NE. (+Over).NE.(+Over)

OO |O|O|O|O

(-Over).NE.(-Over)
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1.10 FAIL/Status Output Function (/F1 Option)

FAIL Output

When a failure occurs in the MV CPU, the MV outputs a relay contact signal (1 signal).
The relay is energized when the CPU is normal and de-energizes when a CPU failure
occurs. Therefore, relay output is carried out when the power is turned OFF (or when
there is a power failure). You cannot change this behavior.

Relay Operation

N LA LA

NO Cc NC NO Cc NC NO Cc NC

During normal operation When a failure occurs When power is turned OFF
* NO: Normally Opened, C: Common, NC: Normally Closed

If a failure occurs, contact your nearest YOKOGAWA dealer for repairs.
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1.10 FAIL/Status Output Function (/F1 option)

Device Status Output

The following status notifications are output with a relay contact signal. You can choose
whether or not to output each kind of status notification. The relay is energized when the
status occurs. This cannot be changed.

P For configuration instructions, see section 9.6.

Status Description Corrective Action
Status of the internal  Internal memory error. Contact your nearest
memory or CF card YOKOGAWA dealer for

repairs.

When the auto save to the CF card function is On.
» The free space on the CF card has Replace the CF card.
dropped to 10% of the total size.
(only when FIFO is disabled. For
details on FIFO, see section 1.5.)
* CF card error. * Replace the CF card.

» Use the MV to format the CF
card (the CF card data will
be deleted).

However, the status of the internal Insert a CF card.
memory is output when the CF card
is not inserted.
* 10 MB or less of available space'
remaining in internal memory.
* The number of files in internal
memory for which Auto Save to the
CF card has not been completed
has exceeded 390.
When the auto save to the CF card function is Off.
* 10 MB or less of available space Save the data in the internal
remaining in internal memory. memory to the CF card.
* The number of files in internal
memory that have not been
manually saved has exceeded

390.

Measurement error ~ A/D converter error. Contact your nearest
YOKOGAWA dealer for
repairs.

Burnout detected. Replace the thermocouple
that has burned out.

Communication error Modbus master or Modbus client Check the error by using the

communication error. Modbus master or Modbus
client display and perform
corrective actions.

FTP file transmission error. Check the FTP log and
perform corrective actions.

Memory stop Memory sampling has stopped. Start memory sampling.

Ta K

* The internal memory’s “available space” refers to the following areas:
* Unused areas of internal memory
» Data areas for which Auto Save or Manual Save (see section 1.5 for details) has been

completed.
Relay Operation
NO Cc NC NO C NC NO Cc NC
During normal When specified When power is
operation status occurs turned OFF
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1.11 Other Functions

Time Related Functions

Time Correction

The MV internal clock can be changed in the following ways.

Method Description

Key operation Use to set the MV to a specified time.

Event action function Sets the MV internal clock to the closest hour.

SNTP client function  Sets the MV internal clock to the time retrieved from an SNTP server.

Time Correction Operation

The time correction operation varies depending on whether or not memory sampling is
in progress.

P For configuration instructions, see section 9.1.

Status Operation
No memory sampling The MV internal clock is changed immediately.
Memory sampling The MV internal clock is gradually corrected. While the time is being

gradually adjusted, the date/time in the status display section is
displayed in yellow.

Gradual Correction of the Internal Clock

If the time deviation between the time of the MV internal clock and the correct time (the
specified time) is within a specified value, the MV clock is adjusted gradually at 40 ms
for each second. Otherwise, the clock is corrected immediately. The maximum value
of time deviation (referred to as tm in the figure below) can be selected from within the
range of 10 s to 5 min.

Time specified manually or retrieved Time when a remote control
from an SNTP server signal is applied (Time on the MV)
Time on the MV Nearest hour
| A 4 J7 | > | h 4 J: | >
I h—— 1 i I h—— 1 4
Time deviation Time deviation
| IS | E— | IS | E—
tm tm tm tm
Range in which the time is Range in which the time is
gradually adjusted gradually adjusted

Example: When changing the time to 12 hours 55 minutes 35 seconds when the time
on the internal clock is 12 hours 55 minutes 32 seconds
The time deviation of 3 seconds is adjusted by 40 ms per second. The internal
clock will be fully synchronized to the specified time after 75 seconds.

Date Format

You can select from the following ways of displaying the year, month, and day:
2008/01/23, 01/23/2008, 23/01/2008, and 23.01.2008.

P For configuration instructions, see section 9.1.

Time Zone
You can set the time difference between the location where the MV is used and GMT.
P For configuration instructions, see section 9.1.

Daylight Saving Time (DST)

If the MV is used in a region that has DST, the time is switched automatically between
DST and standard time at two user-specified times. For configuration instructions, see
section 9.1.
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1.11 Other Functions

System Display

Language

USB Interface

This function displays the total number of inputs on the MV, the size of the internal
memory, the communication functions, the external storage drive, the options, the MAC
address, and the firmware version number.

P For operating instructions, see section 9.3.

The displayed language can be set to English, Japanese, German, French, Chinese, or
Korean.
P For configuration instructions, see section 9.4.

You can connect USB devices, such as keyboards and USB flash memory, to the two
USB ports located on the front and back of the MV.

* You can operate the MV with a keyboard.

» You can save and load measured data and setup data from USB flash memory.
Connectable devices: 109/104 keyboards and USB flash memory

P For configuration instructions, see sections 4.10 and 9.7.

24 VDC Transmitter Power Supply (/TPS2, or /TPS4 option)

Provides 24-VDC power to up to two (/TPS2) or four (/TPS4) two-wire system
transmitters. Transmitters output 4- to 20-mA current signals. You can connect these
signals to an MV input terminal and display measured values.

A%

Current
—_—

Transmitter power
supply output
terminal

Transmitter

Input terminal
Shunt resistor: 250 Q

External Input Channels (/MC1 option)

Temperature Unit

These channels handle measured data that is received from other devices through
communication functions. 240 channels are available. External input channel data can be
displayed and saved in the same ways as measurement channel data.

P For configuration instructions, see sections 11.1 and 11.2.)

When measuring temperature with a thermocouple or RTD, you can set the unit to °C or
°F.
For configuration instructions, see section 9.2.
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Chapter 2

Installation and Wiring

2.1

Where and How to Install

Location

Install the MV indoors in an environment that meets the following conditions:

Temperature of 0 to 40°C
Install the MV in a location where the temperature is 0 to 40°C, and the humidity is 20
to 80% RH (5 to 40°C). Only use the MV when there is no condensation on it.

Note

Condensation may form when moving the MV from a low temperature/humidity environment to
a high temperature/humidity environment, or when there is a sudden change in temperature.
Temperature/humidity changes may also result in thermocouple measurement errors. In these
kinds of circumstances, wait for at least an hour before using the MV, to acclimate it to the
surrounding environment.

Altitude of 2,000 m or below

Good ventilation

To prevent overheating, install the MV in a well-ventilated area. We recommend that
you leave 50 mm or more of space around the top, left, and right of the MV.

Not much mechanical vibration

Install the MV in a location without much mechanical vibration. Placing the MV in a
place that is subject to large levels of mechanical vibration will not only put added
stress on its components, it may also impede ordinary measurement.

Flat surface

Install the MV on a flat surface, neither leaning to the left nor to the right. The MV can
be tilted if the stand is used.

Do not install the MV in the following places:

Outdoors

In an environment with flammable or explosive gases, steam, or dust
(dangerous places)

In direct sunlight or near heating devices

Install the MV in a place that is near room temperature (23°C) and that is not subject
to very much temperature fluctuation . Placing the MV in direct sunlight or near
heating devices can cause adverse effects on the internal circuitry.

In an environment with excessive amounts of soot, steam, moisture,
dust, or corrosive gases

Soot, steam, moisture, dust, and corrosive gases will adversely affect the MV and
should be avoided.

Near strong magnetic fields

Install the MV in a place with a magnetic field of less than 400 A/m. Do not bring
magnets or instruments that produce electromagnetic fields close to the MV. Operating
the MV near strong magnetic fields can cause measurement errors.

Where the display is difficult to see

The MV uses an LCD screen so viewing of the display from an extreme angle is
difficult. Install the MV so that the user can view the display directly from the front.

IM MV1000-01E
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2.1 Where and How to Install

Installation

Install the MV on a flat surface.

Note

¢ You cannot put the MV in a stack.

* You can put rubber feet on the bottom of the MV2000. Please use the ones that come with
the MV2000.

* Using the stand

When using the stand, push it out until it locks into place. When retracting the stand
on the MV2000, fold the stand back while pushing inward on it.
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2.1 Where and How to Install

¢ Using the vertical stand (MV1000 only)
The MV1000 can be installed vertically by attaching the vertical stand (sold
separately).
The appropriate screw tightening torque is 0.6 N°m. Be sure to support the instrument
from the bottom when attaching the stand.

Attaching the stand Instrument placement

* Installing on a panel
The MV can be installed on a panel by using the rack mount kit (sold separately).

See the external dimensions for the installation procedure.

IM MV1000-01E
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2.2 Signal Input Terminal Wiring

Wiring to the Signal Input Terminals

A | WARNING

» To prevent electric shock, make sure that the power source is turned OFF.

CAUTION

« Exposing the input and output signal cables connected to the MV to high tension
may damage the cables and the MV terminals. Do not stretch the cables to their
limit, and make sure that the terminals are not being pulled on.

« To prevent fire, only use signal cables with a temperature rating of 70°C or
above.

» Do not run a current through any of the input terminals that exceeds the voltages
below. Doing so may damage the MV.

* Maximum input voltage: +60 VDC
* Maximum common mode voltage: +60 VDC (under measurement category Il
conditions)

« The MV is an installation category Il product.

Wiring Precautions
Take the following precautions when wiring the input signal cables:
When using a screw terminal, we recommend that you use a crimp-on lug with an
insulation sleeve (designed for 4-mm screws).

B )

When using a clamp terminal, we recommend that you use the following kind of cable:
+ Conductive cross-sectional area: 0.08 mm? to 1.5 mm 2(AWG28 to 16)
+ Stripped section: Approx. 7 mm

Crimp-on lug (designed for 4-mm screws) with an insulation sleeve

Take measures to prevent noise from entering the measurement circuit.

* Move the measurement circuit away from the power cable (power circuit) and ground
circuit.

Ideally, the object being measured should not generate noise. However, if this is
unavoidable, isolate the measurement circuit from the object. Also, ground the object
being measured.

Shielded wires minimize the noise caused by electrostatic induction. Connect a shield
to the ground terminal of the MV as necessary (make sure you are not grounding at
two points).

To minimize noise caused by electromagnetic induction, twist the measurement circuit
wires at short, equal intervals.

Make sure to ground the protective ground terminal through minimum resistance (less
than 100 Q).

When using internal reference junction compensation on a thermocouple input,
take measures to stabilize the temperature at the input terminal.

» Always use the terminal cover.

» Do not use thick wires which may cause large heat dissipation (we recommend a
cross-sectional area of 0.5 mm? or less).

Make sure that the ambient temperature remains reasonably stable. Large
temperature fluctuations can occur if a nearby fan turns ON or OFF.
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2.2 Signal Input Terminal Wiring

Connecting the input wires in parallel with other devices can cause signal

degradation, affecting all connected devices. If you have to make a parallel

connection, then

» Turn the burnout detection function OFF.

» Ground the instruments to the same point.

» Do not turn other instruments ON or OFF during operation. This can have adverse
effects on the other instruments.

» Do not connect RTDs in parallel.

Wiring Procedure
There is a terminal cover screwed onto the signal input terminal block on the rear panel.
It has a label indicating the terminal arrangement on it.

1. Turn the MV OFF and remove the terminal cover.

2. Connect the signal wires to the terminals.

Recommended torque for Screw terminals 0.910 1.0 Nem
tightening the screws Clampted terminals 0.22 to 0.25 Nem

3. Replace the terminal cover and fasten it with screws. The appropriate tightening
torque for the screws is 0.6Nem.

Nofte
It may be difficult to firmly secure input signal wires with diameters of 0.3 mm or less to clamp
terminals. To secure the wires, try folding the conductive parts over when you connect them to
the clamp terminal.

Input Terminal Arrangement

Location of the Input Terminal Blocks
* MV1000

ETRE)|
[®

J
E)e =
Input terminal block 1
r
@ TG
Input terminal block 2
e
5l L

+ MV2000

=

Input terminal block 3 TO T Input terminal block 1

Input terminal block 4 W‘ + Input terminal block 2
g

LI

e
e

I )
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2.2 Signal Input Terminal Wiring

Input Terminal Block Channel Assignments
The following table shows which channels are assigned to which terminal blocks.

Input

MV1000 Channel Assignment

terminalblock |MV1004 (MV1006 |MV1008 [MV1012 |MV1024

1 14 1-12

2 1-4 1-6 5-8 1-12 13-24

Input MV2000 Channel Assignment

terminalblock |MV2008 [MV2010 [(MV2020 |[MV2030 |MV2040 |MV2048
1 1-4 1-10 1-10 1-10 1-10 1-12

2 5-8 11-20 11-20 11-20 13-24

3 21-30 21-30 25-36

4 31-40 37-48

This picture shows where the channel inputs are located on each terminal block.

Input terminal block of
the MV1004, MV1008,
and MV2008.

MV1006 input
terminal block

Input terminal block of
the MV2010, MV2020,
MV2030, and MV2040

Input terminal block of
the MV1012, MV1024,
and MV2048.

Screw terminal

CH4 CH2
CH3 CH1

BDSSD

DD

RS

CH6 CH4 CH2
CH5 CH3 CH1

DD

DD

DD

CH10 CH8 CH6 CH4 CH2

CH9 CH7 CH5 CH3 CH1

DD |

DD

DD |+a

@D

@D |8

CH12 CH10 CH8 CH6 CH4 CH2

H11 CH9 CH7 CH5 CH3 CH1

D@

DDDDDSDDR) b

D@

@
PR

DDDDDSDDD@)|+A
B R)|-.

Clamp terminal

CH3 CH1
—— /b
+IA
_/B
CH4 CH2
CH5 CH3 CH1
T I
§ § +/A
S S| -/B
S Q|
S S i
CH6 CH4 CH2
CH9 CH7 CH5 CH3 CH1
e I
+IA
_/B
CH10 CH8 CH6 CH4 CH2
CH11 CH9 CH7 CH5 CH3 CH1
T = = —=l/b
C A
B
CH12CH10 CH8 CH6 CH4 CH2
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2.2 Signal Input Terminal Wiring

Screw Terminal Wiring
DC voltage input/DI (ON/OFF) input TC input

Compensating leadwire

+ +

+
DC voltage input _+

\)
RTD input DC current input
b
A +
+
€ .

B A DC current input

B — -

b

Shunt resistor

[ ] Example: For 4 to 20 mA input, use a

shunt resistor of 250 Q+0.1%.
Lead wire resistance per wire of

10 Q or less. Make the resistance

of the three wires equal.

Clamp Terminal Wiring

Remove the terminal block Connect the wires Connect the terminal block

Flat-blade

Recommended length
screwdriver

of stripped wire: ~~__

7 mm /

Recommended wire size
0.08 to 1.5 mm2 (AWG28 to 16)

S

Hold both ends of the terminal Input signal wire Hold both ends of the terminal
block and pull straight. First, loosen the screw at the front using block, align it with the connector,
a flat-blade screwdriver. Insert the input and then push it in.

signal wire into the slit on the left side of
the terminal block, and fasten the screw
at the front.

Nofte

RTD input terminals A and B are isolated on each channel. Terminal b is shorted internally
across all channels. On models with the /N1 option (Cu10, Cu25 RTD input/3-wire isolated
RTD) or the /N2 option (3-wire isolated RTD), terminal b is also isolated on each channel.
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2.3 Optional Terminal Wiring

Wiring to Optional Terminals

A

Wiring Precautions
We recommend that you use crimp-on lugs (designed for 4 mm screws) with
insulation sleeves to connect to the optional terminals.

) )

Nofte

To prevent electric shock, make sure that the power source is turned OFF.

If you are going to apply a voltage of more than 30 VAC or 60 VDC to the
output terminals, use round crimp-on lugs with insulation sleeves on all output
terminals to connect the signal cables so that the wires won’t slip out even if the
screws loosen. Also, use cables that comply with double insulation requirements
(dielectric strength of 2300 VAC or more). For voltages below 30 VAC/ 60 VDC,
use cables that comply with basic insulation requirements (dielectric strength
of 1390 VAC or more). To prevent electric shock, attach the terminal cover after
wiring and make sure not to touch the terminals.

CAUTION

Use the following circuit voltages for the connection to the alarm/FAlL/status
output terminal.
*  When the connection is to Mains Circuits (primary AC power source circuits):
150 V or less
* When the connection is to circuits derived from Mains Circuits (secondary
circuits): 250 V or less
(keep the Mains Circuit voltage at less than 300 V, and use an isolation
transformer.)
To prevent fire, only use signal cables with a temperature rating of 70°C or
above.
Exposing the input and output signal cables connected to the MV to high tension
may damage the cables and the MV terminals. Do not stretch the cables to their
limit, and make sure that the terminals are not being pulled on.
Do not short the transmitter power supply output terminal or apply external
voltage to it. Doing so may damage the MV.
When using the transmitter power supply output terminal, do not use current that
exceeds the maximum output current (25 mADC). Doing so may damage the
MV.

For remote control wiring, use shielded wires to reduce noise. Connect the shield to the
functional ground terminal or to the ground terminal of the MV.

Crimp-on lug (designed for 4-mm screws) with an insulation sleeve
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2.3 Optional Terminal Wiring

Wiring Procedure

As shown in the figure below, the optional terminal block is located on the rear panel. The
MV is only equipped with an optional terminal block when an option that requires input/
output, such as the alarm output relay (/A options), FAIL/status output relay (/F1 option),
and remote control function (/R1 option), is installed . There is a terminal cover screwed
onto the optional terminal block. It has a label indicating the terminal arrangement on it.

1. Turn OFF the MV and remove the terminal cover.

2. Connect the signal wires to the terminals. The recommended torque for tightening the
screws is 0.9 to 1.0 Nem.

3. Replace the terminal cover and fasten it with screws. The appropriate tightening
torque for the screws is 0.6 Nem.

Optional Terminal Arrangement

Location of the Optional Terminal Blocks

* MV1000
— —
z 5 ——— ] ‘
E col]
EL
Optional terminal
block 1 7
] ope
1@
[l C

+ MV2000

Optional terminal —j—e

.T Optional terminal
block 2

block 1

izl e
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2.3 Optional Terminal Wiring

Optional Terminal Block Assignment

| Symbols |
Letters such as NC: Indicate the terminal's functions.
Alarm, FAIL, status output | Remote Pulse input Transmitter power supply output
NC: Normally closed 1 to 8: Remote control H, L: See “Pulse Input +,-: See “24VDC Transmitter
C: Common terminal numbers Terminals (/PM1)” Power Supply Output
NO: Normally opened C: Common in this chapter. Terminal (/TPS2, /TPS4)”

Unused terminal (screws included).

|:| Unused terminal (no screws included).

in this chapter.

| Options that only use terminal block 1

==
1
f
IL
— i
IA1 IA2 IA3
Alarm Alarm Ala/[m
r A}
02 o1 04 0302 01 06 0504 0302 01
& R@ [@Ine] [nc & [RInc| [nene] [ne NC| Inc|nc| |Nc|nc| [Nc
& @@ @l |c & @c| [cle| |c cl Telel Jele] e
& 3 [DNo|  [No & (G9No|  [No|No|  |No NO|  Ino|no| [NO|NO| [NO
IA1/R1 IA2/R1 IA3/R1
Alarm Alarm Alarm
Remote ——~——— Remote P A ~ Remote
02 01— 04 0302 O01~—"— 06 0504 0302 01
& @)D |Dnc| |Ncle |3 [ ¢ &) @Inc| [nc|nc] [nc[e 3] NS [Nc|Nc| Nc|nc| [Nc|6 |3 ¢
@ @@ @ic| [cl7]s7] @ @ c| [clc]| [clz]afx] [ lc]c] [elc] [c]7]a]q
@ )G [@)No| [No|8 |5 [ & @no| [No[No| [no|s |55, N9 |Nojno| [No[No| [Noj8 |5
IR1 IA1/F1 IA2/F1
Status output Alarm Status output ~ Alarm
Remote FAIL — FAIL —
n l 02 o1 l 04 0302 o1
6(3(c| INY [Nc|@D)| |GDINc| [N NC| Inc|Nc| |Nc|Nc| |nc
7la7] & [c[@® @|c| |c Cl lclc| |clc]| |c
8|55 N9 [Nno[@) [@D[Nno| |No NO| Ino|No| [Nolno| [NO

210
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2.3 Optional Terminal Wiring

(Continued from previous page)

IF1 /R1 /A1 /PM1 /A2 IPM1
Status Remote Alarm Remote Alarm Remote
output control output lT#;I)Suet control output ?#:)iet control
FAIL input input input
l — 02 01 g g ¢~~~ 04 0302 01 G, ¢
N[ nel@] (@@ [@e]alc] & [@Inc] ne| [nu[u[u]slc] M| [ncIne] [ne[ [u[u[u[ale
¢ c@@@@741®®c c| [uicfufafq] L& e|c| [e| |rfL|L|aly >
v vol@] @@l @[5z @ |@ino] v 12| [ oo Jro .| &
=
S
/A1 [F1 /PM1 /PM1 [F1 /PM1 ]
o
Status
out;;Jut Alarm Pulse Remote Pulse Remote Status Pulse Remote s
output input  control input  control output input ~ control =
FAIL A —A— input input FAIL input g
02 01 8 7 6 8 7 6 ¢ l 8 7 6 ' «Q
NC| INcNc| |Nc| |H|H|H|3[¢ HIH|H[3[c] IN¢] [Nc|@D (@0 [H|H|H|3 [
Cl fclc| [c| |L|L|L|a[y Lic|faf7] & [c|@ (@) |i|i|c|aly
NO| Ino[No| [NO 2 2| N9 [no[@) (@ 5[,
IA1 [TPS2 /A1 IR1 ITPS2
Transmitter Alarm Transmitter Alarm Remote
power output power oufput  control
supply supply input
PN 02 01 —~ 02 01
ti+ NC| |NC tl+ NC| [NC|6 |3 |¢
-l c| |c il c| |c|7]a;
NO NO NO NO| 8 (5|2
ITPS2 IR1 /TPS2
Transmitter Transmitter Remote
power power control
supply supply input
~— ~—
+ +
+ @ @ + & | @s|3|c
=|- @ @ -l & (@ 7]4]
@ ® & @[5
| Option that only uses terminal block 2
ITPS4
Transmitter power supply output
4+
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2.3 Optional Terminal Wiring

| Options that use terminal blocks 1 and 2

Alarm
A
v e - - N
I 16 1514 1312 11
> T > NC| Inc|nc| |Nc|nc| |Ne
r————<um c cle clc c
NOJ  INo|No| |No|NO| [NO
Alarm
r A Y
16 1514 1312 11
NC Inc|nc| [Nc|ne| [Ne
c cle clec c
NO| Ino|no| |No|No| |NO
Alarm
r A N\
16 1514 1312 11
NCl  Inc|nc| |nc|Nc| |Nc
¢l |c|c| |c|c| |c
NOl  INo|No| |No|No| [NO
Alarm
A
r N\
16 1514 1312 11
NC| Inc|nc| |Nc|nc|  |Ne
c cle| |cle| e
NO|  Ino|no| |No|no| |NO
Alarm
A
r N\
16 1514 1312 1
NC| Inc|nc| [Nc|nc| |ne
c cle clc c
NO|  Ino|No| |No|NO| [NO
Alarm
A
r N\
16 1514 1312 11
NC| Inc|nc| |Nc|nc|  |Ne
c cle| |cle| e
NO| Inolno| |No|No| |NO

|
|
i
|
i
|

@

O]

r|lT|~

IA3/F1
FAIL Status output
.|
@ N el @) (@ @
¥ P 1D
NOl ol | @@ @
IA3/F1/R1
Status output
FAIL Remote
| 5
@ Nl el @) [@)e |3 | D
@ @® @7 4%
NOl Mol @@ [@)e |5 2
[A3/PM1
Pulse input Remote
/_/H/—H

8 7 6
H{H|H|3 ¢
LiL|L|afy

512

[A3/F1/PM1
Status output Pulse input
FAIL Remote
—N~
v l 8 7 67~
NC
® NCIE) @) |H[H|H|3 | (@D
c cl® (6D |i|i|L|aly
NO
@ @) 3B
A4
Alarm
r A hY
06 0504 0302 01
@ NC  Inc|nc| |Nc|ne|  [Ne @
C| lclc| |cle] |c
NO| Ino|no| |No|NO|  [NO
[A4/R1
Alarm
p A ~ Remote
06 0504 0302 01
NC
@ NC|NC| |NC|NC| |NC|6 |3 [¢ @
€|l lcle| |elec| |c|7 1
NO|  INo|No| [No[no| [No|8 |5 [,
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2.3 Optional Terminal Wiring

Alarm Output Terminal, FAIL Output Terminal, and Status Output Terminal (/A1,
IA2, IA3, /A4, and /F1)

NC

Output format: Relay contact
c Contact rating: 250 VAC (50/60 Hz)/3 A, 250 VDC/0.1 A (for resistor load)
NO Withstand voltage: 1600 VAC at 50/60 Hz for one minute

(between output terminals and the ground terminal)

Remote Control Input Terminal (/R1)

* Relay contact input * Transistor input (open collector)
(voltage-free contact)
Contact closed at 200 Q ON voltage: 0.5V or less (30 mADC)

Contact open at 100 kQ or greater  Leakage current when turned OFF:
0.25 mA or less

69 o—)3 c T ' T
o— )8 0 o—&) 5 2 7 4 1
8 5 2

Withstand voltage: 1000 VDC for one minute between
input terminals and the ground terminal

Internal circuit

| 5V Input format:

! Photocoupler isolation

i Shared common (C)
@3 Allowable input voltage:
$ 5VDC

1~8
Cc

Pulse Input Terminal (/PM1)

* Relay contact input *Transistor input (open collector)
(voltage-free contact)
Contact closed at 200 Q or less ON voltage: 0.5V or less (30 mADC)

Contact open at 100 kQ or greater Leakage current when turned OFF:
0.25 mAor less

Withstand voltage: 1000 VDC for one minute between
input terminals and the ground terminal

Internal circuit

| 5V Input format:

E Photocoupler isolation

! Shared common (L)

! Allowable input voltage:
H 30 VDC

IM MV1000-01E 213
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2.3 Optional Terminal Wiring

24 VDC Transmitter Power Supply Terminal (/TPS2, /TPS4)

Connect the MV to the transmitter as shown below:

MV

Current

Transmitter power
supply output

terminal Transmitter

Input terminal

Shunt resistor: 250 Q

Note

To reduce noise, use a shielded cable for wiring. Connect the shield to the functional ground
terminal or to the ground terminal of the MV.
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2.4 Connecting the Power Supply

Connecting the Power Cord (if the power supply suffix code is -1)
* Precautions to Be Taken While Connecting the Power Supply

A

Make sure to follow the warnings below when connecting the power supply. To prevent

electric shock and damage to the MV, observe the following warnings.

Make sure that the power supply voltage matches the MV rated supply voltage
and is within the maximum voltage range specified for the power cord.

Confirm that the power switch is OFF before connecting the power cord.

To prevent electric shock, be sure to use a power cord provided by YOKOGAWA
for use with the MV.

To prevent electric shock, make sure to ground the MV. Insert the desktop power
cord into a grounded 3-prong outlet.

Do not use an ungrounded extension cord. If you do, the device will not be
grounded.

Use a power supply that meets the following conditions:

Item Condition

Rated supply voltage 100 to 240 VAC

Operating supply voltage 90 to 132, 180 to 264 VAC
range

Rated supply frequency 50/60 Hz

Power supply frequency range 50/60 Hz + 2%

Maximum power consumption ~ MV1000:45 VA (100 V), 60 VA (240 V)

MV2000:65 VA (100 V), 90 VA (240 V)

Note

Avoid using a power supply voltage of 132 to 180 VAC with the MV because such a power
supply voltage may reduce measurement accuracy.

Connection Procedure

1.
2.

Check that the power switch is OFF.

Connect the MV power cord to the power inlet on the rear panel.

Make sure that the power outlet meets the conditions listed above and that the

power supply voltage is within the maximum voltage range specified for the power

cord. Then, plug the power cord into the power outlet. Use a grounded 3-prong
outlet.

IM MV1000-01E
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2.4 Connecting the Power Supply

Wiring to the Power Terminal (if the power supply suffix code is -2)
When Using an AC Adapter

* Precautions to Be Taken While Connecting the Power Supply
Make sure to follow the warnings below when connecting the power supply. To prevent
electric shock and damage to the MV, observe the following warnings.

A

To prevent electric shock, make sure that the power source is turned OFF.

Only use the power cord that YOKOGAWA provides for use with the MV.
Confirm that the power source voltage matches the specifications of the AC
adapter before connecting the power cord.

When you do not plan on using the MV for a while, remove the AC adapter cord
from the AC outlet.

Only use a YOKOGAWA AC adapter.

Do not place objects on top of the AC adapter or power cord, and keep them
away from heat sources.

When removing the plug from the power outlet, do not pull on the cord. Pull
from the plug. If the power cord is damaged, contact your nearest YOKOGAWA
dealer.

Use a power supply that meets the following conditions:

Item Condition
Rated supply voltage 100 to 240 VAC
Operating supply voltage 90 to 264 VAC
range

Rated supply frequency 50/60 Hz

Power supply frequency range 48 to 62Hz

Maximum power consumption  MV1000: 45 VA (100 V), 60 VA (240 V)

MV2000: 65 VA (100 V), 90 VA (240 V)

Connection Procedure

1.
2.

Check that the power switch is OFF.

Connect the power cord and the protective ground cord to the power terminal.
Use a round crimp-on lug (designed for 4-mm screws) with an insulation sleeve.
The appropriate tightening torque for the screws is 1.4 to 1.5 N/m.

+ 2
a1

Functional ground terminal =

Note

Do not wire the protective grounding
cord to the functional ground terminal.

Power cord

Protective
grounding cord

Attach the power terminal cover (transparent), and fasten it with screws.
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2.4 Connecting the Power Supply

A

When Using a DC Power Supply

* Precautions to Be Taken While Connecting the Power Supply
Make sure to follow the warnings below when connecting the power supply. To prevent
electric shock and damage to the MV, observe the following warnings.

» To prevent electric shock, make sure that the power source is turned OFF.

+ To prevent fire, use cables with a cross-sectional area of 0.5 mm? (AWG20) or
more.

» Use crimp-on lugs (designed for 4 mm screws) with insulation sleeves to
connect both the power cord and the protective ground.

» To prevent electric shock, be sure to attach the electrical wiring cover

(transparent).
. _________________________________________________________________________________________________________________|

Use a power supply that meets the following conditions:

Item Specification
Rated supply voltage 12 or 24 VDC
Operating supply voltage range 10 to 28.8 VDC
Maximum power consumption MV1000: 24 VA

MV2000: 35 VA

e Wiring Procedure

1. Make sure that the power source is OFF. Open the power terminal cover
(transparent).

2. Follow the instructions in “When using an AC adapter” and connect the positive
and negative cables and the protective ground cable to the power terminal.

3. Attach the power terminal cover (transparent), and fasten it with screws.

IM MV1000-01E
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2.4 Connecting the Power Supply

Rechargeable Battery Model (if the power supply suffix code is -3)

Recycle Mark

The Ni-MH battery that is used by the MVV1000 is recyclable.

The following recycle mark is used on the battery and in this user’s manual to indicate
that it is recyclable.

Von’
Ed
Ni-MH
Indication of recharging
When the battery needs recharging after it is used over a given period, the ALARM
LED (red) turns ON. The operation time from the point when the ALARM LED turns ON
until the battery becomes empty is normally 10 minutes to 15 minutes. However, this
varies depending on how it is used. If the battery was not fully charged, the battery may
become empty in less than 5 minutes. Therefore, charge the battery immediately when
the ALARM LED turns ON.

ALARM LED CHARGE LED

OALARN O cHarce

MVY1000 YOKOGAWA ¢

(-—)
(=)

BKEM

When an external storage medium is in operation, the ALARM LED may turn ON due to
the changes in the load of the battery voltage.

If the ALARM LED turns ON while data is being saved, you can continue the save
operation until the battery is empty.

The MV1000 has a built-in over-discharge protection circuit. To prevent the battery from
over discharge, a shutdown operation is performed to cut off the current from the battery
after a short time after the ALARM LED turns ON.

Thus, the power to the MV1000 is automatically turned OFF after the ALARM LED turns
ON. If you leave the MVV1000 in this condition for an extended time, the battery may over
discharge due to the minute consumption of power by the internal circuit operation. If the
MV1000 automatically turns OFF after the ALARM LED turns ON, make sure to turn the
power switch of the MV1000 to the OFF position.

Charging of the battery starts when the AC adapter is connected to the MV1000. In this
case, the CHARGE LED and the ALARM LED may blink simultaneously, but the ALARM
LED will turn OFF after charging the battery for awhile. When fully charged, the CHARGE
LED blinks.

Additionally, while the battery is installed, the battery power is consumed through minute
current even if the power switch of the MV1000 is turned OFF. If you are not using the
MV1000 for an extended time, remove and store the battery.

Note

With Ni-MH batteries, a phenomenon called memory effect occurs in which the apparent

battery capacity decreases when shallow charge and discharge cycles are repeated followed
by a deep discharge. In such case, the capacity recovers by repeating the cycle of operating
the MV100 until shutdown (discharge the battery until the end-ofdischarge

voltage) and recharging several times.

The battery is charged by leaving the AC adapter connected, whether the power switch
is ON or OFF. The battery voltage is different during AC adapter operation and battery

operation. The ALARM LED does not turn ON during AC adapter operation even when
recharging is necessary. Note the following points.

218
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2.4 Connecting the Power Supply

When the AC adapter and the battery are used simultaneously, the AC adapter is used
at higher priority. If the AC power supply is cut off such when a power failure occurs,
the MV1000 automatically switches to battery operation. When the AC power supply
recovers, the MV1000 returns to AC adapter operation. If you are using the battery as
backup power, fully charge the battery before using it.

Approximate Time of Operation1
The time of operation with the battery varies depending on the operating conditions.

Model Operation Time?
Operating Minimum Normal Maximum
Condition consumption consumption consumption
MV1004 10 hours 8 hours 4 hours
MV1008, MV1024 9 hours 7 hours 5 hours
MV1012 13 hours 9 hours 4 hours

1 Reference values when operated at room temperature.
2 See “Power Supply” in the specifications for the instrument’s operating conditions.

Battery Life

The number of times the battery can be recharged is approximately 300 (depends on the
condition in which it is used). If the operation time is short even when it is fully charged,
the battery is dead. Replace with a new battery.

Name Part Number Qty. Notes

Battery box B8805HA 1 When using the MVV1000 with power supply suffix code -3

Replacing the Battery
Follow the procedures below to replace the battery box.

1. Check that the power to the MV1000 is OFF.

2. |If you are using an AC adapter, remove the AC adapter’s power cord from the
outlet.

3. Remove the four mounting screws from the battery box.

4. Rremove the battery box by lifting straight up.

Z
5. Prepare the new battery box.

IM MV1000-01E
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2.4 Connecting the Power Supply

6. Align the new battery box connector with the connector on the MV1000, then
connect the battery box to the MV1000.

7. Fasten the battery box in using four screws. The appropriate screw tightening
torque is 0.6 Nem.

Do not disassemble the battery box.
]
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Chapter 3  Measurement Channels and Alarms

3.1 Setting the Scan Interval and the A/D Converter
Integration Time

Display

This section explains how to set the scan interval and the A/D converter integration time.
P For an explanation of these functions, see section 1.2.

Press MENU and then select Menu tab > Basic setting mode > Menu tab > A/D,
Memory.

Basic Setting Hode

Scan interval

Sean mode | tornal |
Scan interval 1s
A/D intearate Auto
Hemory
Data kind Event

[ Normal | Fast |

¢ Scan interval>Scan mode
Normal: Measures at the normal mode scan interval.
Fast: Measures at a scan interval of 25 ms (MV1004, MV1008, and MV2008) or
125 ms (MV1006, MV1012, MV1024, MV2010, MV2020, MV2030, MV2040,
MV2048). Fast sampling mode is not available on models equipped with
external input channels (/MC1). For details, see section 1.2.

¢ Scan interval>Scan interval
The selectable settings appear.

e Scan interval>A/D integrate
When the scan mode is set to Normal, select an appropriate A/D integration time. Only
the selectable settings are displayed.
Setting Description
Auto The MV automatically detects the power supply frequency and sets the integration

time to 16.7 ms for 60Hz and 20 ms for 50 Hz. The integration time is fixed at 20 ms
(50 Hz) if you are using a 12-VDC power supply.

50Hz Sets the integration time to 20 ms.

60Hz Sets the integration time to 16.7 ms.

100ms Sets the integration time to 100 ms (when the scan interval is 2 s or 5 s).
600Hz The A/D integration time for fast sampling mode. You cannot change this value.

IM MV1000-01E
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3.2 Setting Burnout and Reference Junction
Compensation

Display

This section explains how to set the function that detects sensor burnouts in

thermocouple and 1-5V inputs as well as how to set the reference junction compensation

method of the thermocouple.

Basic Setting Hode T

First-CH: Last-CH: [1

Burnout szet Ooff

RJG

Hode External

Yolt 8wl
4l 2 [ 3 | 4 |

¢ First-CH, Last-CH
Select the target channels.

e Burnout > Mode
Detects thermocouple and 1-5V input sensor burnouts.

Press MENU then select Menu tab > Basic setting mode > Menu tab > Burnout, RJC.

Setting Description

Off Does not detect sensor burnouts.

Up When the MV detects a burnout, it sets the measured result to “+Over.” The

measured value is displayed as “Burnout.”

For 1-5V input, the MV detects a sensor burnout when the measured value exceeds
the scale upper limit by 10% of the scale width. (Example: With a scale of 0 to 100,

burnout is detected at values above 110.)

Down When the MV detects a burnout, it sets the measured result to “~Over.” The

measured value is displayed as “Burnout.”

For 1-5V input, the MV detects a sensor burnout when the measured value goes
below the scale lower limit by 5% of the scale width. (Example: With a scale of 0 to

100, burnout is detected at values below —5.)

e RJC > Mode

Select either Internal or External as the thermocouple input reference junction

compensation method.

Setting Description

Internal Uses the MV reference junction compensation function.

External  Uses an external reference junction compensation function. When the method is set

to External, the Volt setting is displayed.

* RJC > Volt
If you set Mode to External, enter the compensation voltage.

Setting Description

Voltage The compensation voltage that is added to the input. Set the value in the range of

—20000 pV to 20000 pV.
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3.3 Setting the Input Range

This section explains how to set the input range for each channel.

Display

Press MENU and then select > Menu tab > Meas channel > Range, Alarm.

First-CcH Last-CH: [1

Hode Range Span_L Span_ll
[Wo1t [ 2y [-2.eeee [ 2.eee8

¢ First-CH, Last-CH
Select the target channels.

* Range > Mode

Setting Description

Skip Not measured.

Volt, TC, RTD, DI, 1-5V Input type. Represents DC voltage, thermocouple, RTD,
ON/OFF input, and 1-5V inputs, respectively.

Delta, Scale, Sqrt Difference computation, linear scaling, and square root
computation.

Select the checked settings for the modes listed below.

Setting Mode

Volt TC RTD |DI Delta |Scale Sqrt [1-5V  [Skip
Type v v
Range v v v v v v v v
Span Lower v v v v v v v v
Span Upper v v v v v v v v
Scale Lower v v v
Scale Upper v v v
Unit v v v
Ref. CH v
Low-cut v v
Low-cut value v

IM MV1000-01E
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3.3 Setting the Input Range

Range > Type
Input type when Mode is set to Delta or Scale. See the explanation of Mode.

Range > Range
These are specific input settings.

Setting |Input Type Note Setting |Input Type Note
20mV —20,000 mV to 20.000 mVDC |Standard R Type R Standard
60mV —60.00 mV to 60.00 mVDC S Type S

200mV  |-200.00 mV to 200.00 mVDC B Type B

2V —2.0000 V to 2.0000 VDC K Type K

6V —6.000 V to 6.000 VDC E Type E

20V —20.000 V to 20.000 VDC J Type J

50V —50.00 V to 50.00 VDC T Type T

Pt Pt100 N Type N

JPt JPt100 W Type W

Level ON/OFF (Voltage) L Type L

Contact |ON/OFF (Contact) U Type U

1-5V 0.800 V to 5.200 V WRe Type WRe

Setting |Input Type Note Setting |Input Type Note
K Kp vs Au7Fe /N3 option Cu1 Cu10 (GE) /N1 option
PLATI PLATINEL Cu2 Cu10 (L&N)

PR PR40-20 Cu3 Cu10 (WEED)

NiMo NiNiMo Cu4 Cu10 (BAILEY)

W/WRe |W/WRe26 Cub Cu10: a = 0.00392 at 20°C

N2 Type N (AWG14) Cub Cu10: a = 0.00393 at 20°C

Pt50 Pt50 Cu25 Cu25: a = 0.00425 at 0°C

Ni1 Ni100 (SAMA)

Ni2 Ni100 (DIN)

Ni3 Ni120

J263 J263*B

Cu53 Cu53

Cu100 Cu100: a = 0.00425 at 0°C

Pt25 Pt25

Range > Span Lower,Span Upper
The input range. The range of available settings will be displayed on the screen.

Nofte
* You cannot set Span Lower and Span Upper to the same value.
*  When Mode is set to 1-5V or Sqrt, you can only set Span Lower to a value that is less than
Span Upper.

Range > Scale Lower, Scale Upper

The input range after unit conversion.

You can set the scale values to anywhere from —30000 to 30000. The decimal place is
determined by the Scale Lower setting. It can be set to the following positions: X.XXXX,
XX XXX, XXX XX, XXXX. X, or XXXXX.

Nofte

* The MV converts the measured value to a value within the range set by the Scale Lower
and Scale Upper values with their decimal points removed. For example, if you set the scale
range to -5 to 5, the range of converted values will be 10, but if you set the scale range to -5.0
to 5.0, the range of converted values will be 100. The resolution of values converted within
the range of 10 will be less than that of values converted within the range of 100. For a clear
view, set the scale values so that the range of converted values is greater than 100.

* You cannot set Scale Lower and Scale Upper to the same value.

*  When Mode is set to 1-5V or Sqrt, you can only set Scale Lower to a value that is less than
Scale Upper.
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3.3 Setting the Input Range

* Range > Unit
Set the unit (up to six characters, [Ala[#]1])

* Range > Ref. CH
The reference channel for difference computation.

* Range > Low-cut
Select On to use the low-cut function.

*

The low-cut value for 1-5 V input is fixed at 0% of the input span.

* Range > Low-cut value
With square root computation, set the low-cut value in the range of 0.0% to 5.0% of
the input span.

Measured value

Result of square root computation

Low-cut value

U Input value

IM MV1000-01E 3-5
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3.4 Setting the Moving Average of the Input

This section explains how to set the measurement channel moving average function.
This function suppresses the effects of noise.
P For an explanation of this function, see section 1.2.

Display
Press MENU and then select > Menu tab > Meas channel > Moving average.

1,15 e iEzr (5]
Last-CH: [1

irst

Howing average

On/fOff (n
Count 2
1 20 |

—>-|—|<—Scan Interval

A4 AV AV A4 AV AV A4
[— ] Average value
Average value
\_______\/_______/
Count

¢ First-CH, Last-CH
Select the target channels.

* Moving average > On/Off
Select On to use the moving average function.

¢ Moving average > Count
Set the number of moving average data points from within the range of 2 to 400.
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3.5 Setting the Auxiliary Alarm Function

This section explains how to configure alarm display and output relays.
P For an explanation of these functions, see section 1.3.

Display
MV1000
Press MENU and then select Menu tab > Basic setting mode > Menu tab > Alarm

settings > Basic setting > Switch, Relay or Hysteresis.

Basic Setting Hode

Basic setting Internal Switch

Husteresis

=

[]

Q

g

Reflash AND 3

Rate of change Relay 3

Decrease 1 AND Hone @®

Increase 1 Action Eneraize Ei

Indicator Honhold Hold Honhold (e}

Relaw Action on ACK Hormal 93;

>

>

1]

o

Q

(o0 | o ] [ lone 561 [snl 3

>

Y

=

3

Heas CH o
High/Low A.5 ¥
Delta High/Low 8.4 ¥

Hath CH
High/Low a.a ¥
MV2000

Press MENU and then select Menu tab > Basic setting mode > Menu tab > Hysteresis.

Basic Se

r Basic setting Switch, Relay
Ref lash 0ft Internal Switch
Rate of change AND None
Decrease 1 Relay
Increase 1 AND None
Indicator Nonhold fAction Energize
Hold Nonhold
r Hysteresis — Relay Action on ACK | Nornal
Heas CH
High/Low [65
Delta High/Low [0 &
Hath CH
High/Low [0 g
Ext. CH
High/Low [0 g
[0 | 0ff

* Basic setting > Reflash
To set the reflash operation on alarm output relays, select On. The reflash function
affects the first three output relays.
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3.5 Setting the Auxiliary Alarm Function

¢ Basic settings > Rate of change

e Decrease
Set the interval for the rate-of-change calculation of the low limit on rate-of-change

alarm by the number of sampled data points (1 to 32). The actual interval is
obtained by multiplying the value specified here by the scan interval.

* Increase
Set the interval for the rate-of-change calculation of the high limit on rate-of-change
alarm in the same manner as the interval for the low limit on rate-of-change alarm.

e Basic settings > Indicator

You can choose to make the alarm displays behave in the following ways.
Setting Description

Nonhold  Stop when the alarm condition is released (return to normal condition).
Hold Continue until an alarm output release (AlarmACK) operation is performed.

Switch, Relay

* Internal Switch > AND
Select the internal switches you want to set to AND logic. Select how many
switches after and including the first switch will be set to AND logic. All other
switches will be set to OR logic.

* Relay > AND
Select the relays you want to set to AND logic. Select how many relays after and
including the first alarm output relay will be set to AND logic. All relays after the
selected last relay will be set to OR logic. Available settings are None, 101 (101
only), 101-102 (101 and 102), 101-103 (101 to 103), etc. Only alarm output relays that
are installed are valid.

Note

When reflash is turned ON, the operation of the first three output relays is fixed to OR logic.
Specifying AND produces no effect.

* Relay > Action
Select whether to energize or de-energize the alarm output relay when an alarm
occurs. This setting applies to all alarm output relays.

* Relay > Hold
You can choose to make the alarm output relays behave in the following ways. This
setting applies to all relays.
Setting Description
Nonhold  Stop when the alarm condition is released (return to normal condition).
Hold Stay ON until an alarm output release (AlarmACK) operation is performed

Note

When reflash is turned ON, the operation of the first three output relays is fixed to Nonhold.
Specifying Hold produces no effect.

* Relay > Relay Action on ACK
You can select the relay output status that is enabled after the AlarmACK operation
from the following two settings.

Setting Description

Normal The relay output is deactivated when the AlarmACK operation is executed. If the
condition for activating the alarm output relay is met in the next scan interval, the
relay output is activated.
The operation only applies when the alarm output relay is set to Hold.

Reset The relay output is deactivated when the AlarmACK operation is executed. If a
new condition for activating the alarm output relay is met, the relay is activated.

3-8
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3.5 Setting the Auxiliary Alarm Function

An example of the relay action when AlarmACK is executed is shown below. This
example is for the case when the output relay AND item is set to None.

Normal
Alarm Alarm ACK
occurrence ¥
Alarm 1 Alarm
occurrence
Alarm 2

Activated
Alarm output relay J

Deactivated

[Relay is activated at the next scan interval]

Reset
Alarm Alarm ACK
occurrencev
Alarm 1 Alarm
occurrence
Alarm 2

Activated
Alarm output relay
Deactivated

[Relay is activated on the next alarm occurrence ]

* Hysteresis > Meas CH

¢ High/Low
The hysteresis width for alarm occurrence/release of the high/low limit alarm that is
set for measurement channels.
Selectable range: 0.0% to 5.0% of the span or scaling width.

* Delta High/Low
The hysteresis width for alarm occurrence/release of the difference high/low limit
alarm that is set for measurement channels.
Selectable range: 0.0% to 5.0% of the span.

¢ Hysteresis > Math CH (/M1 and /PM1 options), Ext. CH (/MC1 option)
The hysteresis width for the alarm occurrence/release of the high/low limit alarm that
is set for computation channels and external input channels.
Selectable range: 0.0% to 5.0% of the measurement span.

IM MV1000-01E
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3.6 Hiding the Alarm Indication

Display

This section explains how to select whether or not to hide alarm indication.
P For an explanation of this function, see section 1.3.

MV1000
Press MENU and then select Menu tab > Basic setting mode > Environment tab >
Input, Alarm.

Basic Setting Hode

Input

VYalue on owver-range
Alarm

No Togging off

MV2000
Press MENU and then select Menu tab > Basic setting mode > Environment tab >
View, Message, Input, Alarm.

Environment > View, Hessage, Input. Alarn

r View — Input
Trend type T (Ualue on over-range Free
0ff

Partial
Trend rate switching 0tf Alarn
(No logging 0ff
r Hessage
Write sroup Conmon
Power-fail nessage Off
Change message off
[ on [ oif

e Alarms > No logging
Select On to hide alarm indication. Detect will appear in the alarm setting screen (see
section 3.7).

This function disables the alarm indicator and the logging of alarm events to the alarm
summary.

* How to set for each channel and each alarm
p See section 3.7

3-10
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3.7 Setting Alarms on Channels

Configure alarms after you have set the range. A channel’s alarm settings are reset when

the following occur:

* When the input type (Volt, TC, etc.) is changed.

* When the input range is changed.

»  When the upper or lower limit of the span or scale is changed on channels that are set
to linear scaling, square root computation, or 1-5V input (this includes changes in the
decimal place).

P For an explanation of this function, see section 1.3.

Display

* Alarms for Each Channel
Press MENU and then select > Menu tab > Meas channel > Range, Alarm.

:‘@E‘.ﬂn@ )

First-CH: Last-CH: [1

suwue[y puB Sjsuuey?) JUsWaINseay

Range

Hode Range Span_L  Span_U

[Wo1t [ 2y [-2.eeee [ 2.eee8

Alarm Type Walue Relay MNo. Detect
1 On H A, 8868 0n 181 0n
2 |0ff

3 |0ff

4 [off

1 20 |

e Alarm Delay
MV1000
Press MENU and then select > Menu tab > Meas channel > Tag, Memory, Delay.

ey o | )}

First-CH: Last-CH: [1

Tag

Characters li
Hemory sample
On/fOff On
Alarm delay
Time 18 =
1 20 |
MV2000

Press MENU and then select > Menu tab > Meas channel > Tag, Memory sample,
Alarm delay.
GROUP 1 =
el o roec1a R £ I thor (O
Heas channel > Tag, Memory sample, Alarn delay
First-CH Last-CH 171

r Tag

Characters TENPB1

— Hemory sample

On/0ff On
r Alarn delay
Time 18 s
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3.7 Setting Alarms on Channels

¢ First-CH, Last-CH

Select the target channels. All of the alarm settings selected here will be applied to

these channels.

Alarm>1,2, 3,4

Select On for the Alarms that you want to use.

Alarm > Type

Select the alarm type.

Setting Name Description

H High limit alarm -

L Low limit alarm -

h Difference high limit alarm You can use this alarm on measurement

channels set to difference computation.

Difference low limit alarm

You can use this alarm on measurement
channels set to difference computation.

High limit on rate-of-change alarm

Low limit on rate-of-change alarm

Delay high limit alarm

~|—|= |

Delay low limit alarm

The alarms for channels set to difference computation can be activated by the values

at the positions indicated below.

T, L! T,t

IT, rhl

Input value O

Measured value ’

T
Measured value on the reference channel

Alarms > Value

Set the value depending on the type of alarm.
When the Channel Mode Is Volt, TC, RTD, or DI

Type Value

Alarm Value Range Example

H,L  Within the measurable range.

—2.0000 to 2.0000 V for 2 V range

R, r Min: The smallest number expressible, given the
decimal place. Max: The value that is equal to the
width of the measurable range (but cannot exceed

0.0001 to 3.0000 V for 2 V range

0.1 to 1760.0°C for type R
thermocouples

30000 after removing the decimal point)

Tt Same as H and L

Same as H and L

When the Channel Mode Is Delta

Type Alarm Value Alarm Value Range Example
H,L  Within the measurable range. —2.0000 to 2.0000 V for 2 V range
h, | Within the measurable range. —1760.0 to 1760.0°C for type R

thermocouples

R, r Min: The smallest number expressible, given the
decimal place. Max: The value that is equal to the

0.0001 to 3.0000 V for 2 V range
0.1 to 1760.0°C for type R

width of the measurable range (but cannot exceed thermocouples
30000 after removing the decimal point)

Tt Same as H and L

Same as H and L

When the Channel Mode Is Scale, Sqrt, or 1-5V

Type Alarm Value

Alarm Value Range Example

H,L  From -5% to 105% of the scale width.
But within the range of —30000 to
30000, ignoring the decimal point.

—5.0 to 105.0 for a scale of 0.0 to 100.0.

—120.00 to 300.00 for a scale of —100.00 to
300.00.

R, r  Within the range of 1 to 30000,
ignoring the decimal point.

0.1 to 3000.0 for a scale of 0.0 to 100.0.
0.01 to 300.00 for a scale of —100.00 to 300.00.

T, t Same as Hand L

Same as Hand L

3-12
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3.7 Setting Alarms on Channels

¢ Alarms > Relay

Turn relay output On or Off.

Alarms > No.
Select the output relay or internal switch number when Relay is On.

Alarms > Detect

The Detect setting is displayed if the alarm hide function (for details, see section 3.6)
is enabled. To display notifications when alarms are activated, select On. If you select
Off, when an alarm is activated, a signal will be sent to the alarm output relay and
internal switch, but no notification will be displayed. And the alarm will not be recorded
in the alarm summary.

Alarm delay > Time (for delay high/low limit alarms)
Set the alarm delay time to an integer in the range of 1 to 3600 s.

Nofte
» The alarm delay time takes on a value that is an integral multiple of the scan interval. For
example, if the alarm delay time is set to 5 s when the scan interval is 2 s, the actual delay
time is 6 s.
« The delay alarm has the following special operations.

» If a delay alarm is set on a computation channel and computation is stopped when the
computed value exceeds the alarm setting, the alarm is turned On after the specified
period (delay period) elapses.

* The alarm detection operation is reset if a power failure occurs. The operation restarts
after the power recovers.

» If the alarm setting of the delay high limit alarm is changed when an alarm is
already activated and the input is greater than or equal to the new setting, the alarm
continues. For all other cases, the alarm detection operation starts using the new
setting. This is also true for the delay low limit alarm.

IM MV1000-01E
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3.8 Releasing Alarm Output

This operation is valid when:

* Indicator is set to Hold in Basic Setting Mode

» Relay Hold is set to Hold and Relay Action on ACK is set to Normal in Basic Setting
Mode

» Relay Action on ACK is set to Reset in Basic Setting Mode.

P For Hold and Relay Action on ACK configuration instructions, see section 3.5.

Procedure
Perform this operation after an alarm occurs.

1. In Operation Mode, press FUNC.

The function menu appears.
2. Press the AlarmACK soft key.
The alarm output is released.

Explanation

¢ Alarm Output Release (AlarmACK)
When an AlarmACK operation is carried out, the indications and outputs (relays and
switches) of all activated alarms are cleared.
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3.9

Calibrating Input Values (/CC1 option)

This section explains how to calibrate input values to produce measured values.

P For an explanation of this function, see section 1.2.

Display

Press MENU and then select > Menu tab > Meas channel > Calibration correction.

1 Last-CH:

Humber of set points

First-CcH:

ES wal True wal

2. 0@ 2.

HERA

2. 0@ 2.

HERA

2. 0@ 2.

HERA

L

2. 0@ 2.

HERA

[ off | 2 [ 3 | 4 |

F2. 8@ 2.

[ale]elt]

1

ol))

Y5
Y4

Y3
Y2

Condition
X1<X2<X3<X4<X5

Calibration set points

-1

| —

I

[

Y1

X1 X2 X3 X4

X

5

True val

| Number of set points

¢ First-CH

, Last-CH

Select the target channels. You can set consecutive channels whose range is set to
the same value as that of the first channel.

¢ Number of set points

Select the number of points (including the start and end points) that will be used to
divide segments, from within the range of 2 to 16.

To disable calibration correction, select Off.

IM MV1000-01E
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3.9 Calibrating Input Values (/CC1 Option)

¢ Number of set points > Mes val, True val

Press the Input soft key and enter the value.
For Mes val (measured value), set a value that is greater than the previous value.
Press the Measure soft key to set the current measured value to Mes val. If you press
the Measure soft key when you are setting the calibration function for more than one
channel, the measured value of the channel set to First-CH is used as the Mes val for
all channels.
Range of Selectable Values for Mes val and True val
* On Channels Set to Linear Scaling

—30000 to 30000 (decimal place is the same as that set for the scale)
¢ On All Other Channels

The measurable range

Example: If the range is 2 V, —2.0000 to 2.0000

Nofte

» If you change the Mode or Range settings, calibration correction (the Number of set points
setting) is switched Off.
» You cannot set calibration correction for a channel that is set to Skip.
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3.10 Counting Pulses (/PM1 option)

Display

This section explains how to use computation channels to count pulses that are received

from pulse input terminals.
P For an explanation of this function, see section 1.2.

Press MENU and then select > Menu tab > Math channel > Calculation expression,

Alarm.
ik 1 Eﬁ?aﬂﬂ.‘ﬁiﬂ.[:] o0}

First-CH: 0N Last-CH: 181
Hath 0n
Calculation expression
p1
Span Lower Span Upper Unit
[ -zem.ee | <zee.e@ |
Alarm Type Walue Relay MNo. Detect
1 [on [H a.o8 [on  [181 [oOn
2 [off
a [off
4 [off

First-CH, Last-CH
Select the target channels.

Math range > Math On/Off
Select On.

Math range > Calculation expression
You can use the following variables in equations.
Q01 to Q08: The number of pulses per second.
P01 to P08: The number of pulses per scan interval.
*  The numbers 01 to 08 refer to the pulse input terminal numbers.
P For computation channel configuration instructions, see section 10.1.

There are examples on the next page to help explain configuration options.

IM MV1000-01E
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3.10 Counting Pulses (/PM1 option)

¢ Example 1: Pulse Sum
Display the sum of the pulses from pulse input terminal 6.

Pulse input | R R R R RN ER T REE M Time
Scan interval

0
o
o
o

o Sal o
Number of pulses \— \_

per scan interval

(Sum) H
ﬁ

Pulse sum value

Calculation Expression
Select the channel and set the calculation expression. Set an appropriate Span
Lower, Span Upper, and Unit.

Channel Calculation Expression Description
101 TLOG.SUM(P6) The sum of the number of pulses in each scan
interval.

e Example 2: Pulses Per Minute

Using the MV2008 (scan interval 250 ms), count the number of pulses received by
pulse input terminal 6, and calculate the number of pulses per minute.

(Moving average over a minute)

Pulse input " R R AR R ”l Time
Sampling interval

(250 ms) [/
1

Number of pulses I (60

per second K ‘
4

I

Number of pulses
per minute

Calculation Expression
This table shows which calculation expressions to assign to which channels. Set an

appropriate Span Lower, Span Upper, and Unit.

Channel Calculation Expression Description

101 Q6 Number of pulses per second

102 101*K01 Number of pulses per minute

Constant (Value Description

K01 60 The coefficient for converting pulses per
second to pulses per minute.

Channel |Rolling Average Description

101 Interval: 1 s Moving average over a minute

Number of samples: 60

Channel

Computation starts with the smallest channel number at every scan interval.
Assign larger channel numbers to computation channels that calculate pulses per
minute than you assign to computation channels that calculate pulses per second.

3-18
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3.10 Counting Pulses (/PM1 option)

¢ Example 3: Reset if the Pulse Sum Exceeds a Set Value

If the pulse sum exceeds a set value (the reset value), reset the sum and carry over
the value that exceeds the reset value. Count the number of resets, and calculate the
total pulse sum.

Calculation Expression
This table shows which calculation expressions to assign to which channels and what

constants to set.

Channel |Calculation Expression Description

101 ((102+P01).GE.K01)+101 Number of pulse sum resets
102 CARRY(K01):TLOG.SUM(P01) Pulse sum

103 K01*101+102 The total pulse sum

Variable |[Description

P01 The number of pulses per scan interval.
K01 A constant. The reset value. Values that exceed it are reset.
Pulse input ” ”l Time

Scan interyal

sl INsIN NN NAINA]

Number of pulses
per scan interval

o [o |1 | 1 1 | 2 | 2

Reset count

Reset value| (Sum

|:|
Sum value
(Resets the value below the reset value)

Channel 101: Reset Count

Calculates the number of pulse sum resets.

((102+P01).GE.KO01) returns a value of 1 when the value of the previous pulse sum
(102) + the current pulse count (P01) is greater than or equal to the reset value
(K01). Otherwise, it returns a value of zero. The value of Channel 101 increases by 1
whenever the pulse sum exceeds the reset value.

Channel 102: Pulse Sum

Calculates the pulse sum.

This channel normally calculates the pulse sum, TLOG.SUM(PO01). If the pulse sum
goes above the reset value (K01), the excess value is set as the new pulse sum.

Channel 103: Total Pulse Sum
This channel multiplies the reset value (K01) by the reset count (101) and adds the

pulse sum (102) to get the total pulse sum.

Note

+ Computation starts with the smallest channel number at every scan interval. If a channel
number in a calculation expression is greater than or equal to the number of the channel
that contains the expression, the previous computed result (the previous value) of the
channel with that number will be used in the expression.

*  The MV will not compute values correctly if the pulse input value of a scan interval is larger
than the reset value.

IM MV1000-01E

3-19

suwue[y puB Sjsuuey?) JUsSWaINSea| n



3.11 Setting Range-Out Detection for Linearly
Scaled Measurement Channels

Display

MV1000
Press MENU > then select Menu tab > Basic setting mode > Environment tab > Input,

Alarm

Input

VYalue on owver-range
Alarm

Mo logging 0n

MV2000
Press MENU and then select Menu tab > Basic setting mode > Environment tab >
View, Message, Input, Alarm.

Basic Setting Hode

r View —_— Input

Trend type T¥ ’7Ualue on over-range
Partial Off

Trend rate switching 0tf Alarn

(No logging off

r Hessage

Urite sroup Conmon

Power-fail nessage Off

Change message off

* Input > Value on over-range
Setting Description

Free Ignoring the decimal point, less than —30000 is a negative range-out, and above
30000 is a positive range-out. They are displayed as —Over and +Over.
Over A value less than —5% of the scale is a negative range-out, and a value greater than

105% of the scale is a positive range-out. They are displayed as —Over and +Over.
Example: If the scale is 0.0 to 200.0, a value less than —10.0 is a negative range-
out, and a value greater than 210.0 is a positive range-out.

Nofte
With computation and report functions such as TLOG and CLOG, you can specify how the MV

will handle scale range out values.
P> See section 10.1.
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Chapter 4 Measurement and Recording

4.1 Setting the Recording Conditions of Measured
Data

This section explains how to select a method for recording measured data.
P For an explanation of the recording function, see section 1.5.

Display

e Data Type
Press MENU and then select Menu tab > Basic setting mode > A/D, Memory.

Basic Setting Hode

Scan interval

Scan mode Hormal
Scan interval 1s

A/D intearate Auto
Hemory

Data kind

* Measurement Channels
MV1000
Press MENU and then select > Menu tab > Meas channel > Tag, Memory, Delay.
MV2000
Press MENU and then select > Menu tab > Meas channel > Tag, Memory sample,

Alarm delay.
GROUP 1

First-CH: Last-CH: [1

Tag

Characters

Hemory sample

On/fOff On

Alarm delay

Time 18 =
1 20 |

¢ Trend/Storage interval and Save interval (for display data)
Press MENU and then select > Menu tab > Data save > Disp data.

= T3Eg
ol23 05:47.77 WeBen M (O
Disp data
Trend/Storage interval Imin Adiv
{3Bdotidivy
Save interval 1h
|36z [ luwin | Znin | Enin |
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4.1

Setting the Recording Conditions of Measured Data

¢ Event Data Recording Conditions

Press MENU and then select > Menu tab > Data save > Event data.
' , S@eorm(3)

Event data

Sample rate
Hode SingleTriager
Data lenath 1h
Pre-trigaer @ ¥
Trigger =ignal

ey 0n

* Memory > Data Kind

Setting

Description

Display

Records display data.

E+D

Records display data and event data. You cannot select this setting if the
trend interval switching function (Trend rate switching) is set to on On (see

section 6.3 for details)

Event

Records event data.

* Memory sample > On/Off
Select On for the target channels.

e Disp data > Trend/Storage interval
Set the display trend/storage interval. For the trend/storage intervals that can only be
set on high-speed input models, 5 s/div and 10 s/div, 1 division (div) is equal to 40

dots.

You can only set trend/storage intervals that are longer than the scan interval you set
in Basic Setting Mode.

* Disp data > Save interval (when recording display data)
Set the size of recorded data files. Recorded data is divided into files of the size
specified here. The values that you can set here vary depending on the Trend/Storage

interval setting.

Trend/Storage 5s° 10s® 15s* 30s 1min
interval’

Sampling interval 125ms 250ms 500ms 1s 2s
Selectable Save 10minto12h |10 minto 1 10 minto 3 10 minto 7 10 min to 14
Interval Values day days days days
Trend/Storage 2min 5min 10min 15min 20min
interval’

Sampling interval 4s 10s 20s 30s 40s
Selectable Save 10 min to 14 10 min to 31 10 min to 31 10 min to 31 1 hto 31 days
Interval Values days days days days

Trend/Storage 30min 1h 2h 4h 10h

interval’

Sampling interval 1 min 2 min 4 min 8 min 20 min
Selectable Save 1hto31days [1hto31days |2hto31days [4hto31days [8hto31days
Interval Values

1 You can only set a data interval that corresponds to a sampling interval that is slower than
the scan interval.
2 Only available on high-speed input models of the MV.

3 Selectable in fast sampling mode on medium-speed input models of the MV.
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4.1 Setting the Recording Conditions of Measured Data

Event Data

Nofte

Sample rate

Select the data recording interval. Use the table under “Data length” for reference.

Mode

Setting Description

Free Records data continuously.

Single Records data when a trigger condition is met.
Repeat Records data whenever a trigger condition is met.
Data length

Set the size of recorded data files. Recorded data is divided into files of the size
specified here. The data lengths that you can set here vary depending on the
Sample rate setting.

Sample rate' 25ms’ 125ms 250ms 500ms 1s
Selectable data |10 minto4 h 10 min to 1 10 min to 2 10 minto 3 10 minto 7
lengths day days days days

Sample rate’ 2s 5s 10s 30s 1min
Selectable data (10 min to 14 10 min to 31 10 min to 31 1hto31days |1hto31days
lengths days days days

Sample rate’ 2min 5min 10min

Selectable data |1 hto31days |1hto31days [1hto31days

lengths

1 You cannot choose an interval that is faster than the scan interval.
2 Only available on high-speed input models of the MV.

Pre-trigger

Select the amount of data before each trigger activation that you want to record.
You can select 0, 5, 25, 50, 75, 95, or 100% of the set Data length. If you do not
want to record any data before trigger activations, choose 0%.

Trigger signal > Key

To activate a trigger with key operations, select On.

* You can activate triggers with the event action function (see section 7.1 for details).
» If a trigger condition is met when the START/STOP key is pressed, recording will begin.

IM MV1000-01E
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4.2 Setting the Save Method for Measured Data

Display

This section explains how to select a method for saving measured data to memory.
P For an explanation of the save function, see section 1.5.

Auto save

MV1000
Press MENU and then select Menu tab > Basic setting mode > Environment tab >

Security, Media save.

Security
s
Communication Ooff
Save
Auto save On
Hedia FIFO On
fewlock
MV2000

Press MENU and then select Menu tab > Basic setting mode > Environment tab >
Security, Media save, Batch.

r Security E—
Key 0ff
Connunication off

r Save
fAuto save
Hedia FIFQ off

r Batch
On/0ff off

[ on | oif

* Display/Event Data File format, File header, and Data file name

Press MENU and then select > Menu tab > Data save > File settings.

Disp/Event File

File format Binary
File header

Characters

Data file name

Structure

Identified strinas

Seria
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4.2 Setting the Save Method for Measured Data

¢ Save directory
Press MENU and then select > Menu tab > Data save > Save directory.
[=THE @]

o7 0% e
Save directory

Directory name

[ Ireut | |

Save > Auto save

Setting Description

On Automatically saves measured data to a CF card. Set to On when Media FIFO is
enabled.
Off Does not automatically save measured data. Manually save measured data to a

CF card or to USB flash memory.

Save > Media FIFO
The Media FIFO box appears when you set Auto save to On.

Setting Description

On Uses Media FIFO. With this save method, the newest data files are always kept.

Off Does not use Media FIFO. If the free space on the CF card is low, you will need
to change to a different CF card.

Disp/Event File > File format
Select either Binary or Text as the format for saving display and event data.

File header > Characters
Enter a comment to be written into data files (up to 50 characters, [Alal#[1]).

IM MV1000-01E
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4.2 Setting the Save Method for Measured Data

¢ Data file name > Structure
Set the structure used for generating file names.
Setting Description

Date Serial number + user-specified character string + date
Serial Serial number + user-specified character string
Batch Serial number + batch (when using the batch function)

* Data file name > Identified strings
Set the user-specified character string (up to 16 characters, [Ala[#[1]).
You can use these symbols: #% ()+—. @ ° _
P For an explanation of the file naming function, see section 1.5.

¢ Save directory > Directory name
Set the name of the directory to be saved to. (up to 20 characters, [Ala[#[1]).
You can use these symbols: #% ()+—. @ ° _
You cannot use these character combinations: “AUX” “CON” “PRN” “NUL” “CLOCK”
“COM1” to “COM9” “LPT1” to “LPT9".
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4.3 Using the Batch Function

This section explains how to configure the batch function.
P For an explanation of this function, see section 1.6.

Display

e Batch Function

MV1000
Press MENU and then select Menu tab > Basic setting mode > Environment tab >
Batch.

Batch

On/Off | on |

Lot-Ho. digit 3

Auto increment 0n

[ on | 0ff |

MV2000
Press MENU and then select Menu tab > Basic setting mode > Environment tab >
Security, Media save, Batch.

Basic Setting Hode

r Security E—
Key 0ff
Connunication off

r Save —_—
Auto save On
Hedia FIFQ off

r Batch
On/0Ff | On_ |
Lot-No. disit [

Auto increnent On

| on | oif

* Data file name
Press MENU and then select > Menu tab > Data save > File settings.
- )
Disp/Event File

File format Binary

File header

Characters

Data file name

Structure

Identified strinas

Seria
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4.3 Using the Batch Function

e Text Field
Press MENU and then select > Menu tab > Data save > File settings > Batch text.
€o0IF

g R EENT @]

A I
Text field number
Title of field
Characters
2 [ 3 | 4 ]

¢ Batch > On/Off
Select On to use the batch function.

e Batch > Lot-No. digit
You can set the lot number to 4, 6, or 8 digits. Select Off to disable lot numbers.

e Batch > Auto increment

Setting Description

On Automatically sets the lot number of the next measurement to the current lot
number + 1.

Off Turns auto increment off.

e Data file name > Structure
Batch: Creates display and event data filenames by combining the batch number

with the serial number.
P For an explanation of the file naming function, see section 1.5.

¢ Data file name > Identified strings
P For an explanation of the file naming function, see section 4.2.

¢ Text field number
Select a number from 1 to 8.

¢ Text field number > Title of field, Text field number > Characters
Enter a character string.

Title of field: Up to 20 characters, [Alal#[1]. Characters: Up to 30 characters, [Ala[#]1].
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4.3 Using the Batch Function

Procedure

* Setting Batch Names (Batch number + lot number) and Comments

1. In Operation Mode, press FUNC.
The function menu appears.
2. Press the Batch soft key.
The window for entering the batch number, lot number, and comments appears.
3. Set the batch number (up to 32 characters, [Alal#]1]).
You can use these symbols: #% () +—. @ ° _
You can also set the lot number.
4. Setbatch comments 1, 2, and 3 (up to 50 characters, [Alal#]1]).
5. Press DISP/ENTER.
Nofte

» After memory sampling begins, the batch number and lot number cannot be changed.

* You can change comments freely before memory sampling starts. After memory sampling
starts, you can only set comments that have not yet been set. While the window for entering
comments is displayed, you can change the comments freely, but after the window is closed
the comments are fixed.

*  When memory sampling stops comments are cleared.

« Batch numbers, lot numbers, and comments are saved in event and data files, but not in
setup files.

* Displaying Text Field Settings
1. In Operation Mode, press FUNC.
The function menu appears.
2. Press the Text field soft key.

The text field settings appear.

IM MV1000-01E
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4.4 Starting/Stopping Recording, and Saving
Measured Data

Procedure

This section explains how to start recording and save measured data to external storage
media.
P For an explanation of these functions, see section 1.5.

e Starting Recording (memory start)

Press START/STOP. The internal memory icon in the status display section changes

from the icon that indicates that there is no memory sampling to the icon that indicates

memory sampling.

» If you are recording display or event data in Free mode, recording will start.

» If you are recording event data in a triggered mode (Single or Repeat), the MV will
enter a trigger-wait state.

Activating the Trigger to Start Recording

This operation can be performed while the MV is in a trigger-wait state. The MV will
display “Waiting” in the status display section.

Activating the Trigger Using Keys

This operation can be performed when you are recording event data in a triggered
mode (Single or Repeat) and you have set the trigger so that it can be activated with
key operations.

1. In Operation Mode, press FUNC.
The function menu appears.

2. Press the Trigger soft key.
Recording begins.

Activating Triggers with Events (The event action function must be set.

See chapter 7.)
Recording will start when an event occurs.

Saving Automatically

Automatic saving takes place when Auto save is set to On (see section 4.2 for
details).

Data is saved to the CF card.

Leave the CF card in its slot. During memory sampling, measured data in the internal
memory will be automatically saved to the CF card.

When you are not using Media FIFO, if the external storage media cannot be saved to
due to a lack of free space or some other problem, unsaved data will be saved along
with the current data the next time that data is automatically saved.

Using Key Operations to Save Display or Event Data during Memory
Sampling
Data is saved to the CF card.
This operation can be performed when you are recording display data or when you
are recording event data in Free mode. This operation saves the unsaved measured
data in the internal memory to the CF card.

* If you perform this operation when the Auto save setting is Off, the data in the internal

memory will be saved as an individual file.

1. In Operation Mode, press FUNC.
The function menu appears.

2. Press the Save display or Save event soft key.
The display or event data will be saved to the CF card.

Save operation

/ /\t/\ﬁ Jime

I I I I ”
e ——

File File File
Saved the previous time [ Saved this time ]
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4.4 Starting/Stopping Recording and Saving Measured Data

¢ Saving Manually (collectively storing unsaved data)

Perform this operation when Auto save is set to Off (see section 4.2 for details).

You can save to a CF card or to USB flash memory.

P For instructions on how to save to USB flash memory, see section 4.10.

1. Insert the CF card.
A confirmation window containing the message “There is data which is not saved to media.
Do you want to store to media?” appears.
The CF card icon appears in the status display section.

2. Select Yes, then press DISP/IENTER. A menu appears.
The unsaved data in internal memory will be saved to an external storage medium.

3. Follow these steps to remove the external storage medium.
Press FUNC (to display the Function menu) > Media eject soft key > CF soft key.
When the message “Media can be removed safely” appears, remove the storage
medium.

Nofte

If there is not enough space on the storage medium, the message “Not enough free space

on media” appears, and the data is not saved. When this message appears, switch to
another external storage medium and try saving again.
* You cannot cancel a data save operation as it is taking place.

* Stopping Recording (Memory stop)
1. Press START/STOP. A confirmation window appears.

01 255 = IEEE (O]

Imirn/div

A A s
i A

. V _ iV - v
H.6457 v H.5858 v B.5261 v

2. Select Yes using the arrow keys, and then press DISP/ENTER.
If the MV is equipped with computation functions (/M1 and /PM1 options), select
Mem+Math or Memory and press DISP/ENTER.
The internal memory icon in the status display section changes to the icon that indicates
that there is no memory sampling.

¢ Using Keys to Save Selected Data or All Data in Internal Memory
P See section 5.9.
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4.4 Starting/Stopping Recording and Saving Measured Data

Explanation

* Operations That Begin at the Same Time as Memory Sampling (Memory

start)
»  Waveform display updating on the trend display

* Reporting (/M1 and /PM1 options)
» Computation functions (/M1 and /PM1 options), if they are configured to do so.
P For details, see section 10.4.

Operations That Stop at the Same Time as Memory Sampling (Memory
stop)

» Waveform display updating on the trend display

* Reporting (/M1 and /PM1 options)

» Computation operations (/M1 and /PM1 options), if they are being performed.

Save Problems
The following problems may arise when the MV is continually accessing internal or

external memory. If these problems arise, the storage media access indicator will light

frequently.

» External storage media file save error

» Access timeout

These problems can be dealt with in the following ways.

» If you are using the event action function and saving small consecutive files,
increase the size of the files being saved.

» If you are saving multiple files to the same directory on an external storage
medium, change the name of the Save directory, making sure that the number of
files in the directory does not exceed 1000.

 If data recording and display are using up resources (for example if you are
recording on multiple channels using a fast sampling rate, and displaying four trend
displays on the 4-panel display), use a slower sampling rate or change the display.

4-12

IM MV1000-01E



4.5 Saving Measured Data Manually

Procedure

Explanation

This section explains how to save the current values of all channels (except for channels
set to Skip or Off) through key operations.
P For an explanation of this function, see section 1.5.

1. In Operation Mode, press FUNC.
The function menu appears.

2. Press the Manual sample soft key.
Manual sampling begins.

* Manually Sampled Data in Internal Memory
You can check the number of manually sampled data files in internal memory on the
Memory Summary display (see section 1.4 for details).

¢ Saving to a CF Card

« If Auto save is set to On, manually sampled data will be automatically saved to a
CF card when manual sampling takes place.

+ If Auto save is set to Off, use a manual save operation (see section 4.4 for details)
to save manually sampled data to a CF card or to USB flash memory.

* No matter what Auto save is set to, you can always save manually sampled data to
a CF card or to USB flash memory using a manual save operation (see section 5.9
for details).

Setting Which Channels to Save Manually (only on the MV2000)

Display

On models of the MV2000 equipped with external input channels (/MC1 option), you can
set which channels’ (120 channels or less) current values to save.

Available on models equipped with external input channels (/MC1 option).
Press MENU and then select > Menu tab > Data save > Manual sample.
GROUP 1 =]
Sogaal 2o 10400 e EENT I 1o (B)
Data save > Hanual sample

Hanual sample number
( HanualSample

On/0ff On
Channel [[1}
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4.5 Saving Measured Data Manually

¢ Manual Sample number
Select a number from 001 to 120. Current channel values will be saved in this order.

¢ Manual Sample
e On/Off
To assign a channel to the set Manual Sample number, select On.
¢ Channel
Enter the channel number of a measurement, computation (/M1 and /PM1 options),
or external input (/MC1 option) channel.
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4.6 Saving Screen Image Data (Snapshot)

Procedure

Explanation

This section explains how to save the image data from the active display to a CF card.
This operation is referred to as Snapshot, and screen image data files are referred to as
Snapshot data files.

P For an explanation of this function, see section 1.5.

1 In Operation Mode, press FUNC.
The function menu appears.

2. Press the Snap shot soft key.
The MV saves a snapshot data file to the CF card.
Displayed soft keys and message windows will not be saved.

Nofte

If you assign the Snapshot function to the USER key, you can take snapshots in all modes
(Operation Mode, Setting Mode, and Basic Setting Mode). However, error messages will not be
saved.

¢ File Format, Size
Snapshot data files are saved in PNG format.
The maximum snapshot data file size is about 15 KB per screenshot.

¢ File Names
p For details, see section 1.5.

IM MV1000-01E
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4.7 Managing Stored Files

Procedure

This section explains how to display a list of stored files and the amount of available
memory, how to delete files and directories, and how to format storage media.

* Displaying Files, Deleting Files, and Checking Available Memory

To access the display:
Press MENU then select File tab > File list, delete. Press the CF or USB soft key’

then DISP/ENTER.
* When using a CF card and USB flash memory.

[ =1
714 GEeer (D)
File list/delete
kF:s

Directory name Date /

DATHE 6378122 89: 08

DATALL B3./81/22 16:18
DATAEE BE/81/23 18:81
DATALLE B3/81/23 18:34
DATAA_RBA123_18135¢ B3/81/23 18:19

Free space 114497 Kbutes
Delete _ Sort

Displaying a List of Files in a Directory and Checking Available Memory
Use the arrow keys to select a directory, and then press DISP/ENTER. The files in the
directory will appear in a list. / is the root directory.

BRA34E_AT1862_125356. DAD

BaAcd]_A71862_138122 DAD B7/18/82 13:81
BRA3d2_A71862_ 158656 DAD B7/18/82 15:81
BRA3d3_A71862_1581168. DAD B7/18/82 15:36
BaA3dd_A71862_162636. DAD B7/18/82 16:26
BRA345_AT1862_1755822 . DAD B7/18/682 17:58
BRA3d6_AT1863_R34152 ., DAD B7/18/683 85:43

Free space 982576 Kbutes
O O N S T

Changing Files and Directory Display Order

You can arrange files by the date when they were last updated.

Pressing the Sort soft key will switch between displaying files or directories in
ascending or descending order. A marker indicating the sort order is displayed next to
Date/Time.

Deleting Files
Use the arrow keys to select a file, and then press the Delete soft key. A confirmation

window will appear. Select Yes, and press DISP/ENTER.
The file is deleted.

Deleting Directories
First, delete all of the files in the directory.

Select the directory. The remaining steps are the same as those for deleting a file.

Checking Available Memory
The amount of available memory is indicated at the lower right of the display.

4-16
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4.7 Managing Stored Files

Explanation

¢ Formatting Storage Media
Formatting will remove the contents of the storage media.

1. To access the display:

Press MENU then select File tab > Format. Press the CF or USB soft key then

DISP/ENTER.

*

When using a CF card and USB flash memory.

=Wy oo |
45 @ e @] )}

Format

VYolume name CFif _

2. Enter the Volume name (up to 11 characters, [Al1]), and press DISP/ENTER.

A confirmation window appears.

3. Select Yes, and press DISP/ENTER.
The storage device will be formatted.

* Format Types

Memory Size Type
Storage media with less than 512 MB of memory. FAT16
Storage media with more than 512 MB of memory. FAT32

IM MV1000-01E
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4.8 Loading and Displaying Measured Data from
External Storage Media

This section explains how to display the waveforms of display and event data that have
been saved in binary format to external storage media. Loaded data will be displayed on
the historical trend display.

P For historical trend display operating instructions, see section 5.3.

Procedure

* Loading a File

1.

To access the display:

Press MENU and then select File tab > Load display data or Load Event data.
Press the CF or USB soft key and then DISP/ENTER.

* When using a CF card and USB flash memory.

ctory name Date .

DATAAS B7./88/23 14:17

DATAB_ABA123_134742 BE/B1/23 13:47
DATAB_AEA123 204145 BE/B1/23 28:45
DATAB_AT1A82_1d48515 H7/18/82 14:85
DATAL BE/A1/81 @5:18
DATAB BE/B1/23 23:52
DATAB_AZA125_838206 H7/B8/22 11:31
Free zpace 9825dd Kbutes
L [ | Sort |
2. Use the arrow keys to select a directory, and then press DISP/ENTER. The files in
the directory will appear in a list. / is the root directory.
bﬁTﬁB BE/A1/19 @9:38
DATALL BE/81/13 16:18
DATASE BE/B1/18 18:81
DATALIE BE/B1/13 18:34
DATAB_AEA123 181954 BE/B1/13 18:19
Free zpace 114488 Kbutes
L | [ Sort
3. Select a file using the arrow keys, and then press DISP/ENTER.
The MV loads the file and displays its historical trend.
Nofte

The extension for display data files saved in binary format is .DAD. The extension for binary
event data is .DAE.
For details on using the Sort soft key, see section 4.7.
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4.9

Saving and Loading Setup Data

This section explains how to save and load setup data from external storage media.

Procedure

¢ Saving Setup Data

1.

To access the display:

Press MENU and then select File tab > Save settings. Press the CF or USB soft
key and then DISP/ENTER.
* When using a CF card and USB flash memory.

[l hou |
51 G oo m—(O) 0}

Save settings

File name

cF:/ [—

Enter the file name (up to 32 characters, [Ala[#[1]).

You can use these symbols: #% ()+—. @ °

You cannot use these character combinations: “AUX” “CON” “PRN” “NUL”
“CLOCK” “COM1” to “COM9” and “LPT1” to “LPT9".

To cancel the operation, press ESC.

Press DISP/ENTER.
The setup data is saved.

¢ Loading Setup Data
The MV loads all Setting Mode and Basic Setting Mode settings. When setup data is
loaded, the previous settings are erased and the MV restarts with the loaded settings.

1.

*

Note

To access the display:

Press MENU and then select File tab > Load settings. Press the CF or USB soft
key and then DISP/ENTER.

*

When using a CF card and USB flash memory.

15 S=eniEzr (O]

Load settings

kF:s

Directory name Date / Time

DATHE B3/81/23 18:43
DATALL B3./81/23 16:18
DATAEE BE/81/23 18:81
DATALLE B3/81/23 18:34

Free space 113334 Kbutes
L« | | Sort |

For details on using the Sort soft key, see section 4.7.
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4.9 Saving and Loading Setup Data

Explanation

2.

*

Select the setup file to be read by using the arrow keys and DISP/ENTER.
The setup data file is in the root directory (/).
To cancel the operation, press ESC.

Press the DISP/ENTER key.
The setup data is loaded.

¢ Setup Data Files

The setup data file extension is .PDL.

The maximum setup data file size is about 200 KB.
The following settings are also saved.

* The current monitor display condition.

* The Jump default display setting.

» Favorite display key data.

¢ Loading Setup Data

The monitor display condition, Jump default display setting, and favorite display key
settings are also loaded.

If the loaded setup data is not applied, check the error log (see section 5.10).

While setup data is being loaded, key operations, communication operations, and
remote control operations cannot be executed.

4-20
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410 Using USB Flash Memory

Connecting and Removing USB Flash Memory

Procedure

¢ Connecting USB Flash Memory

1. Connect a USB flash memory device to the MV USB port. The message, “USB
device is connected. Please choose operation.” appears, and you are able to use
the USB flash memory.

2. In Operation Mode, selectable operations are displayed. Use the arrow keys to
select an operation, and then press DISP/ENTER.

When saving automatically

M.SAMFLE DATA  (@2a-4ea) :

SAPLE DATA @ @ ELENT DATRC.DAED
Start Time Erd Time Dat.a Factor
WOl el S oL eLiThe 11 Swelins

DATA SAWE HMODE

Cancel

When savmg manually

NSI'-!"PLEDﬂTﬂ CEEZA4PE) = @B1-ZT BEea 28
FEFORT DATA AR 188D =

SAPLE DATA @ @ ELENT DATRC.DAED
Start Time Erd Time Dat.a Factor

w127 BEEE:34  B1-2T BEESIeE

Save Hanual

DATA SAYE HODE

[ Load Settings [ Cancel
Setting Description
Save Manual Saves unsaved data in the internal memory to USB flash memory.

DATA SAVE MODE

Switches to the DATA SAVE MODE display. For instructions on how to

save internal memory data to an external storage medium, see section

5.9. This option is only displayed when it is available.*

* You can use DATA SAVE MODE when there is display, event, report, or
manually sampled data.

You can change the option that is displayed here with the menu

customize function. Displayable options: DATA SAVE MODE, SELECT

SAVE, M. SAMPLE SAVE, REPORT SAVE, ALL SAVE.

Load Settings

Switches to the Setting Mode setup data load display. For instructions

on how to load setup data, see section 4.9.

Load Settings will not be displayed:

* During memory sampling.

* During computation.

* During computation and memory sampling.

» When Media/USB loading is locked (see chapter 8 for details).

» When the MV is accessing storage media (formatting, saving, or FTP
communication).

» \When there are no setup files in the root directory.

Cancel

Closes the operation selection window.

IM MV1000-01E
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4.10 Using USB Flash Memory

* Removing USB Flash Memory

1. In Operation Mode, press FUNC.
The function menu appears.

2. Press the Media eject soft key, and then the USB soft key.
The message “Media can be removed safely.” appears.

3. Remove the USB flash memory.
Nofte

You can connect one USB flash memory device.
»  When disconnecting a USB flash memory device, be sure to follow the procedure listed

above. If you remove the USB memory without performing the above procedure, the data
stored on it could be damaged.

Saving and Loading Data
For information on:
P Saving and loading setup data files, see section 4.9.
P Saving display and event data files, see sections 5.9, and 4.4.
P Loading display and event data files, see section 4.8.
P Listing and deleting files, see section 4.7.
P Formatting storage media, see section 4.7.
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Chapter 5 Screen Operations

5.1 Switching Between Displays

Switching between Displays Using the Arrow Keys and DISP/ENTER
Using DISP/ENTER and the arrow keys, you can open the display selection menu and its
submenus and switch between displays. The following flowchart illustrates the operations
that you can perform.

(( ) DISP/ENTER key and arrow keys

(
\
—
- A
m
4
o
v
d
1]
2
o
=]
a
N

i GROUP1 | ---- GROUP n i e TREND  » [GRoUP 1
E ™ i o
R i e J 3
DIGITAL P Sec 5.2 M
5 ' rr
i (—1—4—17 i =g
> GR( P1  f---1 GROUPn | | +
| i Display selection
et [ e bt $ -------------------- 4 menu
BAR P Sec 5.2 Submenu
i GROUP1  ---+ GROUP n i About tag name display
i | Long tag names may not fit into their display areas.
! ! When this is the case, they are displayed as follows:
Rl ""}' """""""""" . » After the screen is displayed, the tag name
OVERVIEW automatically scrolls through the display area
once.
P Section 5.4 * Press ESC to scroll the tag name through the
display area once.
INFORMATION
r-——=—7"7>"7"9 32 A
| ALARM MESSAGE MEMORY REPORT DATA RELAY !
' | SUMMARY SUMMARY SUMMARY 1
! | B section 5.7 P> Section 5.8 P Section 5.9 P Section 5.5 P Section5.5 | |
S— L IR S ; |
i [MODBUS COLUMN BAR | !
! |[MASTER !
TREND HISTORY ! |[MODBUS CLIENT |
| P Section 5.5 P> Section 5.6 E
P Section 5.3 b T

LOG P Section 5.10

Login log, error log, communication log, FTP log,
Web log, e-mail log, SNTP log, DHCP log, and
Modbus status log

(Not displayed with the default settings.
P To display, see section 6.17.

4-PANEL

P> Section 5.11
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5.1 Switching Between Displays

Operations Using Other Keys
MV1000

START/STOP key > Section 4.4
—— HISTORY key P> Section 6.15

— ESC key
—— MENU key

L FUNC key P> Section 6.17
—— USER key > Section 7.4

—— T/DIVkey P> Sections 5.2 and 5.3

(onan) ] ) CHD]

OB 0,

O o
— ‘—’— Soft key
MV2000
START/STOP key P> Section 4.4
[ HISTORY key P> Section 6.15
—— ESC key
—— MENU key
—— FUNC key > Section 6.17
—— USER key P> Section 7.4
—— T/DIV key P> Sections 5.2 and 5.3
I I I I I I I
o (D J————+1— Ssoftkey
O-
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5.1 Switching Between Displays

FUNC Key Operations
Press FUNC to bring up the function menu at the bottom of the screen. Press the Next
soft key to scroll through the function menu. Select the appropriate soft key for the
operation you want to perform.

Next soft key

Function menu
(Select using the soft keys)

= Trigger
Saver 34 d "

ec. 9.8 Sec. 4.4 Sec. 4.4

P> Sec. 5.1 Sec. 6.4 Sec. 6.4 Sec. 4.4 Sec. 4.6
Sec. 4.10

Timer Ha T ;
reset Reset C e

P> Sec. 7.2 Sec. 7.3 Sec. 8.1 Sec. 8.3 Sec. 8.3

infa info start test

P> Sec. 9.3 Sec. 9.3 Comm.” Comm.” Comm.

»Comm.’ P> Sec. 5.1 (Only MV2000)
* MV1000/MV2000 Communication Interface User’s Manual.

. field s
PSec. 6.3Sec. 4.3Sec. 4.3Sec. 6.15Sec. 5.11
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5.1 Switching Between Displays

Pausing the Display

You can pause the screen display.

The display pause icon is displayed

Memory sampling continues even while the screen display is paused.
The Pause Display function pauses the following displays.

Display Paused Parts of the Display
Trend Trend waveform
Digital values
Digital —
Bar graph Bar graphs
Digital values
Overview —
Information Alarm summary
Message summary
Memory summary
Modbus client
Modbus master
Relay status display
Log Login
Error
Communication
FTP
Mail
WEB
SNTP
DHCP
MODBUS

Procedure

Press the Pause Display soft key listed under “FUNC Key Operations” in this section.
The screen display will pause and an icon will appear in the status display section.

To unpause the display, press any key other than the USER key. If you are using a USB
keyboard, press any key besides the key corresponding to the USER key (Ctrl+U).

Menu Customization
You can change the contents of the function menu, which appears when you press the
FUNC key, and the display selection menu, which appears when you press the DISP/
ENTER key.
P For details, see section 6.17.
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5.2 Displaying Measured Data with Waveforms
(trend), Numbers (digital), or Bar Graphs

This section explains how to use the trend, digital, and bar graph displays.
P For an explanation of these displays, see section 1.4.

Procedure

¢ Opening a Display
1. Press DISP/ENTER to open the display selection menu.

2. Select TREND, DIGITAL, or BAR using the arrow keys, and then press DISP/
ENTER.
The selected display appears.

¢ Changing Display Settings
1. Press DISP/ENTER to open the display selection menu.

2. Press the right arrow key to open the submenu.

3. Select a submenu item with the up and down arrow keys.

Sub menu of the trend display
o123 aa:q9:00 e T IEC (O

Fr ]— Group name:  Displays the group.
o) e

| — ALL CHANNEL: Displays the waveforms of all
channels.
GROUP CHANNEL: Displays the waveforms of the
channels registered to groups.
AUTOZONE ON: Displays trend waveforms separately
by assigning each channel in the group
its own display area (zone).
AUTOZONE OFF: Displays trends using the set range.
SCALE ON: Displays a scale.
SCALE OFF: Clears the scale.
— FINE GRID ON: Displays a fine grid.
FINE GRID OFF: Clears the fine grid.

— DIGITAL ON: Displays the numeric display section.
DIGITAL OFF: Clears the numeric display section.

—— MESSAGE DISP1: Displays messages using display
method 1.

MESSAGE DISP2: Displays messages using display
method 2.

——  TREND SPACE ON: Inserts a space at the right edge

E (horizontal display) or the top edge
' (vertical display) in the waveform

; display section.

' TREND SPACE OFF: Does not insert a space.

(To show these items on the menu, see section 6.17.)

—— AUTO SCROLL ON: Automatically switches the displayed
groups.
AUTO SCROLL OFF: Does not automatically switch the
displayed groups.
EXPAND: Enlarges one of the four panels in the 4-panel
display (MV2000 only).

IM MV1000-01E 5-5
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5.2 Displaying Measured Data with Waveforms (Trend), Numbers (digital), or Bar Graphs

Digital display submenu
> |

0.8818
v

M il— Group name: Displays the group.

— AUTO SCROLL ON: Automatically switches the
displayed groups.
AUTO SCROLL OFF: Does not automatically switch
the displayed groups.

EXPAND: Enlarges one of the four panels in the
4-panel display (MV2000 only).

Bar graph display submenu

y @E‘._E-rrm @]

il— Group name: Displays the group.

— AUTO SCROLL ON: Automatically switches the
displayed groups.
AUTO SCROLL OFF: Does not automatically switch
the displayed groups.
EXPAND: Enlarges one of the four panels in the
4-panel display (MV2000 only).

4. Press DISP/ENTER to change the display setting.
To close the menu without changing the display settings, press ESC.

START/STOP Recording Measured Values and Displaying Waveforms on
the Trend Display

Press START/STOP to start recording measured values and displaying waveforms on
the trend display. Press START/STOP again to stop recording measured values and
updating waveforms.

Writing Messages
P For details, see section 6.4.

Switching Display Groups Using the Arrow Keys
Press the right arrow key to switch from group 1, to 2, to 3, and so on. Press the left
arrow key to switch groups in the opposite order.

Switching between the Trend, Digital and Bar Graph Displays Using the
Arrow Keys

When you are in the trend, digital, or bar graph display, press the down arrow key to
switch from trend, to digital, to bar graph, to trend, and so on. Press the up arrow key
to switch displays in the opposite order.

IM MV1000-01E



5.2 Displaying Measured Data with Waveforms (Trend), Numbers (digital), or Bar Graphs

Explanation

¢ Changing the Trend Update Rate
1. Press T/DIV to display the trend interval configuration screen.

Iminddiv

ANAAA fa

Imin

T2 068y 0.6 5729
S0 nin | 2win | Gwin ARt 173

2. Select the interval using the soft keys. Waveforms will be displayed at the set
trend update rate.

 Trend Display: GROUP CHANNEL Display/ALL CHANNEL Display”

GROUP CHANNEL displays the waveforms of the selected group’s channels. ALL

CHANNEL displays the waveforms of all channels that have been set to be recorded.

The waveforms of channels that are not assigned to the group are displayed in the

waveform display area, but the scales, current value marks, and digital values of the

channels are not displayed.

* On the MV2010, MV2020, MV2030, MV2040, and MV2048, if the device is equipped with

external input channels (/MC1 option), all channel display is not possible with trend update
rates of 15 s/div or 30 s/div.

« AUTO ZONE
Displays trend waveforms separately by evenly dividing display areas (zones) among
a group’s channels.
With AUTO ZONE OFF With AUTO ZONE ON

5 haeerEE ()69

Imingdiv

* FINE GRID
Display the fine grid when the normal grid is too wide for reading measured values.
The fine grid can be used in the trend and historical trend displays. The fine grid
places an additional four lines between the normal grid lines.
With FINE GRID OFF With FINE GRID ON

21:15:29 E""E"”—m@ 21:19:36 @E'"E"”—m@

Taresd ol

Iminddiy

2117

21113

-1.1284
W

21115

4
-B.8795
W
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5.2 Displaying Measured Data with Waveforms (Trend), Numbers (digital), or Bar Graphs

e Trend Display: SCALE: ON/OFF, DIGITAL: ON/OFF

Select whether or not to display the scale and the numeric display section.

AUTO SCROLL

When AUTO SCROLL is ON, the MV automatically scrolls through the displayed
groups at the set interval. The MV scrolls from group 1, to 2, to 3, and so on.

P For instructions on how to set the scrolling interval, see section 6.13.

Trend Display: MESSAGE DISP 1, MESSAGE DISP 2
Select which message display method to use.

Conditions for Changing the Trend Update Rate

When the displayed trend data type is Display or Event, the trend update rate can be
changed. It cannot be changed when the displayed data type is E+D (Event+Display).
The trend interval can be changed regardless of memory sampling conditions.

The trend update rate can be changed on the following kinds of displays.

« Adisplay with an open menu

» Trend display

+ Digital display

» Bar graph display

» Overview display

* 4-panel display

» All information displays accessible from the display selection menu

5-8
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5.3 Displaying Previously Measured Data (TREND
HISTORY)

Procedure

There are five ways that you can display previously measured data.

P For an explanation of the historical trend display, see section 1.4.

P From the display selection menu. This method is explained in this section.

P By pressing HISTORY. This method is explained in this section.

P From the alarm summary. For details, see section 5.7.

P From the message summary. For details, see section 5.8.

P From the memory summary. For details, see section 5.9.

P By displaying measured data that has been saved to an external storage medium. For
details, see section 4.8.

* Displaying Previously Measured Data by Using the Display Selection
Menu
Perform this operation during memory sampling or when there is measured data.

1. Press DISP/ENTER to open the display selection menu.

2. Select TREND HISTORY using the arrow keys, and then press DISP/ENTER.
The TREND HISTORY display appears.

* Opening the Display Registered to the HISTORY Key
Press HISTORY. The display switches to TREND HISTORY. Press HISTORY again to
return to the previous display.
For instructions on how to register a display to the HISTORY key, see section 6.15.

* Changing Display Settings
1. Press DISP/ENTER to open the display selection menu.
2. Press the right arrow key to open the submenu.

3. Select a submenu item with the up and down arrow keys.

IM MV1000-01E
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5.3 Displaying Previously Measured Data (TREND HISTORY)

TREND HISTORY submenu

1
]7 Group name: Displays the group.

—— ALL CHANNEL: Displays the waveforms of all channels.
—[ GROUP CHANNEL: Displays the waveforms of the channels

registered to groups.

AUTOZONE ON: Displays trend waveforms separately
T by assigning display areas (zones) to
the set channels.

AUTOZONE OFF: Displays trends using the set range.

SCALE ON: Displays a scale.
SCALE OFF: Clears the scale.
— FINE GRID ON: Displays a fine grid.
FINE GRID OFF: Clears the fine grid.

— MESSAGE DISP2: Switches to message display 2.
MESSAGE DISP1: Switches to message display 1.

— DIGITAL MAX/MIN: Displays the maximum and minimum
values at the cursor point as well as the
maximum and minimum values within the
screen, in the digital value display area.

CURSOR VALUE: With display data, shows the maximum
data value at the cursor position. With
event data, shows the data at the cursor
position.

—— CURSOR TIME ON: Displays the time at the cursor position
in the lower right.

CURSOR TIME OFF: Displays the date/time of the data at the
right edge of the screen.

—— RELATIVE TIME: Shows the time that has elapsed since
memory start.
ABSOLUTE TIME: Shows the time when data was recorded.

———— EXPAND: Enlarges one of the four panels in the 4-panel
display (MV2000 only).

]— Switches to the specified display.

Returns to the display that was shown before the historical trend.

ALARM SUMMARY: Displays the alarm summary in the
loaded data file.

MESSAGE SUMMARY: Displays the message summary in the
loaded data file.

INFORMATION: Displays the information of the loaded
data file.

Fo

TOP CHANNEL

Displays the trend waveform and scale markers of the selected
channel in front of all the others.

l=-l
Ill—— AUTO SCALE
Adjusts the display span of the selected channel.

OFF
No AUTO SCALE display.

4. Press DISP/ENTER to change the display setting.
To close the menu without changing the display, press ESC.

5-10
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5.3 Displaying Previously Measured Data (TREND HISTORY)

Moving the Cursor

1

Cursor

Hold down an arrow key to move
the cursor by 2 divisions on the
MV2000, or a division on the
MV1000 at a time.

* Use the up and down arrow keys on the vertical trend display.

Moves the cursor to the right by 1 dot.

Scrolling through Continuous Data
The trend display shows a portion of the complete data waveform on the screen. Use
the following operations to scroll through continuous data.

Displayed
/

Move the cursor to the end of the waveform and
press the arrow key again to shift half a page
and display the continuing data.

Move the cursor to the end of the waveform and
press the arrow key again to shift half a page
and display the continuing data.

* Use the up and down arrow keys on the vertical
trend display.

Selecting What Portion of the Data to Display
Perform the following operations to select what data to display. Use the items in
parenthesis if you are using vertical display.

1. Press the up (right) arrow key.
At the top (right) of the display, a complete data waveform appears.

e erzzzm (3)

Complete data waveform
All of the data in the display memory.

Frame indicating the display range
Displayed highlighted.

These icons are not displayed if the scale is
displayed.

=

2. Use the left and right (up and down) arrow keys to move around the frame that
indicates the display range, and select the portion of the data that you want to
display.

3. Press the down (left) arrow key.

The portion of the data that you selected is displayed.

IM MV1000-01E
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5.3 Displaying Previously Measured Data (TREND HISTORY)

¢ When Not All of the Data Fits in the Complete Data Waveform
Move through the complete data waveform to the part that you want to display.
As an example, this is how you would display data that is older than the data that you
are currently displaying. Items in parenthesis are for vertical display.

1. Press the up (right) arrow key.
At the top (right) of the display, the complete data waveform appears. The data portion that
can be loaded from internal memory also appears. If there is more than 8 MB of data, the
MV will indicate the 8 MB worth of data displayed in the complete data waveform with a
square frame that will appear in the data portion that can be loaded from internal memory.
Loadable data in the
internal memory

All data display
All of the data in the display
memory (up to 8 MB)

A frame indicating the range
shown in the screen.

The green arrow indicates
that loadable data exists in
the arrow direction.

A frame indicating the 8 MB
of memory that is shown in
the complete data waveform.

2. Use the left (down) arrow key to move the frame that represents the portion of the
data that will be displayed to the beginning of the complete data waveform. Press
the left (down) arrow key to move the frame beyond the edge of the waveform.
The message “Overwrite old data?” will appear.

3. Select Yes using the arrow keys, and then press DISP/ENTER.

The 4 MB worth of memory used for the display will be overwritten, and the data will be
displayed.

4. Use the left and right (up and down) arrow keys to move around the waveform
and select the portion of the data to display.

5. Press the down (left) arrow key.
The portion of the data that you selected is displayed.

» Splitting the Display in Two and Viewing the Current Trend and the

Historical Trend Together
You can only do this with the historical trend of display data. ltems in parenthesis are

for vertical display.
* You cannot view the two trends together when the scale is displayed.

Press the down (left) arrow key.
The current trend appears on the right (top) half of the screen. The historical trend

Present trend

Historical trend

To return to the previous display, press the up (right) arrow key.
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5.3 Displaying Previously Measured Data (TREND HISTORY)

* Writing Added Messages
P For instructions on how to use this function, see section 6.4.

e Changing the Time Axis Zoom

a . a . Horodqd e[ H.
B.?%‘B—l.l‘ﬁﬁ 8.7331—1.0523| B, 6760 -8, 5787 | B.6111 -8,
.nﬁ'

2. Select the time axis zoom using the soft keys. The waveform will appear with the
new time axis zoom.

GROLP 1 e ()

}diJ_ Historical trend display rate
of the zoomed display.

Set time axis zoom

Explanation

¢ ALL CHANNEL/GROUP CHANNEL Display
Switches between displaying the waveforms of the selected group’s channels and
displaying the waveforms of all channels that have been set to be recorded. The
waveforms of channels that are not registered to the group are displayed, without any
additional information, in the waveform display area.

e SCALE ON/OFF
Select whether or not to display the scale. The scale’s current value mark indicates
the value at the cursor location.

e MESSAGE DISP 1, MESSAGE DISP 2
Select which message display method to use.

¢ AUTO SPAN
For details, see section 1.4.

¢ Changing the Time Axis Zoom
Displays a historical trend with a zoomed time axis.
If the display interval with the new time axis is 5 s/div or 10 s/div, 1 division is equal to
40 dots.
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5.3 Displaying Previously Measured Data (TREND HISTORY)

¢ INFORMATION (information about the displayed measured data)

The following information is displayed.

05103 IS (O)

Page switch mark

Filename

‘Hemory When using the batch function,
File tupe :Event a comment field and a text field
Serial number :ERETHIESD are displayed on the second
Batch number and third pages.

Lot number : BEBEEE

i Use the left and right arrow
Start time  :2098/01/23 08:50:51

keys to switch the page.

End time 12083/01,/23 BB:51:32

Item Description

Filename Displays “Memory” for data stored to internal memory. Displays
the file name for data stored to an external storage medium.

File type Displays “Display” for display data or “Event” for event data.

Serial number The serial number of the MV that was used.

Batch number, Lot number Displayed for files that use batch functions.

Start time, End time The time when recording started/stopped.

User name The name of the user that operated the MV. This item is displayed
if the login function was used.

Nofte

If you display the measured data from an external storage medium, the serial number displayed
will be that of the MV that saved the data.

Historical Trend Background Color
You can change the background color of the historical trend display.
P For configuration instructions, see section 6.12.

TOP CHANNEL

The displayed scale marker and grid are those of the channel selected as the top
channel.

If you switch from TREND HISTORY display to another display, the TOP CHANNEL
setting is cleared. Channels other than the top channel are displayed in the order set
within their display groups. (Set in Group set, Trip line which can be opened from the
MENU tab after pressing MENU.)
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5.4 Viewing All Channels on One Display
(OVERVIEW)

This section explains how to use the OVERVIEW display.
P For an explanation of this display, see section 1.4.

Procedure

* Opening the Display
1. Press DISP/ENTER to open the display selection menu.
2. Select OVERVIEW using the arrow keys, and then press DISP/ENTER.
The OVERVIEW display appears.
¢ Changing Display Settings
1. Press DISP/ENTER to open the display selection menu.

2. Press the right arrow key to open the submenu.

3. Select a submenu item with the up and down arrow keys.
OVERVIEW submenu

101 e IET(O)ME )

E

USARRENDSS 5 U

. TREND
H

- CURSOR ON: Displays the cursor.
CURSOR OFF: Clears the cursor.

JUMP TO ALM SUM: Switches to the alarm summary.

JUMP TO TREND: Switches to the trend display of the
smallest group number that includes
the channel selected with the cursor.

______________________________________________________

+JUMP TO DIGITAL: Switches to the digital display of the :
i smallest group number that includes :
the channel selected with the cursor.:

+JUMP TO BAR: Switches to the bar graph display of :
' the smallest group number that '
' includes the channel selected with !
! the cursor. '

—

(Not displayed with the default settings. To display, see section 6.17.

— EXPAND: Enlarges one of the four panels in the 4-panel
display (MV2000 only).

4. Press DISP/ENTER to change the display setting.
To close the menu without changing the display settings, press ESC.

¢ Switching to a Trend, Digital, or Bar Graph Display that Contains the
Selected Channel

1. Use the arrow keys to move the cursor and select a channel.

19:1a @W‘}' @] )

H B.7724 V

Cursor (white frame)

2. Use the operations outlined in “Changing Display Settings” to switch to the trend,
digital, or bar graph display.
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5.5 Displaying Various Information

Procedure

This section explains how to display reports (/M1 and /PM1 options) and how to use the
various status displays.
P For an explanation of these displays, see section 1.4.

* Opening the Display

1.

2.
3.
4

Press DISP/ENTER to open the display selection menu.
Select INFORMATION with the up and down arrow keys.
Press the right arrow key to open the INFORMATION submenu.

Select a submenu item with the up and down arrow keys.
To close the menu without changing the display, press ESC.

INFORMATION submenu
111055 EpeeT (S

ALARM SUMMARY: Displays an alarm summary.
» Section 5.7
MESSAGE SUMMARY: Displays a message summary.
ALARH SUHHAR'Y » Section 5.8
—_r MEMORY SUMMARY: Displays a memory summary.
» Section 5.9

|-§'|\i|6|5i31]é'éi_'|is}if:' " Displays the Modbus client status. |

'MODBUS MASTER: Displays the Modbus master status. E

\RELAY: Displays the relay status.
(Not displayed with the default settings. To display, see section 6.17.)
REPORT DATA: Displays report data.

COLUMN BAR: Displays the report in a stacked bar graph.
» Section 5.6

5. Press DISP/ENTER.

The selected display appears.
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5.5 Displaying Various Information

* Report Display

Note

Switching Displayed Report Data

“The displayed report data number/the number of report data entries in internal
memory” is displayed next to Index. The report with the largest report data number
is the most recent report.

Displayed report data number
Number of report data entries in internal memory

Index : 14/18 Kind : Hourlw
Start @ 28@5/81/23 19:18:18
Timeup: 2BA5/81/23 12:00:08

Ch Unit Sts fve Hax Hin Sum

eat | —_— B.54% B.9E2E B.6TED  1LSPIPREEHER
eaz L —_— B.6586  B.7B56 B.SIES 1. IMISIEHER
Bas L —_— 85577 B8.554 B.4353  9.954267EHAL
aa4 1) —_— B.4883 B.4335 B339 T.4Z2IEEH1

You can switch the displayed report data with the following operations.

Up arrow key: Switch to the next greatest report number.

Down arrow key: Switch to the next lowest report number.

Left arrow key:  Switch to the report number that is greater than the current
number by 10.

Right arrow key: Switch to the report number that is lower than the current
number by 10.

The display will not be updated while a report is displayed, even if new report data is created.
You can update the display by performing one of the following operations.

» Holding the left arrow key until the display is updated.

* Pressing DISP/ENTER and reselecting REPORT DATA from the display selection menu.

* Changing Report Channels

R wbdnr

You can display up to 30 report channels on one display. If the number of report
channels in the report is greater than 30, you can change the displayed report
channels.

Press DISP/ENTER to open the display selection menu.
Press the right arrow key to open the submenu.
Select CHANGE REPORT CH. with the up and down arrow keys.

Press DISP/ENTER.
The displayed report channels change.

IM MV1000-01E
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5.5 Displaying Various Information

* Relay Status Display
Displays the status of alarm output relays and internal switches. You cannot perform

operations in this display.

s o Red: ON
= igg 0 ses O st Green: OFF
E a4 E =19
W 184 E ses E sze
O 185 O ses O s21
@ I O sev M szz
E se= H =2z
E =sas E =24
E =18 E =25
E 51t E sze
E =1z M sz7
E =1z E sz=
E =14 E =29
E sis E s3e

¢ Modbus Status Display
Displays a list of Modbus client or Modbus master command statuses.

P For configuration instructions, see the Communication Interface User’s Manual (IM
MV1000-17E).

Bareci ratrs + tomig Communication conditions
Comm. Data
Mo. Status First Last  Seruver name Reaisters
= | R & Good CA1 - CAS modbus. dasstati I0EE1
2 W © Mone - 192.168.1.2@8 4BEE1
3 W @ Hone 181 - 185 192.168.1.88 4@a1a
3 A\ —
- L L.
g | L—— 1 Ccommunication destination
a
2 MV channels
i Status
13
13 Command
16
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5.6 Displaying Stacked Bar Graphs (COLUMN
BAR)

This section explains how to use the bar graph display (COLUMN BAR).

Procedure

¢ Changing Display Settings
1. Press DISP/ENTER to open the display selection menu.
2. Press the right arrow key to open the submenu.

3. Select a submenu item with the up and down arrow keys.

Display name: Switches to the specified display.

TS -—— SINGLE GRAPH: Displays a single graph.

HAT ION | DUAL GRAPH: Displays two graphs.

i SELECT GROUP: Use the arrow keys to switch between
displayed report groups.

SELECT COLUMN: Use the arrow keys to select a bar graph.

REPORT GROUP 1 to 6*: Switch between displayed
report groups.
* Varies according to model. For more information about report
channels, see section 10.5.

4. Press DISP/ENTER to change the display setting.
To close the menu without changing the display, press ESC.

¢ Changing Groups, Selecting Bar Graphs, and Moving the Cursor
The amount of data that the up and down arrow keys scroll through depends on the
type of report data. For example, with an hourly + daily (Hour+Day) report, you can
use the arrows to scroll through the data one day at a time.

If set to SELECT GROUP: Switches to the display for the report
group with the next smallest number.

If set to SELECT COLUMN: Moves the bar graph selection cursor
to the left.

Switches to the previous day, week or month's data.

If set to SELECT GROUP: Switches to the display for the report
group with the next highest number.

If set to SELECT COLUMN: Moves the bar graph selection cursor
to the right.

Switches to the next day, week or month's data.
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5.6 Displaying Stacked Bar Graphs (COLUMN BAR)

Explanation

¢ SINGLE GRAPH/DUAL GRAPH
You can display one or two bar graphs. The periodic sums of the first channel in a
group and of all other channels that have the same unit as it are displayed.

SINGLE GRAPH display
ﬁ Emin :;

5.572B37E+05] 5, BEIRASEHAS| B, GESAZEE+ES Numeric display section
5.F620¢3E+A5] 5, E5O03RERS| 8. 656015E+p5| O+ 195648E0E

ey (E+E2 ) N TR

=] e o

a3
gEas. B1-22

W,
L Display area 1 L Display area 2

The report data displayed in display areas 1 and 2 vary depending on the report
type (Report kind).

Report kind Display Area 1 Display Area 2

Hourly, or hourly + daily Hourly data Daily data

Daily + weekly Daily data Weekly data

Daily, or daily + monthly Daily data Monthly data
Nofte

When in 4-panel display, the numeric display section only contains channel names or tag
names.

DUAL GRAPH display

Shows the data from two consecutive periods at the top and bottom of the display.
REP: P 1 :

Channel number or tag name

Wday EHAZY e AT Numbers are abbreviated.
— Display area 4
Display area 3
(Samar 1= play
i N Bl "
= — Display area 2
@88/881/23 AL Y, .
L———— Display area 1

The data type shown in display areas 1, 2, 3, and 4 are determined based on the
report type (Report kind) set in the report function. Display areas 1 and 2 contain
the same report data listed above for SINGLE GRAPH display.

Report kind Display Area1 Display Area2 Display Area3 Display Area 4
Hourly, or Hourly data Daily data Hourly data Daily data

hourly + daily The data of the day before the data
in display area 1 and 2

Daily + weekly  Daily data Weekly data Daily data Weekly data
The data of the week before the
data in display area 1 and 2

Daily, or daily Daily data Monthly data Daily data Monthly data

+ monthly The data of the month before the

data in display area 1 and 2
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5.6 Displaying Stacked Bar Graphs (COLUMN BAR)

Nofte
* The numbers on the vertical axis of display area 4 (the top display area) and the dates on
the horizontal axis are abbreviated.
» Display area 4 can only display the data from the period immediately preceding that of
display area 3.

Selecting a Bar
When in SINGLE GRAPH display, you can move the cursor to a bar that you want to

check, and view the sums of each channel.

. +-=
o153 o= I (R
TRUTL © |P_OUTPUTZ. |P_OUTRUTE
2,5316A9E+04| 2, 931E53E+Ad] 2, 931E29E+AY

P_OUTRUTd __ P_OUTPUTS
2.5931679E+04] 2, 3316A1E+Rd| 2,931 7AqE+aq| 1+ 795988EE5
W (E+A2) WAE+A3:

}— Displays the sums of all channels
at the cursor position.

J@8a

SUN _HMOM TUE WED THU [FRI SAT
288581/ 13-2085.81.-19

Cursor

Power Failure and Time Adjustment Indication

P_OLTP! JUTPUT3 sun
2,5316A9E+04| 2, 931E53E+Ad] 2, 931E29E+AY
P_OUTRUTd __ P_OUTPUTS
2.5931679E+04] 2, 3316A1E+Rd| 2,931 7AqE+aq| 1+ 795988EE5
WAE+RZY WAE+A3:

Indicates a power failure.
Time adjustment is indicated by a C.

J@8a

SUN _HMON TUE WED THU FRI SAT
288581/ 13-2085.81.-19

» Power Failure
A “P” indicates when a power failure occurred and a report was supposed to be
filed. A “P” also indicates when the MV recovered from a power failure and the next
report was filed.

* Time Adjustment
When a time adjustment causes a report to be filed twice because the time was
moved back, the time adjustment is marked with a “C,” and the bar graph of the
report that was filed first is used.

If the data for a period does not exist because of a power failure or time adjustment, a

bar graph for the period will not be displayed.
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5.7 Using the Alarm Summary

Procedure

Explanation

This section explains how to use the alarm summary.
P For an explanation of this display, see section 1.4.

* Changing Display Settings

1. Press DISP/ENTER to open the display selection menu.
2. Press the right arrow key to open the submenu.
3. Select a submenu item with the up and down arrow keys.

hanne] Type =

ol))

Sort symbol
IH 2883/81/23 20:d6:@8 A Ascending sort

o oL 29PB/BL/73 20:45:dd .
- o oomeseises cmasies Y Descending sort

bopa/B1/23 20:44:43

— Display name: Switches to the specified display.
= — 10 HISTORY (EV):  Switches to the historical trend display.
i — TO OVERVIEW: Switches to the overview display.

_LCHANGE SORT KEY: Sorts the alarm information by
channel or alarm time.

— ASCENDING ORDER: Sorts in ascending order.
DESCENDING ORDER: Sorts in descending order.

4. Press DISP/ENTER to change the display setting.
To close the menu without changing the display, press ESC.

¢ Moving the Cursor (») and Scrolling through Alarms

Scrolls the alarm information up by half a page
Moves the cursor up

Scrolls the alarm information down by half a page

Moves the cursor down

* Opening the Historical Trend of an Alarm Occurrence

1. Select the alarm with the cursor.

2. Use the operations outlined in “Changing Display Settings” to open the historical
trend display.

e Changing the Sort Key and the Sort Order

You can set the sort key to one of the following items and sort in either ascending or

descending order. A sort symbol appears next to the sort key (see the figure above).

* Channel number: You can sort by channel number even if you use tags. The
alarms of each channel are sorted by their alarm numbers.

« Alarm activation/release
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5.8 Using the Message Summary

Procedure

Explanation

This section explains how to use the message summary.
P For an explanation of this display, see section 1.4.

* Changing Display Settings
1. Press DISP/ENTER to open the display selection menu.

2. Press the right arrow key to open the submenu.

3. Select a submenu item with the up and down arrow keys.

o @ELEH‘I’@ o0}

=age Use@m— Sort symbol
A Ascending sort
¥ Descending sort

— Display name: Switches to the specified display.

— TO HISTORY (EV): Switches to the historical trend
__|- display.

CHANGE SORT KEY: Sorts messages by message
number, time, group, or user
name.

— ASCENDING ORDER: Sorts in ascending order.
DESCENDING ORDER: Sorts in descending order.

CHANGE DISP ITEM:  Switches between displaying
time and group, and displaying
user name.

iz, INFOR-
R hation

4. Press DISP/ENTER to change the display setting.
To close the menu without changing the display, press ESC.

¢ Moving the Cursor (=) and Scrolling through Messages

Scrolls the message list up by half a page
Moves the cursor up

Scrolls the message list down by half a page

Moves the cursor down

* Opening the Historical Trend of the Period When a Message Was Written

1. Select the message with the cursor.

2. Use the operations outlined in “Changing Display Settings” to open the historical

trend display.

» Switching Displayed Items
You can switch between displaying the following sets of items.
* Message, time, group
* Message, user name

¢ Changing the Sort Key and the Sort Order
You can set the sort key to any of the listed items and sort in either ascending or

descending order. A sort symbol appears next to the sort key (see the figure above).

IM MV1000-01E
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5.9

Using the Memory Summary

This section explains how to use the memory summary.
P For an explanation of this display, see section 1.4.

Procedure

* Changing Display Settings

4.

Press DISP/ENTER to open the display selection menu.

Press the right arrow key to open the submenu.

Select a submenu item with the up and down arrow keys.
SP T ()

PRl ther |
%lm : The displayed data type is indicated

: with a green mark.
(e DISPLAY DATRC.DFDY @ EVENT DATRE, DFE

:I— Display name: Switches to the specified display.

_ =  TOHISTORY: Switches to the historical trend display.

-t —— DATA SAVE MODE:  Switches to the data save mode
display.

—— CHANGE DATA KIND: Switches between display

data and event data
FILENAME DISPLAY: Displays the file name.
» For a description of file names, see section 1.5.

Press DISP/ENTER to change the display setting.
To close the menu without changing the display, press ESC.

* Moving the Cursor (=) and Scrolling through Memory Information

Scrolls the memory information up by half a page
Moves the cursor up

Scrolls the memory information down by half a page

Moves the cursor down

¢ Opening the Historical Trend of the Specified Data

1.
2.

Select the data with the cursor.

Use the operations outlined in “Changing Display Settings” to open the historical
trend display.

* Saving Data
To save the data in the internal memory to a CF card or to USB flash memory
P For an explanation of this function, see section 1.4.

1.

2.
3.
4

Press DISP/ENTER to open the display selection menu.
Press the right arrow key to open the submenu.
Select DATA SAVE MODE with the up and down arrow keys.

Press DISP/ENTER.
The display switches to DATA SAVE MODE.
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5.9 Using the Memory Summary

5. To save a specified file, select it with the cursor.
1P

PRV sein |
M.SEMFLE DATA  cEal-400) = @81.23 28:50:30
FEFORT DATA CERC1ER) 2

SAFLE DATA = & DISFLAY DATAC.DADD & EVENT CATR:.DFAE?
i i Data

Start Time ime Factor
mpE1-27 2136735 B1-23 21880 =) Sarlirg
9123 2116640 @1-23 21iE7i24 45 Stoe
8127 25041 21:EE 11 31 Stoe
9127 2Ad5iAl  @1-23 25520 == Stoe
B127 24405 @1-23 Ao 2 Stoe
9127 2015234 @1-23 2A:d4iE7 1rid Stoe
9123 19:15:34  B1-23 2801533 =] Auto Saee

Cursor
(Move with the arrow keys)

6. Press DISP/ENTER to open the display selection menu.

[ heg e | )
157 ‘Aae ELENTISUT

DISELEY DATAC.DADD & EVENT CHTHE.DAE.

SELECT SAVE: Saves the selected file.
ALL SAVE: Saves all data.
M.SAMPLE SAVE: Saves all manually sampled data.

REPORT SAVE: Saves all report data.

CHANGE DATA KIND: Switches between display
data and event data.

i

TIME DISPLAY:  Switches between displaying the times of
last data entries in the file and displaying

7. Use the up and down arrow keys to select SELECT SAVE, ALL SAVE, M.
SAMPLE SAVE, or REPORT SAVE.

* If you are using a CF card and USB flash memory, the message “Which media do you want
save to?” appears. Use the arrow keys to select which medium you want to save to, and
press DISP/IENTER.

The measured data is saved.

ALL SAVE Progress Indicator
If you select ALL SAVE’ from the memory summary, a progress indicator for the ALL
SAVE operation will appear.

*  This function saves all of the data in the internal memory to a CF card or USB flash memory
device.

SHEE § Bl
AR 188D =

SAMPLE DATA @ O DISPLAY DATAC.DADD €@ ELVENT DATAC.LAED
Start Time Erd Time Dat.a Factor
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5.9 Using the Memory Summary
Note

» The progress indicator only appears in the memory summary.

» Pressing ESC will remove the progress indicator for about 10 seconds, but it will reappear
after that.

» The estimated times for the completion of the ALL SAVE operation (when the internal
memory is full) are listed below. The operation may take longer depending on what other
operations the MV is performing.

Time for ALL SAVE Completion (estimated)
CF Card USB Flash Memory
Standard memory About 20 min. About 40 min.
(internal memory suffix code -3)
» To cancel the ALL SAVE operation,
Press FUNC and then the Save Stop soft key.

Memory Option

Explanation

e Saving Data
« Each time you save data, the MV will create a new directory to store the data in.
The directory name structure is: Specified character string_ YYMMDD_HHMMSS
(The values of YY to SS are determined by the date and time of operation)

[ g
2 45 S EUEHT IS TT= Vol
File list/delete

File list example

tory name

@7/88/23 14:17
12 & 47
ATAB_B28123_204 14 83/81/23 20:45

ATAR_A71882_190515 @ 77— Save directory
ATAL #5/B1/B] BE:1A
ATAR_BER123 218758 #5/81/23 2118
ATAR_BER123_23410d #5/81/23 2341

Free space 981376 Kbytes
» Sort

* You cannot save display or event data when it is being recorded.

» The save operation simply copies the data in the internal memory. It does not
change the classification of data in the internal memory from unsaved to saved (see
section 1.5, “Saving to External Storage Media,” for details).

» Saving will stop if there is not enough space in the external storage medium. When
saving data, make sure that the external storage medium has enough free space.

* When saving a single file:

* The generated folder name is: name of the destination directory_date_time

» The file is saved after you select SELECT SAVE in DATA SAVE MODE.

» You cannot switch save folders while in DATA SAVE MODE.

« If a file with the same name already exists, an overwrite confirmation window appears.
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5.10 Viewing Operation History Logs

Procedure

Explanation

You can view the following kinds of logs.
Login log, error log, communication log, FTP log, Web log, e-mail log, SNTP log, DHCP
log, and Modbus status log

¢ Opening the LOG display
1. Press DISP/ENTER to open the display selection menu.

2. Select LOG with the up and down arrow keys.
* LOG is not displayed by default.
P To display LOG on the menu, see section 6.17.

3. Press the right arrow key to open the submenu.

4. Select a submenu item with the up and down arrow keys.
To close the menu without changing the display, press ESC.
Submenu: LOGIN, ERROR, COMMUNICATION, FTP, MAIL, WEB, SNTP, DHCP,
MODBUS

5. Press DISP/ENTER.
The selected display appears.

« LOGIN Log

The log number of the last line and
= the total number of logs
1o [Se= T (O]

(BE5/BE5) Time Action

B1/23 BA:B5:83 Login KEY  Adginl
@123 B@:85:1d Power(n SY5
81522 16:38:16 PowerOff  SYS
@122 21:57: 88 NewTine KEY

B1/81 BE:08: 81 Ti 'eChsl Nr’

Factor Username

User name

Operation method (see the table below)
Operation (see the table below)

Date and time

Action Description

Login Login

Logout Logout

NewTime Time adjustment while memory is stopped

TimeChg Time adjustment through key operation

PowerOff Power OFF (power failure occurred)

PowerOn Power ON (recovered from a power failure)

TrevStart The start of the operation of gradually adjusting the time
TRevEnd The end of the operation of gradually adjusting the time
SNTPtimset Time adjustment by SNTP

Factor Description

KEY Key operation

COM Operation using communication

REM Operation using remote control function

ACT Operation caused by event action

SYS System operation

IM MV1000-01E
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5.10 Viewing an Operation History Log

e Error Log
ERROR

(BE6/BBE} Time Mo, Hessage

2868./81/22 21:87:15 232 There iz no available da..
2868781722 28:49:53 128 HMeasured walue is incorr..
2868781722 28:dd:83 151 This action is not possi..
2808./81/22 28:42:d48 218 HMedia has not been inser..
2868781722 28:15:35 234 Mo time_correction becau,

I Error m ge*
Error code*

Date and time

*

For details, see section 12.1, “List of Messages.”

¢ Communication Log

(B11/811) Time 1/0 Hessage

2MB8/01/22 21:87:15 1 < (Timed out?

2MBE/01/22 20:49:53 1 < E@

2MBE/R1/22 20:44:89 1 > SR2,VOLT,EY,-328@,32

2MBE/RL/22 20:42:48 1 < (186 byte}

2RA5/A1/22 20:15:35 1 > sch

®
‘ Message*

Input/output symbol (>: Input, <: Output)
User ID number (0: Serial, 1 to 3: Ethernet)

Date and time

* See the Communication Interface User’s Manual (IM MV1000-17E).

o E:giafwtlﬁﬁﬁﬁll[::]

(BA3/683) Time Mo, Code Flag Filename

2868./81/22 18:84:13 283 PASS P B51818_18@d13
2885/81/22 18:8d:BA 282 HOSTNAME S5 FTP_TEST.TAT
2885/81/22 18:B2:88 282 HOSTNAME P FTP_TEST.TAT

File name

FTP connection destination
(P: Primary, S: Secondary)

Error age (detail code)*
Date and time

* For details, see section 12.1, “List of Messages.”

(BA0/8B8} Time Reguest Mo, Parameter

81/22 18:18:18 Message STOP
81/22 18:10:90 HMessage BATTERY
A1/22 18:05:58 Screen TREND  GROUP=1
A1/22 18:87:d8 Screen HISTORY GROUP=1
81/22 18:87:30 Message HIGH WOLTAGE
81722 08:37:50 Hegsase 135 HﬁGH YOLTAGE
Operation (see the table on the next page)

Error code*
Requested operation (see the table below)
Date and time

*

For details, see section 12.1, “List of Messages.”

Request Description

Screen Screen switch

Key Key operation

Message Message assignment/write
Makefile Event file/display file
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5.10 Viewing an Operation History Log

Parameter Description

TREND Trend display

DIGIT Digital display

BAR Bar graph display

HIST Historical trend display

oV Overview display

DISP DISP/ENTER key

UP Up arrow key

DOWN Down arrow key

LEFT Left arrow key

RIGHT Right arrow key

HISTORY Historical trend display/Favorite display selection
Messages Written message character strings

e E-mail Log

[
(AA5/A85) Time Tupe Mo, Recipient / Error

B1/23 16:dB:88  Tine
81523 16:38:59 Alarm
B1/22 16136128 Test
81/22 15:31:48 Test
B1/81 15:30:d8  Test

2 uzer2
1 userl
2 uzer2
1 userl
2 uzer?

T— Recipient (mail address, message)

Recipient (1: Recipient 1, 2: Recipient 2)

=

Error code*

E-mail type (see the table below)

Date and time

* For details, see section 12.1, “List of Messages.”

Type Description
Alarm Alarm e-mail
Time Scheduled e-mail
Report Report timeout mail
Fail Power failure recovery e-mail
Full Memory full e-mail
Test Test e-mail
Error Error message e-mail
¢ SNTP Log

B:10:10 @m'}' m@

(aad/aad) Time Mo, Code

2885/81/22 18:18:18 SUCCESS
2885/81/22 B3:18:18 SUCCESS
2686878122 B3:18:18 254 OVER

2088/81/22 B7:18:28 291 TIMEOUT

Error ge (detail code)*

Error code*

Date and time

*  For details, see section 12.1, “List of Messages.”
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5.10 Viewing an Operation History Log

e DHCP Log

2868781722 B8:15:24 297 NOMAME

2088/81/22 B3:15:24 BES IPCONFIG
2088/81/22 B8:88:24 564 RENEWED
2085/81/22 B3:83:18 565 IPCONFIG

Error message (detail code)*
Error code*
Date and time

* For details, see section 12.1, “List of Messages.”

¢ Modbus Status Log
15:10: 19 e IEEN (S)

(B12/208) Time Kind Factor Command
2885/81/22 B6:136:36 H @ NOWE B3 W

2888/081/22 B6:36:36 H g Dropout
28@3./81/22 18:08:86 C @ aood @2R
2885/81/22 18:58:86 C @ Goop A1 R

G

20B5/81/22_18:50:05 O BT R
Command number, command type

(R: Read, W: Write)

Communication status*

Communication type (C: Client, M: Master)
Date and time

* See the Communication Interface User’s Manual (IM MV1000-17E).

5-30 IM MV1000-01E



5.11 Using the 4-Panel Display (MV2000 only)

This section explains how to use the 4-panel display.
P For an explanation of this display, see section 1.4.

Procedure

* Opening the Display
1. Press DISP/ENTER to open the display selection menu.

2. Use the arrow keys to select 4Panel and then select MIX, ALL TREND, ALL
DIGITAL, or ALL BAR. Press DISP/ENTER. If you have changed the display
names, select the name that the display was changed to (see “Changing the
4-Panel Display Configuration Names” on the next page for details).

The selected display appears.

¢ Switching between Displays
Press the right arrow key to switch from MIX, to ALL TREND, to ALL DIGITAL, to ALL
BAR, to MIX and so on. Press the left arrow key to switch displays in the opposite
order. If you have changed the display names, select the name that the display was
changed to (see “Changing the 4-Panel Display Configuration Names” on the next
page for details).

¢ Changing the 4-Panel Display Configurations
Perform these operations while in the 4-panel display.

1. Press DISP/ENTER.
The title of one of the four displays will turn blue.

2. Use the arrow keys to move to the display you want to change (the display with
the blue title is the selected display).

/123 02108 ois I i (©) 58

GROUP 1 OVERVIEW

TI-181 °C=[P1-286 kPaz
- 184.36"

= [PURP-328
€ 183.81

57.8
43.%

GROUP 1 The selected area’s
heading is displayed
in dark blue.

3. Press DISP/ENTER to open the display selection menu.
4. Use the arrow keys to select a new display.

5. Press DISP/ENTER to assign the new display to the old display’s location.
To close the menu without changing the display, press ESC.

* Registering a New Display Configuration
Perform the operation outlined under “Changing the 4-Panel Display Configuration
Names” on the next page.
* If you do not perform this operation and switch to another display, the changes made to the
current display configuration will not be retained.

Nofte

When the four panel display is showing, screens that you cannot assign to the four panel
display (LOG and TREND HISTORY) do not appear in the menu.
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5.11 Using the 4-Panel Display (MV2000 only)

¢ Expanding and Viewing a Single Display
1. Press DISP/ENTER.
The title of one of the four displays will turn blue.

2. Use the arrow keys to move to the display you want to expand (the display with
the blue title is the selected display).

3. Press DISP/ENTER to open the display selection menu.

4. Press the right arrow key to open the submenu.
5. Select EXPAND with the up and down arrow keys.
Sansm1 /23 89:21:21 nis N 1enin  (S) B i

Select EXPAND

e W P 43.9

EXPAND is not displayed by default. You can display it by performing the following:
Press MENU and then select Menu customize > Display menu > EXPAND.
Then, press the Select soft key.

P To display EXPAND on the menu, see section 6.17.

6. Press DISP/ENTER to view the single selected display.
To close the menu without expanding the display, press ESC.

e Changing the 4-Panel Display Configuration Names
If you change a display configuration’s name, the new name will appear in the display
selection menu.
Perform these operations while in the 4-panel display.
1. Press FUNC to open the function menu.

2. Press the 4Panel soft key to open a list of display configurations.

HIA — :
28H8/81/23 18:25: o 01sp | 18nin @
OVERVIEW

Bl

°C =|PI-286 kPa =l
57._H  131.43

1 2 3 4 5 6 17 8 918

SIEIEIEaEE

dPane] 3 | dPane] 4 NN
3. Choose a configuration and press its soft key (from 4Panel 1 to 4Panel 4). The
configuration name input window appears.
4. Enter the display configuration name (up to 16 characters, [Ala[#1]).

5. Press DISP/ENTER to set the configuration name to the name you entered. You
will return to the 4-panel display.
To cancel the configuration name change, press ESC.
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Chapter 6 Display Configuration

6.1 Setting a Display Group

Display

This section explains how to assign channels to a display group and how to name the
group. It also explains how to set lines at specified positions in the waveform display
range on the trend display.

Press MENU and then select Menu tab > Group set, Trip line.

s T e |03
Group number
Group set
On/fOff (n
Group name GROUP 1
CH set BAl.AA2, @83, AA4, B85, BEE
Trip line
Position Color Width
1 [on [see W Red [2 dat
2 [off
3 |off
4 |off
I S N N

¢ Group number
Select the target group number (from 1 to 10 on the MV1000 and 1 to 36 on the
MV2000).

¢ Group set

* On/Off
Select On to use the group.

¢ Group name
Set the group name (up to 16 characters, [Ala[#]1]).

¢ CH set
Select measurement channels, computation channels (/M1 and /PM1 options), and
external input channels (/MC1 option) that you want to assign to the group. You can
set up to 6 channels on the MV1000 and up to 10 channels on the MV2000.
» Enter channel numbers using two or three digits.
» Separate each channel number with a period.
» To specify a range of consecutive channels numbers, use a hyphen.

Example: To assign channel 1 and channels 5 through 8, enter “001.005-008.”

Nofte
« The MV displays the channels in the specified order on the trend, digital, and bar graph
displays.
* You can assign a channel to multiple groups.
* You cannot assign a channel twice to the same group.
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6.1 Setting a Display Group

Note

You can copy the channel settings of a display group to another group.

[
25 00:00.00 BEEoIEETH(S) )
Group number 1
Group set

On/fOff (n
Group name GROUP 1

CH =et BE1 . AA2 B@d, ARG, 486

Trip line

o|o|o
||+
—+| |+

e

of
[ Ireut | |

-

Procedure

1. Select the CH set box of the copy source.

2. Press the Copy soft key.

3. Select the CH set box of the copy destination.

4. Press the Paste soft key. The copied channel settings are pasted.

e Trip line
You can set lines at specified positions in the waveform display range of the trend
display.

1,2, 3,and 4

Select On for the trip lines you want to display.

Position

Set the position in the range of 0 to 100% of the display width.

Color

The default colors for 1, 2, 3, and 4 are red, green, blue, and yellow, respectively.
To change a color, select from the 24 available colors.

Width

Set the line width of the trip line in dots (1 to 3).

6-2
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6.2 Displaying Tags or Channel Numbers

This section explains how to display channels using tags or channel numbers.

Display

¢ Tag/Channel

Press MENU and then select Menu tab > Basic setting mode > Environment tab >

Operating environment.

Basic Setting Hode

Operating environment

Tag/Channel
Lanauage Enalish

Decimal Point Twpe Foint

MV1000

Press MENU and then select Menu tab > Meas channel > Tag, Memory, Delay.
MV2000

Press MENU and then select Menu tab > Meas channel > Tag, Memory sample,
Alarm delay.

First-CH: Last-CH: [1

Tag

Characters

Hemory sample

On/fOff On

Alarm delay

Time 18 =
1 20 |

¢ Operating environment > Tag/Channel

Setting Description

Tag Displays tags. Channel numbers are displayed for channels that do not have
tags set.

Channel Displays channel numbers.

¢ First-CH, Last-CH
Select the target channels. The settings selected here will be applied to these
channels.

¢ Tag > Characters
Set the tag (up to 16 characters, [Alaf#[1]).
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6.3 Setting the Secondary Trend Interval

Display

This section explains how to switch the trend interval to the secondary interval during
memory sampling. You can configure the MV to automatically write a message when the
trend interval is switched.

P For an explanation of these functions, see section 1.4.

¢ Switching the Trend Interval and Writing a Message (when using the
secondary trend interval)

MV1000
Press MENU and then select Menu tab > Basic setting mode > Environment tab >

View, Message.

Basic Setting Hode

View
Trend twpe T-%
Partial 0ff
Trend rate switching
Hesszage
Write group Common
Power-fail message 0ff
Change message Ooff
T

Press MENU and then select Menu tab > Basic setting mode > Environment tab >
View, Message, Input, Alarm.

Basic Setting Mode

Environment > View, Hessage, Input, Alarm

r View — Input

Trend type TV (Ualue on over-range Free
Partial off

Trend rate switching Alarn

’7Nn logging off

r Hessage

Write group Common

Power-fai | message off

Change message off

[ on | off

¢ Second interval [/div]

MV1000
Press MENU and then select Menu tab > Display > Trend.

a5 RN o | @] o0}

Trend
Direction Wide
Trend clear On
Hessage direction Horizontal
Scale
Digit Hormal
Value indicator Hark
Trend line 2 dot
Grid Auto div
Second interval Imin Adiv
|36z [ luwin | Znin | Enin |
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6.3 Setting the Secondary Trend Interval

MV2000
Press MENU and then select Menu tab > Display > Trend, Bar graph, LCD,
Monitor.

ALARA SUMHARY

e ]
g gy 0 BT I thor (D)

Display > Trend, Bar graph, LCD, Honitor

r Trend —_— ) r LCD E—
Direction Wide Brishtness 2
Trend clear On Backlight saver
HMessage direction Horizontal Hode Dimner
Scale Saver tine 1h

Digit Nornal Restore Key+Aln
Value indicator Hark
Trend line 2 dot _ Honi tor
Grid Auto  div
Second interval Inin /div | | Backsround
Display White
_ Bar graph Historical trend Black
Scroll time 18s
Direction Vertical Junp default display

ot | tnin | 2nin | Swin | 16win | 2fwin [Next 1/2 |

View > Trend rate switching
On: Enables the switching of the trend interval during memory sampling. The Second
interval [/div] item appears in the Setting Mode menu.
* When the trend rate switching function is On, the MV cannot be configured to record both
display and event data (see section 4.1 for details).

Message > Change message
On: Writes a message containing the time and the new trend interval when the trend

interval is switched.

Trend > Second interval [/div]
Select the time corresponding to a division of the time axis on the trend display from
below: You cannot set a trend interval that is faster than the scan interval.
5s*, 10s*, 158**, 30s, 1min, 2min, 5min, 10min, 15min, 20min, 30min, 1h, 2h, 4h, 10h
* Available on high-speed input models.
** Available on high-speed input models and on medium-speed input models set to fast
sampling mode.
If the trend interval on a high-speed input model is set to 5 s/div or 10 s/div, one division is
displayed with 40 dots.

Nofte

If the trend interval is set to greater than or equal to 1h/div, the MV displays the month, day, and

Month, day, and hour
at the grid position.
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6.3 Setting the Secondary Trend Interval

Procedure

¢ Switching the Trend Interval

1. In Operation Mode, press FUNC.
The function menu appears.

2. Press the Second speed soft key or the Normal speed soft key.
The trend display update interval is changed. A message appears on the trend display (when
the MV is configured to write a message).
Display example: 10:53 1min/div

Note

You can also switch the trend interval by using the event action function. For event action
configuration instructions, see chapter 7.
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6.4 Writing a Message

This section explains how to write a message in the trend display.

Display

* Message Write Group

MV1000
Press MENU and then select Menu tab > Basic setting mode > Environment tab >

View, Message.

Basic Setting Hode

View

Trend tupe T-%
Partial 0ff
Trend rate switching 0n
Hesszage

Write aroup W
Power-fail message 0ff
Change message Ooff

MV2000
Press MENU and then select Menu tab > Basic setting mode > Environment tab >

. o
View, Message, Input, Alarm. )
el

M

<

(2

o

r View —_— Input ;h
Trend type ¥ (Ualue on ouer-range Free Q
Partial OFf =}
Trend rate switching On Alarn 8
’7No logging off o

=

r Hessage

Write group
Power-fai | message Off

Change messase off

| Comon_| Separate |

* Registering Messages
Press MENU > select the Menu tab > Message.

T e |03
Hessage Mo,
Characters
1 ETART
2 ETOP
3 Fressure
4 Decompress
5
E
7
g
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6.4

Writing a Message

Procedure

Message
¢ Write group
This setting applies only to messages that are written using keys.

Setting Description
Common Writes messages to all groups.
Separate Writes messages to the displayed group.

¢ Power-fail message
P See section 6.16 for details.

¢ Change message
P See section 6.3 for details.

Message No.
Select a message number (1 to 100). Message numbers 1 to 10 are used for free

messages. If you set a free message, the corresponding message number will be
overwritten.

*

Messages that are created and written on the spot.

Message > Characters
Set the message (up to 32 characters, [Alal#]1]).

Writing a Message
You cannot write a message when memory sampling has stopped.

1. Display the group that you want to write a message to.

Even when Write group is set to Separate, a message is written to all groups if the MV is
showing a display unrelated to a group (such as the overview display). When the MV is
showing a 4-panel display, a message is written to the displayed group.

When Write group is set to Common, a message is written to all groups.

2. Press FUNC.
The function menu appears.

3. Press the Message soft key.

4. Press the soft key corresponding to the desired message number range (example:
[1-10]).
A list of messages appears.

ol))
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6.4 Writing a Message

5. Press the soft key corresponding to the number of the message you want to write.

A message mark, time, and message appear on the trend display.

1 @E‘.ﬂ-ﬁm@ o0}

Imipddiyg
v Message
BETAE STOPN

24T 27 E2i 3 B2 51 =

¢ Writing a Free Message
You can create and write a message on the spot.

1.
2.

Display the group that you want to write a message to.

Press FUNC.
The function menu appears.

Press the Free message soft key.

Press a message number soft key.
The message entry window opens.

Enter a message (up to 32 characters, [Alal#[1]).

Press DISP/ENTER.
A message mark, time, and message appear on the trend display.

e Writing an Add Message
You can add a message to a previously measured data. You can do this on a
previously measured portion of a waveform that is currently being memory sampled.

1.

Carry out the procedure below to display the historical trend of the data that is
currently being memory sampled.

Press DISP/ENTER and select TREND HISTORY > (group name) > DISP/EN-
TER.

Press the arrow keys to move the cursor to the position where you want to write a
message.

Write a message according to the procedure given in “Writing a Message” or
“Writing a Free Message.” Use the Add Message or Add Free Message soft key.

Cursor (yellow line)

Added message

IM MV1000-01E
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6.4 Writing a Message

Explanation

* Message Colors
The message colors on the trend display are shown below. You cannot change them.

No. 1 2 3 4 5 6 7 8 9 10
Color Red Green Blue Blue Brown Orange Yellow- Light Violet Gray
violet green blue

The colors for messages 11 to 100 are repetitions of the colors above.

* Add Message
» The message timestamp is the time when the message was written. It is not the
timestamp at the data position.

Message summary
(BA2/082)  Hessage v Time ire | display example

= STOP B8/81/23 B2:49 A
Pressure BE/B1/23 B2:61 A

Added message
(displayed in blue)

* You can write up to 50 messages.
* You cannot add messages to data in the internal memory that has been saved to a
file or to data that has been loaded from an external storage medium.
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6.5 Changing Channel Display Colors

This section explains how to change channel display colors. The color settings are
applied to the trend and bar graph displays.

Display

Press MENU and then select Menu tab > Meas channel > Color.

2 RieeETE(S) )

Group of channel [LEEREEEE
Calor
a1 . Red
aaz . Green
aa3 . Blue
aad 1 B.violet
aas . Brown
a6 Orange

e Group of channel
Select the target channels.

e Color
To change a color, select from the following 24 colors.
Red, green, blue, blue violet, brown, orange, yellow-green, light blue, violet, gray, lime,
cyan, dark blue, yellow, light gray, purple, black, pink, light brown, light green, dark
gray, olive, dark cyan, and spring green
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6.6

Display

Using Display Zones

This section explains how to assign each channel to a waveform display zone so that
waveforms do not overlap.
P For an explanation of this function, see section 1.4.

MV1000
Press MENU and then select Menu tab > Meas channel > Zone, Scale.

m HHERY o e (O] 6
First-cH: L Lest-cH: -
Zone

Lawer m%

Upper 188 %

Scale

Foszition '1_

Division W
MV2000

Press MENU and then select Menu tab > Meas channel > Zone, Scale, Bar graph.

ALARN SUHHARY =
R AR - i EvENT I 1o (S

Heas channel > Zone, Scale. Bar graph

First-CH [0 Last-CH ]
r Zone —_—
Lower m ¥
Upper 18 %
r Scale
Position 1
Division 18
r Bar gravh
Base position Nornal
Division 18

e First-CH, Last-CH
Select the target channels. The settings selected here will be applied to these
channels.

e Zone > Lower, Zone > Upper
Set the zone where waveforms will be displayed. Set Lower and Upper as
percentages of the maximum display width. Set Upper to a value greater than Lower,
and set the zone width (Upper — Lower) to greater than or equal to 5%.
Lower: 0 to 95%
Upper: 5 to 100%
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6.7 Displaying a Scale on the Trend Display

This section explains how to display a scale on the trend display.
P For an explanation of the trend display, see section 1.4.

Display

¢ Scale Division, Scale Division
MV1000

Press MENU and then select Menu tab > Meas channel > Zone, Scale.

@E‘._E-rr_m

First-CcH: 1 Last-CH: 1
Zone
Lawer A%
Upper 108 %
Scale
Position
Divizion 1@
L off [ 1 | 2 | 3 |

MV2000
Press MENU and then select Menu tab > Meas channel > Zone, Scale, Bar graph.

O
ALARM SUHHARY & 0
Snpraizon b5 el CVENT N thor  (G) 2
Heas channel > Zone. Scale, Bar graph o
First-CH 001 Last-CH o8l ‘;
r Zone — o
=]
Lover [ =h
Upper 188 % tg
o
r Scale =
Position S
Division 18
r Bar graph
Base position Nornal
Division 18

N W O O O O (™5 773

¢ Scale Digit, Value Indicator

MV1000
Press MENU select Menu tab > Display > Trend.

ol))

Trend

Direction Wide

Trend clear On

Hessage direction Horizontal
Scale

Digit | Hormal |

Value indicator Hark

Trend line 2 dot
Grid Auto div
Second interval Imin Adiv

 Normal | Fine |
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6.7 Displaying a Scale on the Trend Display

MV2000
Press MENU and then select Menu tab > Display > Trend, Bar graph, LCD,
Monitor.

ALARN SUHHARY =
Sisrar v byzos:o0 e EVENT I thor ()

Display > Trend. Bar graph. LCD. Honitor

Trend — F LCD —
Direction Wide Brightness 2
Trend clear On Backlight saver
Hessage direction Horizontal Hode Dimmer
Scale Saver time 1h

Digit Restore Key+Aln
Value indicator Hark
Trend line 2 dot _ Honi tor
Grid futo div
Backsround
B h Display White
=P ERL Historical trend Black
Direction Vertical Scroll time 108s
Jump default display off

Showing a Scale

While in the trend display, press DISP/ENTER (to open the display selection menu) >
right arrow key (to open the submenu), and select SCALE ON (see section 5.2 for
details).

First-CH, Last-CH
Select the target channels. The settings selected here will be applied to these
channels.

Position
Select the scale display position on the trend display from 1 to 6 with the MV1000 or
from 1 to 10 with the MV2000. Select Off to not display a scale.

Scale > Division

Select the number of main scale marks on the trend display from 4 to 12 and C10.

C10: The scale is equally divided into 10 sections by main scale marks, and scale
values are indicated at 0, 30, 50, 70, and 100% positions on the trend display.

The next figure contains examples of scales for different numbers of divisions when

the span is 0 to 100 and the unit is set to “unit.”
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6.7 Displaying a Scale on the Trend Display

Horizontal Trend Display
MV1000

l_ Scale display position

oo oo
i1 e 82.75
ip 84.01
E —
paL 85. 26

AL O
S b e 86. 58
F == E
e - B

111E ?.;.__BE'_EE_E Eﬂﬂ
b b b b.4d

Number of scale divisions: 10 t Number of scale divisions:
Number of scale divisions: 11 Number of scale divisions:

Number of scale divisions: 12 Number of scale divisions:
Number of scale divisions: C10 Number of scale divisions:
Number of scale divisions:
Number of scale divisions:

=

MV2000

©oo~NOO OGN

uoneinBbiyuoy Aejdsig n

Scale display position

P

[ ]

6 4 3 2 1
il 100 100 Ulﬂﬂw
= S E B g
= EEE (LN
E S =[5
0 S -
E B - E = F
- ERERE
@ :_mt@;mt __mtlﬁi
:nlt i‘l:mt::mt:_mt
S =
EEEBE [
"
PEELaf
S E M EE L
8L S ?f F?]
o ] i

Number of scale divisions: 4
Number of scale divisions: 5
Number of scale divisions: 6
7
8
9

IE

Number of scale divisions:
Number of scale divisions:
Number of scale divisions:
Number of scale divisions: 10
Number of scale divisions: 11
Number of scale divisions: 12
Number of scale divisions: C10
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6.7 Displaying a Scale on the Trend Display

Vertical Trend Display
MV1000

181 182
8. 05 unit 14768 unit 147.68 unit

=2 -1 = it 4E
Lo b Loy b v vy L Ly

?ﬁ i | 1 1 71| = Number of scale divisions:
it |18

= = 1 L
lI‘E;Ellall|”||1|3l3”||”lf:'|.6!”|||'l:al Hlllllﬁlﬁlll |IIISIEEﬁII%Eﬂ<—Numberofscaled|V|3|ons.
= = 5 o L
e Lo 0 L T DA T Lo 1554 L1771 1 (7]~ Number of scale divisions:
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MV2000
[ |25| [ |UT‘t|5|]| [ N |?5| I I I1|I]I] ~~Number of scale divisions:
o - S
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[d ||||||||||||||||||||||||\||||ur|”||||_é||||||||||||||||||||\|\||| ||||||1| ~Number of scale divisions:
6H||||| Lo b S b |||||||u|n|f\t||||||6|u|||\||||||||||||\ ||||||||\|\||1 ~<—Number of scale divisions:
7H|||\|| g ||||||||||||||||||\|||||||||||Lﬂ|||||||||||\||||||||||||||||‘||||||||H]||||IH ~—Number of scale divisions:
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8 1 <—Number of scale divisions:
9 |\||\||wl|||||||||||||||||||||||¥n||\||||||||||||||L|"|1|‘|t|&H\I|Hl||||||||||||||%|||||||||\m|||||||||||||||||| < Number of scale divisions:
10 [0l bbb oo WO e o oo oo i b i <~ Number of scale divisions:

Scale display position

Nofte

© 00 NOoO O A

10
1"
12
C10

» If the scales of multiple channels are set to the same position, the scale of the channel
assigned to the group first is displayed.

Example: If the channel assignment order to a group is 003.002.001, and the scale display

position is set to 1 for all channels, the scale of channel 3 is displayed at display

position 1.

» Even if some of the scale display positions are skipped, the positions are shifted towards 1

so that there are no empty positions.
Example: Suppose the channel assignment to a group is 001.002.003, and the display

positions of the scales are set to 1, 3, and 6, respectively. The scales will actually

appear at positions 1, 2, and 3, respectively.
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6.7 Displaying a Scale on the Trend Display

* The scale is divided into 4 to 12 sections by the main scale marks. The section between
main scale marks is divided into 10 subsections by medium and small scale marks. Small
scale marks are not displayed if:

* The input range resolution is smaller than the total number of small scale marks.

+ Zone display is enabled.

» Partially expanded display is enabled.

* The scale values are displayed according to the following rules.

» If the number of scale divisions is 4 to 7 for the vertical trend display, values are
displayed at all main scale marks. If the number of scale divisions is 8 to 12, the
values are displayed at every other main scale mark.

» Scale upper and lower limits are displayed at the ends of the scale.

» Scale values are displayed up to three digits, ignoring the minus sign. However, if the
integer parts of the values at the ends of the scale are both one digit or both is zero,
two digits are displayed.

Example: If the scale is —0.05 to 0.50, the lower limit will be —0.0 and the upper limit

will be 0.5.

» If the integer part of either end of the scale is two or three digits, the fractional part is
truncated.
Example: If the scale is 0.1 to 100.0, the lower limit will be 0 and the upper limit will be
100.

» If the integer part of either end of the scale is four or more digits, the value is
displayed using a 3-digit mantissa and an exponent, “x10” or “x10%” for example.
Example: If the scale is 10 to 2000, the lower limit will be 1 and the upper limit will be
200%10.

» The unit is displayed near the center of the scale. If partially expanded display is enabled,
the display position will be offset from the center. For the vertical trend display, up to six
characters can be displayed. For the horizontal trend display, up to four characters can be
displayed.

¢ Trend > Scale > Digit
Fine: If the scale value is displayed with two digits, it can be changed to three digits.
For example, if the scale range is 49.0 to 51.0, the scale values will be displayed with
three digits as shown below.

MV1000

49,8 | |49.2 | I"I/H|49.5 | v |49.? | 54.8)
Iminddiwv
MV2000
49.0 “ 49.6 Hz50.0 50.4 51.0
il bbb B T Lo b B LR bt Lo P

¢ Trend > Scale > Value indicator
The current value is indicated with a mark or a bar.

GBs/d iy

Bar
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6.8 Displaying Alarm Value Marks and Color Scale
Bands

This section explains how to display alarm value marks on the scale and how to display
a color band over a specified range.
P For an explanation of these functions, see section 1.4.

Display

MV1000
Press MENU and then select Menu tab > Meas channel > Alarm mark or Color scale
band.
First-CH: BN Last-cH: First-cH: Last-CH:
Alarm mark Golor scale band
Hark kind Fixed Band area In
Indicate on Scale off Color Lime
Alarm mark color Dizsplay position
Alarm 1 Red Lower B, ARER
Alarm 2 Orange Upper A.8188
Alarm 3 Orange
Alarm ¢ Red
1 1 2 [ 3 | 4 | 1 1 2 [ 3 | 4 |
MV2000
Press MENU and then select Menu tab > Meas channel > Alarm mark, Color scale
band.
ALARM SUMHMARY o]
Sioaairs o e e I hor (B
Meas channel > Alarm nark. Color scale band
First-CH Last-CH [}
Alarm mark —_— Color scale band ———
Hark kind Fixed Band area In
Indicate on Scale off Color Limne
Alarm mark color Display position
Alarm 1 Red Louer [N
Alarm 2 Orange Unper B.8168
Alarm 3 Orange
Alarm 4 Red
[ ot |1 [ 1

s NN

e First-CH, Last-CH
Select the target channels. All of the other settings selected here will be applied to
these channels.
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6.8 Displaying Alarm Value Marks and Color Scale Bands

Alarm mark

Displays marks that indicate the values of the high and low limit alarms, delay high
and low limit alarms, and difference high and low limit alarms. These settings are
shared with the bar graph display.

¢ Alarm mark > Mark kind

Setting Description Mark

Alarm Displays green marks under normal conditions andred = or =
marks when alarms are activated.

Fixed Displays marks in fixed colors. 4

e Alarm mark > Indicate on Scale
To display alarm value marks, select On.
e Alarm mark > Alarm mark color > Alarm 1, Alarm 2, Alarm 3, and
Alarm 4
If Mark kind is set to Fixed, specify the alarm value mark colors.
Color scale band
Displays a color band on the scale for a specified section of the measurement range.
These settings are shared with the bar graph display.

e Color scale band > Band area

Setting Description

In Displays a color band for the area inside the range.
Out Displays a color band for the area outside the range.
Off Disables this function.

¢ Color scale band > Color
Set a color.

e Color scale band > Display position > Lower, Upper
Specify the display position. Specify a value within the span or scale range.
Lower: The lower limit of the area.
Upper: The upper limit of the area.

IM MV1000-01E
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6.9 Partially Expanding a Waveform

Display

This section explains how to expand a portion of a waveform (and shrink the other
portion).
P For an explanation of this function, see section 1.4.

¢ Turning ON/OFF the Partially Expanded Display Function
MV1000
Press MENU and then select Menu tab > Basic setting mode > Environment tab >
View, Message.

Basic Setting Hode

View
Trend tupe T-%
Partial
Trend rate switching 0n
Hesszage
Write aroup Common
Power-fail message 0ff
Change message Ooff

L 00 | off |

Press MENU and then select Menu tab > Basic setting mode > Environment tab >
View, Message, Input, Alarm.

Basic Setting Hode

Environment > View. Message. Inpbut. Alarm

r View —_— Input
Trend type T-¥ (Ualue on over-range Free

Partial
Trend rate suitching 0ff Alarn
(No logging off
r Hessage
Write aroup Cornon
Power-fai | nessage 0ff
Change message off
T

» Partially Expanded Display Settings
Press MENU and then select Menu tab > Meas channel > Partial.

= Eﬁ?aﬂﬂ.‘ﬁiﬂ.[:] o0}

First-CH: Last-CH: [1

Partial

On/Off [on
Expand 58 %
Boundary A, 8868
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6.9 Partially Expanding a Waveform

View > Partial
If you select On, the Partial item appears in the Setting Mode menu.

First-CH, Last-CH
Select the target channels.

Partial > On/Off
To enable the partially expanded display function, select On.

Partial > Expand
Set the position where the value specified by Boundary will be displayed as a

percentage of the display span from within the range of 1 to 99.

Partial > Boundary
Set the boundary value between the reduced section and the expanded section from
within the range of “the minimum span value + the smallest number expressible given
the decimal place” to “the maximum span value — the smallest number expressible
given the decimal place.” For channels that are set to scaling, the selectable range is
“the minimum scale value + the smallest number expressible given the decimal place’
to “the maximum scale value — the smallest number expressible given the decimal
place.”
Example: Inputrange: —6 V to 6V. Expand: 30. Boundary: 0
The —6 V to 0 V range is displayed in the 0% to 30% range, and the 0 V to
6 V range is displayed in the 30% to 100% range.

”
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6.10 Changing the Display Layout, Clearing of the
Waveform at Start, Message Display Direction,
Waveform Line Width, and Grid

This section explains how to change the display layout, waveform line width, and grid. It
also explains how to clear waveforms when memory sampling starts.
P For an explanation of these functions, see section 1.4.

Display
MV1000
Press MENU and then select Menu tab > Display > Trend.

Trend
Direction
Trend clear On
Hessage direction Horizontal
Scale
Digit Hormal
Value indicator Hark
Trend line 2 dot
Grid Auto div
Second interval Imin Adiv
I.I'Er'til:::al Wide
MV2000

Press MENU and then select Menu tab > Display > Trend, Bar graph, LCD, Monitor.

ALARN SUMHRRY =
Sbsvetron b:11:18 G EVENT I 1o (S)

Display > Trend. Bar graph, LCD. Honitor

Trend — F LCD —
Direction m Bri ghtness 2
Trend clear On Backlight saver
Message direction Horizontal HMode Dimner
Scale Saver time 1h

Digit Nornal Restore Kew+Aln
Value indicator Hark
Trend line 2 dot _ Honi tor
Grid futo div
Backsround
B h Display White
=P ERE Historical trend Black
Direction Vertical Seroll tine 108s
Jump default display off

[ Horizon |Vertical | _Uide | Split |

e Trend > Direction
Set the trend waveform display direction to Horizontal, Vertical, Wide, or Split.

¢ Trend > Trend clear

Setting Description
On Clears the displayed waveforms when memory sampling starts.
Off Does not clear the displayed waveforms when memory sampling starts.

* Trend > Message direction
Sets the message display direction to Horizontal or Vertical. The message direction is
fixed to Horizontal if Trend Direction is set to Vertical.

e Trend > Trend line
Sets the line width of trends in dots (1 to 3).
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6.10 Changing the Display Layout, Clearing of the Waveform at Start, Message Display Direction, Waveform

Line Width, and Grid

Trend > Grid
Sets the number of grids that will be displayed in the trend waveform display area.

Setting Description

41012 Displays a grid that divides the display width into 4 to 12 sections.

Auto Displays the same number of grids as the number of scale divisions of the
first-assigned channel of a group.

Second interval
P See section 6.3 for details.

IM MV1000-01E
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6.11 Changing the Bar Graph Display Method

Display

This section explains how to change the bar graph display method.
P For an explanation of the bar graph display, see section 1.4.

* Display Direction

MV1000

Press MENU and then select Menu tab > Display > Bar graph.

Bar araph

Direction

MV2000
Press MENU and then select Menu tab > Display > Trend, Bar graph, LCD,
Monitor.

ALARH SUMHARY
2/A8/A1/23 B3:12:27

Vertical

Display > Trend. Bar graph, LCD. Honitor

Trend
Direction Wide
Trend clear On
Message direction Horizontal
Scale
Digit Nornal
Value indicator Hark
Trend line 2 dot
Grid futo div
Bar graph
’]Ji rection
Vertical

Base Position and the Number of Scale Divisions

MV1000

Press MENU and then select Menu tab > Meas channel > Bar graph.

First-CcH:

Bar araph
Base position
Divizion

Last-CH:

6w oen I thor (O

r LCD EEE—
Brightness 2
Backlight saver

HMode Dimner
Saver time 1h
Restore Kew+Aln

r Honi tor

Backsround

Display White
Historical trend Black
Scroll time 18s

Jump default display off

Hormal
18

1 2 e |
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6.11 Changing the Bar Graph Display Method

MV2000
Press MENU and then select Menu tab > Meas channel > Zone, Scale, Bar graph.

ALARN SUHHARY =
Sibaran v yciocan R EVENT I thor ()

Heas channel > Zone. Scale, Bar graph

First-CH [@01  Last-CH aal
r Zone —_—
Lower [ 4

Upper 108 %

= Scale —_—
Position 1

Division 18

r Bar araph

Base position
Division 18

e Bar graph > Direction

Set the bar graph display direction to Horizontal or Vertical.

First-CH, Last-CH
Select the target channels. All of the other settings selected here will be applied to
these channels.

Bar graph > Base position

Set the base position of bar graphs to Normal, Center, Lower, or Upper. A description

of how the MV displays bar graphs depending on this setting is given on the following
pages. This setting is applied to the bar graph display and to the bar that indicates the
current value on the scale in the trend display.

IM MV1000-01E
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6.11 Changing the Bar Graph Display Method

When the Bar Graph Display Direction Is Set to Vertical
* Normal
The value at the bottom of the bar graph: The span lower limit or span upper limit
(or scale lower limit or scale upper limit),
whichever is less
The value at the top of the bar graph: The span lower limit or span upper limit
(or scale lower limit or scale upper limit),
whichever is greater

Starting point of the bar: Bottom edge
+ Center
The value at the bottom of the bar graph: Same as with Normal.
The value at the top of the bar graph: Same as with Normal.
Starting point of the bar: Center
* Lower
The value at the bottom of the bar graph: Span lower limit (or scale lower limit)
The value at the top of the bar graph: Span upper limit (or scale upper limit)
Starting point of the bar: Bottom edge
* Upper
The value at the bottom of the bar graph: Same as with Lower.
The value at the top of the bar graph: Same as with Lower.
Starting point of the bar: Top edge
Normal Center Lower Upper
VLT VL Vupper[T Vupper <
I4-
VS < VS - Vlower < Vlower

Vupper: Span upper limit (or scale upper limit)
Vlower: Span lower limit (or scale lower limit)

VL: Vlower or Vupper, whichever is greater
VS: Vlower or Vupper, whichever is less
< Starting point of the bar

/
Example: When the span lower and upper limits of the input
range are 0.0 and —100.0, respectively

Normal Center Lower Upper
0.0 0.017 1000H -1 OOOH
-100.0 -100.0L 0.0 0.0
o /
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6.11 Changing the Bar Graph Display Method

When the Bar Graph Display Direction Is Set to Horizontal

The span lower limit (or scale lower limit) is set to the left edge of the bar graph, and

the span upper limit (or scale upper limit) is set to the right edge of the bar graph.
» Starting point of the bar

Normal: The left edge or right edge, whichever is less

Center: Center

Lower: Left edge

Upper: Right edge

Normal Lower
Viower (Viower < Vupper) Vupper Viower Vupper
[ ]
'y A
(Vlower > Vupper) i
A
Center Upper
Viower Vupper Viower Vupper
[ I ] (——
A A

Vupper: Span upper limit (or scale upper limit)
Vlower: Span lower limit (or scale lower limit)
Starting point of the bar

/Example: When the input range’ s span lower limit is 0.0, N
and the span upper limit is —100.0

0.0 -100.0

Normal [C I
0.0 -100.0

Center [ T 1
0.0 -100.0

Lower HEEN ]
0.0 -100.0

| — ]

\_ Upper Y,

When Displaying a Bar That Indicates the Current Value on the Scale in

the Trend Display

Normal Center Lower Upper Viower v, <V ) upper
' ower upper: 1
Vipped T~~~ T I < — ]
Normal : Viower > Vupper) E
5 4
I
I‘l Center ' Y

e Bar graph > Division
Select the number of main scale marks from 4 to 12.

IM MV1000-01E

6-27

uoneinBiyuoy Aejdsiqg n



6.12 Changing the Display Background Color

Display

This section explains how to change the display background color. This setting is applied
to the operation screen.

MV1000

Press MENU and then select Menu tab > Display > Monitor.

Honi tor

Backaround

Dizsplay

Historical trend
Scroll time

Jump default displav

[ ithite | Black |
MV2000

Black
18z
o

Press MENU and then select Menu tab > Display > Trend, Bar graph, LCD, Monitor.

ALARM SUMIARY =
Sy oo 14:50 el EVENT I thor (5]

Display > Trend, Bar sraph, LCD, Honitor

Trend r LCD —
Direction Wide Brightness 2
Trend clear On Backlight saver
Hessage direction Horizontal Hode Dimner
Scale Saver time 1h
Digit Normal Restore Key+Aln
Value indicator Hark
Trend line dot _ Honi tor
Grid Auto div

Backaround
Display | bhite |
Eageiat Historical trend Black
Direction Vertical Scroll time 1Bs
Junp default display 0ff

* Monitor > Background > Display

Set the background color of the operation screen to White (default setting) or Black.

* Monitor > Background > Historical trend

Select the background color of the historical trend display from the following:

Settings: White, Black (default setting), Cream, and Lightgray
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6.13 Automatically Switching Display Groups

This section explains how to enable the automatic switching of the displayed group at
specified intervals.

Display
MV1000
Press MENU and then select Menu tab > Display > Monitor.

Honi tor

Backaround

Dizsplay

Historical trend
Scroll time

Jump default displav

[ 5s | lis | 2ds | G3s | dnin |

MV2000
Press MENU and then select Menu tab > Display > Trend, Bar graph, LCD, Monitor.

ALARN SUHHARY =
R R - e EvENT I o (S

Display > Trend. Bar graph. LCD. Honitor

Trend — r LCD —
Direction Wide Brightness 2
Trend clear On Backlight saver
Message direction Horizontal Hode Dimmer
Scale Saver time 1h

Digit Nornal Restore Key+Aln
Value indicator Hark
Trend line 2 dot _ Honi tor
Grid futo div
Backsround
Display White
Eageatt Historical trend Black
Direction Vertical Scroll tine
Junp default display off
| 5 | s | s | 38 | inin |

* Monitor > Scroll time
Select a switching interval from 5 s to 1 min from the available choices. The displayed
group switches in ascending order.
Use the display selection menu to select whether or not to automatically switch the
display.
P See section 5.2 for details.
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6.14 Automatically Returning to a Specified Display

This section explains how to configure the MV to automatically switch back to a specified
display if there is no user activity within a set time period.

Display
MV1000
Press MENU and then select Menu tab > Display > Monitor.

Honi tor
Backaround
Dizsplay White
Historical trend Black
Scroll time 18z

Jump default display

[ off | lnin [ Znin_| Snin_|
MV2000

Press MENU and then select Menu tab > Display > Trend, Bar graph, LCD, Monitor.

ALARM SUNHARY =]
Sy ma-15:01 el EVENT I thor  (S)
Display > Trend, Bar graph, LCD, Honitor

Trend —_— LCD —
Direction Wide Brightness 2
Trend clear On Backlight saver
Hessage direction Horizontal Hode Dimner
Scale Saver time 1h
Digit Normal Restore Key+Aln
Value indicator Hark
Trend line ? dot _ Honi tor
Grid Auto div

Backaround
Bar graph Display White
Historical trend Black
’7Direction Vertical Scroll time 18s
Junp default display

L off | dmin | Znin | Snin_| 1Bwin_| 2ein_Next 1/2 |

e Monitor > Jump default display
The MV will return to a specified display if there is no key operation within a set time

period.

Setting Description

1min to 1h The time interval for switching the display.
Off Disables this function.

Procedure

* Specifying the Display
1. Switch to the operation screen that you want to register.

2. In Operation Mode, press FUNC.
The function menu appears.

3. Press the Standard display soft key.
The display is registered.
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6.15 Registering Favorite Displays

This section explains how to register often-used displays to the HISTORY key for easy
access.

(1w (Z9—{— HISTORY key

Display

Press MENU and select Menu tab > Display > HISTORY Key action.
i 14 SE@eeniEET(S)

HISTORY Kew action

Action Favorite

Group display Saved

Time axis zoom Saved

e HISTORY key action > Action

uoneinBbiyuoy Aejdsig n

Setting Description
History Switches to the historical trend display when the key is pressed.
Favorite Switches to the favorite display that you registered when the key is pressed.

Select Favorite if you want to register favorite displays and switch to them.

* HISTORY key action > Group display

Setting Description
Current Displays a favorite display in the current group.
Saved Displays a favorite display in the group that was selected when you registered

the favorite display.

¢ HISTORY key action > Time axis zoom

Setting Description
Current Displays a favorite display at the current time axis zoom rate.
Saved Displays a favorite display at the time axis zoom rate that was selected when

you registered the favorite display.

Procedure

* Registering Displays
You can register up to eight displays.
1. Switch to the display that you want to register in Operation Mode.

2. Press FUNC.
The function menu appears.
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6.15 Registering Favorite Displays

3. Press the Favorite regist soft key. Then, press a registration number soft key.

4. Press the Regist soft key.
A window opens for you to enter the display name.
* To delete a registration, press the Delete soft key.

5. Enter the display name (up to 16 characters, [Alal#[1]).

6. Press DISP/ENTER.
The display is registered.

» Switching the Display
Press the HISTORY key to switch the displays in the order of their registration.

Pressing the history key after switching to the last registered display will switch the
display back to the original display.
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6.16 Writing a Message When the MV Recovers
from a Power Failure

This section explains how to configure the MV to write a message to the trend display
when the MV recovers from a power failure that occurs during memory sampling.

Display

* Power Recovery Message

MV1000
Press MENU and then select Menu tab > Basic setting mode > Environment tab >

View, Message.

Basic Setting Hode

View

Trend tupe T-%
Partial 0ff
Trend rate switching Ooff
Hesszage

Write group Common

Power-fail message
Chanae message r___6¥¥____

[ on | 0ff |

MV2000
Press MENU and then select Menu tab > Basic setting mode > Environment tab >

View, Message, Input, Alarm.

Basic Setting Mode

Environment > View. Message. Input. Alarn

r View —_— Input
Trend type ¥ (Ualue on over-range Free
off

Partial
Trend rate switching Off ’* Alarm

No logging off

r Hessage

Write group Cormon
Pouer-fai | nessage [IDBLIZINN
Change message Off

* Message > Power-fail message
Setting Description
On Automatically writes a message when the MV recovers from a power failure that
occurs during memory sampling.
Display example: 15:12 Power Off 2008/01/23 15:12:57

Off Disables this function.
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6.17 Changing the Function Menu and the Display
Selection Menu

This section explains how to change the contents of the function menu, which is
displayed when you press the FUNC key, and the display selection menu, which is
displayed when you press the DISP/ENTER key.

Display

¢ Function Menu
Press MENU and then select Menu tab > Menu customize > Function menu.

13}

Number indicating
the display order

Menu name
White Used
Gray: Not used

¢ Display Selection Menu
Press MENU and select Menu tab > Menu customize > Display menu.

Hl ly &=
,; S@eeriEEr(3) )}

Separator
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6.17 Changing the Function Menu and the Display Selection Menu

* Enabling/Disabling the Function Menu Iltems

Menu items that are in white are shown.
1. Press the arrow keys to select a menu item.

2. Press the Hide or Select soft key.
If you press the Hide soft key, the menu item will be displayed in gray and will not appear in
the function menu.

Changing the Displayed Order of Function Menu Items
Menu items are displayed in numeric order. Menu items appear when the
corresponding function can be used.

1. Press the arrow keys to select a menu item.

2. Press the Select soft key.
The menu item is enclosed in a red frame.

3. Press the arrow keys to select the destination.
4. Press the Transfer soft key.

The menu item moves to the selected number position.

Description of the Function Menu Items
For a description of each item, see the respective section.

P Sec.5.1 Sec.6.4 Sec.6.4 Sec.4.4 Sec.4.6

Hanual
zample

Saver d ay

P Sec.4.5 Sec.3.8 Sec.9.8 Sec.4.4 Sec.4.4

P Sec. 4.4 Sec.5.9 Sec.10.4 Sec. 10.4 Sec.10.4

» Sec.7.2 Sec.7.3 Sec.8.1 Sec.8.3 Sec.8.3

Batch A & .:f:_ _I:ll gl

P Sec. 6.3 Sec. 4.3 Sec. 4.3 Sec. 6.15 Sec. 5.11

Swstem Netwark SNTP

info info

P Sec.9.3 Sec.9.3 Comm.* Comm.* Comm.*

» Comm.* P Sec 5.11 (only with the MV2000)

* MV1000/MV2000 Communication Interface User’s Manual

Enabling/Disabling the Display Selection Menu and Submenu
Menu items that are in white are shown.

1. Press the arrow keys to select a menu item.

2. Press the Hide or Select soft key.
If you press the Hide soft key, the menu item will be displayed in gray and will not appear in
the display selection menu.

IM MV1000-01E
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6.17 Changing the Function Menu and the Display Selection Menu

¢ Changing the Display Selection Menu/Submenu Positions
1. Press the arrow keys to select a menu item.

2. Press the Select soft key.
The menu item is enclosed in a red frame.

3. Press the arrow keys to select the destination.

4. Press the Transfer soft key.
The menu item moves to the selected position.

* Showing/Hiding Separators

1. Press the arrow keys to select a menu item.

2. Press the Separate soft key.
A separator (line) is displayed between the current item and the next lower item.
If the separator is already showing, pressing the key hides it.
You can set up to three separators in the display selection menu and each sub-

menu.

¢ Description of the Display Selection Menu and Submenu Items
Iltems with an asterisk are set to Hide by default.

Display Selection
Menu

Submenu

Reference Section

Trend

GROUP 1 to GROUP 10'/GROUP 36°

Section 5.2/6.12

ALL CHANNEL/GROUP CHANNEL

Section 5.2/6.13

AUTO ZONE ON/OFF Section 5.2
SCALE ON/OFF Section 5.2/6.12
FINE GRID ON/OFF Section 5.2
DIGITAL ON/OFF Section 5.2/6.12
MESSAGE DISP 1/2 Section 5.2

TREND SPACE ON/OFF

Sections 5.2 and 6.12

AUTO SCROLL ON/OFF Sections 5.2 and 6.12
EXPAND? Section 5.11
TREND HISTORY GROUP 1 to GROUP 10'/GROUP 36°  Section 5.3
DIGITAL GROUP 1 to GROUP 10'/GROUP 36>  Section 5.2
AUTO SCROLL ON/OFF Section 5.2
EXPAND? Section 5.11
BAR GROUP 1 to GROUP 10'/GROUP 36>  Section 5.2
AUTO SCROLL ON/OFF Section 5.2
EXPAND? Section 5.11
OVERVIEW CURSOR ON/OFF Section 5.4
JUMP TO ALM SUM Section 5.4
JUMP TO TREND Section 5.4
JUMP TO DIGITAL Section 5.4
JUMP TO BAR Section 5.4
EXPAND? Section 5.11
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6.17 Changing the Function Menu and the Display Selection Menu

*

*

Display Selection Submenu Reference Section

Menu

INFORMATION ALARM SUMMARY Section 5.5
MESSAGE SUMMARY Section 5.5
MEMORY SUMMARY Section 5.5
MODBUS CLIENT Section 5.5
MODBUS MASTER Section 5.5
RELAY Section 5.5
REPORT DATA Section 5.5
COLUMN BAR Section 5.6
TO HISTORY Section 5.7/5.8/5.9
TO HISTORY(DISP) Section 5.7/5.8/5.9
TO HISTORY(EV) Section 5.7/5.8/5.9
TO OVERVIEW Section 5.7
CHANGE SORT KEY Section 5.7/5.8
ASCENDING/DESCENDING ORDER Section 5.7/5.8
DATA SAVE MODE Section 5.9
SELECT SAVE Section 5.9
M.SAMPLE SAVE Section 5.9
REPORT SAVE Section 5.9
ALL SAVE Section 5.9
CHANGE DISP ITEM Section 5.8
CHANGE DATA KIND Section 5.9
FILENAME/TIME DISPLAY Section 5.9
CHANGE REPORT CH Section 5.5
DUAL/SINGLE GRAPH Section 5.6
SELECT COLUMN Section 5.6
REPORT GROUP1 to REPORT Section 5.6
GROUP4'/REPORT GROUP6?
EXPAND? Section 5.11

LOG LOGIN Section 5.10
ERROR Section 5.10
COMMUNICATION Section 5.10
FTP Section 5.10
MAIL Section 5.10
WEB Section 5.10
SNTP Section 5.10
DHCP Section 5.10
MODBUS Section 5.10

4 PANEL? MIX Section 5.11
ALL TREND Section 5.11
ALL DIGITAL Section 5.11
ALL BAR Section 5.11

EXPAND? Section 5.11

1 MV1000 only
2 MV2000 onl

IM MV1000-01E
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Chapter 7  Event Action

7.1 Configuring the Event Action Function

Display

This section explains how to configure the MV to execute a specified action when a
given event occurs. This function is called event action. This section also explains how to
configure the remote control function (/R1 option) and the USER key.

P For an explanation of these functions, see section 1.7.

P For event action configuration examples, see appendix 2.

Press MENU and then select Menu tab > Timer, Event action > Event action.

e SEpeen (D) )
Logic box number “

Event Remote
Remote number 1

Action Dizplaviroupthange
Group number 1

(12 13 [ d [lHext L/18

* Logic box number
You can set up to 40 event actions.

* Event

An event is a condition for executing an action.

Setting Description

None —

Remote Select a remote control input terminal number.

Relay Select an alarm output relay number.

Switch Select an internal switch number.

Timer Select a timer number.

Match T A match time timer.
Select a match timer number.

Alarm —

UserKey —

e Action

An action that is executed when an event occurs.

Setting Description

MV1000 MV2000

Memory Memory Memory start/stop

Start Start Memory start

Stop Stop Memory stop

Trigger Trigger An event trigger.
You can specify this when the MV is configured to record
event data.

AlarmACK AlarmACK You cannot specify this when the event is set to Relay,
Switch, or Alarm.

Math Math Computation start/stop. You can specify this on models with
the /M1 or /PM1 option.

MathStart MathStart You can specify this on models with the /M1 or /PM1 option.

MathStop MathStop You can specify this on models with the /M1 or /PM1 option.

MathReset MathReset You can specify this on models with the /M1 or /PM1 option.

IM MV1000-01E
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7.1 Configuring the Event Action Function

Setting Description

MV1000 MV2000

SaveDisp SaveDisplay You can specify this when the MV is configured to
record display data.

SaveEvent SaveEvent You can specify this when the MV is configured to
record event data.

Message Message Set the message number and destination. Set
the message destination to all groups (All) or to a
specific group number.

Snapshot Snapshot —

Rate1/2 DisplayRate1/2 A display rate switch.

You can specify this when trend interval switching is
enabled.

ManualSample

ManualSample

TimerReset TimerReset Arrelative time timer reset.
You cannot specify this when the event is set to
Timer.

Group DisplayGroupChange A display group switch.
Specify the number of the group you want to
display.

Flag Flag A /M1 or /PM1 option.

PanelLoad PanelLoad You can only specify this when the event is set to
Remote.

TimeAdjust TimeAdjust Time adjustment.

You can specify this only when the event is set to
Remote.

IM MV1000-01E



7.2 Setting Timers

You can set timers on the events of the event action function. Timers are also used in
TLOG computation.
P For an explanation of the event action function, see section 7.1.

Display

Press MENU and then select Menu tab > Timer, Event action > Timer.
*  When relative time is selected * When absolute time is selected
GROUP . EBu= () ) O o o3 19:30:5c o= IEEET(O) )}

imer Mo, imer Mo,

Hode Relative Hode Absolute

Interval B1:88 Interval 1h

Reset at Hath Start 0n Ref.time A 84
1 20 | 1 20 |

You cannot change these settings during memory sampling or computation.

e Timer No.
You can set four timers (1 to 4).

When Using a Relative Timer
* Mode
Select Relative.
e Interval
Set the interval in the range of 00:01 (1 minute) to 24:00 (24 hours).
* Reset at Math Start
On: Resets the timer when computation is started. The resetting of the timer is not
considered a timeout. Even if the timer is used as an event, the action is not executed.

When Using an Absolute Timer
* Mode
Select Absolute.
¢ Interval
Set the interval from within the range of available settings (1min to 24h).

* Ref. time
Set the time in the range of hour 0 to hour 23.

IM MV1000-01E 7-3
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7.2 Setting Timers

Procedure

* Resetting a Relative Timer
1. In Operation Mode, press FUNC.
The function menu appears.

2. Press the Timer reset soft key.

3. Press the timer soft key that you want to reset. Select All to reset all timers.
The relative timer is reset.

Explanation

* Resetting a Relative Timer
Restart the timer.
» The resetting of the timer is considered a timeout. (If the timer is used as an event,
the action is executed.)
» If the timer is used in TLOG computation (/M1 and /PM1 options) and MathReset is
specified, the computed result is reset.
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7.3 Setting the Match Time Timer

Display

You can set the time match condition that is used for the event action function. These
timers are also used in TLOG computation.
P For an explanation of the event action function, see section 7.1.

Press MENU and then select Menu tab > Timer, Event action > MatchTimeTimer.

o o= I ()

Timer number
Kind ear
Honth JAN
Daw 1
Hour:iHinute e aa
Timer action Repeat

1 20 |

You cannot change these settings during memory sampling or computation.

e Timer number
You can set four match time conditions (1 to 4).

e Kind
Setting Description
Day Sets the time match condition for a day.
Week Sets the time match condition for a week.
Month Sets the time match condition for a month.
Year Sets the time match condition for a year.

Set the items with check marks in the following table according to the Kind setting.
Settings Kind

Day Week Month Year
Month 4
Day v v
Day of the week v
Hour:Minute v v v v

* Month

Set the month.
e Day

Set the day.

¢ Day of the week
Set the day of the week.

¢ Hour:Minute
Set the time in the range of 00:00 to 23:59.

e Timer action
Setting Description
Single Executes the action once when the condition is met.
You can reset a timer by pressing FUNC after the timer expires.
Repeat Executes the action each time the condition is met.

IM MV1000-01E
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7.3 Setting a Match Time Timer

Procedure

Explanation

* Resetting a Match Time Timer

1. In Operation Mode, press FUNC.
The function menu appears.

2. Press the Match T Reset soft key.

3. Press the match time timer soft key that you want to reset.
The match time timer is reset.

* Resetting a Match Time Timer
A match time timer becomes inactive after it times out. You can reset an inactive
match time timer to activate it again.
* The resetting of the timer is not considered a timeout.
» Resetting of a timer affects a match time timer whose time action is set to Single.
 |If the timer is used in TLOG computation (/M1 and /PM1 options) and MathReset is
specified, the computed result is reset.

IM MV1000-01E



I 7.4

Using the Remote Control Function (/R1
option) and the USER Key

You can use the event action function to set remote control and USER key inputs as
events that will trigger actions.

For event action configuration instructions, see section 7.1.

For a configuration example, see appendix 2.

IM MV1000-01E
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7.5

Using an Alarm, Output Relay, or Internal
Switch

You can use the event action function to set alarms, output relays, or internal switches as
events that will trigger actions.

For event action configuration instructions, see section 7.1.
For a configuration example, see appendix 2.
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Chapter 8  Security Features

8.1 Disabling the Keys (key lock function)

This section explains how to disable the keys.
P For an explanation of this function, see section 1.8.

Display

* Selecting the Key Lock Function
Mv1000
Press MENU and then select Menu tab > Basic setting mode > Environment tab >
Security, Media save.

Basic Setting Hode

Security

Key c

Communication Ooff

Save

Auto save On

Hedia FIFO Off
MV2000

Press MENU and then select Menu tab > Basic setting mode > Environment tab >
Security, Media save, Batch.

r Security
Key
Connunication off %
(2]
r Save E
Auto save On 02'
Hedia FIFQ off -
[]
- Batch Q
c
On/0ff off =
[1]
(7]

0ff Login | Keylock

* Disabling Keys
MVv1000
Press MENU and then select Menu tab > Basic setting mode > Menu tab > Keylock
> Password, Key action, Media or Action of Function.

t t . a
Basic Setting Hode Lt Basic Setting Hode

Password m Action of Function
kew action AlarnAc
START/STOP [ Fres Hessage / Batch Free
HISTORY Free it En | Free
HEHL [ Fres Data zave Free
|USER [ Fres E-mail # FTP Free
DISP/ENTER Free Uime s | Free
T/OIY [ Fres Display Function Free
Hedia/USE
External media Free
Load settings Free
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8.1 Disabling the Keys (key lock function)

MV2000
Press MENU and then select Menu tab > Basic setting mode > Menu tab >
Keylock.

Basic Setting Hode

r Keylock

Password

Key action
START/STOP
HISTORY
MENU
USER
DISP/ENTER
T/DIV

Hedia/USB
External media
Load settings

]

Free
Free
Free
Free
Free
Free

[ Free
Free—

Free

Action of Function
AlarmACK

Message / Batch
Math

Data save

E-mail 7 FTP
Tine set

Display Function

Free
Free
Free
Free
Free
Free

Free

* Security > Key

Select Keylock.

Setting Description

Keylock Enables the key lock function. The Keylock item appears in the Basic
Setting Mode menu.

Login Enables the login function. See section 8.2 for details.

e Password

The password used to release the key lock (Up to eight characters, [Alal#]1])

The MV displays “********” for the password.

* Key action, External Media, and Action of Function

Select whether or not to lock each item.

Setting Description
Free Does not lock the item.
Lock Locks the item.

8-2
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8.1 Disabling the Keys (key lock function)

Procedure

* Locking the Keys

1.

2.

In Operation Mode, press FUNC.
The function menu appears.

Press the Keylock soft key.
The key lock function is enabled. The key lock icon appears in the status display section.

* Releasing the Key Lock Function

1.

In Operation Mode, press FUNC.
The function menu appears.

Press the Keylock soft key.
A window prompting for the password opens.

Enter the password, and press DISP/ENTER.
The key lock is released. The key lock icon disappears from the status display section.

IM MV1000-01E
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8.2 Allowing Only Registered Users to Operate the
MV (login function)

Display

This section explains how to configure the MV so that only registered users can operate
the MV.
P For an explanation of this function, see section 1.8.

* Login Function

MV1000
Press MENU and then select Menu tab > Basic setting mode > Environment tab >

Security, Media save.

Basic Setting Hode

Security
ey
Communication Loain
Save
Auto save On
Hedia FIFO Off
fiewlock
MV2000

Press MENU and then select Menu tab > Basic setting mode > Environment tab >
Security, Media save, Batch.

Basic Setting Hode

Environment > Security, Hedia save. Batch

Security E—
(Keu

Connunication Login
Save

(nuto save off
Batch —

{Onlﬂff off

0ff Login | Keylock

Logout Method
Press MENU and then select Menu tab > Basic setting mode > Menu tab > Login >
Basic settings.

Basic Setting Hode

User basic settinas

Auto Togout
Operation without Login Off

L off | lnin | Znin_| Snin_[| 18nin_|
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8.2 Allowing Only Registered Users to Operate the MV (login function)

* Registering an Administrator
Press MENU and then select Menu tab > Basic setting mode > Menu tab > Login >
Admin settings.

Admin number
Hode ey
User name Adminl
Pazzword P S22

T O N -

* Registering a User (user-level user)
Press MENU and then select Menu tab > Basic setting mode > Menu tab > Login >
User settings.

User number

Hode ey

User name Userl

Pazzword PR s s

Authority of user Off
1 20 |

e User Privileges
MV1000

(7]
Press MENU and then select Menu tab > Basic setting mode > Menu tab > Login > 3
. . . . . c
Authority of user > Key action, Media or Action of Function. =
<
Basic Setting Hode Basic Setting Hode o
Authority of user Authority of user gﬂ
kew action Action of Function 3
START/STOP Free AlarmACK Free (]
HISTORY Free Hessage / Batch Free
HEMU Free Hath Free
USER Free Data zave Free
DISP/ENTER Free E-mail # FTP Free
TADIY Free Time set Free
HediaslSE Display Function Free
External media W
Load settings W
I BT NN [ 1 20 |
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8.2 Allowing Only Registered Users to Operate the MV (login function)

MV2000
Press MENU and then select Menu tab > Basic setting mode > Menu tab > Login >
Authority of user.

Authority of user

r Authority of user
Key action fAction of Function
START/STOP Free AlarnACK Free
HISTORY Free Hessage / Batch Free
HMENU Free Hath Free
USER Free Data save Free
DISP/ENTER Free E-nail / FTP Free
T/DIV Free Tine set Free
HediasUSB Display Function Free
External media [ Free
Load settings Free

Input +1 =

You can specify different login settings for logins through keys and logins through
communications.

Security > Key

Select Login.

Setting Description

Login Allows only registered users to operate the MV by using keys. The Login
item appears in the Basic Setting Mode menu.

Keylock Enables the key lock function. See section 8.1 for details.

Off Disables security features.

Security > Communication

Setting Description

Login Only allows registered users to operate the MV via a communication
interface. The Login item appears in the Basic Setting Mode menu.

Off Disables security features.

User basic settings > Auto logout

Setting Description
Off Does not log out until you manually log out.
1min to 10min Automatically logs out when there is no key operation for a specified time.

User basic settings > Operation without login
Sets the operations that a user can carry out when logged out.

Setting Description
Off Only allows a user to log in.
Display Allows a user to log in or switch the operation screen.

Admin number
You can register up to five administrators. Be sure to register at least one

administrator. You can only use the login function when there is at least one registered

administrator.

8-6
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8.2 Allowing Only Registered Users to Operate the MV (login function)

e Admin number > Mode
The available settings vary depending on the Security setting.

Setting Description

Off No registration.

Key Allows login through keys.

Comm Allows login through a communication interface.

Web Allows login to the MV operator page and monitor page from a Web browser.

Key+Comm Allows login through keys and through a communication interface.

e Admin number > User name
Set the user name (up to 20 characters, [Alal#]1]).
* You cannot register a user name that is already registered.
* You cannot register “quit” or a user name containing only spaces.

e Admin number > Password
Set the password (up to eight characters, [Ala[#]1]).
The default password is a string of question marks (???????7?). When you set a
password, the MV displays a string of asterisks (********).
» You cannot register “quit” or a password containing only spaces.

e User number
You can register up to 30 users.

e User number > Mode
The available settings vary depending on the Security setting.

Setting Description

Off No registration.

Key Allows login through keys.

Comm Allows login through a communication interface.

Web Allows login to the MV monitor page from a Web browser.

Key+Comm Allows login through keys and through a communication interface.

e User number > User name and Password
See the explanation for the administrator user name and password.

¢ User number > Authority of user

Setting Description
Off Does not limit operations.
11010 An operation limitation registration number.

¢ Authority of user, Key action, Media/USB, and Action of Function
Select the “authority of user” preset number from 1 to 10.
P See section 8.1 for details.
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8.3 Logging in and Logging Out

Procedure

This section explains how to log into the MV by using keys. For instructions on how to
operate the MV via a communication interface, see the Communication Interface User’s
Manual (IM MV1000-17E).

* Logging In
1. In Operation Mode, press FUNC.
A list of registered user names appears.

ol))

I.f,wJ DISF

()

B/18 16:10: 168

Userl

2. Press the arrow keys to select a user name, and press DISP/ENTER.
A window opens for you to enter the password.

3. Enter the password,* and press DISP/ENTER.
The MV is ready for key operation. The status display section shows the logged-in user

name.
* The password that you enter appears as a string of asterisks (********).

* Logging Out
Logging Out Using Keys
1. In Operation Mode, press FUNC.
The function menu appears.

2. Press the Logout soft key.
The MV logs you out. The user name disappears from the status display section.

Auto Logout
If auto logout is enabled, the MV will automatically log you out if you do not operate

the keys for a specified time.

IM MV1000-01E



8.3 Logging in and Logging Out

¢ Changing the Password
Procedure Using Keys

1.

In Operation Mode, press FUNC.
The function menu appears.

Press the Password change soft key.
A window prompting for the current password opens.

Enter the current password, and press DISP/ENTER.
A window prompting for a new password opens.

Enter a new password, and press DISP/ENTER.
A window opens for re-entering the new password.

Enter the new password, and press DISP/ENTER.
The window closes, and the new password is activated.

IM MV1000-01E

sainjea Ajunoeg H



Chapter 9  Environment Settings

9.1 Setting the Date and Time

This section explains how to set the date and time. If you are using the MV in a region

that uses DST, specify the date and time for switching between DST and standard time.

Setting the Date and Time

Display

¢ Date and Time
Press MENU and then select Menu tab > Date/Time.

Guick Heru | File |

Heas channel »

Hath channel »

Data save »

Displ:

Group

Hezsa:| ea

Timer EEFETFEg_TETEETEEE

Henu {

Basic setting mod Dawlisht Saving Time

Time set
Enter the date and time, and press DISP/ENTER.

Configuring Daylight Saving Time

Display
e DST
Press MENU and then select Menu tab > Date/Time > Daylight Saving Time.

==
; GEg=oriE(S)

Davlight savinas time

Uses/Hot
Start time : Honth HAR
Day order 2nd
Day of the week SUN
Hour of the daw 2
End time i Honth HoW
Day order 1st
Day of the week SUN
Hour of the daw 1
* Use/Not
To enable the DST function, select Use.
e Start time

Specify the date/time to switch from standard time to DST. Set the month, the nth
week, the day of the week, and the time.

* End time
Specify the date/time to switch from DST to standard time. Set the month, the nth
week, the day of the week, and the time.

IM MV1000-01E 9-1
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9.1 Setting the Date and Time

Other Time Settings
Set the time zone of the region where the MV will be used, the time correction operation
during memory sampling, and the date format. Be sure to set the time zone if you are
using Ethernet network functions.

Display

Press MENU and then select Menu tab > Basic setting mode > Menu tab > Time
settings.

Basic Setting Hode

Time settings

Time zane (HHHH?
Time deviation limit 38z
Date format ¥ AHAD

* Time settings > Time zone (HHMM)
Set the time zone of the region where the MV will be used in terms of the time
difference from GMT. Specify a value in the range of —1300 to 1300 (where the first
two digits denote the hour and the last two digits denote the minute). A negative value
indicates that the local time is behind GMT.
Example: The standard time in Japan is ahead of GMT by 9 hours. In this case, enter
900.

* Time settings > Time deviation limit

Current time ¢—‘.‘7pecified time
|

|

| |

| —)
[Time deviation limit |

When the time deviation between the time on the MV and the specified time is within
*(the value specified here), the time on the MV is gradually corrected. Otherwise, the
time is corrected immediately.

Setting Description
10s to Smin The time deviation limit.
Off Disables gradual time correction.

Example: If Time deviation limit is set to 10s and the time on the MV is 10 hours 21
minutes 15 seconds, the time is gradually corrected if the specified time
is between 10 hours 21 minutes 5 seconds and 10 hours 21 minutes 25
seconds.
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9.1 Setting the Date and Time

¢ Time settings > Date format

Setting Example for Jan. 23, 2008 Time displayed at the grid position
of the trend display (if the time is 7:00
on Jan. 23)*

Y/M/D 2008/01/23 01/23 07

M/D/Y 01/23/2008 01/23 07

D/M/Y 23/01/2008 23/01 07

D.M.Y 23.01.2008 23.01 07

* Only when the trend interval is set to a value greater than or equal to 1h/div.

Where the Date Format Setting Applies

The date format is applied to the date shown on the display. It does not affect the date
format on the date/time configuration screen, the date in the output data transmitted

via a communication interface, the date information saved along with data, or the date
used in data file names.

IM MV1000-01E
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9.2 Setting the Temperature Unit and Decimal
Point Type

Display

This section explains how to set the temperature unit and how to set the type of decimal
point that is used on the display and in data files saved to text format.

Press MENU and then select Menu tab > Basic setting mode > Environment tab >
Operating environment.

Basic Setting Hode

Operating environment

Tag/Channel Tag
Lanauage Enalish
Temperature 0

Decimal Point Twpe

| Foint | Conna |

¢ Temperature
Select the temperature unit. This setting affects all temperature measurement
channels.

Setting Description
C For Celsius
F For Fahrenheit

* Decimal Point Type

Setting Display Example
Point 1234.56
Comma 1234,56
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9.3

Procedure

Explanation

Viewing MV Information

This section explains how to display the MV system information and network information.

¢ Displaying System Information

1. In Operation Mode, press FUNC.
The function menu appears.

2. Press the System info soft key.
The system information is displayed.
* Displaying Network Information

1. In Operation Mode, press FUNC.
The function menu appears.

2. Press the Network info soft key.
The network information is displayed.

¢ System Information Screen

§go T () )

L4 HaTH: 12 rANALOG: Number of measurement channels
HEHORY: 2RaHE (C) denotes the clamped input
OPTION: terminals (/H2 option).

Egﬁggg“ Eﬁ?g MATH: Number of math channels
ALARH ¢ SPECIAL INPUT i
FAIL/STATUS AL CORRECT (/M1 and /PM1 Opt'(?ns)
REHOTE EXTCH: Number of external input channels
- (/MC1 option)
FRODUCT: o
e oridress MO0 QuniBle ™1 | Li— MEMORY: Internal memory size
OPTIONS
MAC address
Version: Firmware version

¢ Network Information Screen
The screen displays the following MV settings.
IP address, MAC address, DNS server, host name, and domain name

o I (O) M

IF address

1 192,168, 1,188
Subnet mask 255,255,255, @
Default gatewaw @ 192,168, 1. 1A

HAG address 1R R )

DNS zerver
Primary 1 192,168, 1. 28
Secondary 1 192,168, 1. 3@
Host name

HHHHEETHEL

Domain name
o et

IM MV1000-01E
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9.4 Changing the Displayed Language

This section explains how to select the displayed language.

Display

Press MENU and then select Menu tab > Basic setting mode > Environment tab >
Operating environment.

Basic Setting Hode

Operating environment

Tag/Channel Tag
Language English
Temperature G

Decimal Point Twpe Foint

English Japanese

* Operating environment > Language
Set the language to English, Japanese, German, French, Chinese, or Korean.

IM MV1000-01E



9.5 Initializing the MV

Display

Procedure

This section explains how to initialize the MV and how to clear the internal memory.
P For a list of default settings, see the First Step Guide (IM MV1000-02E/IM MV2000-
02E).

Press MENU and then select Menu tab > Basic setting mode > Initialize tab > Clear
settings and data or Clear data only.

Basic Setting Hode

Erwi ronment: ] Henu ] Initialize ]

(lear zettings and data
Glear data onlw

¢ [nitialization Method

Menu Item Description

Clear settings and Initializes the settings in Basic Setting Mode and Setting Mode to their
data default values and clears the data in the internal memory.

Clear data only Clears the data in the internal memory.

Data in the Internal Memory That Is Cleared
Display data, event data, manually sampled data, report data (/M1 and /PM1 options),
and log information.

1. Select Clear settings and data or Clear data only.

2. Press DISP/ENTER.
A confirmation window opens.

3. Select Yes, and then press DISP/ENTER.
The specified operation is executed, and the MV returns to Operation Mode.
If you do not want to initialize, select No, and press DISP/ENTER.

IM MV1000-01E
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9.6 Transmitting the MV Status via Relay Contact
(/F1 option)

This section explains how to configure the MV to transmit a relay contact signal when an
error occurs in the MV CPU. It also explains how to configure the MV to transmit a signal
to another relay when a specific condition occurs.

P For an explanation of these functions, see section 1.10.

Display

Press MENU and then select Menu tab > Basic setting mode > Menu tab > Status
relay.

Status relav

Hemorw/Hedia status “

Heasurement error 0ff
Communication error 0ff
Hemory stop Ooff

[ on | 0ff |

¢ Memory/Media status
On: Transmits the internal memory and CF card statuses to a relay.

* Measurement error
On: Transmits a relay signal when a measurement error occurs.

e Communication error
On: Transmits a relay signal when a communication error occurs.

* Memory stop
On: Outputs a relay signal when memory sampling is stopped.

Procedure

¢ FAIL Output
No settings or operations are required. The MV transmits a relay contact signal if it
detects a CPU error. The MV also transmits a relay contact signal when the MV is
turned OFF.

¢ Status relay
The MV transmits a relay contact signal when a specified condition occurs.
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9.7

Controlling the MV by Using a Keyboard

Connecting/Removing a Keyboard

e Connecting a Keyboard
Connect the keyboard connector to the MV USB port.
The message “USB device has been connected” appears on the screen, and the
keyboard is ready for use.
Front panel USB port Rear panel USB port

I kL:JJ@{

i— @
a® )

* Removing the Keyboard
Remove the keyboard connector from the MV USB port.

Nofte
* You can connect or remove a keyboard regardless of the MV condition (power ON/OFF or
displayed screen).
* You can connect one keyboard to the MV.
* Use a keyboard appropriate for the MV language setting.
» The CapsLock and NumLock key states are retained even if you disconnect the USB
keyboard.

IM MV1000-01E
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9.7 Controlling the MV by Using a Keyboard

Operating from a Keyboard

You can carry out the same operations that you carry out from the MV front panel.

Example: Switch to Setting Mode

While the MV is in Operation Mode, press Ctrl+M.

The MV switches to Setting Mode, and the corresponding menu appears.

Mapping of the MV Keys to the Keyboard Keys

Keyboard Keys MV Keys
Enter DISP/ENTER
— Left arrow key
1 Up arrow key
I} Down arrow key
— Right arrow key
Num Enter DISP/ENTER
Esc ESC
F1to F7 Soft keys 1 through 7
F9 FUNC
F12 Hold down FUNC for 3 seconds
Left-Windows MENU
| Right-Windows MENU
Application HISTORY
Ctrl+S START/STOP
Ctri+T T/DIV
Ctri+U USER
Ctrl+M MENU
Ctrl+H HISTORY
Tab, Shift+Tab Arrow keys*

*

This does not work in the following screens:
Operation screens, the Setting mode and Basic setting mode menus, screens for entering
values and characters, the “Menu customize” and “Save/Load” screens in Setting mode,

and the “Load setting, Initialize” screen in Basic setting mode

Entering Alphabetical Characters, Numbers, and Symbols

Press Tab to move the cursor to the next item or Shift+Tab to move to the previous item.

When alphabetical characters, numbers, and symbols can be entered, you can enter
them from the keyboard. The operation is the same as with normal keys.

Symbols You Can Enter from a Keyboard

You can enter the symbols below. However, only the symbols that are valid on the MV
can be used. For example, you cannot use the following characters for the data save

destination directory name: & */: ?

)
% *

| n

AEENIE

IKE

?

~

e ]

*

Invalid Keys
Keys enclosed in a frame are invalid.

PC104 keyboard (US)

Press # on the keyboard to enter the degree symbol.

9-10
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9.8 Setting the LCD Brightness and Backlight
Saver

Display

This section explains how to change the LCD brightness. It also explains how to set the
backlight saver function to prolong the service life of the LCD backlight.

MV1000
Press MENU and then select Menu tab > Display > LCD.

o g (O] )

Brightness “

Backlight saver

Hode Dimmer

Saver time 1h

Restore KewtAlm
1 20 |

MV2000
Press MENU and select Menu tab > Display > Trend, Bar graph, LCD, Monitor.

ALARM SUMHARY =
AR s God EvENT N 1o ()

Display > Trend, Bar graph, LCD, Honitor

Trend — r LCD —
Direction Wide Brightness “
Trend clear On Backlight saver
Hessage direction Horizontal Hode Dimmer
Scale Saver time 1h

Digit Nornal Restore KeytAln
Value indicator Hark
Trend line 2 dot _ Honi tor
Grid Auto div
Backaround
Brp ieelh Display WUhite
Historical trend Black
’]Jirection Vertical Seroll time 18s
Junp default display off

* Brightness
The larger the value, the brighter the display becomes.

Setting Model
1t08 MV1000
1t06 MV2000

* Backlight saver > Mode

Setting Description

Off Disables the backlight saver.

Dimmer Dims the display if there is no operation for a given time.
Timeoff Turns the backlight OFF if there is no operation for a given time.

IM MV1000-01E
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9.8 Setting the LCD Brightness and Backlight Saver

Procedure

¢ Backlight saver > Saver time
Select a value from 1min to 1h. If the specified time elapses without any key operation
or alarm occurrence, the LCD backlight switches to the specified mode.

* Backlight saver > Restore

Setting Description

Key The backlight returns to the original brightness when a key is
pressed.

Key+Alm The backlight returns to the original brightness when a key is

pressed or when an alarm occurs.

Nofte
» If the backlight is dimmed or turned OFF by the backlight saver function, pressing any key
on the MV will cause the backlight to return to the original brightness. In this instance, the

key does not perform its intended function.

» Ahigher brightness level tends to lead to faster screen discoloration (yellowing) and
brightness degradation. Avoid extended use at an unnecessarily high setting. We also
recommend that you use the backlight saver function.

If you set the mode to Dimmer or Timeoff, you can execute the specified operation at any
time by pressing FUNC and selecting LCD saver.

9-12
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Chapter 10 Computation and Report Functions (/M1 and /PM1 options)

10.1 Configuring Computation Channels

This section explains how to set a computation channel’s expression, measurement
range, tag, alarm, and recording On/Off. You cannot set expressions or constants during
memory sampling or computation.

P For an explanation of these functions, see section 1.9.

Display

* Expressions and Alarms
Press MENU and then select Menu tab > Math channel > Expression, Alarm.

=
.., Ggg=ormETT (O]

First-CH: Last-CH: 181
Hath an
Calculation expression
p1
Span Lower Span Upper Unit
[ -2ee.88 [ 2ee.08 |
Alarm
1 Off
2 Off
3 Off
¢ [off

¢ Constants Used in Expressions
Press MENU and then select Menu tab > Math channel > Constant.

2.5 o (D)
Number of constant K@l

Walue 1

e Computation Channel Tag, Memory Sampling On/Off, Alarm Delay
MVv1000
Press MENU and then select Menu tab > Math channel > Tag, Memory, Delay.

MV2000
Press MENU and then select Menu tab > Math channel > Tag, Memory sample,
Alarm delay.

[
- EBeerETTa(C)

First-cH: J:b)  Last-CH: 181
Tag

Characters

Hemory sample

On/fOff On

Alarm delay

Time 18 =
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10.1 Configuring Computation Channels

¢ TLOG Computation Conditions, Rolling Average
Press MENU and then select Menu tab > Math channel > TLOG, Rolling average.

First-CH: Last-CH: 181
TLOG
Timer tvpe Timer
Timer Mo, 1
Sum scale 0ff
Reset 0ff
Rolling average
Ons0ff On
Interval 18s
Humber of samples 1

e Computation Error Display, Overflow Data Handling in Statistical
Computation
Mv1000

Press MENU and then select Menu tab > Basic setting mode > Environment tab >
Math.

Basic Setting Hode

Hath
VYalue on Error

VYalue on Owverflow

SUH, AYE Skip
HAX, MIN. P-P Over

MV2000
Press MENU and then select Menu tab > Basic setting mode > Environment tab >
Math, Report.

Basic Setting Hode

r Hath

Value on Error
Value on Ouerflow

SUH, AVE Skip
HAK. HIN, P-P Ouer

r Report
Report select
fAve
2 Hax
3 Hin
[ Sunm
File type Separate

+ver ~Over
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10.1 Configuring Computation Channels

¢ First-CH, Last-CH
Select the target channels.

¢ Calculation expression, span

¢ Math On/Off
Select On for channels that you want to use.

¢ Calculation expression
Set the expression by using up to 120 characters.
P For instructions on how to write expressions, see section 10.2.
MV1000
Press the Input soft key to open a window for entering an expression.
Press the M1/M2 soft key to switch between a screen used to enter values and
characters and a screen used to enter operators and functions. Use soft keys,
arrow keys, and DISP/ENTER to enter an expression.

== ==
17:45.00_ R0=o Y (S) =0T (O)

MV2000
Press the Input soft key to open a window used to enter an expression.

GROLP 1 &
Sotanl 20 52025 el EVENT I thor (S
Hath channel > Calculation expression, Alarm

First-CH [
Hath

Math On/0f
Calculatio

Span_Lower
-208. 8¢

r Hath

1 [off]
2 [off]
3 [off
4 [Off

Space Del Bs Ins m
Nofte

You cannot simultaneously use a USB keyboard and the keys on the MV to enter an
expression. If you press an MV soft key while entering an expression from a USB keyboard, the
expression will be cleared.

IM MV1000-01E 10-3

(suondo LNd/ pue LIN/) suoioung Joday pue uoieindwo) E



10.1 Configuring Computation Channels

¢ Span Lower, Span Upper
Set the measurement range.

Selectable range of values: —9999999 to 99999999
Selectable decimal places: X.XXXX, XX. XXX, XXX.XX, XXXX.X
e Unit
Set the unit for the computed values (up to six characters, [Ala[#[1]).

Alarm

The available alarm types are high limit alarm, low limit alarm, delay high limit alarm,
and delay low limit alarm.

The range of alarm values is as follows:

Type Alarm Values
H LTt —9999999 to 99999999 ignoring the decimal point

P For alarm configuration instructions, see section 3.7.

*

If you change the On/Off or expression setting of a computation channel, the alarm on that
channel will be set to Off.

Alarm delay > Time
Set the alarm delay using an integer in the range of 1 s to 3600 s.

Tag > Characters
Set the tag name (up to 16 characters, [Ala[#[1]).

Constant

¢ Number of constant
Select the constant (K01 to K60) you want to set.

e Value
The selectable range is as follows:
—9.9999E+29 to —1.0000E-30, 0, 1.0000E-30 to 9.9999E+29
The number of significant digits for constants is five. If you are setting a constant in
exponential notation, use up to five digits for the mantissa and up to two digits for
the exponent.

TLOG
e Timer type
Set the timer type to Timer or MatchTimeTimer.
¢ Timer No.
Select the timer number that you want to use.
P For timer configuration instructions, see section 7.2.
P For instructions on how to set the match time timer, see section 7.3.

e Sum scale
Select the sum scale from /s to /h to match the time unit of the measured value.
Example: If the unit of the measured value is m3/min, select /min.
Off: Directly sums the measured data for each scan interval.
* Reset
To reset the TLOG computed value after each interval, select On.

10-4
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10.1 Configuring Computation Channels

* Rolling Average

* On/Off
To calculate the rolling average of the computed results, select On.

* Interval
Select the sampling interval for the rolling average from the available settings. The
sampling interval takes on a value that is an integral multiple of the scan interval.
For example, if the sampling interval is set to 5 s when the scan interval is 2 s, the
actual sampling interval is 6 s.

* Number of samples
Set the number of samples to use for the rolling average using an integer between
1 and 1500.
The rolling average time is equal to the sampling interval x the number of data
samples.

Nofte

« If the number of data points to be averaged has not reached the specified number
of samples immediately after computation starts, the average of the available data is
calculated.

« Computation error data is excluded from the rolling average computation.

« If the computed data exceeds the upper or lower limit, the data is clipped at the upper or
lower limit, and the rolling average is computed. The upper and lower limits are 100000000
ignoring the decimal point. The decimal place is the same as that of the span lower limit.

* Memory sample > On/Off
Select On to record the computed data of the target channels.

¢ Math
¢ Value on Error
Specify whether to display a computation error as +Over or —Over.
¢ Value on Overflow > SUM, AVE
Specify how to handle overflow data when it is detected in a SUM or AVE
computation of TLOG or CLOG. This setting is also applied to report generation.

Setting Description

Error The computed result is a computation error indication.

Skip Discards the overflow data and continues the computation.

Limit Uses a limit value in place of the overflow data and continues the
computation.

¢ Value on Overflow > MAX, MIN, P-P
Specify how to handle overflow data when it is detected in a MAX, MIN, or P-P

computation of TLOG or CLOG. This setting is also applied to report generation.

Setting Description
Over Uses the overflow data as-is.
Skip Discards the overflow data and continues the computation.
IM MV1000-01E 10-5
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10.2 Writing Expressions

This section defines expressions and explains how to write them.

Common Items

Follow the rules below when writing expressions.

Use up to 120 characters to write expressions.

Use parentheses to indicate the order of mathematical functions.

Specify channels in an expression using channel numbers.

Examples: 1, 12, 101, and 201

You can write the one digit numbers of constants (K), communication input data (C),
remote input terminal statuses (D), pulse inputs (P, Q), internal switch statuses (S),
alarm output relay statuses (), and flags (F) in an expression using two digits or one
digit. For example: 01 or 1.

Examples: K01, K1, C01, C1, D01, D1, P01, P1, Q01, Q1, S01, S1, 101, I1, FO1, and F1
Be aware that the data of the previous scan is used for the computation channel’s
value and for the values of channels with numbers that are greater than the
computation channel’s number.

Write special computations (HOLD, RESET, and CARRY) and conditional expressions
at the beginning of an expression.

Order of Precedence for Computations
The order of precedence for computations in an expression is as follows:

Type Operators and Functions
(High order of precedence)
Functions ABS(), SQR(), LOG(), LN(), EXP(), TLOG.MAX(), TLOG.MIN(),

TLOG.AVE(), TLOG.SUM(), TLOG.P-P(), CLOG.MAX(), CLOG.
MIN(), CLOG.AVE(), CLOG.SUM(), CLOG.P-P()

Special computations and conditional expressions

PRE, HOLD, RESET, CARRY, [a?b:c]

Power **

Logical negation NOT

Multiplication and division * !

Addition and subtraction +, -

Greater than and less than .GT,, .LT,, GE., LE.
Equal and not equal .EQ., .NE.

Logical product AND

Logical sum and exclusive logical sum OR, XOR

(Low order of precedence)

Limitations
Expressions have these limitations.

Expression Limitations

TLOG computation  An operator or function cannot be written inside the parentheses.

An expression can contain only one TLOG function.

CLOG computation  The maximum number of channels that can be written in the parentheses is 30.

An operator or function cannot be written inside the parentheses.
An expression can contain only one CLOG function.

PRE An operator or function cannot be written inside the parentheses.
HOLD(a):b Can only be written at the beginning of an expression.

An expression can contain only one HOLD function.
RESET(a):b Can only be written at the beginning of an expression.

An expression can contain only one RESET function.
CARRY(a):b Can only be written at the beginning of an expression.

An expression can contain only one CARRY function.

Only TLOG.SUM can be specified for b.
Conditional RESET, CARRY, and HOLD cannot be specified for a, b, and c.

expressions [a?b:c]  Conditional expressions cannot be combined with other operators or functions ([a?b:

c]+001 for example). However, a conditional expression can be specified for a, b, and c.

10-6
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10.2 Writing Expressions

Basic Arithmetic

Expression Example
+ Addition 001+002
(Determines the sum of the measured values of channel 1 and channel 2)
» Subtraction 001-002
(Determines the difference between the measured values of channel 1
and channel 2)
* Multiplication 001*K03
(Multiplies the measured value of channel 1 by constant K0O3)
+ Division 001/K02
(Divides the measured value of channel 1 by constant K02)

Power and Other Operations

Expression Example
+ Power 001**002
(Determines the measured value of channel 1 to the power of the
measured value of channel 2)
« Square root SQR(002)
(Determines the square root of the measured value of channel 2)
» Absolute value ABS(002)
(Determines the absolute value of the measured value of channel 2)
+  Common logarithm LOG(001)
(Determines the common logarithm (logw) of the measured value
of channel 1)
* Natural logarithm  LN(001)
(Determines the natural logarithm of the measured value of
channel 1)
+ Exponent EXP(001)
(Determines e to the power of the measured value of channel 1)

Relational Computation

Expression Example

002.LT.003
If the measured value of channel 2 is less than the measured value of channel 3, the
computed result is 1. Otherwise, the result is zero.

002.GT.003
If the measured value of channel 2 is greater than the measured value of channel 3, the

computed result is 1. Otherwise, the result is zero.

002.EQ.003
If the measured value of channel 2 is equal to the measured value of channel 3, the

computed result is 1. Otherwise, the result is zero.

002.NE.003
If the measured value of channel 2 is not equal to the measured value of channel 3, the
computed result is 1. Otherwise, the result is zero.

002.GE.003
If the measured value of channel 2 is greater than or equal to the measured value of

channel 3, the computed result is 1. Otherwise, the result is zero.

002.LE.003
If the measured value of channel 2 is less than or equal to the measured value of channel 3,
the computed result is 1. Otherwise, the result is zero.

IM MV1000-01E
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10.2 Writing Expressions

Logical Computation
Checks whether the two data values, e1 and e2 (e1 only for NOT), are zero or nonzero,
and computes according to each condition.

AND
Logical product
(Syntax) e1ANDe2
(Condition) If the two data values e1 and e2 are both nonzero, the computed result
is 1. Otherwise, it is zero.
(Explanation) e1=0,e2=0 — e1ANDe2 =0
e1#0,e2=0 — e1ANDe2 =0
e1=0,e2#0 — e1ANDe2 =0
e1#0,e2#0 — e1ANDe2 =1
OR
Logical sum
(Syntax) e10Re2
(Condition) If the two data values e1 and e2 are both zero, the computed result is
zero. Otherwise, it is 1.
(Explanation) e1=0,e2=0 — e10Re2=0
e1#0,e2=0 — e1ORe2 =1
e1=0,e2#0 — e10Re2 =1
e1#0,e2#0 — e1ORe2 =1
XOR
Exclusive OR
(Syntax) e1XORe2
(Condition) If the two data values e1 and e2 are zero and nonzero or nonzero and
zero, the computed result is 1. Otherwise, it is zero.
(Explanation) e1=0,e2=0 — e1XORe2 =0
e1#0,e2=0 — e1XORe2 =1
e1=0,e2#0 — e1XORe2 =1
e1#0,e2#0 — e1XORe2 =0
NOT
Logical negation
(Syntax) NOTe1
(Condition) The result is the inverse of the status of data e1 (zero or nonzero).
(Explanation) e1=0 — NOTe1 =1
el1#0 — NOTe1 =0

Expression Example
01-020R03.GT.04
Determines the OR of the computed results of “01-02” and “03.GT.04".
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10.2 Writing Expressions

TLOG Computation

In the explanation below, you cannot enter an expression that contains an operator or
function, an internal switch (S), a relay (l), or a flag (F) for e1. Also, an expression can
contain only one TLOG function.

TLOG.MAX()

Maximum value

(Syntax) TLOG.MAX(e1)

(Condition) Determines the maximum value of channel e1.
TLOG.MIN()

Minimum value

(Syntax) TLOG.MIN(e1)

(Condition) Determines the minimum value of channel e1.
TLOG.AVE()

Average value

(Syntax) TLOG.AVE(e1)

(Condition) Determines the average value of channel e1.
TLOG.SUM()

Sum value

(Syntax) TLOG.SUM(e1)

(Condition) Determines the sum of channel e1.
TLOG.P-P()

Maximum — minimum value

(Syntax) TLOG.P-P(e1)

(Condition) Determines the maximum — minimum value of channel e1.

Expression Example
TLOG.MAX(01)+K01*SQR(02)

Examples of Invalid Expressions
TLOG.AVE(01)+TLOG.AVE(02)

Reason: TLOG appears twice in one expression.

TLOG.AVE(ABS(01))
Reason: A function is used inside the parentheses.

IM MV1000-01E
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10.2 Writing Expressions

CLOG Computation
Only data from measurement, computation, and external input channels can be used in a
CLOG computation. Up to 30 channels can be written inside the parentheses.
In the explanation below, an operator or function cannot be placed inside the
parentheses. Also, an expression can contain only one CLOG function.

CLOG.SUM()

Sum value

(Syntax) CLOG.SUM(e1.e2.e4-e6)

(Condition) Determines the sum of the data of channels e1, e2, e4, €5, and €6 that

are measured at the same time.

CLOG.MAX()
Maximum value

(Syntax) CLOG.MAX(e1.e2.e4-e6)
(Condition) Returns the maximum measured data value at a given point in time
from channels e1, e2, e4, e5, and 6.

CLOG.MIN()

Minimum value

(Syntax) CLOG.MIN(e1.e2.e5.e7)

(Condition) Returns the minimum measured data value at a given point in time from
channels e1, e2, €5, and e7.

CLOG.AVE()

Average value

(Syntax) CLOG.AVE(e1-e6)

(Condition) Returns the average of the measured data values of channels e1 to e6
at a given point in time.

CLOG.P-P()

Maximum — minimum value

(Syntax) CLOG.P-P(e1.e2.e5.e7)

(Condition) Returns the difference between the maximum and minimum data values

measured at a given point in time from channels e1, e2, €5, and e7.

Expression Example
CLOG.MAX(001.002.104-106)+K01*SQR(002)

Examples of Invalid Expressions
CLOG.AVE(001.003.005)+CLOG.AVE(002.004.006)

Reason: CLOG appears twice in one expression.

CLOG.AVE(001.ABS(001))
Reason: A function is used inside the parentheses.
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10.2 Writing Expressions

Special Computation:

PRE()

(Syntax) PRE(e1)

(Condition) Determines the previous value of e1.

HOLD(a):b

(Syntax) HOLD(a):b

(Condition) When a is zero, b is carried out to derive the computed value.
Otherwise, the previous computed value is held.

RESET(a):b

(Syntax) RESET(a):b

(Condition) When a is zero, b is carried out to derive the computed value.
Otherwise, the previous computed value of b is reset, and b is carried
out to derive the computed value.

CARRY(a):b

(Syntax) CARRY(a):b

(Condition) Only TLOG.SUM can be specified for b. If the computed value X of b is
less than a, the computed result is X. If X is greater than or equal to a,
the computed result is the excess (X — a).

(Explanation)  When a value such as a flow rate is summed and the threshold value
is reached or exceeded, the sum value is reset while carrying over the
amount that exceeded the threshold value.

Expression Example
Expression that sums the values of channel 1 and resets the value when it reaches or

exceeds 10000
K01=10000
CARRY(K01):TLOG.SUM(001)

Examples of Invalid Expressions
002+HOLD(K01): TLOS.SUM(001)

HOLD is not at the beginning of the expression.

RESET(101.GT.K01):TLOG.SUM(001)+RESET(101.GT.K01):002
Reason: RESET appears twice in one expression.

Conditional Expression

[a?b:c]
(Syntax) [001.GT.K01?002:003]
(Condition) If the measured value of channel 1 is greater than constant KO1, the

computed result is the measured value of channel 2. Otherwise, the
computed result is the measured value of channel 3.

Examples of Invalid Expressions
[001.GT.K01?002:003]*K02

Reason: Used in combination with another operator.

Nested Conditional Expressions
A conditional expression can be written in Expression1, Expression2, and Expressions in

the equation [Expression:?Expression.:Expressions]. For example, the following expression
is allowed: [Equationi?[Equationz+?Equation.z:Equation:s]:[Equations3-i?Equations-:
Equations-]]

Expressions can be nested as long as the number of characters does not exceed 120
characters.

IM MV1000-01E
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10.3 Displaying Computation Channels

Display

You can assign computation channels to groups and display them just like measurement

channels.

P For an explanation of these functions, see section 1.9.

e Color

Press MENU and then select Menu tab > Math channel > Color.

Golor

181
182
183
1md
185
186

187-112

5]
Group of channel

G

Red

reen

Blue

B

B.violet

rown

Orange

* Showing the Zone Display, Scale Display, and Bar Graph display

MV1000

Press MENU and then select Menu tab > Math channel > Zone, Scale or Bar graph.

17.45:52 GEBeerEET(O)

First-CcH:

J:b)  Last-CH:
Zone
Lawer A%
Upper 1aa
Scale
Position 1
Divizion 1@

MV2000

Last-CH: 181

Hormal
18

Press MENU and then select Menu tab > Math channel > Zone, Scale, Bar graph.

GROUP 1 =
2008/01/23 05:20:50  ‘poe EoENT NN 1hour
Hath channel > Zone. Scale. Bar graph

First-CH Last-CH

r Zone
Lower [ |
Upper 100 2
r Scale
Position 1
Division 18
- Bar graph
Base position Nornal
Division 18
Input +1 -1
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10.3 Displaying Computation Channels

¢ Partially Expanded Display
Press MENU and then select Menu tab > Math channel > Partial.
* The Partial command appears in the menu if you set Partial to On in Basic Setting Mode.
P For configuration instructions, see section 6.9.

=
5 SEeor (D)
First-CH: Last-CH: 181
Fartial
On/OFf On
Expand 58 ¥
Boundary B, 88

¢ Alarm Mark and Color Scale Band
MV1000
Press MENU and then select Menu tab > Math channel > Alarm mark or Color
scale band.

[ =1
747,05 e T (O)

First-CH: Last-CH: 181 First-CH: Last-CH: 181
Alarm mark Color scale band
Hark kind Fixed Band area In
Indicate on Scale 0n Calor Lime
flarm mark color Dizsplay position
Alarm 1 Red Lawer A, aa
Alarm 2 Orange Upper 1.88
Alarm 3 Orange
Alarm 4 Red

MV2000
Press MENU and then select Menu tab > Math channel > Alarm mark, Color scale
band.

GROUP 1 &
el ez e EET I hor (5
Hath channel > Alarm mark. Color scale band

First-CH It Last-CH 1681
Alarn nark —_— Color scale band
Hark Kind Fixed Band area In Q
Indicate on Scale On Color Lime 3
Alarn mark color Display position 5
Alarn 1 Red Lower [N] c
Alarn 2 Orange Upper 1.08 I3
Alarn 3 Orange g
Alarn 4 Red S
Q
=
(X
A
]
T
o
=
Input +H -1 -n
c
>
Q
(=
o
=
(7]
=
=
—
Q
>
Qo
-~
hY
=
—
[}
T
=+
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10.3 Displaying Computation Channels

Group of channel, First-CH, and Last-CH

Select the target channel range.

Color
P See section 6.5 for details.

Zone
P See section 6.6 for details.

Partial
P See section 6.9 for details.

Bar graph
P See section 6.11 for details.

Scale
P See section 6.7 for details.

Alarm Mark and Color Scale Band
P See section 6.8 for details.
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10.4 Starting/Stopping Computation

¢ Action Performed When the START Key Is Pressed
Press MENU and then select Menu tab > Math channel > Math start action.

[ =1
3 17:47.07 RORoTIEEYE(S)

Hath start action

Hath start

¢ Math start action > Math start

Setting Description
Off Does not start computation even when the START/STOP key is pressed.
Start Start computation when the START/STOP key is pressed.

Reset+Start Starts computation when the START/STOP key is pressed and resets the
computed result up to that point.

Procedure

e Starting Computation

¢ Starting Computation and Memory Sampling at the Same Time
Press START/STOP. Computation starts at the same time as memory sampling.

The computation icon appears in the status display section.
* Math start must be set to Start or Reset+Start.

¢ Starting Computation Only

1. In Operation Mode, press FUNC.
The function menu appears.

2. Press the Math start soft key.
Computation starts, and the status display section shows the computation icon.

IM MV1000-01E 10-15
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10.4 Starting/Stopping Computation

¢ Stopping Computation
Stopping Computation and Memory Sampling at the Same Time

Press START/STOP.
A confirmation dialog box opens.

1.

Hem+Hath [ Hemory [ cancel
iy a iy a i
A. AAAA v A. AAAT v A. AAAR v

Select Mem+Math, and then press DISP/ENTER.
Memory sampling and computation stop, and the computation icon in the status display
section disappears.

Stopping Computation Only

1. In Operation Mode, press FUNC.

The function menu appears.
2. Press the Math stop soft key.

Computation stops, and the computation icon in the status display section disappears.
Nofte

When computation is stopped, the computed data of the computation channel is held at the
value that existed immediately before the computation was stopped. If memory sampling is in
progress, the held value is recorded.

* Resetting the Computed Results of All Computation Channels
You can carry out this operation regardless of whether or not computation is in

progress.

1.

In Operation Mode, press FUNC.
The function menu appears.

Press the Math reset soft key.
The computed results of all computation channels are reset.

¢ Releasing the Computation Data Dropout Display
You can carry out this operation when a computation data dropout occurs. When a
computation data dropout occurs, the computation icon turns yellow.

1.

In Operation Mode, press FUNC.
The function menu appears.

2. Press the Math ACK soft key.

Note

The computation icon returns to white.
* Math ACK appears in the function menu only when a computation data dropout occurs.

A computation data dropout occurs when the MV cannot process computation within a scan
interval. If computation data dropout occurs frequently, reduce the load on the CPU by reducing
the number of computation channels or by setting a longer scan interval. If a computation data
dropout occurs during memory sampling, the data immediately before the dropout is recorded
as the computed data of the scan interval in which the dropout occurred.
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10.5 Generating Reports

This section explains how to configure report generation.
P For an explanation of these functions, see section 1.9.

Display

* Report Computation Type
MVv1000
Press MENU and then select Menu tab > Basic setting mode > Environment tab >
Report.

Basic Setting Hode

Report
Report select
1
2 Hax
3 Hin
4 Sum
File twpe Separate

e | Hin | fve | Sun | Inst |

MV2000
Press MENU and then select Menu tab > Basic setting mode > Environment tab >
Math, Report.

Basic Setting Mode

Environment > Math, Report

r Hath —
Value on Error +0uer

Value on Ouerflow
SUH, AVE Skip
HAR. HIN, P-P Over

r Report
Report select
1 | fve |
2 Max
3 Hin
4 Sun
File type Separate
Hax Hin fve Sum Inst

¢ Report Type and Time of Generation
Press MENU and select Menu tab > Basic setting mode > Menu tab > Report >
Basic settings.

Basic Setting Hode

Report set

Report kind Hour+Dayw
Date
Time thour? 5] )

IM MV1000-01E
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10.5 Generating Reports

¢ Target Channels
Press MENU and select Menu tab > Basic setting mode > Menu tab > Report >
Report settings

Basic Setting Hode
Report channel number

Ons0ff On
Channel BA1
Sum scale /=

e Overflow Data Handling
See page 10-5.

* Report > Report select > 1, 2, 3, 4
Select the type of data to output as reports. The only data type that can be set more
than once is Off. You cannot set 1 to Off.

Setting Description

Off Does not generate reports.

Ave Outputs the average value.

Max Outputs the maximum value.
Min Outputs the minimum value.
Sum Outputs the sum.

Inst Outputs the instantaneous value.

* Report > File type
Set this item to generate two types of reports such as daily and monthly reports.

Setting Description
Separate Saves each type of report to a separate file.
Combine Saves two types of report data to a single file.

¢ Overflow Data Handling
Overflow data is handled in the same way as it is in statistical computations (TLOG
and CLOG).
P See section 10.1 for details.

* Report set > Report kind
Select the type of report to be generated.

Setting Description

Hour Generates hourly reports.

Day Generates daily reports.

H+D Generates hourly and daily reports.
Day+Week Generates daily and weekly reports.
D+M Generates daily and monthly reports.
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10.5 Generating Reports

Procedure

¢ Report set > Date/Day of the week, Time (hour)

Set the date or day of the week and the time when the report will be generated. The
specified date/time is when the report file is divided. Set the values in the range
indicated below. Items with a dash are invalid.

Report Type Date Day of Week Time

Hour - - 0 to 23
Day 1to 28* - 0to 23
H+D - - 0 to 23
Day+Week - SUN to SAT 0to 23
D+M 1 to 28* - 0to 23

* You cannot specify 29, 30, or 31.

Report Filing Time and Date/Time When a Report File Is Divided

Example: When the Date of a daily report is set to 1 and the Time (hour) is set to
18:00

A daily report is created every day at hour 18.

The file that the report is stored to is divided at 18:00 on day 1 of each month.

Report channel number
Determines the order in which reports are output.

Report CH > On/Off
Select On to use the report channels.

Report CH > Channel
Set the channel to be assigned to the report channel. All channels can be assigned,

but reports are not generated for channels set to Skip or Off even if they are assigned.
In a stacked bar graph display (see section 5.6 for details), the MV shows report data
for each group indicated below. However, the MV displays only channels with the
same unit as the first channel in the group.

Report Group  MV1004, MV1008, MV1006, MV1012, MV2010, MV2020,

MV2008 MV1024 MV2030, MV2040,
MV2048

1 R001 to RO06 R001 to RO06 R001 to RO10

2 R007 to R0O12 R007 to R012 R011 to R020

3 - R013 to R018 R021 to RO30

4 - R019 to R024 R031 to R040

5 - - R041 to RO50

6 - - R051 to R0O60

Report CH > Sum scale

Select the sum scale from /s to /day to match the time unit of the measured value.
Example: If the unit of the measured value is m3/min, select /min.

Off: Directly sums the measured data for each scan interval.

Start/Stop Report Generation
Report generation starts when memory sampling starts. Report generation stops when

memory sampling stops.

Displaying Reports
P See sections 5.5 and 5.6 for details.

Saving Reports
P See section 1.5 for details.

IM MV1000-01E
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Chapter 11 External Input Channels (/MC1 option)

11.1 Configuring External Input Channels

You can use external input channels on MV2000 medium-speed input models. With
communication functions, you can load data from other devices and display and save the
loaded data on the MV.

Display

* Configuring the Input
Press MENU and then select Menu tab > Basic setting mode > Menu tab >

Communication (Ethernet) or Communication (Serial) > Modbus client or
Modbus master > Command settings.

Basic Setting Mode

Connmunication (Ethernet) > Hodbus client > Command settings

Client command number 1-8

— Command settings

Client settinss Server settings
First  Last Server  Registers  Tupe
[201 -[201 4m [1 30881 INT16
[202 -[202 4m [1 3L TNT16
[283 -[283 4m [1 30881 INT16

0 3o o1 m e
ﬂﬂﬂﬂwww
2l2(2|2]=|=|=
Ed =

* Input Range and Alarm
Press MENU and then select Menu tab > Ext. channel > Range, Alarm.

GROUP 1 =
Sosra/z ncoocn R EVENT N thor ()

Ext. channel > Range. Alarn

First-CH Last-CH 20l
Ext. range
On/0f f Span Lower Span Upper Unit

[On  [-Z2e0.08 [ z60.60

Ext. alarm

0ff
0ff

0ff
off

I XN

Input +1 -1
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11.1 Configuring External Input Channels

* Tag, Memory sample, and Alarm delay

Press MENU and then select Menu tab > Ext. channel > Tag, Memory sample, Alarm
delay.

GROUP 1 =
oo a0 c0:00:04 8 EVENT I b (S)

Ext. channel > Tag. Hemory sample, Alarm delay
First-CH Last-CH 201

Tag
(Characters
Hemory sanple
’70n/0ff On

Alarm delay
(Time 18 s

Input +1 -1

Channels to Be Manually Sampled
P See section 4.5.

Configuring the Input

The measured values of external devices are loaded into external input channels by

using the Modbus client or Modbus master function.

P For configuration instructions, see the Communication Interface User’s Manual (IM
MV1000-17E).

First-CH, Last-CH
Select the target channels. Channel numbers are from 201 to 440.

Ext. range > On/Off
Select On to use the channels.

Ext. range > Span Lower, Span Upper
The measurement range.

Selectable range of values: —30000 to 30000
Decimal place: Up to four fractional digits

Ext. range > Unit
Set the unit (up to six characters, [ala[#1]).

Ext. alarm

The available alarm types are high limit alarm, low limit alarm, delay high limit alarm,
and delay low limit alarm.

The range of alarm values is as follows:

Type Alarm Values Example of Alarm Values

H, L In the range of —30000 to 30000 ignoring  If the span is 0.0 to 100.0:
the decimal point —3000.0 to 3000.0

T, t Same as H, L Same as H, L

P For alarm configuration instructions, see section 3.7.
*

If you change the On/Off or span settings of an external input channel, the alarm on that
channel will be set to Off.

11-2
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11.1 Configuring External Input Channels

e Alarm delay > Time
P For instructions on how to set the alarm delay, see section 3.7.

* Tag
P For information on how to set the tag name, see section 6.2.

* Memory sample > On/Off
Select On for the target channels.

IM MV1000-01E
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11.2 Displaying External Input Channels

You can assign external input channels to groups and display them just like measurement
channels. See chapter 6 for details.

Display

e Channel Display Color
Press MENU and then select Menu tab > Ext. channel > Color.

GROUP 1 =1
6e8/ai /23 20-00:42  pod EVENT NN 1hour ®
Ext. channel > Color

Group of channel 201-218

r Color —
2aL [ ] Red
a2 B [ Green
2m [ ] Blue
a4 B [B.violet
285 B [ Brown
286 Orange
2a7 Y.green
208 Lightblue
289 Violet
21a [ | Gray

201-218 | 211-228 | 221-230 | 231-24R | 241-258 | 251-268 |Next 1/4

¢ Showing the Zone Display, Scale Display, and Bar Graph display
Press MENU and then select Menu tab > Ext. channel > Zone, Scale, Bar graph.

GROUP 1 =]
oo /23 cozonza s EVENT I thor  (S]
Ext. channel > Zone, $cale, Bar graph

First-CH Last-CH 2d1
r Zone —_—
Louer a2
Upper 188 2

r Scale —_—
Position 1
Division 18

r Bar graph

Base position Nornmal
Division 18

Input + -1
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11.2 Displaying External Input Channels

e Partially Expanded Display
Press MENU and then select Menu tab > Ext. channel > Partial.

The Partial command appears in the menu if you set Partial to On in Basic Setting Mode.
P For configuration instructions, see section 6.9.

Ext. channel > Partial
First-CH Last-CH 201
Partial
On/0ff On
Expand 58 %
Boundary B.88
Input +1 -1

¢ Alarm Mark and Color Scale Band
Press MENU and then select Menu tab > Ext. channel > Alarm mark, Color scale
band.

GROUP 1 r=1
Sgbvatr2s 2p:o-ag G EVENT I 1o (S)
Ext. channel > Alarm mark. Color scale band

First-CH Last-CH 201
Alarm mark —_— Color scale band

Mark kind Fixed Band area In
Indicate on Scale On Color Line
Alarn mark color Display position
Alarn 1 Red Lower 888
Alarn 2 Orange Ubper 1.88
Alarn 3 Orange
Alarn 4 Red

Input +1 -1

m
X
—
(1]
=
=]
L
5
o
c
-
(2]
=
Q
=]
=]
o
(7]
=
=
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-
o
k]
=4
o
=)
=
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11.2 Displaying External Input Channels

Group of channel, First-CH, Last-CH
Select the target channels. Channel numbers are from 201 to 440.

Color
P See section 6.5.

Zone
P See section 6.6.

Partial
P See section 6.9.

Bar Graph
P See section 6.11.

Scale
P See section 6.7.

Alarm Mark and Color Scale Band
P See section 6.8.
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Chapter 12 Troubleshooting and Maintenance

12.1 List of Messages

There are cases in which error codes and messages are displayed on the screen during

operation. A list of the possible error codes and messages are given in the table below.
Communication error codes and messages are also listed.
Error responses to communication commands are output in English.

Errors Related to Parameter Settings
» Setting Errors

Code Message Explanation/Countermeasures/Ref. section

1 System error. Contact your nearest YOKOGAWA dealer.

2 Incorrect date or time setting. Enter a correct value.

3 A disabled channel is selected. Specify a channel that is not set to Skip or Off.
Specify a channel that is installed.

4 Incorrect function parameter. See the Communication Interface User’s Manual.

5 The input numerical value exceeds the set range. Enter a proper value.

6 Incorrect input character string. Enter a proper character string.

7 Too many characters. Enter the correct number of characters.

8 Incorrect input mode. Specify a correct mode.

See section 3.3.

9 Incorrect input range code. Specify a correct range code.
See section 3.3.

11 Range settings are not same within the selected channels. Specify channels with the same range setting.
See section 3.9.

21 Cannot set an alarm for a skipped channel. Cannot be specified on channels set to Skip.
See section 3.7.

22 The upper and lower span limits are equal. Cannot be set to the same value.

See section 3.3.
23 The upper and lower scale limits are equal. Cannot be set to the same value.
See section 3.3.
24 The lower limit of the span band is greater than the upper Set the lower limit less than the upper limit.
limit. See section 3.3.
25 The lower limit of the scale band is greater than the upper Set the lower limit less than the upper limit.
limit. See section 3.3.

30 The partial boundary value exceeds the range of the span. Set the boundary value in the range of “the minimum
span value + 1 digit” to “the maximum span value — 1
digit.”

See section 6.9

31 Partial-expansion display is set ON for a SKIPPED channel. Cannot be specified on channels set to Skip.
See sections 3.3 and 6.9

35 The upper and lower limits of the display band are equal. Set the upper limit greater than the lower limit + 5.
See section 6.6

36 The lower limit of the display band is greater than the upper Set the upper limit greater than the lower limit + 5.

limit. See section 6.6

37 The display band is narrower than 4% of the entire display. Set the upper limit greater than the lower limit + 5.
See section 6.6

40 Incorrect group set character string. Check the syntax.

See section 6.1

41 There is no specified input channel. Specify a channel that is installed.
See sections 2.3 and 6.1

42 Exceeded the number of channels which can be set. Up to 10 channels/group (MVV2000).
Up to 6 channels/group (MV1000).
See section 6.1

43 A channel number cannot repeat in a group. Check that a channel is not registered twice.
See section 6.1

45 There is no character string saved in the clipboard. Copy a character string to the clipboard.

See section 6.1

IM MV1000-01E
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12.1 List of Messages

Code

Message

Explanation/Countermeasures/Ref. section

46

The character string saved in the clipboard is too long.

Paste a character string with the specified number of
characters.

Check the character length limitation at the
destination.

“Settings and Values” in the First Step Guide

61

There is no channel specified by the MATH expression.

Check the channel number specified by the
expression.
See sections 1.9 and 10.1

62

MATH expression grammar is incorrect.

Check that the expression grammar is correct.
See section 10.2

63

MATH expression sequence is incorrect.

Check that the operator used in the expression
in relation to the applicable operands meets the
grammar requirements.

See section 10.2

64

MATH upper and lower span values are equal.

Set different values for the upper and lower limits of
the computation span.
See section 10.1

65

Too many operators for MATH expression.

The maximum number of operators in an expression
has been exceeded. Reduce the number of
operators, such as by splitting up the expression into
multiple computation channels.

See section 10.2

70

Nonexistent constant specified in MATH expression.

Check the constant number specified by the
expression.
See section 10.1

71

Set range of the MATH constant is exceeded.

Check the selectable range.
See section 10.1

80

This username is already registered.

Register another user name.
See section 8.2

81

All space or ‘quit’ string cannot be specified.

Change the character string.
See section 8.2

84

The login password has not been set up.

Set a password.
See section 8.2

85

The login password is incorrect.

Check the password. If you lost the password, ask
your administrator to reset it.
See sections 8.2 and 8.3

86

The key-lock release password is incorrect.

Check the password. If you lost the password, it must
be reset.

See section 8.1

87

This key is locked.

Release the key lock.
See section 8.1

88

This function is locked.

Release the key lock.
See section 8.1

89

Press [FUNC] key to login.

Login.
See section 8.3

90

No permission to enter to the SETUP mode.

The MV never generates this message.

91

Password is incorrect.

Enter the correct password. If you lost the password,
it must be reset.

Sections 8.2 and 8.3

92

Press [ESC] key to change to the operation mode.

Press ESC.

93

String including space or all space cannot be specified.

Spaces are not allowed in the Web browser user
name and password.

Section 2.4 in the communication manual

94

More than one address cannot be specified.

Only a single sender is allowed.
Section 2.3 in the communication manual

95

Number entered exceeds channel number range.
Use another command.

Check the syntax of the Modbus command.
Sections 2.9 and 3.5 in the communication manual

100

IP address doesn’t belong to class A, B, or C.

Check the IP address.
Section 2.2 in the communication manual

101

The result of the masked IP address is all Os or 1s.

Check the subnet mask.
Section 2.2 in the communication manual
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12.1 List of Messages

Code

Message

Explanation/Countermeasures/Ref. section

102

SUBNET mask is incorrect.

Check the subnet mask.
Section 2.2 in the communication manual

103

The net part of default gateway is not equal to that of IP
address.

Check the IP address.
Section 2.2 in the communication manual

105

This port number is already in use. Please enter a different
number.

Enter a different port number for each function.
Section 7.1 in the communication manual

113

Password entered is incorrect.

Enter the correct password.
See section 8.3

119

This user name is unable to use this mode.

A user-level user cannot enter the Basic Setting
mode.

See section 8.2

120

Measured value is incorrect. (in ascending order)

Set the calibration correction value to a value greater
than the previous value.
See section 3.9

122

Measured value exceeds the range setting.

Check the channel input or the channel range setting.

See sections 3.3 and 3.9

125

Character entry cannot be performed.

The MV is not showing a display used to enter
character strings.
See section 9.7

126

You cannot use the same password.

Specify a different password.
See section 8.3

127

Report kind overlaps and cannot be set up.

Change the overlapped report data type.
See section 10.5

129

IP address is not set.

Set the MV IP address.
Section 2.2 in the communication manual

131

You have exceeded the available channel capacity.

You cannot connect more than 240 channels.
Section 2.9 in the communication manual

132

You have exceeded the available number of commands.

The maximum number of commands that can be
sent is 16. The modules that can be set with a
single command are consecutive modules that can
be automatically set. Change the MW100 module
configuration so that there are no empty slots.
Section 2.9 in the communication manual

133

External I/O auto setting information is not available.

Below are the possible causes. Check them.
* The MW100 is in calibration mode. Change to the
setting mode or measurement mode.

» The measurement module may not have been
detected. Perform system reconfiguration.

» There are no modules that can be automatically set.

Check the modules.

* An IP address has not been assigned to the
MW100. Set the IP address.

* The Modbus server of the MW100 is turned OFF.
Turn the server ON.

Section 2.9 in the communication manual

134

Auto setting has already been executed.

You cannot set an MW100 that has been
automatically set.
Section 2.9 in the communication manual

135

External /0O cannot be found.

Check the Ethernet connection.
Section 2.2 in the communication manual

136

External I/O start cannot be executed.

The current MW100 settings do not allow the
measurement to be started. Check the settings.

137

DNS for this device is not set.

Set the MV DNS parameter.
Section 2.2 in the communication manual

IM MV1000-01E
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12.1 List of Messages

¢ Execution Errors

Code Message Explanation/Countermeasures/Ref. section
150 This action is not possible because sampling is in Stop memory sampling and then execute.
progress. See section 4.4
151 This action is not possible during sampling or calculating. ~ Stop memory sampling or computation first.
See sections 4.4 and 10.4
152 This action is not possible because saving is in progress.  Wait until the saving is complete.
153 This action is not possible because formatting is in Wait until the formatting is complete.
progress.
154 Message not accepted because message limit was The limit is 50 messages.
reached. See section 6.4
155 The message is not written while sampling is stopped. Start memory sampling and then execute.
See section 4.4
156 There are no channels to be saved to the memory. Set the channels to be saved.
See sections 4.1 and 10.1
157 This function is not possible at this time. If the data type to be recorded is set to E+D, you cannot
change the trend interval by using the T/DIV key.
See section 5.2
158 Exceeds time deviation setting. When synchronizing the clock through remote control.
See section 1.7
159 It is outside the postscript message write-in range. Add message can be written to the past section of the

data being memory sampled.
See section 6.4
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12.1 List of Messages

Operation Errors
* Errors Related to the External Storage Medium

Code Message Explanation/Countermeasures/Ref. section

200 Operation aborted because an error was found in media. Use another storage medium or format it.
See section 4.7

201 Not enough free space on media. There is not enough free space on media or the
number of directories exceeded the limit.
Replace with another medium.
See section 1.5

202 Media is read-only. Make it writable.

210 Media has not been inserted. Insert a storage medium into the drive.

21 Media is damaged or not formatted. Remove the medium and set it again. If an error still
occurs, replace or format the medium.
See section 4.7

212 Format error. Try formatting again.
See section 4.7

213 The file is read-only. Access another file or make the file writable.

214 There is no file or directory. Specified a file in which data is being added. Tried to
save a file which does not exists in the internal memory.

215 Exceeded the allowable number of directories or files. Replace with another storage medium. Delete
unneeded files and directories.
See section 4.7

216 The file or directory name is incorrect. Use alphanumeric characters.
See section 4.2

217 Unknown file type. Check the extension.
See section 13.3

218 This directory or file now exists. Delete it or change the See section 4.2

name.

219 Invalid file or directory operation. Tried to delete multiple directory levels. Or, tried to
delete a directory containing files.
Delete the files and directories in the directory first
before executing the operation.
See section 4.7

220 The file is already in use. Try again later. Wait until the file is accessible.

221 This action is not possible because FTP transmission is in Execute after FTP data transfer is complete.

progress.

222 Media is not recognized. Remove the medium and set it again.

230 There is no setting file. Switch to a medium that contains a setup file (.pdl
extension).

231 Abnormal setting exists in file. Specify another file.

IM MV1000-01E
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12.1 List of Messages

Errors Related to the Historical Trend

232 There is no available data. Appears when displaying historical trends.
Specify another file.

233 The specified historical data do not exist. Appears when switching to historical trend from
information display.
Sections 5.7, 5.8, and 5.9

234 The specified channel is not assigned to the display group.  Appears when switching to trend, digital, or bar graph

from overview.
See sections 5.4 and 6.1

Errors Related to E-mail and Web Server

260

IP address is not set or ethernet function is not available.

The IP address is not specified. Check the IP address.
Section 2.2 in the communication manual

261

SMTP server is not found.

Occurs when the SMTP server is specified by name.
* Check the DNS setting.

¢ Check the SMTP server name.

Sections 2.2 and 2.3 in the communication manual

262

Cannot initiate E-mail transmission.

* The host name of the MV is not correct. Check the
host name.

* The port number of the SMTP server is not correct.
Check the port name.

Sections 2.2 and 2.3 in the communication manual

263

Sender’s address rejected by the server.

Check the sender address.
Section 2.3 in the communication manual

264

Some recipients’ addresses are invalid.

Check the recipient addresses.
Section 2.3 in the communication manual

265

SMTP protocol error.

May occur if a network failure (cable problems, duplicate
addresses, network device failure, and so on) occurs in
the middle of the e-mail transmission.

266

Ethernet cable is not connected.

Check the cable connection.
Section 2.2 in the communication manual

267

Could not connect to SMTP server.

* Check to see that the SMTP server is connected to the
network.

« |If the SMTP server name is specified using an IP
address, check to see that the IP address is correct.
Section 2.3 in the communication manual

268

E-mail transmission request failed.

Contact your nearest YOKOGAWA dealer.

269

E-mail transfer error.

May occur if a network failure (cable problems, duplicate
addresses, network device failure, and so on) occurs in
the middle of the e-mail transmission.

270

Could not connect to the POP3 server.

Check whether or not the destination POP3 server is
running. Check that the cables are connected properly
and that the HUB is turned on. Section 2.3 in the
communication manual

271

POP3 server authentication failed.

Check whether the user name and server name are
permitted by the server.
Section 2.3 in the communication manual

275

The current image cannot be output to the Web.

The setup display cannot be output to the Web browser.
This message is displayed on the Web browser.

276

Image data currently being created. Unable to perform key
operation.

Try again a little later. This message is displayed on the
Web browser.

277

Could not output screen to Web.

Failed to create the image. This message is displayed on
the Web browser.

12-6
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12.1 List of Messages

¢ Errors Related to FTP Client

For a description of the FTP client function of the MV, see the Communication Interface
User’s Manual (IM MV1000-17E). The detail code does not appear in the error message on
the screen. You can view the code on the FTP log display of the MV or using the FTP log
output via communications.

Code

Message

280

IP address is not set or FTP function is not available.
Further details are provided by the character string that appears after error code 280.
Character String and Details
HOSTADDR
An IP address has not been assigned to the MV.
Check the IP address.
DORMANT
Internal processing error."’
LINK
Data link is disconnected.
Check the cable connection.

281

FTP mail box operation error.
Further details are provided by the character string that appears after error code 281.

Character String and Details

MAIL

Internal processing error.’
STATUS

Internal processing error.’
TIMEOUT

Internal processing error.’
PRIORITY

Internal processing error.’
NVRAM

Internal processing error.’

282

FTP control connection error.
Further details are provided by the character string that appears after error code 282.

Character String and Details

HOSTNAME
Failed the DNS lookup (search the IP address corresponding to the host name).
Check the DNS setting and the destination host name.
TCPIP
Internal processing error.”’
UNREACH
Failed to connect to a control connection server.
Check the address setting and that the server is running.
OOBINLINE
Internal processing error.’
NAME
Internal processing error."’
CTRL
The control connection does not exist.
Check that the server does not drop the connection and that it responds within the proper
time period.
IAC
Failed to respond in the TELNET sequence.
Check that the server does not drop the connection and that it responds within the proper
time period.
ECHO
Failed to transmit data on the control connection.
Check that the server does not drop the connection and that it responds within the proper
time period.
REPLY
Failed to receive data on the control connection.
Check that the server does not drop the connection and that it responds within the proper
time period.

IM MV1000-01E
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12.1 List of Messages

Character String and Details

SERVER

The server is not in a condition to provide the service.

Check that the server is in a condition in which service can be provided.

Code Message
283 FTP command was not accepted.
Further details are provided by the character string that appears after error code 283.
Character String and Details
USER
Failed to verify the user name.
Check the user name setting.
PASS
Failed to verify the password.
Check the password setting.
ACCT
Failed to verify the account.
Check the account setting.
TYPE
Failed to change the transfer type.
Check that the server supports the binary transfer mode.
CWD
Failed to change the directory.
Check the initial path setting.
PORT
Failed to set the transfer connection.
Check that the security function is disabled.
PASV
Failed to set the transfer connection.
Check that the server supports PASV commands.
SCAN
Failed to read the transfer connection settings.
Check that proper response to the PASV command is received from the server.
284 FTP transfer setting error.
Further details are provided by the character string that appears after error code 284.
Character String and Details
MODE
Internal processing error.’
LOCAL
Internal processing error.’
REMOTE
The destination file name is not correct.
Check that you have the authority to create or overwrite files.
ABORT
File transfer abort was requested by the server.
Check the server for the reason for the abort request.
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12.1 List of Messages

Code

Message

285

FTP data connection error.

Further details are provided by the character string that appears after error code 285.

Character String and Details

SOCKET

Failed to create a socket for the transfer connection.?
BIND

Failed the transfer connection command.?
CONNECT

Failed the transfer connection.?
LISTEN

Failed the transfer connection reception.”
ACCEPT

Failed to accept the transfer connection.?
SOCKNAME

Internal processing error.’
RECV

Failed to receive data over the transfer connection.?
SEND

Failed to send data over the transfer connection.?

286

FTP file transfer error.

290

SNTP access failure.

Further details are provided by the character string that appears after error code 290.

Character String and Details

DORMANT
Internal processing error.’
LINK
Data link is disconnected.
Check the cable connection.

291

SNTP server does not respond.

Further details are provided by the character string that appears after error code 291.

Character String and Details

TIMEOUT
Check that the server is running.”

292

Incorrect SNTP server setting.

Further details are provided by the character string that appears after error code 292.

Character String and Details

HOSTNAME
Failed the DNS lookup (search the IP address corresponding to the host name).
Check the DNS setting and the SNTP server name.

TCPIP
Internal processing error.’

293

Invalid SNTP server reply.

Further details are provided by the character string that appears after error code 293.

Character String and Details

SEND
A correct IP address has not been assigned to the MV.
Check the IP address.
BROKEN
There is a problem with the SNTP server.
If this error occurs even after executing SNTP manually several times, check the SNTP
server.

IM MV1000-01E
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12.1 List of Messages

Code Message
294 No time correction because excess time deviation with SNTP server.
Further details are provided by the character string that appears after error code 294.
Character String and Details
OVER
This error occurs when periodic SNTP is executed by the auto setting of the clock and
the clock is not adjusted because the time difference between the MV and the SNTP
server is greater than or equal to 10 minutes.
Check the time on the MV and the SNTP server.
295 IP address was released because DHCP setting is invalid.
Further details are provided by the character string that appears after error code 295.
Character String and Details
REJECT
Address obtained by DHCP is inappropriate.

296 DHCP access failure.
Further details are provided by the character string that appears after error code 296.
Character String and Details
ESEND
Failed to transmit to the DHCP.
ESERVER
DHCP server not found.
ESERVFAIL
No response from the DHCP server.
ERENEWED
Address renewal rejected.
EEXTENDED
Address lease extension rejected.
EEXPIRED
Address lease period expired.
297 Registration of the hostname to the DNS server failed.
Further details are provided by the character string that appears after error code 297.
Character String and Details

INTERNAL
Failed to register the host name (transmission error, reception timeout, etc.).
FORMERR
Failed to register the host name (format error: DNS message syntax error).
SERVFAIL
Failed to register the host name (server failure: DNS server processing error).
NXDOMAIN
Failed to register the host name (non existent domain).
NOTIMP
Failed to register the host name (not implemented).
REFUSED
Failed to register the host name (operation refused).
YXDOMAIN
Failed to register the host name (name exists).
YXRRSET
Failed to register the host name (RR set exists).
NXRRSET
Failed to register the host name (RR set does not exist).
NOTAUTH
Failed to register the host name (not authoritative for zone).
NOTZONE
Failed to register the host name (different from zone section).
NONAME

Host name not entered on the MV.
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12.1 List of Messages

Code

298

Deletion of the hostname to the DNS server failed.

Further details are provided by the character string that appears after error code 298.

Character String and Details

INTERNAL

Failed to delete the host name (transmission error, reception timeout, etc.).
FORMERR

Failed to delete the host name (format error: DNS message syntax error).
SERVFAIL

Failed to delete the host name (server failure: DNS server processing error).
NXDOMAIN

Failed to delete the host name (non existent domain).

NOTIMP

Failed to delete the host name (not implemented).
REFUSED

Failed to delete the host name (operation refused).
YXDOMAIN

Failed to delete the host name (name exists).
YXRRSET

Failed to delete the host name (RR set exists).
NXRRSET

Failed to delete the host name (RR set does not exist).
NOTAUTH

Failed to delete the host name (not authoritative for zone).
NOTZONE

Failed to delete the host name (different from zone section).
NOTLINKED

4Physical layer was disconnected when removing the host name.

Nofte

1 Contact your nearest YOKOGAWA dealer.
2 These errors may occur if the network experiences trouble during the data transmission
(bad cable connection, duplicate addresses, network equipment failure).

The FTP client function on the MV has a timer function that drops the connection if there is
no data transfer for two minutes. If the server does not respond within this time period, the
transfer fails.

The FTP client function on the MV overwrites files without a warning if files with the same
name exist at the transfer destination unless the server returns a negative response.

IM MV1000-01E
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12.1 List of Messages

Communication Errors
For information regarding the communication function of the MV, see the Communication
Interface User’s Manual (IM MV1000-17E).

* Errors during Setting and Basic Setting Modes, Output Communication
Command Execution, and Setup Data Loading

Code Message

300 Command is too long.

301 Too many number of commands delimited with ;.

302 This command has not been defined.

303 Data request command can not be enumerated with sub-delimiter.
350 Command is not permitted to the current user level.

351 This command cannot be specified in the current mode.

352 The option is not installed.

353 This command cannot be specified in the current setting.

354 This command is not available during sampling or calculating.

* Memory Access Errors during Setting and Basic Setting Modes and Output
Communication Command Execution
An English error message is returned via the communication interface. It is not displayed
on the screen.

Code Message
362 There are no data to send ‘NEXT or ‘RESEND’.
363 All data have already been transferred.
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* Maintenance and Test Communication Command Errors
An English error message is returned via the communication interface. It is not displayed
on the screen.

Code Message

390 Command error.

391 Delimiter error.

392 Parameter error.

393 No permission.

394 No such connection.

395 Use ‘quit’ to close this connection.
396 Failed to disconnect.

397 No TCP control block.

398 Format error.

e Other Communication Errors
An English error message is returned via the communication interface. It is not displayed
on the screen.

Code Message

400 Input username.

401 Input password.

402 Select username from ‘admin’ or ‘user’.

403 Login incorrect, try again!

404 No more login at the specified level is acceptable.
410 Login successful. (The special user level)

411 Login successful. (The general user level)

420 Connection has been lost.

421 The number of simultaneous connection has been exceeded.
422 Communication has timed-out.

IM MV1000-01E 12-13
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12.1 List of Messages

Status Messages

Code Message

500 Execution is complete.

501 Please wait a moment...

503 Data are being saved to media...

504 File is being loaded from media...

505 Formatting...

506 Memory save to media was interrupted.

508 There is no file or directory.

509 Press [DISP/ENTER] key to display file name.
510 Range cannot be changed during sampling or calculating.
511 MATH expression cannot be changed during sampling or calculating.
513 Post process in progress.

514 Now loading historical data.

515 Data save is completed.

516 Files are now being sorted.

520 Connecting to the line...

521 The data file is being transferred.

530 Media can be removed safely.

531 Media was removed compulsorily.

532 USB device has been connected.

533 USB device cannot be recognized.

534 There was no data which is not saved to media.
535 Media was recognized.

536 Media is not recognized.

542 Media read error.

543 Flash write error.

550 The A/D calibration is being executed...

551 FTP test is being executed...

552 E-mail test is being executed...

560 Now connecting to SNTP server...

561 Now adjusting the time.

1214
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Code Message
562 Ethernet cable is disconnected.
Further details are provided by the character string that appears after error code 562.
Character String and Details
ON
Detected that an Ethernet cable was connected.
OFF
Detected that an Ethernet cable was disconnected.
563 The command is sent to DHCP.
Further details are provided by the character string that appears after error code 563.
Character String and Details
RENEW
Requesting address renewal to the DHCP server.
564 The response was received from DHCP.
Further details are provided by the character string that appears after error code 564.
Character String and Details
RENEWED
Address renewal complete.
EXTENDED
Address release extension request complete.
RELEASED
Address release complete.

565 IP address was set.
Further details are provided by the character string that appears after error code 565.
Character String and Details
IPCONFIG
Assigned the IP address.
566 It is a setting that doesn’t register hostname to the DNS server.
Further details are provided by the character string that appears after error code 566.
Character String and Details
NOREQUEST
Configured not to register the host name.
567 The hostname was registered to DNS server.
Further details are provided by the character string that appears after error code 567.
Character String and Details
UPDATE
Registered the host name to the DNS server.
568 The hostname was deleted from DNS server.
Further details are provided by the character string that appears after error code 568.
Character String and Details
REMOVE
Assigned the IP address.
OFF
Removed the host name from the DNS server.

IM MV1000-01E 12-15

H asueusjulepy pue Buijooyssjgno.)



12.1 List of Messages

Warning Messages

Code Message Ref. Section
600 Measured data and Settings have been initialized. -

601 Measured data have been initialized. —

610 This username is already registered. See section 8.2.
614 Calibration settings are reset because of range setting change. See section 3.9
615 Noise may influence measurement in test mode. See section 3.1

System Errors
Servicing is required when a system error occurs. If this happens, contact your nearest
YOKOGAWA dealer for repairs.

Code Message

901 ROM failure.

902 RAM failure.

910 A/D memory failure for all input channels.
911 Channel 1 A/D memory failure.

912 Channel 2 A/D memory failure.

913 Channel 3 A/D memory failure.

914 Channel 4 A/D memory failure.

921 Channel 1 A/D calibration value error.
922 Channel 2 A/D calibration value error.
923 Channel 3 A/D calibration value error.
924 Channel 4 A/D calibration value error.
930 Memory acquisition failure.

940 The Ethernet module is down.
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12.2 Troubleshooting

Does not function at all (nothing is displayed).

Is the power switch
turned ON? Does the
switch work properly?

Make sure that the power FS.G
is turned ON properly. R

Is the power supply
connected properly?

Connect the power supply properlD Section 2.2

Is the power
supplied properly?

Use a power supply of the specified | Section 2.2
voltage and frequency.

Contact your nearest YOKOGAWA
dealer to have your MV serviced.

F.S.G.: First Step Guide

IM MV1000-01E

1217

H adueusjulepy pue Buijooyssjgno.)



12.2 Troubleshooting

* Large measurement errors.
* Trend or digital wave value fluctuation.

* Trend going off the scale beyond either 0% or 100%.

Does the input meet
the specifications?

NO

YES

Are the range/span
settings appropriate?

NO

YES

Are you taking measures
against noise?

NO

YES

Are you keeping the
environmental temperature
constant (TC input)?

NO

YES

Is the input wiring correct? NO

YES

NO

Is the input wiring parallel
with other equipment?

YES

NO

Is the RJC setting correct
(TC input)?

YES

Contact your nearest YOKOGAWA
dealer to have your MV serviced.

Change the input to meet the specificatio@

« Adjust the span and range settings \
(section 3.3).

« If you use input calibration (/CC1 option),
check the set values for correction points

(section 3.9). j

KSeparate the input wiring from the \
noise source.

* Ground the recorder.

» Ground the measured object.

* Insulate the TC from the measured object.

*» Use shielded cables for input.

» Change the integration time of the input
A/D converter (section 3.1).

+» Use the moving average of the input
(section 3.4).

« Attach the input terminal cover correctly.
* Protect the input terminal from fans
and other sources of wind.
* Keep the temperature fluctuation near
the input terminal to a minimum.

*» Wire correctly (Section 2.3) \
« Install the terminal block correctly.

« Fasten the terminal screws correctly.

* Insulate the RTD from the ground.

- If burnt, replace the TC. j

+ Stop the TC burnout upscale/downscalth
function of other equipment.

» Ground the MV and other equipment

at one point.

» Disconnect parallel wiring

(use a double-element TC, for instance). j

Configure correctly. )

Section 13.1

Section 3.2

1218
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12.2 Troubleshooting

Display and other functions do not work properly.

Are you taking measures
against noise?

YES

Contact your nearest YOKOGAWA
dealer to have your MV serviced.

\

/-Move the input and communication wires
away from the noise source.

* Ground the recorder.

* Use shielded cables for input.

* Insert an isolation transformer into the
power line.

* Insert a power line filter into the power line.

«If an inductive load is used in the alarm
output line, insert a surge suppressor in

Kthe line. j

Items on the display selection menu or function menu are not displayed.

Are all of the typical
conditions for displaying
the item satisfied?

Contact your nearest YOKOGAWA
dealer to have your MV serviced.

(Make sure that the menu item is set to \
be displayed using the customize-menu
function.

If the item is not set to be displayed, then
set it to be displayed (see section 6.17).
+ Confirm that the MV is equipped with the
thlons required for that menu item. j

IM MV1000-01E
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12.3 Periodic Inspection

Check the operation periodically to keep the MV in good working order.

Perform the following checks and replace worn parts as needed.

 Is the display and storage functioning properly?
If not, see section 12.2, “Troubleshooting.”

* Has the brightness of the LCD backlight deteriorated?
If replacement is necessary, see section 12.5, “Recommended Replacement Periods
for Worn Parts.”
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12.4 Calibrating the MV

It is recommended that the MV be calibrated once a year to assure its measurement

accuracy.

Calibration service is also provided by YOKOGAWA dealers.
For details, contact your nearest YOKOGAWA dealer.

Required Instruments
Calibration instruments with the following resolution are required for calibrating the MV.

Recommended Instruments
» DC voltage standard:

» Decade resistance box:

» 0°C standard temperature device:

9100 by FLUKE or equivalent

Main specifications

Output accuracy: £(0.005% + 1 pV)

Yokogawa Meters & Instruments Model 2793-01
or equivalent

Main specifications

Accuracy of output range 0.1 to 500 Q: +(0.01%
+2 mQ)

Resolution: 0.001 Q

ZC-114/ZA-10 by Coper Electronics or equivalent
Main specifications

Standard temperature stability accuracy: +0.05°C

For information on purchasing the calibration instruments, contact your nearest

YOKOGAWA dealer.

Calibration Procedure

1. Wire the MV and the calibration instrument as shown in the following figure, and
adequately warm up the instruments (the warm-up time of the MV is at least 30

minutes).

2. Check that the operating environment such as ambient temperature and humidity
is within the standard operating conditions (see section 13.6).

3. Apply appropriate input signals corresponding to 0, 50, and 100% of the input
range and calculate the errors from the readings.
If the error does not fall within the accuracy range of the specifications, contact
your nearest YOKOGAWA dealer.

Note

For thermocouple inputs, you must measure the temperature of the input terminal and apply a

voltage taking into account the reference junction temperature.

DC Voltage Measurement (Example for the MV1012)

Screw terminal

CH12 CH10 CH8 CH6 CH4 CH2
H11 CH9 CH7 CH5 CH3 CH1

FRRRRRRER@ R b
B @ @DRRRBRRD D) +a
BEEERRRRRR]-.

Clamp terminal
CH11 CH9 CH7 CH5 CH3 CH1

S S S

CH12CH10 CH8 CH6 CH4 CH2
Input terminal

IM MV1000-01E
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12.4 Calibrating the MV

Temperature Measurement When Using an RTD (Example for the MV1012)

Screw terminal  The resistances of the three lead wires should be equal.

CH12 CH10 CH8 CH6 CH4 CH2
H11 CH9 CH7 CH5 CH3 CH1

FRRRRRRRERR . —>
PERERERRROR e a — 5
e —- —

(o]
(e]i]
(o]
Qu
On
Qu

o ¥

Clamp terminal = -
CH11 CHS CH7 CH5 CH3 CH1 Decade resistance box

g

CH12 CH10 CH8 CH6 CH4 CH2

Input terminal

Temperature Measurement When Using a Thermocouple (Example for the

MV1012)
Thermocouple wires or
Copper wires TC extension wires
ij (( (( -
I )) )]
« « +
Screw terminal
D] |O|® CH12 CH10 CH8 CH6 CH4 CH2
@@ @@ H11 CH9 CH7 CH5 CH3 CH1
by %@@@@@@@@@@@m
S 0 o 8 9 © i BSOS D) +a -
5600066 [ B N CeleeeeeEees) s —
e Copper i Hr- Thermocouple Clamp terminal
DC voltage standard wires wires CH11 CH9 CH7 CHS5 CH3 CH1

S|

§ S

CH12CH10 CH8 CH6 CH4 CH2

(0°C standard temperature device
ZC-114/ZA-10 by Coper Electronics) Input terminal

RJC of TC Input

As the measurement terminal of the MV is generally at room temperature, the actual
output of the thermocouple is different from the values given on the thermoelectromotive
force table based on 0°C. The MV performs compensation by measuring the temperature
at the input terminal and adding the corresponding thermoelectromotive force to the
actual output of the thermocouple. Therefore, when the measurement terminal is shorted
(equivalent to the case when the detector tip is 0°C), the measured value indicates the
temperature of the input terminal.

When calibrating the MV, this compensation voltage (thermoelectromotive force of 0°C
reference corresponding to the input terminal temperature) must be subtracted from the
output of the standard generator before application. As shown in the figure, by using the
0°C standard temperature device to compensate the reference junction at 0°C, you can
input the thermoelectromotive force of 0°C reference from the DC voltage standard and
perform the calibration.
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12.5 Recommended Replacement Periods for Worn

To maintain the reliability of the MV and to use the MV in a good condition for an
extended time, we recommend that parts be replaced periodically. The replacement parts
may change to accommodate preventive maintenance over extended time. Be sure to
check with your nearest YOKOGAWA dealer.

The following table shows the recommended replacement period for expendable parts.
The replacement period shown here applies when the MV is used under standard
operating conditions. For the actual replacement period, consider the actual conditions
of use. Replacement of parts will be carried out by a YOKOGAWA engineer or a
YOKOGAWA-certified engineer. Contact your nearest YOKOGAWA dealer when such
replacement is necessary.

MV1000
Item Replacement Name Quantity Used Notes
Period
LCD 5 years Bezel Assembly 1
Battery 10 years Battery Assembly 1
Aluminum 5 years Power Supply 1
electrolytic Assembly”
capacitor 5 years AD Assembly” Depends on the model

*

Replacement period when used at the upper limit of the normal operating temperature (40°C).
The replacement period varies depending on the operating temperature and the MV specifications. If the
operating temperature is 30°C, it may be possible to use the part for more than 10 years.

MV2000
Item Replacement Name Quantity Used Notes
Period
LCD 5 years Bezel Assembly 1
Battery 10 years Battery Assembly 1
Aluminum 5 years Power Supply 1
electrolytic Assembly”
capacitor 5 years AD Assembly” Depends on the model

*

Replacement period when used at the upper limit of the normal operating temperature (40°C).
The replacement period varies depending on the operating temperature and the MV specifications. If the
operating temperature is 30°C, it may be possible to use the part for more than 10 years.

Nofte

* The LCD replacement period indicates the half life of the brightness when the brightness
is set to the factory default setting. The half life is shortened as the brightness is set
higher. The deterioration of brightness varies depending on the condition of use, and its
determination is subjective. Consider these points when determining the actual replacement
period.

* The LCD color may turn yellowish over time. The discoloration tends to progress faster as
the brightness is set higher.

IM MV1000-01E
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Chapter 13 Specifications

13.1 Signal Input and Alarm

Signal Input

Item Specifications
Number of inputs, scan interval, and A/D integration time

Scan Interval
Model Number of Inputs: Normal mode Fast sampling mode*
MV1004 4 125 ms, 250 ms 25ms
MV1008 8
MV1006 6
MV1012 12 1s,2s,5s 2s,5s 125 ms
MV1024 24
MV2008 8 125 ms, 250 ms 25 ms
MV2010 10
MV2020 20
MV2030 30 1s,2s5,5s 2s,5s 125 ms
MV2040 40
MV2048 48
A/D Converter Integration Time 60 Hz/50 Hz 100 ms 600 Hz (fixed)
* Not available on models equipped with external input channels (/MC1 option).
Input types DC voltage, 1-5V, thermocouple (TC), resistance temperature detector (RTD), ON/OFF input
(DI), and DC current (by adding an external shunt resistor)
Input format Floating unbalanced input
Measurement range and measurable range
Input Type Range Measurable Range
DC voltage 20 mV —20.000 to 20.000 mV
60 mV —60.00 to 60.00 mV
200 mV —200.00 to 200.00 mV
2V —2.0000 to 2.0000 V
6V —6.000 to 6.000 V
20V —20.000 to 20.000 V
50V —50.00 to 50.00 V
1-5V 1-5 V6 0.800 to 5.200 V
Thermocouple| R? 0.0 to 1760.0°C 32 to 3200°F
St 0.0 to 1760.0°C 32 to 3200°F
B1 0.0 to 1820.0°C 32 to 3308°F
K1 —200.0 to 1370.0°C —328 to 2498°F
E? —200.0 to 800.0°C —328.0 to 1472.0°F
J1 —200.0 to 1100.0°C —328.0 to 2012.0°F
T —200.0 to 400.0°C —328.0 to 752.0°F
N1 0.0 to 1300.0°C 32 to 2372°F
W2 0.0 to 2315.0°C 32 to 4199°F
L3 —200.0 to 900.0°C —328.0 to 1652.0°F
U3 —200.0 to 400.0°C —328.0 to 752.0°F
WRe# 0.0 to 2400.0°C 32 to 4352°F
RTD Pt (Pt100)5 —200.0 to 600.0°C —328.0 to 1112.0°F
JPt (JPt100)5 | —200.0 to 550.0°C -328.0 to 1022.0°F
DI Voltage 0: Less than 2.4 V. 1: 2.4V or higher (judged at the 6 V range
Contact” 0: Open. 1: Closed (parallel capacitance of 0.01 yF or less)
1: R, S,B,K,E, J, T, N: IEC584-1 (1995), DIN IEC584, JIS C1602-1995
2:  W: W-5%Re/W-26%Re (Hoskins Mfg. Co.), ASTM E988
3:  L: Fe-CuNi, DIN43710, U: Cu-CuNi, DIN43710
4:  WRe: W-3%Re/W-25%Re (Hoskins Mfg. Co.)
5:  Pt100: JIS C1604-1997, IEC751-1995, DIN IEC751-1996

JPt100: JIS C1604-1989, JIS C1606-1989
Measuring current: i = 1mA (Pt100, JPt100)

6: The range for linear scaling of 1-5V inputs. Burnout detection and low-cut functions are
available.

7: The detected current value is approx. 10 pA.
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13.1 Signal Input and Alarm

Item Specifications
Thermocouple burnout’ Burnout upscale/downscale selectable (for each channel)
Normal: 2 kQ or less, burnout: 100 kQ or more (parallel capacitance of 0.01 uF or less)
Detection current: Approx. 10 pA
1-5 range burnout’ Burnout upscale/downscale selectable (for each channel)
Burnout detection: Greater than the scale upper limit + 10% of scale width or less than the
scale lower limit — 5% of scale width

TC reference junction compensation
Internal reference junction compensation or external reference junction compensation

Filter function Takes the moving average of the input values (for each channel). Moving average data points:
2 to 400
Computation
Difference computation =~ Computable range: DC voltage, TC, RTD, and DI
Linear scaling Computable range: DC voltage, TC, RTD, and DI

Scalable range: —30000 to 30000. The decimal place is anywhere that values will have less
than four fractional digits.
Unit:Up to six characters
Range-out detection: You can configure the MV to indicate a range-out when a value falls
outside +5% of the scale range.
Square root computation Takes the square root of the input and apply linear scaling
Computable range: DC voltage
Scalable range and unit: Sam as linear scaling
Low-cut: Set the low-cut point to a value in the 0.0% to 5.0% of the span
Range-out detection: Same as linear scaling
1-5V Computable range: 1-5
Scalable range and unit: Sam as linear scaling
Low-cut: The low-cut point is fixed to the span lower limit.
Range-out detection: Same as linear scaling

*

In fast sampling mode, the MV cannot detect burnouts on all measurement channels within a scan interval. The MV may
not detect a burnout for the following number of measurements, if measurement is started in a burnout condition, or after
a burnout condition occurs.

MV1004, MV1008, MV2008: a maximum of four measurements

MV1006, MV1012, MV1024, MV2010, MV2020, MV2030, MV2040, MV2048: a maximum of two measurements

Alarms

Item Specifications

Number of alarms Up to four alarms (levels) for each measurement channel

Alarm types High limit, low limit, difference high limit, difference low limit, high limit on rate-of-change alarm,
low limit on rate-of-change alarm, delay high limit, delay low limit

Alarm delay 1 to 3600 s (for each channel)

Rate-of-change calculation interval of rate-of-change alarms

1 to 32 times the scan interval (common to all channels)
Alarm output Output to the internal switch

Number of internal switches: 30

Internal switch operation: AND/OR operation selectable

Hysteresis High and low limit alarms: 0.0 to 5.0% of the span (common to all channels)
Difference high and low limit alarms: 0.0 to 5.0% of the span (common to all channels)
Display Displays the status on the respective operation screen and an alarm icon on the status display

section when an alarm occurs.

Display operation: Hold or not hold the display until the alarm output release operation.
Alarm hide function (no alarm logging function)

Not display alarms nor record to the alarm summary (for each channel)
Alarm information Displays a log of alarm occurrences on the alarm summary.
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13.2 Display Functions

Display

Item Specifications

Display” MV1000: 5.5-inch TFT color LCD (320 x 240 dots)
MV2000: 10.4-inch TFT color LCD (640 x 480 dots)

Brightness MV1000: Eight levels. MV2000: Six levels.

Backlight saver function

Dim or turn off the LCD backlight if there is no key operation for a specified time.
Dim or turn off the LCD backlight at any time by using the FUNC key

* The LCD monitor may contain few pixels that are always on or off. The brightness of the LCD may not be uniform due to the
LCD characteristics. This is not a malfunction.

Screen
Item Specifications
Display groups Allows you to assign channels to groups on the trend display, digital display, and bar graph display

Number of groups

for displaying
MV1000: 10. MV2000: 36.

Number of channels per group

MV1000: 6 max. MV2000: 10 max.

Display colors

Channel: Select from 24 colors
Background: Select white or black

Trend display
Waveform line width
Display method

Scale

Miscellaneous

Select 1, 2, or 3 dots

Displays with orthogonal time (T) and measured value (Y) axes

Layout: Vertical, horizontal, wide, or split

Trend interval: MV1004, MV1008, MV2008: Select from5s, 10 s, 15 s, 30 s, 1 min, 2 min,
5 min, 10 min, 15 min, 20 min, 30 min, 1 h, 2 h, 4 h, 10 h/div
MV1006, MV1012, MV1024, MV2010, MV2020, MV2030, MV2040,
MV2048: Select from 15 s (only for fast sampling mode), 30 s, 1 min, 2 min,
5 min, 10 min, 15 min, 20 min, 30 min, 1 h, 2 h, 4 h, 10 h/div

Switchable to the secondary trend interval

Displays a scale for each channel

Current value bar graph, color scale band, and alarm value marks can be displayed on the scale.

Grid (divisions: 4 to 12), trip line (line width: 1, 2, or 3 dots), message, zone display, partially

expanded display, auto zone display

Digital display
Update rate

Displays measured values numerically
1 s (or the scan interval if the scan interval is greater than 1 s)

Bar graph display
Direction
Base position
Update rate
Scale

Displays measured values on a bar graph

Vertical or horizontal

End or center

1 s (or the scan interval if the scan interval is greater than 1 s)

Displays a scale for each channel

Color scale band and alarm value marks can be displayed on the scale.

Historical trend display

Display format

Time axis operations
Added message
Background colors

Shows the display data or event data in the internal memory or external storage medium.

All screen or half screen (only when the display data is being redisplayed)

Foreground display (TOP CHANNEL): Displays a specified channel’'s waveform in foreground
Auto span display: Displays a waveform by automatically adjusting the display span of a specified
channel

Auto zone display: Displays waveforms in separated display zones for each channel
Reduction/expansion, continuous data display, absolute/relative time display

Adds messages

White, cream, black, and light gray

Overview display

Displays measured values of all channels and alarm statuses (measured values not displayed if
there are 261 or more channels on the MVV2000)

IM MV1000-01E

13-3

suoneoysadg H



13.2 Display Functions

Item

Specifications

Information display
Alarm summary display

Message summary display

Memory summary display

Report (/M1, /PM1)

Displays a log of up to 1000 alarms

You can specify an alarm by using the cursor and jump to the corresponding section on the
trend display.

Time and content of up to 450 messages (including 50 added messages)

You can specify a message by using the cursor and jump to the corresponding section on
the trend display.

Displays information about the internal memory data

You can specify a file by using the cursor and jump to the corresponding section on the trend
display.

You can save data in the internal memory to an external storage medium by using keys.
Displays report data in the internal memory

Stacked bar graph (/M1, /PM1)

Displays stacked bar graphs of report data for each report group

Display type: Hourly+daily (uses hourly report data for displaying), hourly+weekly (uses daily
report data for displaying), daily+monthly (uses daily report data for displaying)

Report groups: Every 6 channels (MV1000) or every 10 channels (MV2000) are assigned

in order to groups 1, 2, 3, and so on, starting with the first report channel (R001). Channel
assignment is fixed.

Scale/grid: Fixed to four sections

Update rate: 1's

Stacks report data of channels in the specified group and displays the result on a bar graph.
Displays only channels with the same unit as the first channel in the group.

Status display Relay status display: Displays the ON/OFF status of alarm output relays and internal
switches
Modbus client status: Displays the communication status of the Modbus client
Modbus master status: Displays the communication status of the Modbus master
Log display Displays the login log, error log, communication log, FTP log, Web log, e-mail log, SNTP log,

DHCP log, and Modbus status log

4-panel display (only with the MV2000)

Divides the display into quadrants and shows four different display formats
Four display combinations can be registered.

Display pause

You can pause the display using keys.

Other Displayed Information

Item Specifications
Tag display Up to 16 alphanumeric characters
Messages You can write messages to the trend display.
Number of messages 100
Characters Up to 32 alphanumeric characters

Write method
Write destination
Auto message

Enter a preset message or write a message on the spot

You can specify to write only to the display group or to all groups.

Writes a message when the MV recovers from a power failure while memory sampling is in
progress.

Writes a message when the trend interval is switched while memory sampling is in progress.

Added messages
Number of messages

Writes messages to past data positions
50

Status display section
Displayed information

Displays the MV status at the upper section of the display

(1) Year, month, day, time, (2) displayed group name/display name, (3) user name (when
using the login function), (4) batch name (when using the batch function), (5) internal
memory status, (6) external storage medium status, (7) alarm status, and (8) function usage
status (key lock , computation function, and e-mail)

Auto switching of displayed groups

Switches the display group at given intervals.
Interval: Select from the available settings between 5 s and 1 min.

Auto recovery display

Specify the display that will appear automatically when keys are not operated.
Time until the display switches: Select from the available settings between 1 min and 1 h.

Favorite display

You can register an often-used display to the HISTORY key and use the key to switch to the
display quickly
Up to eight displays can be registered.
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13.2 Display Functions

Item Specifications

Available languages English, Japanese, German, French, Chinese, or Korean

System information display Displays the number of measurement, computation, and external input channels; available
options; remote controller ID; MAC address; firmware version; and internal memory capacity.

Network information display Displays the MV network configuration information.

Display selection menu customization
You can show/hide and change the positions of each item in the display selection menu and

submenus
You can insert or delete separators.
Function menu customization ~ You can show/hide and change the display positions of each item.
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13.3 Storage Function

Configuration

Item Specifications

Internal memory Temporarily stores various types of data
Medium Flash memory

External storage medium

Medium CF card (up to 2 GB)
Format FAT32 or FAT16
Data Types
Data Type Extension Format Display Method
MV DAQSTANDARD Application
Display data DAD Binary (undisclosed) Yes  Yes Yes'?
TDD Text - - Yes
Event data DAE Binary (undisclosed) Yes  Yes Yes':?
TDE Text - - Yes
Report data DAR Text Yes Yes Yes
Manually sampled data DAM Text - - Yes
Setup data PDL Binary (undisclosed) Yes Yes -
Snapshot data PNG PNG (general format) - - Yes

1 You can convert the data format on DAQSTANDARD and then open the data on a software application such as Microsoft Excel.

2 You can open on a software application, the data loaded from the MV through the communication function.

Display Data and Event Data

Item

Specifications

Internal memory

File storage capacity 400 MB
Number of files Up to 400
Operation FIFO (First In First Out)
Display data
Source Measurement, computation, and external input channels (/MC1)

Sampling interval

Set by Trend/Storage interval

MV1004, MV1008, MV2008: Select from 5 s, 10s, 15s, 30 s, 1 min, 2 min, 5 min, 10 min, 15 min,
20 min, 30 min, 1 h, 2 h, 4 h, 10 h/div

MV1006, MV1012, MVV1024, MVV2010, MV2020, MV2030, MV2040, MVV2048: Select from 15 s (only
for fast sampling mode), 30 s, 1 min, 2 min, 5 min, 10 min, 15 min, 20 min, 30 min, 1 h, 2 h, 4 h, 10
h/div

Contents The maximum and minimum values within the data update interval among the data values
sampled at the scan interval

Data size Measurement and external input channel (/MC1) data: 4 bytes/data value. Computation channel
data: 8 bytes/data value.

Files size Up to 8 MB

Data format Binary or text

Recording Records data at all times

Event data
Source Measurement, computation, and external input channels (/MC1)

Sampling interval

Contents
Data size

Files size
Data format
Mode

Set by Sample rate

Select from 25ms, 125ms, 250ms, 500ms, 1s, 2s, 5s, 10s, 30s, 1min, 2min, 5min, and 10min
However, you can only set rates that are slower than the scan interval.

Data for each sampling interval

Measurement and external input channel (/MC1) data: 2 bytes/data value. Computation channel
data: 4 bytes/data value.

Up to 8 MB

Binary or text

Free: Records data at all times

Triggered: Starts recording data when a certain event occurs and stops after a specified interval.

Saved data combinations

Display data only, event data only, or display data and event data.

File size

See appendix 1.
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13.3 Storage Function

Manually Sampled Data

Item

Specifications

Contents

Data format

Values measured at user-specified times
You can specify up to 120 channels when using external input channels (/MC1).
Text

Maximum number of data values that can be stored to the internal memory

400

Report Data (/M1,

IPM1)

Item

Specifications

Contents
Data format

Report at each scheduled time of report
Text

Maximum number of reports that can be stored to the internal memory

100

Saving of Data to

an External Storage Medium

Item

Specifications

Manual saving

Auto saving
Auto saving interval

Auto saving operation

Select the data in the internal memory and save to an external storage medium

If auto saving is disabled, saves when you insert an external storage medium and operate the
keys.

Automatically saves data in the internal memory to an external storage medium

Display data: Select from 10, 20, 30 min, 1, 2, 3,4, 6,8, 12h, 1, 2, 3, 5, 7, 10, 14, and 31 days.
Set by Save interval.

Event data (Free mode): Set by Data length.

Event data (triggered modes): Saves data at the end of a sampling operation at a specified time.
Set by Data length.

Manually sampled data: When you execute manual sampling

Report data: When reports are generated

Select “save data only if there is sufficient free space on the CF card” or “constantly retain the
most recent data files in the CF card (media FIFO)”.

File name

Select from “serial number+user-assigned string+date,” “sequence number+user-assigned string,”

and “sequence number+batch name.”

Save destination

Auto saving: CF card. Manual saving: CF card or USB flash memory
Directory name: Specify using up to 20 characters

Snapshot Data

Item

Specifications

Contents
Data format
Output destination

Displayed screen image data
PNG
CF card or communication output

Setup Data

Item Specifications

Contents MV setup data

Data format Binary

File name Specify using up to 32 characters

Output destination CF card or USB flash memory

Loading Loadable from a CF card or USB flash memory

Data File Loading

Item Specifications

Function You can load display data or event data from a CF card or USB flash memory and display the
loaded data.

Miscellaneous

Item Specifications

Header comment

You can add comments using up to 50 characters to display data, event data, manually sampled
data, and report data files.

IM MV1000-01E
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13.4 Other Standard Functions

Event Action Function

Item Specifications
Event action Executes a specified operation when a given event occurs.
Number of settings 40
Event Remote control input, etc.
Timer Number of timers: 4
Match time timer Number of timers: 4
Action You can specify memory start/stop, alarm ACK, etc.

There are limitations on the combinations of events and actions.

Security Functions

Item Specifications
Key lock function Limitations on key operations, access to the external storage medium, and various operations
Login function Allows registered users to operate the MV

Administrators 5 users

Users 30 users

Time Related Functions

Item Specifications
Clock With a calendar function
Accuracy +10 ppm, excluding a delay (of 1 second, maximum) that results each time the power is
turned ON.
Time setting Using key operation, communication command, event action function, or SNTP client
function

Time adjustment method
While memory sampling Corrects the time by 40 ms for each second.
Limit by which the time is gradually adjusted: Select from the available settings between 10 s
and 5 min.
If the time is outside the limit, the time is immediately corrected.
Cannot be used after hour 0 on January 1st, 2038.
While no memory sampling
Immediately changes the time
Time zone You can set the time difference from GMT.
Date format Select YYYY/MM/DD, MM/DD/YYYY, DD/MM/YYYY, or DD.MM.YYYY

Types of Characters That the MV Can Handle

Item Specifications
Characters Alphabet characters, numbers, and symbols (limitation exists)
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13.4 Other Standard Functions

Communication Functions

Item

Specifications

Electrical and mechanical

Conforms to IEEE 802.3 (Ethernet frames conform to the DIX specification)

Medium

Ethernet (10BASE-T)

Implemented protocols

TCP, IP, UDP, ICMP, ARP, DHCP, HTTP, FTP, SMTP, SNTP, Modbus, and MV-dedicated
protocols

E-mail client Automatically send e-mail when a specified event occurs such as an alarm
POPbeforeSMTP authentication available
FTP client Automatically transfer data files to the FTP server
Applicable files: Display data, event data, screen image data, and report data
FTP server Transfer files, delete files, manipulate directories, and output file lists from the MV
Web server Shows the MV display on a Web browser.
SNTP client Queries the SNTP server for the time and sets the MV.
Cannot be used after hour 0 on January 1st, 2036.
SNTP server Transmits the MV time.
Time resolution: 5 ms
Cannot be used after hour 0 on January 1st, 2036.
DHCP client Automatically obtains the network address settings from the DHCP server

Modbus client

Reads data from another device and writes to the registers.

Modbus server

Transmits MV data

Setting/measurement server

Operate, set, and transmit data from the MV using a dedicated protocol

Maintenance/test server

Transmits connection information and network information

Instrument information server

Transmits the connected MV information (serial number, model name, etc.).

Batch Function

Item Specifications
Function Data management using batch names. You can enter text fields and batch comments in the
data file.
Batch name Added to the file name of the display data and event data.
Structure Batch number (up to 32 characters) + lot number (up to 8 digits)
Text field Adds text to the display data and event data.

Batch comment

Adds text to the display data and event data.

USB Interface

Item

Specifications

USB port

Conforms to Rev 1.1, host function

Number of ports

2 (One on the front panel and another of the rear panel)

Supplied power

5V = 10%, 500 mA(per port)
If the total bus power of the two ports exceeds 500 mA, the devices cannot be used
simultaneously.

Connectable devices
Keyboard

External media

Only connect the devices listed below. Connecting other devices may damage the MV.
HID Class Ver1.1 compliant

104 keyboard (US) and 109 keyboard (Japanese)

Maximum number of connections: 1

USB flash memory (up to 2 GB)

We do not guarantee the operation of all USB flash memory devices.

External media such as hard disks, ZIP, MO, and optical disks cannot be used.
Maximum number of connections: 1

IM MV1000-01E
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13.5 Options

Alarm Output Relay (/A1, /A2, /A3, and /A4)

Item Specifications

Action Transmits relay contact signals from the terminals on the rear panel when alarms occur.
Number of outputs 2 outputs (/A1), 4 outputs (/A2), 6 outputs (/A3), and 12 outputs (/A4)

Relay contact rating 250 VAC (50/60 Hz)/3 A, 250 VDC/0.1 A (for resistance load)

Output format NO-C-NC

Relay operation Energized/de-energized, AND/OR, hold/non-hold, and reflash settings are selectable.

RS-232 Interface (/C2) and RS-422/485 Interface (/C3)

Item Specifications

Medium EIA RS-232(/C2) or EIA RS-422/485(/C3)
Protocol Dedicated protocol or Modbus protocol
Synchronization Start-stop synchronization

Transmission mode (RS-422/485)
Four-wire, half-duplex, multi-drop connection (1:N (N = 1 to 32))

Data rate 1200, 2400, 4800, 9600, 19200, or 38400 bps
Data length 7 or 8 bits
Stop bit 1 bit
Parity Odd, even, or none
Handshaking Off:Off, XON:XON, XON:RS, and CS:RS
Communication distance (RS-422/485)
1200 m
Modbus communication Operation modes: Master or slave

FAIL/Status Output Relay (/F1)

Item Specifications
FAIL output Relay contact output on CPU error
Relay operation Energized during normal operation and de-energized on system error.
Status output Transmits a relay contact signal when a selected condition occurs
Relay operation Energized when a condition occurs
Relay contact rating 250 VAC (50/60 Hz)/3 A, 250 VDC/0.1 A (for resistance load)
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13.5 Options

Computation Function (including the report function) (/M1)

Item

Specifications

Number of computation channels MV1004, MV1008, MV2008: 12 channels (101 to 112)

MV1006, MV1012, MV1024: 24 channels (101 to 124)
MV2010, MV2020, MV2030, MV2040, MV2048: 60 channels (101 to 160)

Operation

General arithmetic operations: Basic arithmetic, square root, absolute, common logarithm,
natural logarithm, exponential, and power

Relational operations: <, <, >, 2, =, #

Logic operations: AND, OR, NOT, XOR

Statistical operations: TLOG, CLOG

Special operations: PRE, HOLD, RESET, CARRY

Conditional operation: [a?b:c]

Computation accuracy

Double-precision floating point

Usable data
Channel data
Constants
Communication input data
Remote control input status
Pulse input
Status input

Measurement, computation, and external input channels (/MC1)
60 constants

MV1000: 24, MV2000: 60

0/1 (/IR1)

Counts the number of pulses (/PM1)

Internal switch, alarm output relay (/A[ 1), and flags

Rolling average:

Performs moving average on the computed results.

Measure range

—9999999 to 99999999
Decimal place: Zero to four fractional digits

Alarms High limit, low limit, delay high limit, and delay low limit
Hysteresis: High and low limit alarm: 0.0% to 5.0% of the span.

Display Same as the measurement channels

Data saving Same as the measurement channels

Report function

Number of report channels: same as the number of computation channels
Operations: Average, maximum, minimum, sum, instantaneous value
Report types: Hourly, daily, hourly + daily, daily + weekly, daily + monthly

Cu10, Cu25 RTD Input/Three-Wire Isolated RTD Input (/N1)

Item

Specifications

Function

In addition to the standard input, the MV can also receive Cu10 and Cu25 input.
On the MV1006, MV1012, MV1024, MV2010, MV2020, MV2030, MV2040, and MV2048,
all the RTD input terminals (A, B, and b) are isolated on each channel.

Measurement/display accuracy

Under standard operating conditions

Input Type Measurement | Accuracy Measurement Accuracy Max..
Range Guaranteed A/D integration time: A/D integration time: | Resolution
Range 16.7 ms or more 1.67 ms
Cu10 (GE) —70to 170°C
Cu10 (L&N) —75to 150°C
Cu10 (WEED) —200 to 300°C |-200 to 260°C (0.4% of rdg + 1.0°C) (0.8% of rdg + 5.0°C)
Cu10 (BAILEY) —328 to 572°F 0.1°C
Cu10: a = 0.00392 at 20°C —200 to 300°C
Cu10: a = 0.00393 at 20°C
Cu25: o = 0.00425 at 0°C (0.3% of rdg + 0.8°C) (0.5% of rdg + 2.0°C)

* Measuring currenti =1 mA
Input source resistance

1 Q or less per wire (The resistance of all three wires must be equal.)

Ambient temperature influence (applies when the A/D integration time is 16.67 ms or greater)

Signal source resistance

+(0.2% of range + 2 digits) or less

With a variation of 1 Q per wire (same resistance for all three wires): £(0.1% of rdg +
1 digit) or less

With a maximum difference of 40 mQ between wires: Approx. 1°C

IM MV1000-01E
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13.5 Options

Three-Wire Isolated RTD Input (/N2)

Item

Specifications

Input terminal

Isolation on each channel

Applies to MV1006, MV1012, MV1024, MV2010, MV2020, MV2030, MV2040, and MV2048

Extended Input (/N3)

Item

Specifications
Measurement/display accuracy
Under standard operating conditions

Input Type Measurement Range Measurement Accuracy Max.
A/D integration time: AID integration time: | Reso-
16.7 ms or more 1.67 ms lution
Kp vs Au7Fe 0.0 to 300.0 K 0to 20K Within 4.5 K Within 13.5 K
20 to 300 K Within 2.5 K Within 7.5 K 01K
PLATINEL 0.0 to 1400.0°C |32 to 2552°F (0.25% of rdg + 2.3°C) (0.25% of rdg + 8.0°C)
PR40-20 0.0 to 1900.0°C |32 to 3452°F 0 to 450°C Accuracy not guaranteed [Accuracy not guaranteed
450 to 750°C (0.9% of rdg + 3.2°C) {(0.9% of rdg + 15.0°C)
TC 750 to 1100°C  |(0.9% of rdg + 1.3°C) [(0.9% of rdg + 6.0°C)
1100 to 1900°C  |(0.9% of rdg + 0.4°C) [(0.9% of rdg + 3.0°C)
NiNiMo 0.0 to 1310.0°C  [32 to 2390°F (0.25% of rdg + 0.7°C) (0.5% of rdg + 3.5°C) .
W/WRe26 0.0 to 2400.0°C |32 to 4352°F 0 to 400°C 15.0°C 30.0°C 0.1°C
400 to 2400°C  |(0.2% of rdg + 2.0°C) |(0.4% of rdg + 4.0°C)
Type N (AWG14) |0.0 to 1300.0°C |32 to 2372°F (0.2% of rdg + 1.3°C) (0.5% of rdg + 7.0°C)
Pt50 —200.0 to 550.0°C|-328.0 to 1112.0°F | (0.3% of rdg + 0.6°C) (0.6% of rdg + 3.0°C)
Ni100 (SAMA)  |-200.0 to 250.0°C|-328.0 to 482.0°F | (0.15% of rdg + 0.4°C) (0.3% of rdg + 2.0°C)
Ni100 (DIN) —60.0 to 180.0°C |-76.0 to 356.0°F | (0.15% of rdg + 0.4°C) (0.3% of rdg + 2.0°C)
Ni120 —70.0 to 200.0°C [-94.0 to 392.0°F (0.15% of rdg + 0.4°C) (0.3% of rdg + 2.0°C)
RTD* |J263"B 0.0 to 300.0 K 0to40K Within 3.0 K Within 9.0 K
40 to 300 K Within 1.0 K Within 3.0 K 01K
Cu53 —50.0 to 150.0°C |-58.0 to 302.0°F | (0.15% of rdg + 0.8°C) (0.3% of rdg + 4.0°C)
Cu100 —50.0 to 150.0°C [-58.0 to 302.0°F (0.2% of rdg + 1.0°C) (0.4% of rdg + 5.0°C) 0.1°C
Pt25 —200.0 to 550.0°C|-328.0 to 1022.0°F| (0.15% of rdg + 0.6°C) (0.3% of rdg + 3.0°C)

mA

Thermocouple input: 2 kQ or less

RTD input: 1 Q or less per wire (The resistance of all three wires must be equal)
Ambient temperature influence (applies when the A/D integration time is 16.67 ms or greater)

* Measuring current i = 1
Input source resistance

TC input +(0.1% of rdg + 0.05% of range) or less, excluding the reference junction compensation error
RTD input +(0.2% of range + 2 digits) or less
Signal source resistance
TC input With a variation of signal source resistance +1 kQ: £10 pV or less
RTD input With a variation of 1 Q per wire (same resistance for all three wires): £(0.1% of rdg + 1 digit) or

less
With a maximum difference of 100 mQ between wires: Approx. 1°C

Remote Control (/R1)

Item Specifications
Number of input terminals 8
Input type Isolated from the main circuitry through a photocoupler, built-in isolated power supply for the input

terminals, and shared common.
Input type and signal level
Voltage-free contact
Open collector

Contact closed at 200 Q or less and contact open at 100 kQ or greater.
ON voltage: 0.5 V or less (sink current 30 mA or more), leakage current when OFF: 0.25 mA or

less
Allowable input voltage 5VDC
Signal type Level or edge (250 ms or more)
Action Executes a specified action by applying a given signal to the remote signal input terminal

Action assignment: Set using the event action function
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13.5 Options

24 VDC Transmitter Power Supply (/TPS2 and /TPS4)

Item Specifications
Number of loops 2 (/TPS2), 4 (/TPS4)
Output voltage 22.8 to 25.2 VDC (under rated load current)

Rated output current
Maximum output current
Allowable conductor resistance

Max. length of wiring
Insulation resistance
Dielectric strength

4 to 20 mADC

25 mADC (overcurrent protection operation current: approx. 68 mADC)

RL < (17.8 — minimum transmitter operation voltage)/0.02 A

where 17.8 V is the result obtained by subtracting the maximum drop voltage of 5V,
when the load shunt resistance is 250 Q, from the minimum output voltage of 22.8 V
2 km (when using a CEV cable)

20 MQ or more at 500 VDC between output terminal and ground

500 VAC (50/60 Hz, | = 10mA) for one minute between output terminal and ground
500 VAC (50/60 Hz, | = 10mA) for one minute between output terminals

Pulse Input (/PM1)

Item

Specifications

Pulse input
Number of Inputs:
Input type

Input type and signal level

Counting

Allowable input voltage

Max. sampling pulse period
Minimum detected pulse width
Pulse detection period

Pulse measuring accuracy
Pulse count interval
Miscellaneous

3 (8 when using the remote control input terminals)

Isolated from the main circuitry through a photocoupler and built-in isolated power supply

for the input terminals.

Shared common for pulse inputs

Voltage-free Contact closed at 200 Q or less and contact open at 100 kQ or

contact greater.

Open collector ON voltage: 0.5 V or less (sink current 30 mA or more), leakage
current when OFF: 0.25 mA or less

Counts the rising edges of pulses.

For voltage-free contact input: Contact open to contact close

For open collector: The H terminal voltage level changing from high to low

30 vDC

100 Hz

5 ms or more for both low (closed) and high (open)

Approx. 3.9 ms (256 Hz)

11 pulse

Scan intervalor 1's

Pulse input terminals can be used as remote control input terminals, isolated from

remote control input terminals

Remote control

Number of inputs: 5. Other items are the same as with remote control (/R1)
Remote control input terminals can be used as pulse input terminals.

Computation Function

Same as the computation function (/M1)

Calibration Correction (/CC1)

Item

Specifications

Callibration correction method

Corrects the measured value of each channel using segment linearizer approximation
Number of segment points: 2 to 16 (including the start and end points)

External Input Channel Function (/MC1)

Item

Specifications

Function

Loads data from other instruments by using the Modbus client or Modbus master
function and displays, records, and saves the data

Number of channels

240 channels (201 to 440)

Display

Same as the measurement channels

Data saving

Same as the measurement channels

Manual sampling

Specify up to 120 channels from measurement, computation, and external input
channels.
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13.6 General Specifications

Construction

Item Specifications

Material Case: Aluminum plate (MVV2000), metal plate (MV1000)
Bezel: Polycarbonate

Color Case: Smoke blue (Munsell 4.1PB6.0/4.5 or equivalent)

External dimensions

Weight

Bezel: Light gray (Munsell 5.2PB8.2/1.0 or equivalent)

MV1000: 189(W) x 177(H) x 253(D) mm, 189(W) x 177(H) x 259(D) mm"', 189(W) x 186(H) x
259(D) mm*

MV2000: 307(W) x 273(H) x 254(D) mm , 307(W) x 273(H) x 260(D) mm"’

*1 With clamp terminals (input terminal suffix code is -1) or pulse inputs (/PM1 option)

*2 Rechargeable battery model (power supply suffix code is -3)

MV1004, MV1006, MV1012: Approx. 3.3 kg, Approx. 4.5 kg”, MV1008, MV1024: Approx. 3.5 kg,
Approx. 4.7 kg*1 MV2008, MVV2020: Approx. 5.3 kg, MV2010: Approx. 5.2 kg, MV2030: Approx. 5.5
kg, MV2040, MV2048: Approx. 5.6 kg excluding options

*1 Rechargeable battery model (power supply suffix code is -3)

Normal Operating Conditions

Item

Specifications

Supply voltage
Power supply frequency
Ambient temperature
Ambient humidity
Vibration
Shock
Magnetic field
External noise
DC voltage
Thermocouple

RTD
Common mode noise

90 to 132, 180 to 250 VAC

50 Hz + 2%, 60 Hz + 2%

0 to 40°C, 10 to 40°C (Rechargeable battery model (power supply suffix code is -3))
20 to 80%RH (at 5 to 40°C)

10 to 60 Hz, 0.2 m/s?

Not allowed

400 A/m or less (DC and 50/60 Hz)

Normal mode (50/60 Hz)

The peak value including the signal must be less than 1.2 times the measuring range.
The peak value including the signal must be less than 1.2 times the measuring thermal
electromotive force.

50 mV or less

250 VACrms or less for all ranges (50/60 Hz)

Maximum noise voltage between channels

Installation position

Warm-up time
Installation location
Operating altitude

250 VACrms (50/60 Hz) or less

Horizontal

You can tilt the MV by bringing the front legs out.
At least 30 minutes after power-on

Indoors

2000 m or less

Input Terminal (input terminal suffix code -1)

Item

Specifications

Type

Clamp terminal
Attachable and detachable for each channel
Recommended wire size: 0.08 mm? to 1.5 mm? (AWG28 to 16)

Input Terminal (input terminal suffix code -2)

Item

Specifications

Type

M4 screw

13-14
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13.6 General Specifications

Power Supply (Power supply suffix code -1)

Item Specifications
Rated supply voltage 100 to 240 VAC
Supply voltage range 90 to 132, 180 to 264 VAC
Rated power supply frequency 50 Hz or 60 Hz
Power consumption MV1000/MV2000 Supply voltage LCD backlight off Normal Maximum
MV1000 100 VAC 15 VA 30 VA 45 VA
240 VAC 25 VA 40 VA 60 VA
MV2000 100 VAC 28 VA 40 VA 65 VA
240 VAC 38 VA 54 VA 90 VA
Allowable interruption time Less than 1 cycle of the power supply frequency

Power Supply (Power supply suffix code -2)

Item Specifications
Rated supply voltage 12 VDC/24 VDC
Supply voltage range 10.0 to 28.8 VDC
Power consumption MV1000/MV2000 Supply voltage LCD backlight off Normal Maximum
MV1000 12 VDC 7 VA 14 VA 24 VA
24 VDC 7 VA 14 VA 23 VA
MV2000 12VDC 9 VA 18 VA 35 VA
24 VDC 9 VA 18 VA 33 VA
Miscellaneous A/D converter integration time: Fixed to 20 ms (50 Hz) if set to Auto
When using the AC adapter
Rated supply voltage 100 to 240 VAC
Supply voltage range 90 to 264 VAC

Rated power supply frequency 50 Hz or 60 Hz
Maximum input power consumption

MV1000: 60 VA, MV2000: 90 VA
Rated power supply frequency 48 to 62 Hz

Power consumption MV1000/MV2000 Supply voltage LCD backlight off Normal Maximum
MV1000 100 VAC 15 VA 30 VA 45 VA
240 VAC 25 VA 40 VA 60 VA
MV2000 100 VAC 28 VA 40 VA 65 VA
240 VAC 38 VA 54 VA 90 VA
Dielectric strength 1500 VAC (50/60 Hz) for one minute between the AC adapter power supply terminal and
earth
Miscellaneous A/D converter integration time: Fixed to 20 ms (50 Hz) if set to Auto

Power Supply (Power supply suffix code -3)

Item Specifications

Battery drive mode
When the AC adapter and the battery are used in combination, the AC adapter is the primary power supply.

Charging function Charge mode by connecting the AC adapter, whether the power switch is ON or OFF.
Charge time Approx. 2.5 hours

Number of times chargeable Approx. 300 times (depends on operating conditions)

LED display ALARM LED : Lights when the battery voltage drops

CHARGE LED : Lights while charging, blinks when fully charged.

When using the AC adapter

Rated supply voltage 100 to 240 VAC
Supply voltage range 90 to 264 VAC

Rated power supply frequency 50 Hz or 60 Hz

Power supply frequency 48 to 62 Hz

Rated AC adapter output 19.5V (18.0 t0 20.0 V)
voltage

Maximum AC adapter output 4.7A

current

IM MV1000-01E
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13.6 General Specifications

Item Specifications

Maximum input power 125 VA

consumption

Power consumption Supply voltage Minimum Normal Maximum
100 VAC 105 VA 105 VA 115 VA
240 VAC 105 VA 115 VA 125 VA

The operating conditions of the MV1000 and MV2000 are as follows:

Minimum: No USB connection, no optional terminal, back light saver ON, Auto save ON
Normal:  No USB connection, no optional terminal, LCD brightness 2, Auto save ON
Maximum: No USB connection, with optional terminals, LCD brightness 8, Auto save ON

Dielectric strength 1500 VAC (50/60 Hz) for one minute between the AC adapter power supply line and earth

Miscellaneous A/D converter integration time: Fixed to 20 ms (50 Hz) if set to Auto

Isolation

Item Specifications

Insulation resistance Between the Ethernet, RS-422/485, and insulation terminals and earth: 20 MQ or greater at 500
VDC

Dielectric strength Between the power terminal and earth: 2300 VAC at 50/60 Hz for one minute

Between the contact output terminal and earth: 1600 VAC at 50/60 Hz for one minute

Between the signal input terminal and earth: 1500 VAC at 50/60 Hz for one minute

Between signal input terminals: 1000 VAC (50/60 Hz) for one minute (excluding the “b” input
terminal of MV1006, MV1012, MV1024, MV2010, MV2020,
MV2030, MV2040, MV2048)

Between the remote input terminal and earth: 1000 VDC for one minute

Between the pulse input terminal and earth: 1000 VDC for one minute

Ground Grounding resistance: 100 Q or less

Transporting and Storage Conditions

Item Specifications

Ambient temperature —25 10 60°C

Ambient humidity 5 to 95%RH (no condensation)
Vibration 10 to 60 Hz, 4.9 m/s® or less

Shock 392m/s? or less (in packaged condition)

Compliant Standards

Item Specifications
CSA CSA22.2 No.61010-1, installation category Il," pollution degree 2,2 and measurement category Il
UL UL61010-1 (CSA NRTL/C)
CE
EMC directive EN61326 compliant (Emission: Class A, Immunity: Annex A)

EN61000-3-2 compliant
EN61000-3-3 compliant

EN55011
Low voltage directive EN61010-1, installation category |l, measurement category Il,3 pollution degree 2
C-Tick AS/NZS CISPR11 compliant, Class A Group 1

1 Installation category (overvoltage category) II: Describes a number which defines a transient overvoltage condition. Implies
the regulation for impulse withstand voltage. “II” applies to electrical equipment which is supplied from the fixed installation
like a distribution board.

2 Pollution degree 2: Describes the degree to which a solid, liquid, or gas which deteriorates dielectric strength or surface
resistivity is adhering. “2” applies to normal indoor atmosphere. Normally, only non-conductive pollution occurs.

3 Measurement category II: Applies to measuring circuits connected to low voltage installation, and electrical instruments
supplied with power from fixed equipment such as electric switchboards.
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13.6 General Specifications

Standard Performance

Item Specifications
Measurement/display accuracy
Standard operating conditions:
Temperature:
Humidity:
Power supply voltage:
Power supply frequency: 50/60 Hz + 1%
Warm-up time: At least 30 minutes.
Other ambient conditions such as vibration should not adversely affect the operation.

23+2°C
55% + 10%RH
90 to 132 or 180 to 250 VAC

Input Type Range Measurement Accuracy (Digital Display) Max. Resolution
A/D integration time: 16.7 ms or more | A/D integration time: 1.67 ms of Digital Display
20 mV (0.05% of rdg + 12 digits) (0.1% of rdg + 40 digits) 1V
V 10 pVv
gg OmmV (0.05% of rdg + 3 digits) (0.1% of rdg + 15 digits) 18 ﬁv
c 2V (0.05% of rdg + 12 digits) (0.1% of rdg + 40 digits) 100 pv
DC voltage 15V Tmv
6V o . - 1mV
. f + 19 +
20V (0.05% of rdg + 3 digits) (0.1% of rdg + 15 digits) ey
50 V 10 mV
R (0.15% of rdg + 1°C) (0.2% of rdg + 4°C)
R,S 0to 100°C: 3.7°C, R,S 0to100°C: 10°C,
S 100 to 300°C: 1.5°C 100 to 300°C: 5°C
B 400 to 600°C: 2°C, B 400 to 600°C: 7°C,
Thermocouple B Accuracy not guaranteed for Accuracy not guaranteed for
* Not including the values less than 400°C values less than 400°C
accuracy of referenge K (0.15% of rdg + 0.7°C) (0.2% of rdg + 3.5°C)
J\/L:/r']ﬁtlgn Compfnsat'_on —200 to —100°C: (0.15% of rdg + 1°C) | —200 to ~100°C: (0.15% of rdg + 6°C)
o purout detection | g (0.15% of rdg + 0.5°C) (0.2% of rdg + 2.5°C)
J —200 to —100°C: (0.15% of rdg + 0.7°C) | —200 to —100°C: (0.2% of rdg + 5°C) 0.1°C
T
N (0.15% of rdg + 0.7°C) (0.3% of rdg + 3.5°C)
W (0.15% of rdg + 1°C) (0.3% of rdg + 7°C)
L (0.15% of rdg + 0.5°C) (0.2% of rdg + 2.5°C)
U —200 to —100°C: (0.15% of rdg + 0.7°C) | —200 to —100°C: (0.2% of rdg + 5°C)
WRe (0.2% of rdg + 2.5°C) (0.3% of rdg + 10°C)
0 to 200°C: 4.0°C 0 to 200°C: 18.0°C
Pt100 o o o o
RTD JPt00 (0.15% of rdg + 0.3°C) (0.3% of rdg + 1.5°C)
DI Voltage |Threshold level (Vth=2.4 V) accuracy + 0.1V
Contact |1 kQ orless: 1 (ON), 100 kQ or more: 0 (OFF) (parallel capacitance of 0.01 pF or less)
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13.6 General Specifications

Item Specifications
Measurement accuracy when scaling
Accuracy during scaling (digits) = measurement accuracy (digits) x multiplier + 2 digits (rounded up)
* Fractions rounded up
where the multiplier = scaling span (digits)/measuring span (digits).
Example For 1-5V range (A/D integration time is 16.7 ms or more), measurement span of 1.000
to 5.000 V, and scaling span of 0.000 to 2.000
The measuring accuracy for 5 V input is as follows:
Measuring accuracy (1-5V range) = +(0.05% x 5 V + 3 digits) = £(0.0025 V [3 digits] +
3 digits) = +6 digits
Multiplier = {2000 digits (0.000 to 2.000)}/4000 digits (1.000 to 5.000) = 0.5
Thus, accuracy during scaling = £(6 x 0.5 + 2) digits = 5 digits (fractions rounded up)
Reference junction compensation accuracy
When measuring temperature greater than or equal to 0°C and when input terminal temperature
is balanced
Type R, S, W, WRe: £1°C
Type K, J,E, T, N, L, and U: £0.5°C
Type B: Internal reference compensation is fixed to 0°C
Maximum input voltage +60 VDC (continuous)

Input resistance 200 mV range or less and TC: 10 MQ or more
2V range or higher: Approx. 1 MQ
Input source resistance
Volt, TC 2 kQ or less
RTD input (Pt100) 10 Q or less per wire (The resistance of all three wires must be equal.)
Bias current 10 nA or less (except when burnout detection function is enabled)

Maximum common mode noise voltage
250 VACrms (50 Hz/60 Hz)
Maximum noise voltage between channels
250 VACrms (50 Hz/60 Hz)
Inter-channel interference 120 dB (when the input source resistance is 500 Q and the input to other channels is 60 VDC)
Common mode rejection ratio
When the A/D integration time is 20 ms
120 dB (50 Hz + 0.1%, 500 Q unbalanced, between the minus terminal and ground)
When the A/D integration time is 16.7 ms
120 dB (60 Hz + 0.1%, 500 Q unbalanced, between the minus terminal and ground)
When the A/D integration time is 1.67 ms
80 dB (50/60 Hz + 0.1%, 500 Q unbalanced, between the minus terminal and ground)
Normal mode rejection ratio
When the A/D integration time is 20 ms
40 dB or more (50Hz + 0.1%)
When the A/D integration time is 16.7 ms
40 dB or more (60 Hz + 0.1%)
When the A/D integration time is 1.67 ms
Not reject 50/60 Hz
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13.6 General Specifications

Effects from Operating Conditions

Item

Specifications

Ambient temperature (applies when the A/D integration time is 16.7 ms or greater)

DC voltage, TC range

RTD range
Power supply fluctuation

Magnetic field
Signal source resistance
DC voltage range

TC range
RTD range (Pt100)

Effects of vibration

With temperature variation of 10°C: £(0.1% of rdg + 0.05% of range) or less

* Excluding the reference junction compensation error

+(0.1% of rdg + 2 digits) or less

With a fluctuation within 90 to 132 V and 180 to 250 VAC (50/60 Hz): Accuracy specifications are
met.

With a fluctuation of +2 Hz of the rated power frequency (supply voltage 100 VAC): Accuracy
specifications are met.

AC (50/60 Hz) and 400 ADC/m fields:  +(0.1% of rdg + 10 digits) or less

With a variation of source signal resistance + 1 kQ:
200 mV range or less: £10 pV or less
2 V range or higher: £0.15% of rdg or less
With a variation of signal source resistance +1 kQ: +10 pV or less
With a variation of 10 Q per wire (same resistance for all three wires): £(0.1% of rdg + 1 digit) or
less
With a maximum difference of 40 mQ between wires: Approx. 0.1°C
Effects from a sinusoidal vibration along all three axes at a frequency between 10 to 60 Hz and
an acceleration of 0.2 m/s?: £(0.1% of rdg + 1 digit) or less

Miscellaneous

Item

Specifications

Memory backup

A built-in lithium battery backs up the settings and runs the clock
Battery life: Approximately 10 years (at room temperature)

Clock

With a calendar function
Time can be synchronized by using an external contact (remote control function, option).
Clock accuracy: +10 ppm, excluding the delay at power-on (1 s or less)
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13.7 External Dimensions

MV1000
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If not specified, the tolerance is *3 %. However, in cases of less than 10 mm, the tolerance is 0.3 mm.
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13.7 External Dimensions

With vertical stand attached

| Unit: mm
§ (approx. inch)
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If not specified, the tolerance is £3 %. However, in cases of less than 10 mm, the tolerance is 0.3 mm.
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13.7 External Dimensions

With an EIA/ANSI-compliant rack

Unit: mm
482.6+1 - (approx. inch)
(19.0) ane
30 228
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w|E Rack mounting screw cramp
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Dimension of oval holes
If not specified, the tolerance is #3 %. However, in cases of less than 10 mm, the tolerance is 0.3 mm.

Rechargeable Battery Model (Power supply suffix code is -3)
Unit: mm
(approx. inch)
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If not specified, the tolerance is *3 %. However, in cases of less than 10 mm, the tolerance is 0.3 mm.
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13.7 External Dimensions

MV2000

Unit: mm

(approx. inch)
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If not specified, the tolerance is *3 %. However, in cases of less than 10 mm, the tolerance is 0.3 mm.
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13.7 External Dimensions

With an EIA/ANSI-compliant rack

Unit: mm
(approx. inch)
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Rack mounting screw cramp
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[T T T T T T T T T T T T T T T T T T T T T T T ! [~ [ Appropriate tightning torque:
| Spacer 0.9 N'm )
gl T mom ; .
—~ L0 & | | & | [
S : : ~ Rack 1 Rack ‘
O le=< |0 ‘ mounting | mounting | S
~ i fittings | fittings ‘ P 1
wT= : o
le | ’ ]
sel L]
L 1
- -——4892b6)—
N 13.7
ol ~ +  (0.54)
(18.31) I

(Distance between mounting holes) 10.3
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Dimensions of oval holes

If not specified, the tolerance is £3 %. However, in cases of less than 10 mm, the tolerance is 0.3 mm.
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Appendix

Appendix 1 Data File Size

This section explains how to calculate the file sizes of display data files and event data
files. The calculation examples are for when the MV is set to record only display data or
only event data. If you are recording both display and event data, calculate the data size
of each and add them together.

Use the calculated file size as a rough estimate.

File Size
Afile consists of the following:
sampled-data related information + sampled data

The maximum size of a single display data file or event data file is 8 MB.

Sampled-Data Related Information Size

Item Size in Bytes
File header 216
Channel information 88xN + 32
Group information 96%10 + 32 = 992 (MV1000)
96x36 + 32 = 3,488 (MV2000)

Message information 104x50 + 32(an add message area is reserved by default)
Batch information 832
Sampled data header 80+32+Nx8+16+2
Alarm information header 24 + 8 (add the size of this item even if there is no alarm)
Message information Up to 104x1050 (varies depending on the number of messages)
Alarm information Up to 32x5000 (varies depending on the number of alarms)

N is the number of channels (measurement channels + external input channels + computation

channels).

Example 1: When recording measured data of 30 measurement channels, 240
external input channels, and 10 computation channels with no messages
or alarms.

216 + (88x280 + 32) + 3,488 + (104x50 + 32) + 832 + (80 + 32 + 280x8 + 16 + 2) + (24 + 8)=
36,842 bytes

Sampled Data Size
¢ Data Sizes of Display Data and Event Data

Channel Display Data Event Data
Measurement channel 4 bytes/channel 2 bytes/channel
External input channel 4 bytes/channel 2 bytes/channel
Computation channel 8 bytes/channel 4 bytes/channel

Time data is added to all channels at each sampling.
| Time data | 8 bytes/sample |

» Data Size per Sample
Display Data
(Number of measurement channelsx4 bytes) + (number of external input channelsx4
bytes) + (number of computation channelsx8 bytes) + 8 bytes (time data)

Event Data
(Number of measurement channelsx2 bytes) + (number of external input channelsx2

bytes) + (number of computation channelsx4 bytes) + 8 bytes (time data)
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Appendix 1 Data File Size

Sampled Data Size per File

Display Data

Data size per samplexfile save interval/sampling interval

The sampling interval is determined by dividing the Trend/Storage interval (s/div) by
30.

Example 2: When recording the display data of 30 measurement channels, 240
external input channels, and 10 computation channels with the Trend/
Storage interval set to 30 min/div (display data sampling interval is 60 s)
and the file save interval set to 1 day (24 h)

(30x%4 bytes + 240%4 bytes + 10%8 bytes + 8 bytes)x24hx60x60/60 s
= 1,168 bytesx24hx60x60/60 s
=1,681,920 bytes

Event Data
Data size per samplexdata length/sample rate

Example 3: When recording the event data of 30 measurement channels, 240
external input channels, and 10 computation channels with the sample
rate set to 1 s and the data length set to 2 h.

(30%2 bytes + 240x2 bytes + 10x4 bytes + 8 bytes)x2hx60%x60/1 s
= 588 bytesx2hx60x60/1 s
= 4,233,600 bytes

Size of a File
The size of a file is the sum of the sampled-data related information size and the sampled
data size.

Display Data

Example 4: When recording under the conditions given in examples 1 and 2
From examples 1 and 2, the size of a file is 36,842 + 1,681,920 = 1,718,762 bytes =
1.639 MB.

Event Data

Example 5: When recording under the conditions in examples 1 and 3
From examples 1 and 3, the size of a file is 36,842 + 4,233,600 = 4,270,442 bytes =
4.073 MB.

App-2
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Appendix 1 Data File Size

CF Card Recording Length

Here we will estimate how long the MV can record to a CF card when automatically
saving measured data.
Display Data
CF card recording length (estimate) = (CF card size/file size)xfile save interval
Example 6: We will estimate the CF card recording length under the conditions
given in examples 1 and 2. We assume the CF card size to be 256 MB.

256 MB/1.639 MBx24 h
= 3,748 h
~ 156 days

Event Data
CF card recording length (estimate) = (CF card sizeffile size)xdata length

Example 7: We will estimate how often we will need to replace the CF card under
the conditions given in examples 1 and 3. We assume the CF card size

to be 256 MB.

256 MB/4.073 MBx2 h
=125h
=~ 5.2 days

Nofte
If you format a 256-MB CF card, you will be able to use approximately 246 MB.

Internal Memory Recording Length
If you are manually saving measured data to the internal memory, old data will be

overwritten when the internal memory becomes full. You must save the measured data to
a CF card before the data is overwritten.
Display Data
Internal memory recording length (estimate) = (Internal memory sizeffile size)xfile
save interval
Example 8: We will estimate the internal memory recording length under the
conditions given in examples 1 and 2. An internal memory size is 400

MB.

400 MB/1.639 MB%24 h
=~ 5,857 h
= 244 days

Event Data
Internal memory recording length (estimate) = (Internal memory sizeffile size)xdata

length
Example 9: We will estimate the internal memory recording length under the
conditions given in examples 1 and 3. An internal memory size is 400

MB.

400 MB/4.073 MBx2 h
=196 h
~ 8.18 days
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Appendix 2 Event Action Configuration Examples

Example 1: To Start/Stop Memory Sampling by Using the Remote Control
Function (/R1 Option)

We will configure the MV so that it starts or stops memory sampling when a signal is
applied to remote control input terminal 2. We will use event action number 1.

* Display and Settings
Press MENU and then select Menu tab > Timer, Event action > Event action.

Logic box number

Event Remote
Remote number 2
Action HemoryStart/Stop

2 [ 3 | 4 ]

<Operation>
If you turn ON the input to remote control input terminal 2, the MV will start memory
sampling (if it isn’t already). If you turn OFF the input, the MV will stop memory sampling.

Example 2: To Write a Message When an Alarm Occurs
We will configure the MV so that it will write the message “Channel 1 Alarm” to group 1

when an alarm occurs on channel 1. We will use event action number 2.

* Display and Settings
Press MENU and then select Menu tab > Timer, Event action > Event action.

Logic box number “

Event Switch
Switch MNo. SA3
Action Heszage
Heszage MNo. q
Write to Select
Group number 1

1 2 e |

<Other Settings>
» Assign an alarm to channel 1, and configure the MV so that alarm events are sent to

internal switch 3.
» Register “Channel 1 Alarm” to message number 4.
P For alarm configuration instructions, see section 3.7.
P For message registration instructions, see section 6.4.
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Appendix 2 Event Action Configuration Examples

Example 3: To Save Data Every Day at 17:00

We will configure the MV so that it will store recorded data to a CF card every day at hour
17. We will use event action number 3. We will use timer number 1.

* Display and Settings

To set the Event Action
Press MENU and then select Menu tab > Timer, Event action > Event action.

HatchTimeTimer
1
SaveDisplay

Logic box number
Event
Timer number
Action

2 [ 3 | 4 ]

To Configure Match Timer Number 1
Press MENU and then select Menu tab > Timer, Event action > MatchTimeTimer.

; b= MY (S)

Timer number
Kind Dav
Daw 1
Hour:iHinute 1788
Timer action Repeat

1 20 |

<Other Settings>
Configure the MV to automatically save display data, and set the file save interval to

1day or longer. If you set the file save interval shorter than 1day, the MV also saves data

at the file save interval.
P For instructions on how to configure display data recording conditions, see section 4.1.
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Appendix 2 Event Action Configuration Examples

Example 4: To Release Alarm Output by Using the USER Key (AlarmACK
Operation)
We will configure the MV so that the alarm output is released when the USER key. is
pressed. We will use event action number 4.
* Display and Settings
Press MENU and then select Menu tab > Timer, Event action > Event action.

0.5 BB BEZE(S] &)
Logic box number

Event Userkey
Action AlarmAcK
1 20 |

<Operation>
Pressing USER releases an active alarm indication and relay output.

<Other Settings>
Set the alarm indication and alarm output relay operation to Hold.

P For instructions on how to configure the alarm indication and alarm output relay
operation, see section 3.5.
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Appendix 3 Text File Formats

This section explains the text file formats. The MV can generate the following text files:
display data files, event data files, manually sampled data files, and report files.
In the explanation below, CRLF represents a terminator.

Display Data

+ If you set the display data file format to text, the MV generates a tab-separated text

file that contains numeric values and text.

* The MV does not generate values for measurement channels set to Skip or for

computation or external input channels set to Off.

Format
YRECCRLF
Measure Data Version 1.00.00CRLF
Model MV1000CRLF
Language Code Shift JISCRLF
Serial No. IITIeeICRLF
File Header HHHe e «HCRLF
File ID N1 N2CRLF
Time Correction TTTTCRLF
Start Info FEFeeeF SSSeeeS JJJee**JCRLF
End Info FEFeeeF SSSeeeS JJJee**JCRLF
Extra Data PPPP KKKK Q1010Q01° Q1
Sampling Interval SI UNCRLF
Trigger Point TPCRLF
Batch Info BI BBBe e+ *BCRLF
Batch Comment (Time) RRRe**R GGGe**GCRLF

Text InfoCRLF

Text Field YYYeeeY EEEeeeECRLF
Ch cceccce ccccece e
Tag ttteeet ttteeet oo
Unit uuuuuu uuuuuu see
Type PPPP PPPP L
Kind KKKK KKKK eee

Sampling DataCRLF

(Time) nnneeen nnneeen eee

Message DataCRLF

(Time) WWiWeeelW SSSeeeS RRReeeRCRLF

020202 (2

ccccec
Ltteeet
uuuuuu
PPPP
KKKK

nnneeen

e**CRLF

MessageCRLF
CRLF

CRLF
MessageCRLF
CountCRLF

5sssssCRLF

Xipuaddy
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Appendix 3 Text File Formats

IITeeeT
HHHe e H
Nx

TTTT

FEFeeeF

SSSeeeS

JJJeeeJd
PPPP

KKKK

Q101Q1°° Q1

020202 Q2

ST
UN
TP
BI
BBBee*B
RRRe R
GGGe G
YYYeeeoY
EEEeeE

MV serial number (16 characters)
File header (50 characters)

N1 Memory start number

N2 File serial number up to memory stop

Time adjustment

Done Carried out

None Not carried out

Start and stop conditions

Manual Manually (using key operations or
communications)

Auto Auto (auto save, etc.)

Black Out On a power failure event

Trigger On a trigger event

Start and stop trigger source or message trigger source
None

Key START/STOP key input
Communication Communication input
Remote Remote input

Event Event occurrence

Start/end user name (up to 20 characters)

Data type

Meas Measurement channel data

Math Computation channel data

Ext External input channel data
Maximum/minimum value

Max Maximum value

Min Minimum value

Inst Instantaneous value

Error data handling

PlusOver Positive range-out

MinusOver Negative range-out

BurnOutUp Positive range-out due to burnout
BurnOutDown Negative range-out due to burnout
Error Computation error

NoData Undefined

Error data value (5 digits including the sign (measurement and external
input), 10 digits including the sign (computation))
Trend/Storage interval

Time unit

Trigger point (0 and greater, displays the trigger point number)
Lot number

Batch number (up to 32 characters)

User name (up to 20 characters)

Comments (up to 50 characters)

Title (up to 20 characters)

Text (up to 30 characters)

App-8
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Appendix 3 Text File Formats

Event Data

ccccece
ttteeet
uuuuuu
nnneeen
Sssss

WIWWe e eW

Time Format

Channel number (five characters)

Tag name (up to 16 characters)

Unit (up to six characters)

Measured value (up to 10 characters)
Number of messages (up to five characters)
Message string (up to 32 characters)

yyyy/mo/dd hh:mi:ss bbb  Year, month, day, and time of sampling (23 characters)

yyyy  Year
mo Month
dd Day

hh Hour
mi Minute
ss Second

bbb Millisecond

» If you set the event data file format to text, the MV generates a tab-separated text file
that contains numeric values and text.

* The MV does not generate values for measurement channels set to Skip or for
computation or external input channels set to Off.

Format

For the format and parameters, see “Display Data.”
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Appendix 3 Text File Formats

Manually Sampled Data

YRECCRLF

The MV generates manually sampled data to a tab-separated text file that contains
numeric values and text.

* The MV does not generate values for measurement channels set to Skip or for
computation or external input channels set to Off.

» Data is added to the file each time you carry out a manual sampling operation.

Format

Manual Sample Data Version 1.00.00CRLF

Model
Language Code
File Status
Serial No.

File Header

MV2000CRLF
shift-JISCRLF
fEffEff£f£CRLF
IIIee**ICRLF
HHHe e «HCRLF

Ch ccccce ccccce see cccccCRLE
Tag ttteeet ttteeet ttteestCRLF
Unit uuuuuu uuuuuu e UUUUUUCRLE
yyyy/mo/dd hh:mi:ss nnneeen nnneeen e nnne e *nCRLF
FEEEELET File status (eight characters)
Complete Completed
Progress Data being added
Decrease Defective
IITeeeI MV serial number (16 characters)
HHHe e sH File header (50 characters)
ccecece Channel number (five characters)
ttteeot Tag name (16 characters)
uuuuuu Unit (six characters)
yyyy/mo/dd hh:mi:ss Year, month, day, and time of sampling (19 characters)
nnnesen Measured value (13 characters)

App-10
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Appendix 3 Text File Formats

File Output Example
Below is an example of manually sampled data for channels 1, 2, 3, and 4.

YREC

Manual Sample Data Version 1.00.00

Model MvV2000

Language Code shift-JIS

File Status Progress

Serial No. S5E701600

File Header

Ch CHOO1 CH002 CHO003 CHO04
Tag TI-101 oUT-102 FI-103 VA-204
Unit °C Y m3/h %
2008/01/23 08:57:22 213.8 0.517 368.4 68.9
2008/01/23 08:57:28 208.6 0.494 363.0 68.1

Nofte
» The output when error data, range-out data, or computation range-out data is detected

Channel Data Output
Measurement Error (Space)
channels and
external input Positive range-out (includes burnout detection) 99999
channels

Negative range-out (includes burnout detection) —-99999
Computation Error 999999999
channels

Positive computation range-out (when the value 999999999

exceeds approx. 3.4E+38)

Negative computation range-out (when the value is —-999999999

less than approx. —3.4E+38)

* The MV generates a new manually sampled data file in the following cases:
* A measurement channel is changed to Skip from a range other than Skip.
* A measurement channel is changed from Skip to a range other than Skip.
» A computation or external input channel is changed from On to Off or Off to On.
* The unit is changed.

IM MV1000-01E App-11
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Appendix 3 Text File Formats

Report File
* The MV generates hourly, daily, weekly, and monthly reports to a tab-separated text
file that contains numeric values and text.
* The MV does not generate values for measurement channels set to Skip or for
computation or external input channels set to Off.
» Data is added to the file each time a file is generated.
Format
YRECCRLF
Report Data Version 1.00.00CRLF
Model MV2000CRLF
Language Code shift-JISCRLF
File Status ffffff££CRLF
Serial No. IIIee*ICRLF
File Header HHHe e e HCRLF'
Report Set RRRe ¢ *RCRLF
File Data rrree*rCRLF
Math Set MMM MMM MMM MMMMCRLF
Start Time YYYY/MO/DD HH:MI:SSCRLF
Ch cceccece ccccece e cccccCRLF
Tag ttteeet ttteeet ttteestCRLF
Unit uuuuuu uuuuuu soe UuuuuuCRLEF
Data Type Sssee**sCRLF
Time yyyy/mo/dd hh:mi:ssCRLF
Status ceceeceeeeeeCRLF
Ave nnneeen nnneeen LR nnnee*nCRLF
Max nnneeen nnneeen oo nnnee*nCRLF
Min nnneeen nnneeen soe nnnee *nCRLF
Sum nnneeen nnneeen see nnnee*nCRLF
fEEFEFEf File status (eight characters)
Complete Completed
Progress Data being added
Decrease Defective
IITeeeI MV serial number (16 characters)
HHHe s ¢ H File header (50 characters)
RRRe**R Report setting (setting on the MV) (13 characters)
Hourly
Daily
Hourly+Daily
Daily+Weekly
Daily+Monthly
rrreeer Report file contents (13 characters)
Hourly
Daily
Hourly+Daily
Daily+Weekly
Daily+Monthly

Example: When the MV is set to Hourly+Daily and Combine,
Hourly+Daily is output.
When the MV is set to Hourly+Daily and Separate, the
hourly report is output as Hourly, and the daily report as
Daily.
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Appendix 3 Text File Formats

YREC

Report Data
Model
Language Code
File Status
Serial No.
File Header
Report Set
File Data
Math Set
Start Time
Ch

Tag

Unit

Data Type
Time

Status

Ave

Max

Min

Sum

MMMM

YYYY/MO/DD HH:MI:SS
ccecee

ttteeet

uuuuuu

ceeeeceeeee

SSSeeeS

yyyy/mo/dd hh:mi:ss

nnneeen

File Output Example

Report items. Up to four types. 16 characters (including tabs
that are counted as one character each).

Ave
Max
Min
Sum
Inst Instantaneous value

Report start year, month, day, and time (19 characters)
Channel number (five characters)

Tag name (16 characters)

Unit (six characters)

Status (the events that occurred while creating report data) (10

characters)

Bo Burnout detected
Er Error detected

ov Overflow detected
Pw Power failure

Cg Change (time changed)

Report type (seven characters)

Hourly

Daily

Weekly

Monthly

Report year, month, day, and time (19 characters)
Average, maximum, minimum, sum, or instantaneous value
(13 characters)

Below is an example of an hourly report for four channels (with the report type set to
Hourly+Daily reports and the file type set to Separate).

Version 1.00.00

MvV2000
shift-JIS
Complete
S5E701600

Hourly+Daily
Hourly

Ave

2008/01/23 08:10:56

CHOO1
TI-101
°C
Hourly

2008/01/23 09:00:00

91.5

259.8

-59.9
3.293636E+05

Max Min Sum
CHO002 CHOO03 CHO004
oUT-102 FI-103 VA-204
v m3/h %
-0.039 241.1 48.6
0.726 416.5 76.6
-0.727 83.4 23.3

-1.392980E+02 8.680871E+05 1.748983E+05

IM MV1000-01E
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Appendix 3 Text File Formats

Note

When channel data is in a condition shown in the table below, the MV outputs Exr, Ov, or Bo
to the report.

Data Condition Status
Error Er
Measurement and external input channels
Positive range-out Ov
Negative range-out Ov
Burnout detection Bo
Computation channels
Positive computation range-out (when the value exceeds Ov
approx. 3.4E+38)
Negative computation range-out (when the value is less Ov

than approx. —3.4E+38)

The report output value of Ave, Max, Min, Sum, and Inst varies depending on the channel
data condition as shown in the table below.

Item Data Condition of Measurement or External Input Report Output
Channels Value

Ave When all of the data are errors or range-outs (Space)

Max, » When all of the data are errors (Space)

Min, * Positive range-out values (includes burnout detection) 99999

Inst » Negative range-out values (includes burnout detection) —-99999

Sum * When all of the data are errors or range-outs (Space)
* When the sum value exceeds approx. 3.4E+38 9.999999E+99
* When the sum value is less than approx. —3.4E + 38 —9.999999E+99

Item Data Condition of Computation Channels Report Output

Value

Ave When all of the data are errors or computation range-out (Space)

Max, * When all of the data are errors (Space)

Min, * When the maximum value or instantaneous value exceeds 999999999

99999999
Inst * When the minimum value or instantaneous value is less —999999999
than —9999999

Sum » When all of the data are errors or computation range-outs  (Space)
* When the sum value exceeds approx. 3.4E+38 9.999999E+99
» When the sum value is less than approx. —3.4E + 38 —9.999999E+99

*

The decimal place for maximum, minimum, and instantaneous values is set to the
decimal place that was specified for the span setting of the expression. For example, if
the span setting of the expression is 200.0, the MV outputs 999999999 when the value
exceeds 9999999.9 and —999999999 when the value is less than —999999.9.
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Symbol

ettt et ee e ettt e e ettt eaaheeee e teee e e —eee e e —eeeeaartee e naeeeareeeeareeeaanreeeas 10-7
[A2DIC] s 10-11
Numeric

4-panel display ........c.cceeciiiiiiiii e 1-24, 5-31
A

abnormal data............coooiiiiiiiii e 1-47
ABS s 10-7
absolute time Mode ..........cccoooeiiiiiiieececccee e 1-36
ACK ..ooiiiieieee 1-8, 3-14
ACHION . 1-37
added message .1-16, 6-9
= Lo [0 [T PSSP PPPN 9-5

alarm configuration ..o 3-11
alarm delay time ..o 3-13, 10-4
alarm detection ..........coocovvieeiiii i 3-13
alarm hide function ...........ccoooiiiii e 1-7
alarm indication

AlAarmM MaArK.......c.oveeeee e
alarm output relay..........coooiiiiiii e 1-7, 3-8

1-8, 3-14

alarm output release .
.. 1-19, 5-22

alarm summary..

AULO INCIEMENT ...
auto logout
AUEO MESSATE ....eiiiieieiiiiii ettt
AUEO SAVE ..o

AU SWItChING.....ooiiiiii
AUED ZONE ...

B

background COIOr...........ceiriiiiiiiiieiiieeeeeee 1-25, 5-14, 6-28
backlight saver...........cccveeiiiiice e 1-25, 9-11
bar graph base position............ccccoiviiiiiiii 6-25
bar graph direCtion............occceeiiiiiiiiee e 6-25
bar graph display
basic arithmetiC..........ocooiiiii e
batch comment ...

batch function ...
batch name....
batch number.

brightness...
Burnout.......
burnout .............

burnout detection.............cooiviiiiiii 1-4

c

calculation eXPreSSION .......cuie i 10-6
calibration

CF card record length...
change message...
CHARGE LED.................
clock, gradual COrreCtion...........ccueeeiiieeeiiiie e 1-50
CLOG computation.........coccueiiieiiie e

color scale band ...........
communication errors
communication 10g..........ccccvevrennenn. .
computation, order of precedence..........c.cceeveveniieeeniieeens 10-6
computation, starting ..........ccceeieeiiiiei e
computation, usable data ... .
computation channels..........cccccoooiiiiiieii e
computation data dropout...........cccoceeeiiiiiiiiincnen.
CoOmMPUEALION EITOT .....eviiiiiiei e
computation fuNCioN ...........cocceiiiiiiiiiecn
computation type .
conditional eXPreSSioN .......coccvveivie i
CONINUOUS data ......oeeiiiiiieiiee e
current value indicator
CUISO ...ttt ettt ettt

D

data, SAVING ...ocieiiiiieie e 5-24
data length.. ... 4-3
data recording and storage flowchart.............cccooiiiienenne. 1-27
data tYPES ..o 1-26, 4-2
date format ... ...1-50, 9-3
AE-ENEIGIZE....cceiiiiiiiie e 1-7, 1-8
dedicated computation channels...........ccccccevviieiiieecinne 1-42
delay high limit alarm...................

delay low limit alarm.....

device status output...

(] [0 o Yo TSRS
difference computation .............cccceeiiii e

difference high limit alarm...
difference low limit alarm....

display, registration .
display, SPIttNG .......oooiiiiiii e
display channel..........cooooiiii e
display configuration name.............cccceiviiiiiiiiiiic e
display data .........cocooeiiiiiii e
display data recording conditions....
displayed items, SWitChing..........cccoiiiiiiiiiiie
AISPlAY GrOUP ...t
display layout...................
display selection menu....
display zone...........ccocee..
dOmMaiN NAME ...

E

error log
©ITON MESSAUES. .. eutiiieeiteieeeieeeeetr e e sttt e e e e e s e e anreeeas 12-1
errors related to parameter settings .........ccccooviiiiiiiiicn. 12-1
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Index

EVENME .t 1-36
event action ...........ooiiiiiii e 1-36, 7-1
eventdata........cooeeiiiiiiiiincnnen. ... 1-26, 1-28
event data recording conditions...........c.cccooeiiiiiiiiieeneee 1-29
EX P e 10-7
EXPANSION ...ttt ettt e e e e b e e neee s 5-32

external dimensions (MV1000)...
external dimensions (MV2000)...
external input channels............cccccoiiii, 1-51, 111
external storage media, SaviNg.........cccoevviiiiiiiiiiiee 1-31

F

FAIL OUEPUL ...
favorite display key
FIFO oottt

file, deltion ......cccveeeeeee e
file, loading ....
file format.........oooveiiiie e

(LIS oY= o (=T RN
FlE TST. e
file NAME ...
file name, user-specified
file name structure
file save interval...........ccooeiiiiii i
file siz€....uvveeeeeennnn,

file size calculation
fine grid.........cccccee
fixed alarm Mark..........cccoueveeeiiicieeeeeeeceee e

flash memory ....
format type........

I 1-29
fre€ MESSAGE ...cciiiiiiiiiii e 1-12, 6-9
frEE SPACE ...ttt 4-16
function MenuU ..., 5-3, 6-35
G

GE e

group

high limit on rate-of-change
historical display submenu ...... .
historical trend ...

hold (alarm indication) ...
hold (alarm output relay).........ccooeeiiiiieiieiieeee e
hold/NONNOId ...
horizontal split diSplay ........c.coeiiiiiiiiieee s
oSt NaME ...
NYSTEIESIS ...t

indication hold............cocoiiiii 3-8
information display submenu.............cccccooiiiiiiiiinn 5-16
initialization
INPUL PrOCESSING ...vviiiiiiiieeie e 1-4
INPUL FANGE. ... 3-3
INPUL EYPE . 1-3

installing on @ panel...........ccooiiiiiiiiiie e 2-3
integration time....
interface.............
internal MemMOrY ...

internal memory recording length ..o,
internal switch...............cccooon.
interval for rate-of-change alarm ..
INVALI KEYS ...

J

Jump default display.........coooeeeiiiii e 6-30

K

keyboard...
key lock............... .
Key 10CK relase........ocouiiiiiiiiiiiicct e 8-3

log display.
logging in ..
logging out

logical computation..........cccceiiiiiiiiiie e 10-8
10giN FUNCHON ..o 1-41, 8-4
login log

1Ot NUMDET. ... 1-35
lot NUMDbEr digits .....coueviiiiiie e 4-8
JOW=CUL ..o 1-5, 3-5
low limit on rate-of-change ...........ccccoiiieiiiiiii e 1-6
LT e 10-7
M

MAINTENANCE .....eeiiiiie e 12-20
manually sampled data...........cocoeeiiieiniiiieiien 1-26, 1-30
manually sampled data format ............cccoceeiiiiiiniiiiinens App-10
manuals i
manual SAMPLNG .....oooiiiiiiii e 4-14
MANUAL SAVE ....oeiiiiiieiiiie e 1-32, 4-11
match time timer...............ccccoe... .1-36, 1-37
measured values, update interval.... 1-9
measurement channel.................. .. 1-3
measuremMent MOAE. ........oouiiiiiiiieiii e 3-1

Measure SOft KEY .......ueeiiiiiiiiiiie e 3-16
memory information...

memory sampling .. .4-2
memory start.......... 4-10
MEMOTY SOP ....eeiiiiiteeiiie ettt 4-11
MEMOTY SUMMAIY .....iiiieiiiieeiiieeesieeeeseee e reee e 1-21, 5-24
menu custoMization.............cceeviiiiiiiiiciece 1-25, 5-4
message................ . 112, 6-7
MESSAGE COIOTS ...ttt 6-10
message display direction ...........ccooceeiiiiiiii e 6-22
messages (errors, status, etC).........ccveveriiiiieeiieiiic e 1241
message summary .

Modbus client status display..........cccccoriiiiiiiieiniieeceee, 1-23
Modbus master status display ..........ccoccveeviiiiniiiciniece, 1-23
Modbus status display ..........ccceceeriienieiiiiiieeeee e 5-18

Index-2

IM MV1000-01E



Modbus status 10g ........ccoouviiiiiii
mode (event data) ...
mode (range)...........
MONILON PAUSE ...eeieiiiiiiiieiee e e et e e e e st e e e e e e s e e e e e ennneeees
MOVING @VETAJE .....cuviiiiieiiieiee ittt

N

network information screen
NO JOGGING -ttt
NONNOIA.....oiiii e
nonhold (alarm indication).......

nonhold (alarm output relay)....

NUMENIC AISPIAY ...t
numeric display SECHON ..........cccooiiiiiiiieeee e

0)

operation, order of ...
operation errors ..........
operation history log
operations available while logged out...........c.cccoviiiiiinennn. 1-41

Over..
over-range detection... .
OVEITIOW i
OVErflOW data .......coviiiiiiiic e
overview display
overview display SUDMENU .........cceeiiiiiiiiiiiiiieee e 5-15

P

PrE-trgEr ettt
pulse input..
PUISE SUM ..ottt eeee e

R

L= 10T [PPSR 3-4
FANGE-OUL ...ttt ettt e e 1-14
recommended replacement periods for worn parts............ 12-20
recommended torque for tightening the screws ... ..2-5, 2-9

recording, StOPPING ......evviiiiie i 4-11
TECYCIE ..t 2-18
reference channel.............ccooiiii 3-5
reference junction compensation..............cccceeiienennnn.

reflash......ccccoceeeennenn.
relational computation
relative time mode ............cccooiiiiiiiii,
relay action 0N ACK .......c.coiiiiiiiiiiii e
relay status display..
remote control..........
remote control function..
rePEAL trIGQET .. eeii it
replacing the battery ..o
report channels, changing .
report data ........oooveveeiiiii e

FEPOrt AiSPlAY .....coieeiiiiiiie i
report file, date when divided...
report file diVISION...........cooiiiii e

report file format

report function.....

report generation

FEPOI GrOUD ...
RESET ..ottt
reset (computation ..10-16
reset (timer)........... 7-4, 7-6
reset+start .... ..10-15
FEVISIONS ...ttt ii
rolliNg @VErage .......covueiiiiiiieeiee e 1-45, 10-5
S

SAMPIE FALE ...

sampling count

scale, number of diViSIONS .........c..evvieeiiiiiiiieee e 6-14
scale lower
SCAIE POSItION ...
SCAIE UPPET ..ttt
SCAN INTEIVAl ..o
screen iMage data.........ccevovieieiiiieiiee e
second trend interval . .
SECUILY ettt ettt ettt ettt et e e et e e et e e e nneeeeannes
SEPANATON ...

setup data..............
setup data, loading
setup data, SAVING ....ccceeiiiiiiiiiiee e
single/dual graph ...
single trigger-.......

snapshot....
snapshot data..

square root cComputation............ccceeiiiiiiiiiie e 1-5
stacked bar graph..........coccii 5-19
standard display ................. 6-30
standard temperature device.. 12-21
START key operation.............. ..10-15
status display Section ...........ccoceeiiiiiiiiii 1-10
Status MESSAGES. ... .ueiiiiiieiie e 12-14
Status OULPUL.....eeeiiiee e 9-8
storage medium, formatting.... 4-17
SEYIE NUMDET ... iii
SUDMENU.....oiiiii 5-1, 6-36
SUM OPeration UNit..........c.ooiiiiiiiiiiiiee e 1-46
symbols

symbols, inputtable............coooiiiiiii 9-10
SYSTEIM EITOIS ... 12-16
system information ..o 9-5
T

TAG NAME....o e
text.........

text field ....
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